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Adapters

FlexNet Manager Suite relies on software inventory collected from the computers in your computing estate to
calculate what licenses are required. While the system includes a full inventory-gathering capacity, it also allows
you to import inventory collected by other tools you may already have.

As well, the system uses a considerable amount of business-related data, including organizational structure, and
records of purchases, to correctly track your existing license entitlements. This business data can also be imported
from other sources in your enterprise.

The data collected by these 'third party' tools usually needs to be rationalized in different ways, and mapped into
the data fields within the FlexNet Manager Suite database. The interfaces that allow this mapping are called
adapters. Several adapters are provided by default with the system, or are available for download from the Flexera
Product and License Center. You can also build custom adapters for inventory using the Inventory Adapter Studio,
or for business data using the Business Adapter Studio, supplied with the product. (These tools are documented in
the FlexNet Manager Suite System Reference PDF, available through the title page of the online help.)

This document collects information on several of the standard adapters available for FlexNet Manager Suite.
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I
Using the BMC Discovery (ADDM)

Adapter

The tool from BMC for collecting hardware and software information, previously known as Atrium Discovery and
Dependency Mapping (ADDM), from version 11 has been renamed BMC Discovery. This tool can be a useful
inventory source as input to FlexNet Manager Suite to help in calculating license consumption as part of assessing
your overall license compliance.

To collect inventory information from BMC Discovery and import into the operations databases maintained by
FlexNet Manager Suite requires a data adapter. The adapter is documented in the following chapters.

Supported versions

The BMC Discovery adapter supports inventory import from the following releases of the BMC tool:

• 8.3 (ADDM)

• 9.0 (ADDM)

• 10.0 (ADDM)

• 11.0 (BMC Discovery)

• 11.1 (BMC Discovery)

• 11.2 (BMC Discovery)

10 FlexNet Manager Suite Adapters Reference | Company Confidential



1
Choosing a Configuration

The adapter to extract data from BMC Discovery can operate at different levels of detail, and with different
overheads, that depend on what level of licensing information you need to collect. This section gives a brief
overview of how the adapter works, and explains the different configurations and how to choose between them.
You need to choose the configuration appropriate for your enterprise before implementing the adapter.

How the Adapter Works
Although it is downloaded as a single zipped archive, the adapter includes several components to improve your
license reporting. The overview of the finished system shows:

• An optional set of patterns that can be deployed to each BMC Discovery instance to improve the initial level
of inventory detail collected by BMC Discovery.

• A staging server, which includes a simple SQL database where data collected from BMC Discovery can be
massaged for upload to FlexNet Manager Suite. The executable that speeds the data extraction process also
resides here. For on-premises solutions, this staging database may optionally reside on the central operations
databases server.

• The conversion and upload component, which converts data formats and uploads the result to the central
operations databases maintained by FlexNet Manager Suite.

Operation is summarized in this high-level diagram:

Figure 1: Process overview

The diagram shows:

Choosing a Configuration
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1. Optionally making use of additional patterns packaged with the adapter download, inventory details are
collected by BMC Discovery (previously ADDM).

2. The executable FnmpADDMStage.exe uses the web API to extract the information from BMC Discovery. This
method is used because the export process is 100 times faster than using mappings, and there is no
requirement to configure custom mappings for each BMC Discovery instance. This executable optionally
writes the gathered data into local XML files (available for inspection when required), and (determined by
the mode of operation) also writes the data from these XML files into the staging database.

3. A standard component of FlexNet Manager Suite called a Compliance Reader, executing from the central
application server, collects data from the staging database and imports it into the operations databases.
This final stage occurs when you run an inventory import to process the incoming inventory.

Components Explained
This section describes each of the components in more detail, with information to help you decide which of
these you will implement in your enterprise. Installation and setup follows in a separate section. The
components described below are:

• Optional collection patterns to enrich the inventory detail collected by BMC Discovery (see Optional Patterns)

• The FlexNet inventory agent (see The FlexNet inventory agent)

• The scripts for creating the staging database in Microsoft SQL Server (see Database Table Creation)

• The FnmpADDMStage.exe executable to extract inventory information from BMC Discovery, optionally write it

to XML files, and insert it into the staging database (see The Adapter Executable).

Optional Patterns
There are six collection patterns in all.

• FileEvidence allows collection of file evidence for use within FlexNet Manager Suite. This evidence may be

of two sub-types:

◦ Executable files that form part of the application, which are gathered only for Window platforms, and may
allow application recognition (particularly to the level of editions and versions)

◦ Identification files including ISO tag files, which may be gathered across any platform (including Windows
and UNIX-based environments).

The next two collection patterns run both on Windows and on non-Windows devices, instructing the BMC
Discovery inventory agent to gather additional data:

• InstallAnywhereEvidence returns the list of package titles found in the repository maintained by Flexera’s

InstallAnywhere

• InstallShieldMultiplatformEvidence returns the list of packages installed by InstallShield

Multiplatform, an earlier installation technology developed by Flexera.

Choosing a Configuration
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The next collection pattern is for non-Windows devices only, and uses the FlexNet inventory agent to capture
additional data elements and integrate these with the BMC Discovery inventory collected in the standard way:

• UnixHardwareData gets accurate hardware details to allow license metrics for capacity-based license

calculations (such as for Processor, Core, IBM PVU, and other license types).

Note: This pattern relies on the installation of two files, ndtrack.sh and ndtrack.ini, that are not
included with the adapter package. These files are available with any installation of the FlexNet Beacon or
application server. For more information, see The FlexNet inventory agent.

The last collection pattern contains instructions for the BMC Discovery inventory agent to pull additional data
from the Windows Registry and WMI on Windows-based computers:

• WindowsLastLoggedOnUser recovers information about end-users that is required for user-based licensing

(such as Named User license types).

Note: There is no equivalent data available for UNIX-like systems.

To help you assess which of the patterns you wish to use, the following table summarizes the available
collection patterns. The default state, whether the pattern is enabled or disabled, is shown in the Pattern
column. The Footprint column details the additional installation impact (other than loading the pattern into
BMC Discovery) required for the collection pattern (the downside of using the pattern), and the Impact column
shows what will not work if you omit this pattern (the downside of not using it).

Choosing a Configuration
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Pattern Footprint Impact of omitting pattern

FileEvidence

Default: Functionality is
controlled in two parts:

• Gathering identity (or tag)
files (all platforms) is
enabled by default

• Gathering executable
evidence (Windows only) is
disabled by default.

No installation required.
This pattern is configurable
for paths searched (per
platform), and for file name
extensions used for tag files.
Search times on target
machines will depend on
configuration and the
numbers of installed
applications found.

An application that

• Is not already correctly recognized by
BMC Discovery (perhaps because it is
installed but not currently running), and

• Relies exclusively on file evidence (as
distinct from installer evidence) for
recognition within FlexNet Manager Suite

will not be recognized for inventory
collected through BMC Discovery without
this pattern.
While the Application Recognition Library
rarely makes use of file evidence for
Windows-based applications, some
publishers including IBM and Oracle make
use of special identity files. Software
identity tags are also in increasing use, and
these are identified using this pattern.
Likely impact of omitting this pattern in
total is medium (through the loss of
identity files). Likely impact of leaving
executable gathering turned off is low.

Note: Within FlexNet Manager Suite, file
evidence is also required for application
usage tracking; but no application usage
tracking is possible through the BMC
Discovery inventory tool.

InstallAnywhere Evidence

Default: Enabled
No installation required. BMC Discovery does not recognize

installation evidence from InstallAnywhere.
Unless it recognizes the application by other
means, the application will be missed
without this pattern.

InstallShield

MultiplatformEvidence

Default: Enabled

No installation required. BMC Discovery does not recognize
installation evidence from InstallShield
Multiplatform. Unless it recognizes the
application by other means, the application
will be missed without this pattern.

Choosing a Configuration
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Pattern Footprint Impact of omitting pattern

UnixHardwareData

Default: Enabled
Requires less than 13 MB
installation (ndtrack.sh and
ndtrack.ini), either on the
hard disk of the target
machines, or on a network
share accessible to them all.
Run-time is a second or so
when triggered by BMC
Discovery.

Without this, BMC Discovery does not
capture sufficient hardware attributes from
servers to support license consumption
calculations on license types based on
hardware capacity metrics (such as
Processor, Core, IBM PVU, and other license
types). Assess impact based on the license
types you need to support through BMC
Discovery inventory (mandatory for capacity
metrics).

WindowsLast LoggedOnUser

Default: Enabled
No installation required. Without this pattern, BMC Discovery does

not report any end-user identification that is
needed for licenses requiring identification
of the individual (such as Named User
license types). Note that for general user-
based licensing, in the absence of end-user
identities, FlexNet Manager Suite will
calculate every installation of such software
as usage by an unknown end-user, so that
only license types depending specifically on
identity will be affected. If you wish to
allocate license entitlements to specific
individuals, you also require this
identification. Impact: medium.

Note: For releases of BMC Atrium Discovery and Dependency Mapping up to and including 11.0, there is an
additional pattern that improves the details about processors collected by BMC Discovery. This level of detail
is required only for Oracle and IBM license calculations (for other licenses, the patterns above are adequate).
By contractual arrangement with BMC, this pattern can be provided only to customers approved by BMC. For
further information, ask your Flexera consultant, who can arrange the necessary approval and provide the
pattern for you. Notice that for BMC Discovery release 11.1 or later, the additional pattern is deprecated. BMC
Discovery 11.1 (and later) has improved processor information collection which makes this additional pattern
unnecessary.

For more information:

• About each of these patterns, please see Appendix A: Details of Patterns

• About installing these patterns, see Installing Optional Patterns

• About enabling or disabling each of the patterns, see Enabling Optional Patterns.

The FlexNet inventory agent
The FlexNet inventory agent is a standard component of any installation of FlexNet Beacon, and of the
application server that is included with FlexNet Manager Suite. For this reason, the necessary files are not
included in the BMC Discovery adapter zip archive, since they are already present in any standard product

Choosing a Configuration
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implementation. Installation to suit the BMC Discovery adapter is described in Installing the FlexNet inventory
agent.

For use on Linux or UNIX platforms, the agent has two component files:

• ndtrack.sh, an agent responsible for collecting inventory details (in this case, from the BMC Discovery

inventory system) and writing them in an intermediate format to a data file, ready for upload to an
application server. The script has no active elements until it is triggered by BMC Discovery through one of
the enhanced collection patterns.

• ndtrack.ini, a text file that contains configuration variables for ndtrack.sh.

The combined disk space requirement of both files is under 13MB.

Database Table Creation
The staging server requires an operating version of Microsoft SQL Server 2008 or later. Any edition is suitable,
including Microsoft SQL Server Express (if its limitations on CPU, RAM, and database size are adequate for your
purposes). As described in Choosing a Staging Server, the staging database may be located on a separate
staging server, or on your central (on-premises) operations databases on your FlexNet Manager Suite server.

In the SQL\ subdirectory of your unzipped adapter archive, the script ADDM_staging.sql is provided for
creating the staging database, its tables, and its stored procedure. Obviously, this must be run on the SQL
Server instance that is to host the staging database.

Important: If you have been using an earlier version of ADDM, and are now migrating to BMC Discovery
release 11 (or later), you must run the same ADDM_staging.sql script to update your staging database
schema. If you are continuing to use ADDM release 10 (or earlier), the update to the staging database
schema is not required, and you may omit it for now; but if you choose to apply the upgrade now (so that the
staging database is prepared for any future migration to BMC Discovery 11 or later), you must also use the
latest version of the FnmpADDMStage.exe executable from the same Adapter Tools for FlexNet Manager
Suite 2018 R1.zip archive. This executable transfers to BMC Discovery data (for any BMC Discovery/ADDM
version) to the staging database, and is schema-aware for the upgraded staging database.

The Adapter Executable
BMC Discovery supports two ways of extracting inventory data it has collected:

• Using export mapping sets

• Using a web API.

While the former is more commonly used, the BMC Discovery adapter for FlexNet Manager Suite uses the
latter, for the following reasons:

• It avoids the need to deploy and maintain export mapping sets on every BMC Discovery instance in your
enterprise.

• Performance of data collection can be 100 times faster using the web API. For example, data extraction that
can take over 24 hours using mapping sets can be completed in 20 minutes with the web API. This is

Choosing a Configuration
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because the export feature in BMC Discovery is designed for more complex export capabilities and can
therefore be slow to perform simple queries. FlexNet Manager Suite requires only simple queries to be
executed on BMC Discovery, and these are performed far more efficiently using the web API.

The tool to query the web API consists of two parts:

• FnmpADDMStage.exe — A .NET 4.5 console program capable of querying the XML API of BMC Discovery

and writing the results into an SQL Server database, and optionally to XML files on the local file system. This
program supports command line arguments, available using FnmpADDMStage -h

• FnmpADDMSettings.xml — The self-documenting configuration file for FnmpADDMStage.exe which

contains the queries executed against BMC Discovery (in the BMC Discovery query language), and can
include connection settings for BMC Discovery and SQL Server.

In operation, the executable, FnmpADDMStage.exe, extracts the inventory data from BMC Discovery and saves
it for further processing. There are different ways that it can save the data, based on the following values of its
method parameter:

• Stage — Summary: BMC Discovery to XML. Inventory gathered from BMC Discovery is saved to a series of

XML files on the staging server. It is not imported into the staging database. The XML files allow for review
of the gathered data, but the inventory is not imported into FlexNet Manager Suite from these files.

Tip: The XML file option also allows for disconnected scenarios, where inventory collected from an BMC
Discovery server that is out of reach of the staging server can be written to XML, manually copied and
transferred to another staging server, and the upload process resumed. See also the Prestaged method
below.

• Staged — Summary: BMC Discovery to XML/SQL. Inventory gathered from BMC Discovery is first written

to the XML files on disk (for example for review), and then copied into the staging database where it can be
imported into FlexNet Manager Suite for use in compliance calculations.

• Prestaged — Summary: XML to SQL. In this mode, inventory is not gathered from BMC Discovery. Instead,

the XML files present on the disk from a previous inventory collection (and perhaps reviewed and approved
by a human agent in this format) are now copied into the staging database where it can be imported into
FlexNet Manager Suite for use in compliance calculations.

• Stream — Summary: BMC Discovery to SQL. Inventory is gathered from BMC Discovery, and loaded into

the staging database where it can be imported into FlexNet Manager Suite for use in compliance
calculations. In this method, inventory is not recorded in XML files on the staging server.

Default values for the method and all other parameters are set in the companion FnmpADDMSettings.xml file,
and these are the values used when the executable is triggered (or run) without other command-line options.
The settings file is self-documented, and the matching command-line options are available using
FnmpADDMStage -h

When the executable writes XML files to (or reads them from) the local disk on the staging server, the files
include the following (details are available in FnmpADDMSettings.xml):

Choosing a Configuration
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Filename Content

Cluster.xml Details for each cluster.

ClusterHost.xml Computers (host nodes) that are members of a cluster, including a
key to the Cluster node to identify that cluster.

CPUInformationDetail.xml Details of computer processors.

DiscoveredPackages.xml Raw installer evidence gathered by BMC Discovery from the installer
technologies supported by each operating system.

DiscoveredService.xml A report of particular services, used to help identify capabilities of
hosts. This includes the VMMS service used to identify Windows
machines with the Hyper-V role enabled.

DiscoveredVirtualMachine.xml Raw results from BMC Discovery querying the list of virtual machines
on a virtualization host.

FileEvidenceDetail.xml File evidence produced by the
Flexera.FNMP.InventoryRawData.FileEvidence pattern,
covering software tag files and Windows executables.

FileSystem.xml Name and size of all local file systems, used to approximate the total
disks and storage of host.

HardwareEvidenceDetail.xml Hardware details produced by the
Flexera.FNMP.InventoryRawData.UnixHardwareEvidence

pattern, using information gathered by the FlexNet inventory agent.

Host.xml Details of all hosts known by BMC Discovery including their host
name, operating system details, unique identification, processor,
memory, and other hardware details.

HostInfo.xml Raw host details not represented in a Host node, mainly the raw
LPAR information from an IBM AIX LPAR environment.

HostContainerProcessorInfo.xml Processor details for systems that are a container for hosts. For
example, a container is a device partitioned into a number of logical
hosts.

InstallerEvidenceDetail.xml Installation evidence gathered using the patterns in the BMC
Discovery adaptor, including evidence from installations by Install
Anywhere and InstallShield Multi-platform.

LastLoggedOnUserDetail.xml Details of the last logged-on user for Windows systems. (There is no
equivalent data available for UNIX-like systems.)
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Filename Content

NetworkInterface.xml The IP and MAC addresses of each network interface, used to build a
list of these addresses for each host.

Note: ADDM 9.0 introduced the IPAddress nodes which cover
both IPv4 and IPv6. Prior to that, the IPv4 IP address was in the
NetworkInterface node. This query checks both of these sources.

SoftwareInstance.xml Software installations identified by BMC Discovery's pattern
language. BMC Discovery queries various properties such as
processes and files of a host to determine which software is installed
and its version.

SoftwareInstanceVirtual

Machine.xml

These SoftwareInstance nodes are used to represent virtual
machines on a host. These records are typically only created when
the virtual machine is running.

Conditions for Use

Use of this executable, FnmpADDMStage.exe, imposes the following conditions:

• Within BMC Discovery, the XML-based API must be enabled (by default, it is enabled). BMC documentation
for the XML API is available at https://docs.bmc.com/docs/display/DISCO111/XML+API.

• There must be HTTP or HTTPS communication available between the staging server, on which this
executable runs, and the server hosting BMC Discovery.

• The staging server requires the .NET 4.5 (minimum) runtime environment.

• The staging tool must be configured with credentials that provide read access to the BMC Discovery
instance. These credentials may either be configured in FnmpADDMSettings.xml or supplied on the

command line for FnmpADDMStage.exe (for details see Account Configuration). For Discovery 11.1 and

later, you need to grant the API access permission (api-access group), or update group permissions to
include the api/access permission for the user that is specified in the FnmpADDMSettings.xml, who

requires access to the XML Web APIs.

• For linking upstream to the staging database, you can either

◦ Use a trusted connection to the SQL server and run the executable under an account that has read/write
access to the staging database; or

◦ Use service account credentials for SQL through a connection string, which may either be configured in
FnmpADDMSettings.xml or supplied on the command line for FNMPAddmStage.exe (see Creating the

Staging Database Tables for details).

Important: It is critical that the FnmpADDMStage.exe tool is not run simultaneously with the
ComplianceReader tool that uploads from the staging database to the compliance server. The adapter
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executable commences its writing activity with a truncate of the staging database to clear old results, an
action which (if it occurred in the middle of an upload to the compliance server) could clearly corrupt the
imported dataset. While ComplianceReader is blocked until FnmpADDMStage.exe finishes, you must adjust
your schedules to prevent starting FnmpADDMStage.exe while the ComplianceReader is running.
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2
Installation and Configuration

For on-premises implementations, files are included in your product installation archive for the application
server. As well, the latest version of the adapter is available for download from the Flexera flexnetoperations

website. For cloud implementations of FlexNet Manager Suite, you also require this download: although you do
not need to make changes to your central application server, there are additional components you require in the
download.

You need credentials supplied by Flexera to access this download. Details of the download are included in
Creating the Staging Database Tables.

• The BMC Discovery adapter suits FlexNet Manager Suite releases 9.2.3, and 2014 and later for on-premises
delivery.

• The build number for this adapter is 12.0 (or higher). You can identify this number by right-clicking on
FNMPADDMStage.exe, selecting Properties and looking at the Details tab.

Save the zipped archive to a suitable temporary location, and unzip it.

Full details of setting up the BMC Discovery adapter are included in the following sections.

Choosing a Staging Server
The FlexNet adapter for BMC Discovery requires a ‘staging server’ that supports installation of the adapter’s
executable and of the staging database. Several configurations are possible. The staging server may be installed
on:

• A dedicated stand-alone server (or virtual machine)

• Any other suitable machine in your enterprise, such as a print server

• An inventory beacon

• The central application server where FlexNet Manager Suite is installed (for on-premises installations).

The requirements for a suitable server include:

• A Windows-based operating system
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• Access to an installation of Microsoft SQL Server 2008 or later, in any edition, where the staging database
may be implemented (it may be on the staging server, or on a separate database server)

• The .NET 4.5 runtime environment installed

• Network access to the central application server (when not co-installed there)

• Efficient network access to each BMC Discovery server in your enterprise, using the HTTP or HTTPS protocols.

Note: Disconnected scenarios are also possible, using the intermediate XML files saved to disk to allow
manual intervention. For more information, see The Adapter Executable.

Creating the Staging Database Tables
Once you have selected your staging server, and it can access an operating implementation of Microsoft SQL
Server running a database instance you intend to use for the staging database, you should use the script
provided to create the staging database and set up the appropriate database tables within it. This can be done
from SQL Server Management Studio, or from the command line as described in the following procedure.

1. Download the Adapter Tools for FlexNet Manager Suite 2018 R1.zip archive from the Flexera
Customer Community knowledge base:

a. Access https://flexeracommunity.force.com/customer/articles/en_US/INFO/Adapter-Tools-for-
FlexNet-Manager-Suite.

Tip: Access requires your Customer Community user name and password. If you do not have
one, use the link on the login page to request one.

b. Click the link Adapter Tools for FlexNet Manager Suite.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet
Manager Suite 2018 R1.zip commences.

c. In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C:\Temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it
to the appropriate working location when the download is finished.

2. Right-click the downloaded zip archive, and choose Extract All....

3. Navigate through the unzipped archive to Adapter Tools for FlexNet Manager Suite 2018 R1.zip >
BMC Atrium Discovery and Dependency Mapping Tools > SQL.

4. If necessary, copy the script ADDM_staging.sql from the SQL\ folder of your unzipped adapter archive to
a temporary folder on your staging server.

5. Open a command prompt on the staging server.

6. In the command prompt window, execute the following command, as amended:
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sqlcmd -S ServerName\InstanceName -i TemporaryPath\ADDM_staging.sql

where:

• The database ADDM_Staging is created with all necessary tables, indices, and so on.

• ServerName is the name of the database server hosting the staging database, or its IP address, or “.”

(dot) if you are running the staging script on the same server as the database instance

• InstanceName is the name of the instance to use for the database staging tables (this parameter may

be omitted if the instance is the default instance)

• TemporaryPath is the location where you saved the SQL procedure.

Example:

sqlcmd -S 192.100.0.20\Development -i C:\temp\ADDM_staging.sql

7. Ensure that the account under which the adapter executable will run has read/write/execute permissions on
this database instance. Authentication may be through Windows NT authentication or SQL Server
authentication. Using Windows NT authentication, the default account is the username running the
FnmpADDMStage.exe adapter. SQL connection is specified as a standard connection string, which you may
supply in FnmpADDMSettings.xml, or override with the -c option on the command line.

Tip: Configuration of the account is done through SQL Server Management Studio.

The staging database is now ready for operation.

Installing and Configuring the Staging Tool
This procedure includes many separate sub-processes to complete the set-up of the adapter executable. We
start from the configuration of the inventory reader that uploads inventory gathered by the adapter.

To install and configure the staging tool:

1. Navigate to C:\ProgramData\Flexera Software\Compliance\ImportProcedures\Inventory\

Reader\.

This is the fixed location on the inventory beacon where the inventory reader (reaching out from the
compliance server) must find configuration files to control its uploads. By default, the inventory import
(starting with the reader) is triggered around 2am. Therefore you might consider scheduling this task for
some time such as 10pm daily. The command line for the scheduled task (assuming that you have saved
your preferred settings) is simply to invoke the executable. Any parameters not specified on the command
line are taken from the settings file in the same folder as the executable.

2. From your unzipped adapter archive, copy the folder BMC Atrium Discovery and Dependency Mapping
(found in the path Adapter\Reader\) to the location identified in the previous step. This folder includes at
least ten XML files and a reader.config file. This completes configuration for the inventory reader.
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3. Create a folder to contain the adapter executable and its configuration file. Location is not critical; a
suggested path is under C:\Program Files\Flexera Software. In your chosen location, create a folder
such as ADDMAdapter.

4. From the FnmpADDMStage\ folder within your unzipped archive, copy both FnmpADDMStage.exe and
FnmpADDMSettings.xml to your newly created folder (such as C:\Program Files\Flexera Software\
ADDMAdapter).

5. Open your copy of FnmpADDMSettings.xml in a text editor of choice, and review the self-documenting
comments within that file. Modify the following values as required (at the very minimum, correct the IP
address of your BMC Discovery server):

• BMC has changed the permission required to access the XML API. You need to grant the new API
access permission (api-access group), or update group permissions to include the api-access
permission for users who require access to the XML web API. Existing integrations will fail if you do not
add the permission.

• Update values in the first element describing the downstream connection to the BMC Discovery server,
including the IP address, the account name and password for access. Keep a record of the account
name and password for registering with BMC Discovery (see Account Configuration). The default values
are: <server protocol="http" address="10.200.20.138" username="exportuser"

password="Pa$$w0rd" timeout="3600"/>

Tip: If you do not wish to record the password in the plain text configuration file, you can use a script
to retrieve the password from an encrypted store, and supply it as a command-line option when
starting the FnmpADDMStage.exe tool.

• Update the second element for the connection to the staging database. The default values are:
<database connection-

string="Server=.;Database=ADDM_Staging;Trusted_Connection=yes;"/>

• Update the third element to configure whether, and where, the executable should save XML files of the
inventory collected from BMC Discovery. The default value stores any XML files below the location of
the executable (but turns off storage anyway): <staging path="." method="stream"/> You may

wish to redirect the path setting for easier access for human inspection.

• Save your modified settings file.

6. Assuming that you do not wish to trigger the adapter manually every time it needs to run, start Windows
Task Scheduler, and create a basic task to run the adapter.

Important: It is critical that you schedule the adapter to run at times which cannot overlap with the
inventory reader uploading the results to the compliance server. Check the schedule for the compliance
reader on the central compliance server, and avoid this time slot.

By default, the inventory import (starting with the reader) is triggered around 2am. Therefore you might
consider scheduling this task for some time such as 10pm daily. The command line for the scheduled task
(assuming that you have saved your preferred settings) is simply to invoke the executable. Any parameters
not specified on the command line are taken from the settings file in the same folder as the executable.
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This completes the configuration of the adapter executable itself. Now we can turn our attention downstream,
first to possible installations on target UNIX-based machines, and then to enhancements to BMC Discovery
itself.

Installing the FlexNet inventory agent
If you have chosen to install any of the UNIX-related collection patterns to enhance the inventory collection
available through BMC Discovery, the FlexNet inventory agent must be copied either:

• On to each UNIX-based machine that is a target for enhanced inventory collection; or

• To a pre-configured NFS share that is accessible from each of the target UNIX-based machines.

In the following procedure, your choice of either of the above two locations is referred to as the ‘target location’.

(For background information about the FlexNet inventory agent, see The FlexNet inventory agent. For choosing
between the collection patterns, see Optional Patterns. Further information about deploying the FlexNet
inventory agent is available in the separate PDF file Gathering FlexNet Inventory.)

To install the FlexNet inventory agent for UNIX collection patterns:

1. Using the installations of either FlexNet Beacon, or application server, locate the subdirectory that contains
the ndtrack files. The default location is C:\Program Files\Flexera Software\Inventory Beacon\
RemoteExecution\Public\Inventory

2. From this folder, copy the two files ndtrack.sh and ndtrack.ini to the target location you selected
above (that is, either to a pre-configured NFS file share, or to each target UNIX-based machine). The
default location pre-configured in the template file is /opt/flexera/, but you may modify this as
required.

Important: The file path on all individual UNIX-based machines must be identical.

3. Note the file path used (whether a file share, or the identical path used across all target devices) for entry
into ADDM when you are enabling the optional collection patterns (see next section).

Configuring BMC Discovery
There are three customizations needed for BMC Discovery:

• Installing any of the optional patterns needed for the adapter in your environment (see below)

• Ensuring that BMC Discovery applies these patterns to the appropriate target computers (see Rediscovering
Affected Computers)

• Ensuring that the account running the adapter has access to BMC Discovery (see Account Configuration).
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Installing Optional Patterns
For information about choosing which patterns to use, see Optional Patterns. For details about enabling each
of the patterns, and modifying their behavior, see Appendix A: Details of Patterns. All these patterns are
contained in a single template (Flexera.FNMP.InventoryRawData.tpl), which must be installed first.
Thereafter, individual patterns can be enabled, disabled, and modified.

1. Log in to the BMC Discovery interface, and select the Discovery tab.

2. Select the Knowledge Management button in ADDM version 10, or BMC Discovery version 11 or later (in
earlier versions of ADDM, select the Pattern Management button).

Figure 2: The workspace in ADDM 10

3. Click on Upload (or in earlier versions, Upload New Package).

Figure 3: Choose the file from your unzipped archive

4. Click on Choose File, and in your unzipped archive of the adapter, select the FlexNet Manager

Platform\Installers\BMC Atrium Discovery and Dependency Mapping Tools\patterns\

Flexera.FNMP.InventoryRawData.tpl file.

5. If you are using ADDM version 8:
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a. Optionally modify (or accept) the default name of the package as
Flexera.FNMP.InventoryRawData.

b. Optionally, set the description to something you will find helpful, such as FNMP export patterns.

6. Click Upload (or in earlier versions, Upload & Activate).

Ensure that the message The Requested Changes were Successful is displayed. The
Flexera.FNMP.InventoryRawData pattern is now in the Active state. For further fine tuning, jump
ahead to step 4 in the following procedure.

Tip: For releases of BMC Atrium Discovery and Dependency Mapping up to and including 11.0, if you are
using data imported through the BMC Discovery adapter to manage points-based licenses for IBM and
Oracle, there is an additional optional pattern that collect further details about processors available on
request from Flexera. Notice that for BMC Discovery release 11.1 or later, the additional pattern is
deprecated. BMC Discovery 11.1 (and later) has improved processor information collection which makes this
additional pattern unnecessary.

Enabling Optional Patterns
By default, after installation some patterns are enabled and others disabled (see Optional Patterns). The
following procedure allows you to turn individual patterns on and off as required, as well as enabling (or
disabling) the entire module.

1. In the user interface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that the
Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled before
any of its member patterns can operate.)

3. From the Pattern Package properties, select the link for the Pattern Module.

4. Scroll down to the Pattern Configuration area.

Several closed groups are displayed, one for each optional pattern and another for configuration of the
FlexNet inventory agent on UNIX platforms.

5. For each group that you want to modify, select Edit Configuration to the right of the group. The group
opens, and configurable controls are displayed. Select the True radio button to turn on a pattern, and the
False radio button to turn off a pattern.

More details about configuration are included in Appendix A: Details of Patterns.

6. Click Apply.

The modified settings are displayed.

Tip: If you later use the Edit Module button to modify the module, be sure to activate, validate, and then
commit your changes.
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Rediscovering Affected Computers
Where (as is common) you are adding these patterns to an operational BMC Discovery instance that has
already taken inventory of computers in your estate, you must rediscover any computers that are to be
targeted through these new patterns, so that BMC Discovery applies to patterns to the rediscovered
computers. To achieve this, you may either:

• Create (or wait for) a scheduled scan

• Initiate a Snapshot discovery scan

• Manually execute each pattern for suitably grouped targets, as summarized in the following procedure.

For more information about these options, see the BMC Discovery documentation available at
http://discovery.bmc.com/confluence/display/90/Documentation.

To manually execute the new patterns:

1. In the BMC Discovery interface, select target computers (hosts or other nodes) by adding them to a
group, creating separate groups to receive distinct types of patterns (for example, one group for
Windows-related patterns, and another group for UNIX-related patterns). Create your groups using either
of these approaches:

• From a view node (including host) page, select Groups from the Actions list and add the node to a
group.

• From a report or other search result, select the required target computers. Then, select Groups from
the Actions list and add the target machines to a group.

2. From the Discovery tab, click Pattern Management.

3. Select the Flexera.FNMP.InventoryRawData pattern from the package list.

4. Click the Pattern Modules link.

5. Select the Pattern Module containing the pattern that you want to run.

6. Click the Pattern link in the heading table.

7. From the Actions list, select Run Pattern.

8. In the Run against Group list, select the group containing your target machines for the current pattern(s).

9. Set the Expand and Execution Logging preferences for the run.

10. Set Additional Discovery to Get all new discovery data. This forces a new discovery.

More details about this procedure are available from http://discovery.bmc.com/confluence/display/90/
Manual+pattern+execution.
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Account Configuration
The user name and password that the adapter needs to access the BMC Discovery API is defined in
FnmpADDMSettings.xml (see Installing and Configuring the Staging Tool). Here we grant that account
adequate rights.

1. In the BMC Discovery interface, select the Administration tab.

2. In the Security section of the Administration page, click the Users icon.

3. From the Users page, click Add at the bottom of the page.

Tip: If the account has already been registered in BMC Discovery, you can select it from the list of
users and review its settings.

4. Configure the adapter account, which can be a member of the readonly group. Ensure that the user name
and password are exactly same values that you configured in FnmpADDMSettings.xml. For BMC Discovery
11.1 and later, the permission required to access the XML API has changed. You need to grant the new
API access permission (api-access group), or update group permissions to include the api-access
permission for users who require access to the XML Web APIs. Existing integrations will fail if you do not
add the permission.

Installation and Configuration

FlexNet Manager Suite Adapters Reference | Company Confidential 29



Figure 4: Sample settings for a adapter account to access BMC Discovery

5. Save your settings.

BMC Discovery is now configured for use of the adapter.

Validation and Operation
Normal operation relies on the following sequence of events:

1. BMC Discovery gathers inventory using the enhanced patterns you have enabled (details: Installing
Optional Patterns, and Rediscovering Affected Computers).

2. At the time you scheduled (Installing and Configuring the Staging Tool), the adapter reads the current
content of the BMC Discovery database and stages the new data in the staging database (previous data is
first removed with a single truncate statement). The resulting status is flagged within the database.
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3. Following the schedule on the central compliance server, and provided that the staging status is Success,
the import reader uploads this content to the inventory database.

4. The next inventory import brings the final data set into the compliance database, where it is automatically
taken into account for compliance calculations. As always, the inventory records must be recognized by the
Application Recognition Library, and you must have the resulting application records linked to the
appropriate license, for compliance calculations to proceed.

To validate operation of the adapter:

1. Wait until BMC Discovery collects new inventory, so that the enhanced collection patterns are exercised.
For further details, see the BMC Discovery documentation.

2. Manually trigger the adapter executable.

By specifying a different method parameter, you have a one-time override of the default you set in the
settings XML file. For example:

C:\Program Files\Flexera Software\ADDMAdapter\FnmpADDMStage.exe

-f "C:\temp" -m staged

This will write XML files under your C:\temp directory for review. As well, it writes data into the staging
database.

3. Inspect the saved XML files to validate the inventory gathered.

4. Use SQL Server Management Studio to validate that the data is written to the staging database. Also review
the StagingState property in the ADDMStagingDatabaseConfiguration table in the staging database.
Possible values are Running, Failed, or Success. This value must be Success before the BMC Discovery
data can be uploaded from the staging database to the central inventory database.

5. Wait (for example, overnight) until the next inventory import and calculations have run.

6. Use FlexNet Manager Suite to validate that new evidence has been recovered. Identify which evidence has
been recognized by the ARL and which new rules are required. Link the applications to appropriate
licenses.
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3
Known Issues

The following issue has been identified:

• UNIX-based devices that have the same host name and no detected serial number in BMC Discovery are
merged into a single computer record in FlexNet Manager Suite.
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4
Appendix A: Details of Patterns

While the BMC Discovery discovery tool is a state-of-the-art tool to support ITAM, the out-of-the-box collection
of inventory does not capture all of the data elements required by FlexNet Manager Suite to perform an accurate
software license calculation. The optional patterns in this appendix extend those data capture capacities.

Overview of Patterns
The BMC Discovery Adapter available for FlexNet Manager Suite includes six additional patterns that can be
incorporated into BMC Discovery to capture these additional data attributes.

Pattern name FlexNet inventory agent
dependency

Default

FileEvidence No dependency. Tag files (all platforms):
Enabled
Executables (Windows
only): Disabled

InstallAnywhereEvidence None Enabled

InstallShieldMultiplatformEvidence None Enabled

UnixHardwareData Required Disabled

WindowsLastLoggedOnUser None Enabled

The patterns are written in the BMC Discovery Pattern Language (TPL), for which documentation is available at
http://discovery.bmc.com/confluence/display/90/The+Pattern+Language+TPL.

For a summary of the patterns to help decide which ones to enable or disable for your enterprise, see Optional
Patterns. The following sections go into more detail about each of the patterns.

Note: For releases of BMC Atrium Discovery and Dependency Mapping up to and including 11.0, the optional
patterns listed above do not provide enough detail about processors to allow management of points-based
licenses for IBM and Oracle based on data collected through BMC Discovery. If you need this capability
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through BMC ADDM (up to release 11.0), ask your Flexera consultant to request additional optional patterns
for you. Notice that for BMC Atrium Discovery and Dependency Mapping release 11.1 or later, the additional
pattern is deprecated. BMC Discovery 11.1 (and later) has improved processor information collection which
makes this additional pattern unnecessary.

FileEvidence
Some applications cannot be recognized by installer package information alone. It is sometimes necessary to
examine files that form part of the software installation, for either of two reasons:

• Some files are intended to provide identification details about an application, sometimes in human-readable
formats

• Examining executable files installed with the application may help with identification, even though this is not
their primary purpose.

Of the first class, identification files may take various forms. For example, many IBM applications are correctly
identified by specific files that IBM installs for this purpose. Oracle and Adobe are among other publishers using
specific files to identify some applications. Thus the Application Recognition Library (ARL) requires this file
information to correctly identify such applications. ISO/IEC 19770-2 SWID tags are also increasingly available,
and these ID tags are another useful form of identification file. The BMC Discovery Inventory Agent by default
does not capture the complete set of identity files.

Secondly, in addition to gathering those specific files that identify an application (and have no other function in
the application), it is sometimes necessary to identify installed executable files that are part of the application.
These may be the only way to identify an application, such as a particular edition or version of a product. A
standard implementation of BMC Discovery does not track executable files.

With this pattern, the functionality of BMC Discovery is extended to gather identification (tag) files on all
platforms, and executable file evidence on Windows platforms. Note that the pattern does not search network
shares or NFS mounts; nor does it follow symlinks (because of the risk of self-referencing loops). It also skips any
files or folders that are inaccessible. Within these constraints, it provides details of files matching the
specification and found within the defined paths on the local file system.

Important: Enabling and configuring the tracking of executables within this pattern should be handled with
skill and care, for two reasons:

• Tracking Windows executables using BMC Discovery is slow. It may be unacceptably slow to use for a wide
range of directories, and you may require very targeted inventory gathering using this facility.

• Tracking executable files can produce a very large data set. Across large Windows server farms, the number
of installation records can quickly run even into the millions, which may comprise a stress test for BMC
Discovery implementations and concentrators, and (to a slightly lesser extent) for your FlexNet Manager
Suite implementation.

Note: In FlexNet Manager Suite, you can use file evidence to track the usage of an application (perhaps with
a view to reclaiming under-used licenses). While that functionality requires you to identify a watch-list of at
least one executable file for each tracked application, file evidence alone is not sufficient for usage tracking: it
also requires additional FlexNet agents on the managed device, and an upload path through inventory
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beacons that preserve the additional usage data. File evidence gathered through the BMC Discovery adaptor is
not sufficient for usage tracking.

Results

The file evidence gathered on Windows servers is somewhat richer than on UNIX-based servers.

• On both platforms, the pattern first collects the target directories from the pattern configuration file (under
Flexera.FNMP.InventoryRawData.FileEvidenceConfigs).

• In the specified folders and their subfolders, the pattern retrieves:

◦ All files with extensions listed under File extensions to report as tag files (assuming that Report
software tag files has its default value of true). For each matching file found, BMC Discovery creates a
Detail node linked to the host record. This happens for both Windows and UNIX-based systems.

◦ On Windows only, and only when the setting for Report executable files on Windows platforms has
been changed to true, files with a .exe extension from the same paths. For each executable file found, by

default a WMI query is used to retrieve the file’s name, version, and manufacturer. A DiscoveredWMI node

in BMC Discovery is created for each WMI query (essentially for each file). However, because
DiscoveredWMI nodes are ephemeral (may not survive future inventory gathering), the information is

duplicated into a Detail node under the host server for each file discovered there.

By the appropriate means, then, a Detail node is created for each file evidence record, with the following
properties dependent on the collection method:

Property Value Notes

name File path and name

type FNMP_FileEvidence

size File size

key A unique key for this file, combining the values of
name/type/host.key

version The release number of the file Available only on Windows servers when
executables are tracked.

company The publisher of the application of which this file
forms a part

Available only on Windows servers when
executables are tracked.

Configuration

In the FileEvidence pattern, you may:

• Separately enable or disable collection of:

◦ Identity tag files

◦ Executable files (remember to consider the potential volume of data for this option)
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• Identify the file name extensions for tag files (but there is no need to identify executable file name
extensions)

• Separately for Windows and UNIX-like hosts, specify the starting point(s) in the file systems for inventory
scanning to begin (searches recurse through local subdirectories).

Important: The BMC Discovery inventory agent stops scanning at partition boundaries, even those on the
local file system. This has important implications on systems, such as IBM AIX, that typically mount key paths
like /opt on separate partitions. You must specify a search starting point within each target partition on the
file system. For example, the default values of ∕opt, ∕var, and ∕usr are well suited for inventory gathering
with BMC Discovery.

All configuration items are covered in the following procedure.

To configure the FileEvidence pattern

1. In the user interface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your
current Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled
before any of its member patterns can operate.)

3. From the Pattern Package properties, select the link for the Pattern Module.

4. Scroll down to the Pattern Configuration area.

5. In the FileEvidence group, click Edit Configuration.

6. Select the appropriate true/false radio button for Report software tag files. If you are turning off the
collection of tag files, skip the next step.

7. Adjust the list of File extensions to report as tag files, if necessary deleting values or adding new ones
that you have identified. Each extension must stand alone on its own line.

8. Select the appropriate true/false radio button for Report executable files. Review the discussion before
this procedure while considering the data quantities implied by enabling this option.

If you have now turned off both options, so that both options now have False selected, you have
completed the process, and may skip the next step. If either option has True selected, continue to define
the paths for the inventory gathering.

The configuration changes are saved.

9. For both types of operating system, customize the ...scan these file paths for evidence list.

• Each file path must stand alone on its own line, and must be absolute (starting from root).

• For Windows, the path must include the drive letter with its colon delimiter.

• These same paths are scanned for identity (tag) files and for executable files.

10. Click Apply (at the bottom of this group).

The configuration changes are saved.
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InstallAnywhereEvidence
InstallAnywhere is a package installation solution developed by Flexera. Packages track their installation status in
an XML file, which is interrogated by this pattern.

After collection of the inventory data, a Detail node is linked to the host computer for each package installed
on the computer:

Property Value

name The name of the application as identified by InstallAnywhere.

type FNMP_InstallerEvidence

vendor The publisher of the application

version The release number of the application.

install_date The date that the application was installed on this host computer.

evidence IA (fixed string literal).

key A unique key for this installation record, combining (with the different literal text
separators shown) the values of name:version/type:evidence/host.key

To configure the InstallAnywhereEvidence pattern:

1. In the user interface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your
current Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled
before any of its member patterns can operate.)

Tip: The InstallAnywhereEvidence pattern is enabled by default when the pattern collection is
initially enabled. If it has previously been disabled, you can re-enable it with the remainder of this
procedure.

3. From the Pattern Package properties, select the link for the Pattern Module.

4. Scroll down to the Pattern Configuration area.

5. In the InstallAnywhereEvidence group, click Edit Configuration.

6. Select the True radio button for Report installations by InstallAnywhere.

7. Click Apply (at the bottom of this group).

InstallShieldMultiplatformEvidence
InstallShield Multiplatform is an older packaging solution from Flexera, in use by many software publishers.
InstallShield stores software information in “vital product data” (VPD) collections, which were originally stored in
flat files and subsequently in SQL scripts.
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This pattern locates either format of VPD storage (which may exist in a range of locations across different
platforms), extracts the data, and creates a Detail node for the software installation linked to the host
computer:

Property Value

name The name of the application as identified by InstallShield.

type FNMP_InstallerEvidence

vendor The publisher of the application

version The release number of the application.

install_date The date that the application was installed on this host computer.

evidence ISMP (fixed string literal).

product_code The product identification code recorded (usually) by the publisher for the particular
application. This is not standardized and may be used as the publisher desires.

key A unique key for this installation record, combining (with the different literal text separators
shown) the values of name:version/type:evidence/host.key

To configure the InstallShieldMultiplatformEvidence pattern:

1. In the user interface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your
current Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled
before any of its member patterns can operate.)

Tip: The InstallShieldMutiplatformEvidence pattern is enabled by default when the pattern
collection is initially enabled. If it has previously been disabled, you can re-enable it with the remainder
of this procedure.

3. From the Pattern Package properties, select the link for the Pattern Module.

4. Scroll down to the Pattern Configuration area.

5. In the InstallShieldMultiplatformEvidence group, click Edit Configuration.

6. Select the True radio button for Report installations by InstallShield Multiplatform.

7. Click Apply (at the bottom of this group).

UnixHardwareData
Especially for managing the corporate Data Centre, it is critical for FlexNet Manager Suite to have accurate
hardware inventory for capacity-based license metrics (Processor, Core, IBM PVU, and so on). While BMC
Discovery can capture this information for a Windows server, it may not consistently capture it for servers
running UNIX or Linux. For example, BMC Discovery does not currently report:
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• CPUs and cores on Linux, nor cores on virtual machines

• LPARs on IBM AIX (correctly)

• Solaris resource pools.

This pattern retrieves hardware data on UNIX-based systems using the FlexNet inventory agent.

Note: The pattern must be configured with the installed location of the agent. The agent may be installed
either in the same location on the file system of each target UNIX server, or on a file share accessible to all
target devices. This is included in the configuration process described below.

It executes the inventory agent, which writes the collected data to a file in the /var/tmp/flexera/addm/ folder
on the host server. BMC Discovery then reads this output, and for each installed file, creates a Detail node
linked to the host record:

Property Value

Name FNMP hardware evidence for %host.name%

Type FNMP_HardwareEvidence

Key %type%/%host.key%
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Property Value

(Additional
properties)

Each records one of the following hardware properties:

• Disk size

• IP Address

• MAC Address

• Model

• Number of cores

• Number of disks

• Number of logical processors

• Number of processors

• OS

• Processor speed

• Processor type

• RAM (total physical memory)

• Vendor.

If the machine is found to be a virtual machine, the following additional properties are
collected:

• Node capacity

• Node capacity in cores

• Node capacity in threads

• Physical shared pool capacity

• Physical shared pool capacity in cores

• Physical shared pool ID

• Shared pool capacity

• Shared pool capacity in cores

• Shared pool ID

• VM capacity

• VM capacity in cores

• VM entitlement

• VM ID
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Property Value

• VM is capped

• VM is shared type

• VM name

• VM type

To configure the UnixHardware pattern:

1. In the user interface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your
current Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled
before any of its member patterns can operate.)

3. From the Pattern Package properties, select the link for the Pattern Module.

4. Scroll down to the Pattern Configuration area.

5. In the Flexera.FNMP.InventoryRawData.CommonFlexeraInventoryAgentConfigs group, click Edit
Configuration.

6. Enter the path (only, not including the file name) to the inventory agent executable. (For details about
installing the FlexNet inventory agent, see Installing the FlexNet inventory agent.)

7. Click Apply (at the bottom of this group).

8. In the UnixHardware group, click Edit Configuration.

9. Select the True radio button for Report UNIX hardware properties.

10. Click Apply (at the bottom of this group).

WindowsLastLoggedOnUser
For a Windows-based computer, standard BMC Discovery collection does not capture any inventory related to
the Windows Logon. User identification is important for FlexNet Manager Suite to accurately calculate license
consumption for user-based licensed, such as a Named User license. (There is no equivalent data for UNIX-like
systems available through the BMC Discovery adapter.)

This pattern queries the registry at HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Authentication\
LogonUI\LastLoggedOnUser to find the last logged-on user (for legacy Windows platforms before Vista, it
queries WMI for the value of UserName from Win32_ComputerSystem). If the query is successful, a
DiscoveredRegistryValue node is created for the host computer:

Property Value

Name The user name.

Type FNMP_LastLoggedOnUser
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Property Value

Key %type%/%host.key%

To configure the WindowsLastLoggedOnUser pattern:

1. In the user interface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your
current Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled
before any of its member patterns can operate.)

Tip: The WindowsLastLoggedOnUser pattern is enabled by default when the pattern collection is
initially enabled. If it has previously been disabled, you can re-enable it with the remainder of this
procedure.

3. From the Pattern Package properties, select the link for the Pattern Module.

4. Scroll down to the Pattern Configuration area.

5. In the WindowsLastLoggedOnUser group, click Edit Configuration.

6. Select the True radio button for Report Windows last logged-on user.

7. Click Apply (at the bottom of this group).
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5
Appendix B: Data Mappings

This appendix maps the data transformations from BMC Discovery to FlexNet Manager Suite in two stages:

• From the source nodes in BMC Discovery datastore to the staging database (suggested: ADDM_Stage). The

data constructs within this database are mirrored in the XML files that may be saved on the staging server for
your inspection. For this reason, this section may also be used as a guide to understanding the sources of data
within BMC Discovery that populate the various XML entities.

• From the staging database (suggested: ADDM_Stage) to the final destination within the web interface of

FlexNet Manager Suite. This is not a simple and direct path: the ComplianceReader component first loads the

data from the staging database to various compliance database tables with names starting with Imported,

where the data waits until the next "data import" (usually associated with a full license consumption
calculation, by default scheduled overnight). In effect, the data first moves from remote staging tables to local
staging tables. Thereafter the data is normalized and loaded into a range of compliance database tables, for
the most part arrayed around the ComplianceComputer table. Since navigating these tables is not straight-

forward, we here present the data in its more visible form, within the web interface. Serious devotees of
database structures can find all compliance database tables documented in the FlexNet Manager Suite 2018 R1
Schema Reference PDF file, available through the title page of online help.

In both parts, each destination has its own topic, so that you can jump to destination names using the table of
contents of this PDF (in the first of these sections, the destinations are table names within the staging database;
and in the second, the destinations are "object" names presented in the web interface).

Because an individual node in BMC Discovery may link to multiple staging tables, it's not quite so easy to find the
original nodes in BMC Discovery. One way is to do a search in the PDF file for "SEARCH nodeName", since each
staging database topic begins with the Query Language statements used to extract the related data from BMC
Discovery.

Source to Staging
This section provides:

• The Query Language queries exercised against BMC Discovery to extract data
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• The tables in the staging database, and within each table the individual properties (database columns), where
the data is staged.

For each table topic, the following details are included:

• The source alias (usually identical to the following)

• The property/column name in the staging table

• The data type in the staging table

• For string types, the maximum number of characters (except as noted, excess string length is truncated).

Each topic also notes the name of the XML file that may be saved on the staging server (depending on the
command line given to the staging tool).

ADDMVersion_ci (Staging Table)
Data in this staging table may also be saved in ADDMVersion.xml on the staging server.

BMC Discovery query

This query extracts the version information for BMC Discovery, saving the details in the table below:

LOOKUP Version

Mapping into ADDMVersion_ci

Source alias ADDMVersion_ci property Type Max

Version Version varchar 32

Release Release varchar 32

Release Name Release Name varchar 32

Cluster_ci (Staging Table)
Data in this staging table may also be saved in Cluster.xml on the staging server.

BMC Discovery query

This query extracts data from the Cluster node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Cluster

SHOW

key AS 'ClusterKey',

type AS 'ClusterType',

(type = 'vCenter Cluster' AND
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(single(#ManagedElement:Management:Manager:SoftwareInstance.instance)

+ '|' + id)

OR NONE) AS 'InternalIdentifier',

(cluster_name OR name) AS 'InternalName',

single(#HostContainer:HostContainment:ContainedHost:Host.domain)

AS 'Domain',

formatTime(modified(#), "%FT%T") AS 'LastUpdate'

Mapping into Cluster_ci

Source alias Cluster_ci property Type Max

ClusterKey ClusterKey nvarchar 400

ClusterType ClusterType nvarchar 255

Domain Domain nvarchar 512

InternalIdentifier InternalIdentifier nvarchar 512

InternalName InternalName nvarchar 512

LastUpdate LastUpdate datetime

ClusterHost_ci (Staging Table)
Data in this staging table may also be saved in ClusterHost.xml on the staging server.

BMC Discovery query

This query extracts data from the Cluster node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Cluster

WHERE (NODECOUNT

(TRAVERSE HostContainer:HostContainment:ContainedHost:Host) > 0)

SHOW

key AS 'ClusterKey',

EXPLODE #HostContainer:HostContainment:ContainedHost:Host.key

AS 'HostKey'

Mapping into ClusterHost_ci

Source alias ClusterHost_ci property Type Max

ClusterKey ClusterKey nvarchar 400

HostKey HostKey varchar 64
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CPUInformationDetail_ci (Staging Table)
Data in this staging table may also be saved in CPUInformationDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below.

Tip: This data relies on a custom CPU pattern available through your Flexera consultant. Be aware that from
BMC Discovery release 11.1, BMC provided improved data gathering with new ProcessorInfo functionality.
However, this does not gather the full dataset enabled through the custom pattern, and it remains best
practice to combine the data gathered by BMC Discovery with additional data available through the custom
pattern.

SEARCH Detail

WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > 0)

AND (type = 'CPU Information')

SHOW

host_partitioning_type AS 'HostType',

(

(host_partitioning_type = 'physical' AND total_logical_cpus

OR allocated_threads) OR none

) AS 'LogicalProcessors',

(

(host_partitioning_type = 'physical' AND total_cpu_cores

OR involved_cores) OR none

) AS 'Cores',

(

(host_partitioning_type = 'physical' AND total_cpu_sockets

OR involved_sockets) OR none

) AS 'Processors',

(total_logical_cpus OR none) AS 'PhysicalLogicalProcessors',

(total_cpu_cores OR none) AS 'PhysicalCores',

(total_cpu_sockets OR none) AS 'PhysicalProcessors',

zone_pool_name AS 'ZonePoolName',

lpar_id_to_partition AS 'LPARIdToPartition',

lpar_id_to_system AS 'LPARIdToSystem',

(

(lpar_partition_number <> '-' AND lpar_partition_number) OR none

) AS 'LPARPartitionNumber',

lpar_partition_name AS 'LPARPartitionName',

lpar_type AS 'LPARType',

lpar_mode AS 'LPARMode',

(lpar_active_physical_cpus_in_system OR none)

AS 'LPARActivePhysicalCpusInSystem',

(lpar_shared_physical_cpus_in_system OR none)

AS 'LPARSharedPhysicalCpusInSystem',
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((lpar_shared_pool_id <> '-' AND lpar_shared_pool_id) OR none)

AS 'LPARSharedPoolID',

(lpar_active_cpus_in_pool OR none) AS 'LPARActiveCpusInPool',

(lpar_entitled_capacity OR none) AS 'LPAREntitledCapacity',

#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into CPUInformationDetail_ci

Source alias CPUInformationDetail_ci
property

Type Max

Cores Cores int

HostKey HostKey varchar 64

HostType HostType varchar 32

LogicalProcessors LogicalProcessors int

LPARActiveCpusInPool LPARActiveCpusInPool int

LPARActivePhysical

CpusInSystem

LPARActivePhysical

CpusInSystem

int

LPAREntitledCapacity LPAREntitledCapacity float

LPARIdToPartition LPARIdToPartition nvarchar 200

LPARIdToSystem LPARIdToSystem nvarchar 200

LPARMode LPARMode nvarchar 255

LPARPartitionName LPARPartitionName nvarchar 255

LPARPartitionNumber LPARPartitionNumber int

LPARSharedPhysical

CpusInSystem

LPARSharedPhysical

CpusInSystem

int

LPARSharedPoolID LPARSharedPoolID int

LPARType LPARType nvarchar 255

PhysicalCores PhysicalCores int

PhysicalLogicalProcessors PhysicalLogicalProcessors int

PhysicalProcessors PhysicalProcessors int

Processors Processors int

ZonePoolName ZonePoolName nvarchar 200
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DiscoveredPackages_ci (Staging Table)
Data in this staging table may also be saved in DiscoveredPackages.xml on the staging server.

BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Host

STEP IN Host:HostedSoftware:InstalledSoftware:Package

SHOW

#:InstalledSoftware:Package.name AS 'Name',

#:InstalledSoftware:Package.version AS 'Version',

#:InstalledSoftware:Package.vendor AS 'Vendor',

#:Host:Host.key as 'HostKey'

Mapping into DiscoveredPackages_ci

Source alias DiscoveredPackages_ci property Type Max

HostKey HostKey varchar 64

Name Package nvarchar 255

Vendor Vendor nvarchar 255

Version Version nvarchar 255

DiscoveredService_ci (Staging Table)
Data in this staging table may also be saved in DiscoveredService.xml on the staging server.

BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Host

TRAVERSE InferredElement:Inference:Associate:DiscoveryAccess

WHERE end_state = 'GoodAccess'

TRAVERSE DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:ServiceList

TRAVERSE List:List:Member:DiscoveredService

WHERE name = 'vmms' AND display_name = 'Hyper-V Virtual Machine Management'

SHOW

name AS 'Name',

#Member:List:List:ServiceList.#DiscoveryResult:DiscoveryAccessResult:
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DiscoveryAccess:DiscoveryAccess.#Associate:Inference:

InferredElement:Host.key AS 'HostKey'

Mapping into DiscoveredService_ci

Source alias DiscoveredService_ci property Type Max

HostKey HostKey varchar 64

Name Name nvarchar 255

DiscoveredVirtualMachine_ci (Staging Table)
Data in this staging table may also be saved in DiscoveredVirtualMachine.xml on the staging server.

BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Host

TRAVERSE InferredElement:Inference:Associate:DiscoveryAccess

WHERE end_state = 'GoodAccess'

TRAVERSE DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:VirtualMachineList

WHERE access_method IS DEFINED

TRAVERSE List:List:Member:DiscoveredVirtualMachine

SHOW

name AS 'Name',

uuid AS 'UUID',

config_os_full AS 'ConfigOSFull',

power_state AS 'PowerState',

vsphere_id AS 'vSphereID',

#Member:List:List:VirtualMachineList.access_method AS 'AccessMethod',

formatTime(modified(#), "%FT%T") AS 'LastUpdate',

#Member:List:List:VirtualMachineList.#DiscoveryResult:DiscoveryAccessResult:

DiscoveryAccess:DiscoveryAccess.#Associate:

Inference:InferredElement:Host.key AS 'HostKey'

Mapping into DiscoveredVirtualMachine_ci

Source alias DiscoveredVirtualMachine_ci
property

Type Max

AccessMethod AccessMethod nvarchar 255

ConfigOSFull ConfigOSFull nvarchar 512

HostKey HostKey varchar 64
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Source alias DiscoveredVirtualMachine_ci
property

Type Max

LastUpdate LastUpdate datetime

Name Name nvarchar 512

PowerState PowerState nvarchar 255

UUID UUID nvarchar 255

vSphereID vSphereID nvarchar 255

FileEvidenceDetail_ci (Staging Table)
Data in this staging table may also be saved in FileEvidenceDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Detail

WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > 0)

AND (type = 'FNMP_FileEvidence')

SHOW name AS 'FileName',

size AS 'FileSize',

description AS 'Description',

company AS 'Company',

version AS 'FileVersion',

#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into FileEvidenceDetail_ci

Source alias FileEvidenceDetail_ci property Type Max

Company Company nvarchar 255

Description Description nvarchar 255

FileName FileName nvarchar 800

FileSize FileSize bigint

FileVersion FileVersion nvarchar 255

HostKey HostKey varchar 64
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FileSystem_ci (Staging Table)
Data in this staging table may also be saved in FileSystem.xml on the staging server.

BMC Discovery query

This query extracts data from the FileSystem node in the BMC Discovery datastore, and provides the aliases
for properties referenced in the table below:

SEARCH FileSystem

WHERE (NODECOUNT

(TRAVERSE MountedFileSystem:FileSystemMount:Mounter:Host) > 0)

AND fs_kind = 'LOCAL'

AND size IS DEFINED

AND size > 0

AND fs_type <> 'tmpfs'

AND fs_type <> 'devtmpfs'

AND fs_type <> 'DevFS'

SHOW

fs_name AS 'Name',

size AS 'Size',

#MountedFileSystem:FileSystemMount:Mounter:Host.key AS 'HostKey'

Mapping into FileSystem_ci

Source alias FileSystem_ci property Type Max

HostKey HostKey varchar 64

Name Name nvarchar 255

Size Size bigint

HardwareEvidenceDetail_ci (Staging Table)
Data in this staging table may also be saved in HardwareEvidenceDetail.xml on the staging server.

This data is generated through use of the optional UnixHardwareData pattern, which triggers the Flexera
inventory component ndtrack ("the tracker"). Before staging, the information is visible in the Detail node of
BMC Discovery, with a type of FNMP_HardwareEvidence.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Detail

WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > 0)
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AND (type = 'FNMP_HardwareEvidence')

SHOW

os AS 'OS',

num_processors AS 'Processors',

num_cores AS 'Cores',

num_logical_processors AS 'LogicalProcessors',

processor_type AS 'ProcessorType',

processor_speed AS 'ProcessorSpeed',

ram AS 'RAM',

vendor AS 'Vendor',

model AS 'Model',

ip_address AS 'IPAddress',

mac_address AS 'MACAddress',

num_disks AS 'NumDisks',

disk_size AS 'DiskSize',

vm_type AS 'VMType',

node_capacity AS 'NodeCapacity',

node_capacity_in_cores AS 'NodeCapacityInCores',

node_capacity_in_threads AS 'NodeCapacityInThreads',

physical_shared_pool_capacity AS 'PhysicalSharedPoolCapacity',

physical_shared_pool_capacity_in_cores

AS 'PhysicalSharedPoolCapacityInCores',

physical_shared_pool_id AS 'PhysicalSharedPoolID',

shared_pool_capacity AS 'SharedPoolCapacity',

shared_pool_capacity_in_cores AS 'SharedPoolCapacityInCores',

shared_pool_id AS 'SharedPoolID',

vm_capacity AS 'VMCapacity',

vm_capacity_in_cores AS 'VMCapacityInCores',

vm_entitlement AS 'VMEntitlement',

vm_id AS 'VMID',

vm_is_capped AS 'VMIsCapped',

vm_is_shared_type AS 'VMIsSharedType',

vm_name AS 'VMName',

partition_id AS 'PartitionID',

partition_number AS 'PartitionNumber',

#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into HardwareEvidenceDetail_ci

Source alias HardwareEvidenceDetail_ci
property

Type Max

Cores Cores smallint

DiskSize DiskSize bigint

HostKey HostKey varchar 64

IPAddress IP nvarchar 512
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Source alias HardwareEvidenceDetail_ci
property

Type Max

LogicalProcessors LogicalProcessors smallint

MACAddress MAC nvarchar 512

Model Model nvarchar 512

NodeCapacity NodeCapacity smallint

NodeCapacityInCores NodeCapacityInCores smallint

NodeCapacityInThreads NodeCapacityInThreads smallint

NumDisks NumDisks int

OS OS nvarchar 256

PartitionID PartitionID nvarchar 512

PartitionNumber PartitionNumber int

PhysicalShared

PoolCapacity

PhysicalShared

PoolCapacity

smallint

PhysicalSharedPool

CapacityInCores

PhysicalSharedPool

CapacityInCores

smallint

PhysicalSharedPoolID PhysicalSharedPoolID nvarchar 255

Processors Processors smallint

ProcessorSpeed ProcessorSpeed int

PhysicalLogicalProcessors PhysicalLogicalProcessors int

ProcessorType ProcessorType nvarchar 128

RAM RAM bigint

SharedPoolCapacity SharedPoolCapacity smallint

SharedPoolCapacityInCores SharedPoolCapacityInCores smallint

SharedPoolID SharedPoolID nvarchar 255

Vendor Vendor nvarchar 255

VMCapacity VMCapacity float

VMCapacityInCores VMCapacityInCores float

VMEntitlement VMEntitlement float

VMID VMID nvarchar 255

VMIsCapped VMIsCapped bit

Appendix B: Data Mappings

FlexNet Manager Suite Adapters Reference | Company Confidential 53



Source alias HardwareEvidenceDetail_ci
property

Type Max

VMIsSharedType VMIsSharedType bit

VMName VMName nvarchar 512

VMType VMType nvarchar 128

Host_ci (Staging Table)
Data in this staging table may also be saved in Host.xml on the staging server.

BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below.

Tip: The following properties are recent additions to BMC Discovery:

• num_cores is available from BMC Discovery release 11.0

• zone_pool_name is available from BMC Discovery release 11.1.

SEARCH Host

SHOW

hostname AS 'Hostname',

(dns_domain OR domain) AS 'Domain',

os AS 'OS',

os_type AS 'OSType',

os_class AS 'OSClass',

service_pack AS 'ServicePack',

uuid AS 'UUID',

(

num_processors

OR nodecount(traverse Host:Detail:Hardware:ProcessorInfo)

) AS 'Processors',

(

num_cores

OR ((num_processors > 0 AND cores_per_processor > 0)

AND (num_processors * cores_per_processor))

OR ((num_logical_processors > 0 AND threads_per_core > 0)

AND (num_logical_processors/threads_per_core))

OR none

) AS 'Cores',

num_logical_processors AS 'LogicalProcessors',

processor_type AS 'ProcessorType',

processor_speed AS 'ProcessorSpeed',

ram AS 'RAM',
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vendor AS 'Vendor',

model AS 'Model',

serial AS 'Serial',

hostid AS 'HostID',

partition_id AS 'PartitionID',

lpar_name AS 'LPARName',

lpar_partition_number AS 'LPARNumber',

wparid AS 'WPARID',

npar_partition_number AS 'NPARNumber',

vpar_partition_number AS 'VPARNumber',

ldom_name AS 'LDOMName',

ldom_role AS 'LDOMRole',

zonename AS 'Zonename',

zone_uuid AS 'ZoneUUID',

(zone_pool_name OR none) AS 'ZonePoolName',

formatTime(modified(#), "%FT%T") as 'ModifiedDate',

key AS 'HostKey

Mapping into Host_ci

Source alias Host_ci property Type Max

Cores Cores smallint

Domain Domain nvarchar 255

HostID HostID nvarchar 255

HostKey HostKey varchar 64

Hostname Hostname nvarchar 255

LDOMName LDOMName nvarchar 255

LDOMRole LDOMRole nvarchar 255

LogicalProcessors LogicalProcessors smallint

LPARName LPARName nvarchar 255

LPARNumber LPARNumber int

Model Model nvarchar 512

ModifiedDate ModifiedDate datetime

NPARNumber NPARNumber nvarchar 64

OS OS nvarchar 1024

OSClass OSClass nvarchar 64

OSType OSType nvarchar 255
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Source alias Host_ci property Type Max

PartitionID PartitionID nvarchar 255

Processors Processors smallint

ProcessorSpeed ProcessorSpeed int

ProcessorType ProcessorType nvarchar 128

RAM RAM bigint

Serial Serial nvarchar 255

ServicePack ServicePack nvarchar 128

UUID UUID nvarchar 255

Vendor Vendor nvarchar 255

VPARNumber VPARNumber nvarchar 64

WPARID WPARID int

Zonename Zonename nvarchar 255

ZonePoolName ZonePoolName nvarchar 255

ZoneUUID ZoneUUID nvarchar 255

HostContainerProcessorInfo_ci (Staging Table)
This data is available only from ADDM 11.0 and later releases.

Data in this staging table may also be saved in HostContainerProcessorInfo.xml on the staging server.

BMC Discovery query

This query extracts data from the ProcessorInfo node in the BMC Discovery datastore, and provides the
aliases for properties referenced in the table below:

SEARCH ProcessorInfo

WHERE NODECOUNT(TRAVERSE Hardware:Detail:HostContainer:HostContainer) > 0

SHOW

#Hardware:Detail:HostContainer:HostContainer.num_logical_processors

AS 'LogicalProcessors',

#Hardware:Detail:HostContainer:HostContainer.num_cores AS 'Cores',

#Hardware:Detail:HostContainer:HostContainer.num_processors

AS 'Processors',

EXPLODE #Hardware:Detail:HostContainer:HostContainer.#HostContainer:

HostContainment:ContainedHost:Host.#InferredElement:Inference:Associate:

DiscoveryAccess.#DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:

HostInfo.systemid AS 'SystemID',
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EXPLODE #Hardware:Detail:HostContainer:HostContainer.#HostContainer:

HostContainment:ContainedHost:Host.hostid AS 'HostID',

#Hardware:Detail:HostContainer:HostContainer.#HostContainer:HostContainment:

ContainedHost:Host.vendor AS 'Vendor'

Mapping into HostContainerProcessorInfo_ci

Source alias HostContainerProcessorInfo_ci
property

Type Max

Cores Cores smallint

HostID HostID nvarchar 255

LogicalProcessors LogicalProcessors smallint

Processors Processors smallint

SystemID SystemID nvarchar 255

Vendor Vendor nvarchar 255

HostDetail_ci (Staging Table)
This data is available only from BMC Discovery 11.1 and later releases. The latest Technology Knowledge
Update must be applied to the BMC Discovery 11.1 release.

Data in this staging table may also be saved in HostDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Detail

WHERE type = 'LPAR Resource'

SHOW

id_to_partition as 'LPARIdToPartition',

id_to_system as 'LPARIdToSystem',

#Detail:Detail:ElementWithDetail:Host.key as 'HostKey'

Mapping into HostDetail_ci

Source alias HostDetail_ci property Type Max

HostKey HostKey varchar 64

LPARIdToPartition LPARIdToPartition nvarchar 200

LPARIdToSystem LPARIdToSystem nvarchar 200
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HostInfo_ci (Staging Table)
Data in this staging table may also be saved in HostInfo.xml on the staging server.

BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Host

TRAVERSE InferredElement:Inference:Associate:DiscoveryAccess

WHERE end_state = 'GoodAccess'

TRAVERSE DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:HostInfo

WHERE NODECOUNT(TRAVERSE Primary:Inference:InferredElement:Host) > 0

SHOW

systemid AS 'SystemID',

lpar_partition_number AS 'LPARPartitionNumber',

lpar_partition_name AS 'LPARPartitionName',

lpar_type AS 'LPARType',

lpar_mode AS 'LPARMode',

lpar_active_physical_cpus_in_system AS 'LPARActivePhysicalCpusInSystem',

lpar_shared_physical_cpus_in_system AS 'LPARSharedPhysicalCpusInSystem',

lpar_shared_pool_id AS 'LPARSharedPoolID',

lpar_active_cpus_in_pool AS 'LPARActiveCpusInPool',

lpar_entitled_capacity AS 'LPAREntitledCapacity',

formatTime(#DiscoveryResult:DiscoveryAccessResult:DiscoveryAccess:

DiscoveryAccess.starttime,"%FT%T") as 'InventoryDate',

#Primary:Inference:InferredElement:Host.key AS 'HostKey'

Mapping into HostInfo_ci

Source alias HostInfo_ci property Type Max

HostKey HostKey varchar 64

InventoryDate InventoryDate datetime

LPARActiveCpusInPool LPARActiveCpusInPool int

LPARActivePhysical

CpusInSystem

LPARActivePhysical

CpusInSystem

int

LPAREntitledCapacity LPAREntitledCapacity float

LPARMode LPARMode nvarchar 255

LPARPartitionName LPARPartitionName nvarchar 255

LPARPartitionNumber LPARPartitionNumber int
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Source alias HostInfo_ci property Type Max

LPARSharedPhysical

CpusInSystem

LPARSharedPhysical

CpusInSystem

int

LPARSharedPoolID LPARSharedPoolID int

LPARType LPARType nvarchar 255

SystemID SystemID nvarchar 255

InstallerEvidenceDetail_ci (Staging Table)
Data in this staging table may also be saved in InstallerEvidenceDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Detail

WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > 0)

AND (type = 'FNMP_InstallerEvidence')

SHOW name AS 'Name',

version AS 'Version',

vendor AS 'Vendor',

install_date AS 'InstallDate',

evidence AS 'Evidence',

product_code AS 'ProductCode',

#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into InstallerEvidenceDetail_ci

Source alias InstallerEvidenceDetail_ci
property

Type Max

Evidence Evidence nvarchar 64

HostKey HostKey varchar 64

InstallDate InstallDate nvarchar 255

Name Name nvarchar 512

ProductCode ProductCode nvarchar 110

Vendor Vendor nvarchar 400

Version Version nvarchar 144
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LastLoggedOnUserDetail_ci (Staging Table)
Data in this staging table may also be saved in LastLoggedOnUserDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Detail

WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > 0)

AND (type = 'FNMP_LastLoggedOnUser')

SHOW name AS 'UserName',

#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into LastLoggedOnUserDetail_ci

Source alias LastLoggedOnUserDetail_ci
property

Type Max

HostKey HostKey varchar 64

UserName UserName nvarchar 255

NetworkInterface_ci (Staging Table)
Data in this staging table may also be saved in NetworkInterface.xml on the staging server.

BMC Discovery query

This query extracts data from the NetworkInterface node in the BMC Discovery datastore, and provides the
aliases for properties referenced in the table below:

SEARCH NetworkInterface

WHERE (NODECOUNT

(TRAVERSE InterfaceOfDevice:DeviceInterface:

DeviceWithInterface:Host) > 0)

SHOW

(ip_addr

OR (NODECOUNT(TRAVERSE InterfaceWithAddress:InterfaceAddress:

IPv4Address:IPAddress) > 0

AND fmt("%.510s", join(#InterfaceWithAddress:InterfaceAddress:

IPv4Address:IPAddress.ip_addr, ', ')))

OR ''

) AS 'IP',

mac_addr AS 'MAC',
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#InterfaceOfDevice:DeviceInterface:DeviceWithInterface:Host.key

AS 'HostKey'

Mapping into NetworkInterface_ci

Source alias NetworkInterface_ci property Type Max

HostKey HostKey varchar 64

IP IP nvarchar 512

MAC MAC nvarchar 512

SoftwareInstance_ci (Staging Table)
Data in this staging table may also be saved in SoftwareInstance.xml on the staging server.

BMC Discovery query

This query extracts data from the SoftwareInstance node in the BMC Discovery datastore, and provides the
aliases for properties referenced in the table below:

SEARCH SoftwareInstance

WHERE (NODECOUNT(TRAVERSE RunningSoftware:HostedSoftware:Host:Host) > 0)

AND vm_type IS NOT DEFINED

SHOW

type + (edition AND (' ' + edition) OR '') AS 'Name',

product_version AS 'Version',

(publisher OR single(#Element:Maintainer:Pattern:Pattern.publishers))

AS 'Publisher',

EXPLODE #RunningSoftware:HostedSoftware:Host:Host.key AS 'HostKey'

Mapping into SoftwareInstance_ci

Source alias SoftwareInstance_ci property Type Max

HostKey HostKey varchar 64

Name Name nvarchar 255

Version Version nvarchar 255

Publisher Publisher nvarchar 255

Appendix B: Data Mappings

FlexNet Manager Suite Adapters Reference | Company Confidential 61



SoftwareInstanceVirtualMachine_ci (Staging Table)
Data in this staging table may also be saved in SoftwareInstanceVirtualMachine.xml on the staging
server.

BMC Discovery query

This query extracts data from the SoftwareInstance node in the BMC Discovery datastore, and provides the
aliases for properties referenced in the table below (note that the regex is wrapped for printing, and should
appear all on one line):

SEARCH SoftwareInstance

WHERE (NODECOUNT(TRAVERSE RunningSoftware:HostedSoftware:Host:Host) > 0)

AND vm_type IS DEFINED

SHOW

vm_type AS 'VMType',

(zone_uuid OR vm_bios_serial) AS 'VMSerial',

(zonename OR vm_name) AS 'VMName',

(zoneid OR

(vm_type = 'VMware Virtual Machine'

AND extract(vm_uuid, regex "^(..) (..) (..) (..) (..) (..) (..)

(..)-(..) (..) (..) (..) (..) (..)

(..) (..)$",

regex "\1\2\3\4-\5\6-\7\8-\9\10-\11\12\13\14\15\16")

OR vm_uuid

)

) AS VMID,

vm_guest_os AS 'GuestFullName',

zonepath AS 'VMPath',

formatTime(last_update_success, "%FT%T") as 'LastUpdateSuccess',

single(#HostContainer:HostContainment:ContainedHost:Host.key)

AS 'GuestHostKey',

single(#RunningSoftware:HostedSoftware:Host:Host.key) AS 'HostKey'

Mapping into SoftwareInstanceVirtualMachine_ci

Source alias SoftwareInstanceVirtualMachine_ci
property

Type Max

GuestFullName GuestFullName nvarchar 512

GuestHostKey GuestHostKey varchar 64

HostKey HostKey varchar 64

LastUpdateSuccess LastUpdateSuccess datetime

VMID VMID nvarchar 255

VMName VMName nvarchar 512
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Source alias SoftwareInstanceVirtualMachine_ci
property

Type Max

VMPath VMPath nvarchar 512

VMSerial VMSerial nvarchar 255

VMType VMType nvarchar 255

Staging to FlexNet Manager Suite
This section provides the mapping from the staging database to the final presentation in the web interface for
FlexNet Manager Suite.

This section is organized alphabetically by object names in FlexNet Manager Suite (for example, 'computers' are
known as 'inventory devices'). This is useful when you are starting from data displayed in FlexNet Manager Suite,
tracing it back to the staging database, and then using the preceding section to see the source of that data
point in BMC Discovery.

If you are coming the other direction, it is easiest to use your PDF search tool to find the staging database table
name, a dot separator, and the property name. For example, to find out where the Hostname property from the
Host_ci table of the staging database ends up, search for Host_ci.Hostname. You will find it listed against the
Name property in the All Inventory page (and other similar listings) of the web interface .

For each object-based topic, the following details are included:

• Whether the import of new data that was not previously in the compliance database creates new records on
import.

• Whether the import of changed data for records with matching key values is allowed to update the
compliance database.

• Whether the absence of records previously imported from only the BMC Discovery source causes the old
records to be removed from the compliance database.

• The source table and property (in dot-separated format) from the staging database. Look back to the
previous section to check data types and maximum string sizes in the staging database.

• The property name in the destination page of the web interface. Each listing is sorted alphabetically on this
property name. Where a property forms part of a compound key identifying records in the underlying
compliance database, it is appropriately marked as a partial key ("p/key").

• The data type of the property.

• For string values, the maximum length allowed in the the web interface (which is also normally the maximum
string length available in compliance database). If this is less than the string length allowed in the staging
database, the string is normally truncated to length (except as noted in the comments for an individual
property).

• Any general notes.
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Inventory Device (Computer)
Inventory devices are (in the main) computers that have been found in imported inventory; and in the current
context, they are found in data imported from BMC Discovery. (Keep in mind that it is possible for a device to
be reported in more than one inventory source, which becomes important when you are assessing automatic
deletion of records no longer appearing in the source inventory.)

FlexNet Manager Suite correlates data from several points within BMC Discovery to create inventory device
records. For example, the main sources from lowest to highest priority are:

1. The HostInfo node, by default populated during the discovery phrase of data gathering by BMC
Discovery. Current data is staged in the HostInfo_ci staging table; but if BMC Discovery does not
inventory the target device regularly, its information may be cleaned up and lost from this node.

2. The Host node, which by default BMC Discovery populates with data from the HostInfo node.

3. Data (of type CPU Information) visible in the Detail node of BMC Discovery, and staged into the
CPUInformationDetail_ci staging table.

Tip: This data depends on a custom CPU pattern available only by request (see
CPUInformationDetail_ci (Staging Table) for details).

4. The optional UnixHardwareData pattern (delivered as part of the BMC Discovery adapter). Data from this
source is also visible in the Detail node of BMC Discovery (with the type FNMP_HardwareEvidence), and
is staged in the HardwareEvidenceDetail_ci table.

Generally, after import into FlexNet Manager Suite, inventory devices are stored in the ComplianceComputer

table of the underlying compliance database.

Because inventory devices have so many properties, the following tables group their properties into smaller
subsets. Within each subset, the tables are sorted alphabetically by the Display property column.

• Are new records created by imports from the staging database table? — Yes.

• Can records with matching compound keys be updated by these imports? — Yes.

• Are records unmatched by an import from the staging table deleted from the compliance database
(provided that the staging database for BMC Discovery data is the last/only source for these records)? —
Yes.

Inventory device: Computer (general properties)

All these properties are available in listings such as the All Inventory page; and within the properties of an
individual inventory device, these all appear on the General tab.

Source table.property Display property Type Max Notes

Host_ci.Domain Domain name (p/
key)

String 100
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Source table.property Display property Type Max Notes

Host_ci.Serial Firmware serial
number

String 100 Visible in the General tab of the
inventory device properties.
Identifies the firmware on the
inventory device.

NetworkInterface_ci.

IP

IP address String 256

NetworkInterface_ci.

MAC

MAC address String 256

Host_ci.Vendor Manufacturer String 128

Host_ci.Model Model String 128

Host_ci.Hostname Name (p/key) String 256

Host.Serial Serial number String 100 A duplicate of Host_ci.Serial, this
time taken from the Host database
view.

Inventory device: Hardware properties

Except as noted, these properties are available in listings such as the All Inventory page; and within the
properties of an individual inventory device, these mostly appear on the Hardware tab (where several values
may be manually overridden if the collected inventory data is inaccurate).

Source table.property Display
property

Type Max Notes

Host_ci.ProcessorSpeed Clock speed
(MHz)

Integer The maximum clock speed of
the fastest processor in the
computer in megahertz.

Host_ci.Cores (or
CPUInformationDetail_

ci.Cores for ADDM 11.0 or earlier);
or, when the optional
UnixHardwareData pattern has been
used,
HardwareEvidenceDetail_ci.Cores

Cores Integer The number of cores in the
device (or, for a virtual
machine, the number of cores
assigned to the VM).
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Source table.property Display
property

Type Max Notes

FileSystem_ci.Size (summed) Disk (GB) Integer All FileSystem_ci records
with an identical HostKey are
selected from the staging
database, and their Size
values are summed and the
result converted to GB for
display.

Not applicable Display
adapters

Integer The number of display
adapters is not returned by
BMC Discovery.

FileSystem_ci.

COUNT(HostKey)

Hard drives Integer

Not applicable Inventory
chassis type

String 128 After import from BMC
Discovery, this value is always
Unknown (although some
inventory tools can return the
chassis type, BMC Discovery is
not among them). The result is
only available in the property
sheet for an inventory device
(and its linked asset, if any),
and not in device listings.
There is also an Assigned
chassis type where you can
correct inventory data if
required.

NetworkInterface_ci.

IP

(counted)

Network cards Integer The number of network cards
in the device is not returned by
BMC Discovery. Instead, the
count of distinct IP-enabled
interfaces sharing a common
HostKey is used.

Host_ci.LogicalProcessors (or
CPUInformationDetail_ci.

LogicalProcessors for ADDM 11.0
or earlier); or, when the optional
UnixHardwareData pattern has been
used,
HardwareEvidenceDetail_ci.Cores

Threads Integer Saved in the
ComplianceComputer table in
the compliance database, and
generally represented in the
web interface as Threads for
virtual machines.
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Source table.property Display
property

Type Max Notes

Host_ci.OS Operating
system

String 128

Host_ci.Processors (or
CPUInformationDetail_

ci.Processors

(for ADDM 11.0 or earlier); or, when the
optional UnixHardwareData pattern
has been used,
HardwareEvidenceDetail_ci.Cores

Processors Integer The number of processors
reported in the inventory
device.

Host_ci.ProcessorType Processor type String 256

Host_ci.RAM RAM (GB) String 128 The imported value (in bytes)
is converted to GB for display.

Host_ci.ServicePack Service pack String 128

n/a Sockets Integer The number of sockets — a
value that is not reported by
BMC Discovery.

Inventory device: Last inventory details

These properties are available in listings such as the All Inventory page; and within the properties of an
individual inventory device, these appear on the General tab.

Source table.property Display property Type Max Notes

HostInfo_ci.

InventoryDate

Last inventory date Date For virtual hosts, the most recent
inventory date for any guest system
may update this value.

BMC Atrium Discovery and

Dependency Mapping

Last inventory
source

String 128 The string literal "BMC Atrium
Discovery and Dependency
Mapping" is always inserted as the
source value when using this
adapter.

Inventory device: User details

These properties are available in listings such as the All Inventory page; and within the properties of an
individual inventory device, these appear on the Ownership tab.
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Source table.property Display property Type Max Notes

n/a Assigned user String 512 This value is set manually by an
operator in FlexNet Manager Suite.

n/a Calculated user String 512 Set automatically as the logged-on
user seen most frequently in the last
10 inventory imports.

LastLoggedOnUser

Detail_ci.Username (when
the optional pattern
WindowsLastLoggedOnUser

has been used)

Last logged on user String 512 This information is available only for
Windows platforms, and only when
WindowsLastLoggedOnUser has
been used. On data import, if the
username cannot be matched in the
ComplianceUser table of the
compliance database, a new record
is created, and appropriately linked
to the ComplianceComputer record.

Installer Evidence
Installer evidence is a record of software installation on an inventory device. 'Normalized' installer evidence
(meaning installer evidence that includes standard string values as noted below) allows the automatic
matching of the evidence to the application that it represents, using the Application Recognition Library (ARL),
frequently updated by Flexera.

• Are new records created by imports from the staging database table? — Yes.

• Can records with matching compound keys be updated by these imports? — No.

• Are records unmatched by an import from the staging table deleted from the compliance database
(provided that the staging database for BMC Discovery data is the last/only source for these records)? —
Yes (records linking applications to inventory devices are deleted under these conditions).

Installer evidence mapping

Most of these properties are available in listings such as the Installer evidence tab of the All Evidence page;
and within the properties of an individual installer evidence record, these appear on the General tab.
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Source table.property Display property Type Max Notes

Host_ci.HostKey Not displayed. (p/
key)

n/a Identifies the inventory device on
which the installer evidence was
found. This value is not displayed in
listings of, nor properties for,
installer evidence (because in those
contexts, the installer evidence may
be relevant to many different
devices). However, the link from the
installer evidence to the application,
plus this link to an individual device
where the installer evidence has
been found, allows the list of
installed applications to appear on
the Applications tab of the
inventory device properties.

DiscoveredPackages_

ci.Name

Name (p/key) String 256 For recognition using the standard
ARL to work reliably, this value must
be the Display Name from Add/

Remove Programs on Windows (or
equivalent).

DiscoveredPackages_

ci.Publisher

Publisher (p/key) String 200 For recognition using the standard
ARL to work reliably, this value must
be the Publisher from Add/Remove

Programs on Windows (or
equivalent).

ADDM (string literal) Type String 32 The string literal "ADDM" is supplied
as the installer evidence type for this
adapter.

DiscoveredPackages_

ci.Version

Version (p/key) String 72 For recognition using the standard
ARL to work reliably, this value must
be the Display Version from Add/

Remove Programs on Windows (or
equivalent).

File Evidence
File evidence consists of files found on the disk of an inventory device. 'Normalized' file evidence (meaning file
evidence that includes standard string values as noted below) allows the automatic matching of the file
evidence to the application of which it forms part, using the Application Recognition Library (ARL), frequently
updated by Flexera.

• Are new records created by imports from the staging database table? — Yes.
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• Can records with matching compound keys be updated by these imports? — No.

• Are records unmatched by an import from the staging table deleted from the compliance database
(provided that the staging database for BMC Discovery data is the last/only source for these records)? —
Yes.

File evidence mapping

Most of these properties are available in listings such as the File evidence tab of the All Evidence page; and
within the properties of an individual file evidence record, these appear on the General tab. (This listing is
alphabetical by Display property values.)

Source table.property Display property Type Max Notes

Host_ci.HostKey Not displayed. (p/
key)

n/a Identifies the inventory device on
which the file evidence was found.
This value is not displayed in listings
of, nor properties for, file evidence
(because in those contexts, the file
evidence may be relevant to many
different devices). However, once
the file evidence is linked to an
application, this link to an individual
device where the file evidence has
been found may affect the list of
installed applications that appears
on the Applications tab of the
inventory device properties.

FileEvidenceDetail_

ci.Company

Company (p/key) String 100 For recognition using the standard
ARL to work reliably, this value must
be the Company WinPE header
property from Windows executables.

FileEvidenceDetail_

ci.Description

Description (p/key) String 200 For recognition using the standard
ARL to work reliably, this value must
be the Description WinPE header
property from Windows executables.

FileEvidenceDetail_

ci.FileName

Name (in listings) or
File name (in file
evidence properties)
(p/key)

String 256 For recognition using the standard
ARL to work reliably, this value must
be:

• On Windows, the file name
without path

• On UNIX-like platforms, the full
absolute file path.
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Source table.property Display property Type Max Notes

FileEvidenceDetail_

ci.FileSize

Size Integer

FileEvidenceDetail_

ci.FileVersion

Version (p/key) String 100 For recognition using the standard
ARL to work reliably, this value must
be the File Version WinPE header
property from Windows executables.

The following extended properties of file evidence records are not populated in an BMC Discovery import:

• File path

• Language

• Product name

• Product version.

WMI Evidence
Windows Management Instrumentation (WMI) evidence is most often customized to help recognize operating
systems, and (when the FlexNet inventory agent is in use) to help recognize aspects of special applications like
Microsoft SQL Server. 'Normalized' WMI evidence (meaning WMI evidence that includes standard string values
as noted below) allows the automatic matching of the WMI evidence to the application to which it relates,
using the Application Recognition Library (ARL), frequently updated by Flexera.

• Are new records created by imports from the staging database table? — Yes.

• Can records with matching compound keys be updated by these imports? — No.

• Are records unmatched by an import from the staging table deleted from the compliance database
(provided that the staging database for BMC Discovery data is the last/only source for these records)? —
Yes.

WMI evidence mapping

In the web interface for FlexNet Manager Suite, there is no separate listing of WMI evidence. It is only possible
to see these properties using the search facility in the WMI section of the Evidence tab of application
properties. (This listing is alphabetical by Display property values.)
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Source table.property Display property Type Max Notes

Host_ci.HostKey Not displayed. (p/
key)

n/a Identifies the inventory device on
which the WMI evidence was found.
This value is not displayed in the
application properties Evidence tab.
However, once the WMI evidence is
linked to an application, this link to
an individual device where the WMI
evidence has been found may affect
the list of installed applications that
appears on the Applications tab of
the inventory device properties.

Caption (string literal) Property name (p/
key)

String 50 The string literal "Caption" is
inserted for all WMI evidence
records from BMC Discovery.

Host_ci.OS (left-most 256
characters)

Property value (p/
key)

String 256 For OS recognition using the
standard ARL to work reliably, this
value must be the equivalent of the
Win32_OperatingSystem.Name

WMI property.

Host_ci.OSType converted
as per notes.

WMI class (p/key) String 50 The BMC Discovery data converts to
standard class types used by FlexNet
Manager Suite as follows:

• Windows becomes

Win32_OperatingSystem

• Either of VMware ESX or VMware

ESXi becomes

VMWARE_OperatingSystem

• Any other value is replaced by
MGS_OperatingSystem.
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II
App-V Server Adapter

Microsoft App-V (full name Microsoft Application Virtualization) is an application virtualization and application
streaming solution. It allows access to applications in three different ways:

• Users may stream applications directly from a central App-V Management Server to their client computers,
executing the code locally in light virtual machines that provide a protective 'bubble' around the executing
software.

• The applications may be deployed using Microsoft System Center Configuration Manager (SCCM).

• Applications may be deployed in 'stand alone' mode, such as manual delivery through file shares or on a USB
stick, without the use of any server infrastructure.

Applications delivered in any of these ways require licensing, and you can manage the appropriate licenses using
FlexNet Manager Suite:

• Applications streamed from the App-V Publishing Server(s) are monitored using the App-V server adapter
supplied as a standard part of FlexNet Manager Suite, and (for App-V release 5.0 and later) the
AppVMgmtSvr.ps1 PowerShell script installed on the App-V Management Server. Both the App-V server

adapter and the AppVMgmtSvr.ps1 PowerShell script are documented in this chapter.

• Applications deployed using Microsoft SCCM are recorded automatically as part of the standard inventory
import from SCCM.

• Applications deployed manually can be recorded manually in FlexNet Manager Suite. Manual deployment is not
a recommended best practice because of the inherent difficulties in management and demonstrating
compliance, and there is no automation possible through FlexNet direct inventory gathering to cover manual
deployment.

Supported versions

The App-V server adapter supports the current version of FlexNet Manager Suite, and releases 4.6, 5.0, and 5.1 of
Microsoft Application Virtualization.

Because of significant architectural change between release 4.6 and release 5.0 of App-V, there are matching
significant differences in the App-V server adapter for the different versions. It is important to read this document
carefully, noting the differences that apply to "release 4.6" and "release 5.0 and later".
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1
Architecture, Components, and

Prerequisites

Following the changes that Microsoft made in the architecture of App-V between release 4.6 and release 5.0, the
App-V server adapter is also significantly different when interfacing to the different App-V releases. There are
separate chapters for each different architecture. Identify the release of Microsoft App-V in use in your enterprise,
and focus on the architecture that is appropriate to that release.

Architecture and Operation for App-V 4.6
This discussion applies to use of Microsoft App-V server infrastructure, streaming applications to App-V clients
on end-point devices. (Where applications are instead installed by Microsoft SCCM, use the inventory import
from SCCM instead of this adapter.)

In its streaming implementation, Microsoft App-V release 4.6 has three main kinds of components:

• A database (referred to here as the App-V Management Server database), which may be on a separate server

• One or more Management Servers that access the App-V Management Server database and provide a user
interface for system control

• One or more streaming servers that may directly deliver application packages.

Of these, only the App-V Management Server database is relevant to the App-V server adapter for FlexNet
Manager Suite.

Prerequisites

Operation requires that you have:

• A supported version of Microsoft App-V (see App-V Server Adapter).

• An operational App-V Management Server database.

• A FlexNet inventory beacon that has network access to your App-V Management Server database, and is also
able to upload gathered inventory to the central FlexNet Manager Suite server (either directly or through a
hierarchy of inventory beacons).
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• An inventory beacon importing Active Directory data from the same domain where the App-V server resides.
(This may be the same inventory beacon that runs the App-V server adapter, but this is not a requirement.)

Tip: If you have App-V applications secured by security groups from multiple Active Directory domains,
ensure that the Active Directory import runs against all applicable domains in your environment. The
simplest approach may well be to ensure that you import from all your Active Directory domains, since if
you use foreign security principals from multiple trusted domains, it can be difficult to keep track of access
to App-V packages. FlexNet Manager Suite imports only from each individually specified Active Directory
domain; so you need to ensure that all applicable domains are specified. As an example of multiple
domains being affected:

◦ Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes
from Domain-B.

◦ In this case, granting access to an App-V package to Group-A also grants access to Group-B (because of
the parent-child relationship between the groups).

◦ This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.

◦ In such a case, it is imperative that you run an Active Directory import against both Domain-A and
Domain-B. When you have many domains, the simplest path is just to run an Active Directory import
from every domain.

• Operators who can identify the applications represented by the App-V packages, and link those applications
to the appropriate licenses.

Tip: You may have multiple App-V Management Servers, and multiple streaming servers, that link to a single
App-V Management Server database. This requires only one connection from the FlexNet Manager Suite App-
V server adapter, because this connects only to the database. However, if you have multiple App-V
Management Server databases in your estate, configure a separate connection to each of them on appropriate
inventory beacons. Where helpful, you may configure multiple such connections (each separately scheduled as
you choose) on one inventory beacon.

In operation

The following diagram shows the operational architecture for the App-V server adapter for App-V release 4.6.
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The numbers here refer to the numbers shown in the diagram above:

1. The inventory beacon imports data from Active Directory, including groups (and their members), users, and
computers, and the security identifiers for each item within Active Directory. (These security identifiers, or
SIDs, are the same identifiers that App-V reports for usage of the applications delivered through App-V
packages.)

• These are immediately uploaded to the central application server for FlexNet Manager Suite.

• As soon as the upload is completed, the data is imported into the compliance database.

2. On the schedule you specify on the inventory beacon, the App-V adapter:

• Connects to the App-V Management Server database

• Imports a list of the App-V packages from the database, and the access control lists (ACLs) that
determine which Active Directory groups and users have access to the applications inside the packages.
The latter are identified by their security identifiers (SIDs).

• Immediately uploads the data to the central application server for FlexNet Manager Suite. (If the upload
fails for some reason, there is a catch-up upload task that by default is scheduled overnight.)

• The data waits in the staging area on the central application server for the next scheduled inventory
import and compliance calculation (by default, scheduled overnight).

3. When information about a new App-V package is first imported, an operator must identify the package
and link it (like installer evidence) to an application record. This work must be done manually because (in
release 4.6) App-V packages are opaque about the applications they contain. As well, for any meaningful
calculations of consumption, the application must be linked to a suitable license. This linking effort is
required only for the first import of each new package.

Once the links are established, each subsequent compliance calculation assigns consumption by the correct
users and computers to the appropriate (linked) license. This consumption information is then available both in
the management views and in reports.
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Architecture and Operation for App-V 5
and Later
This discussion applies to use of Microsoft App-V server infrastructure, streaming applications to App-V clients
on end-point devices. (Where applications are instead installed by Microsoft SCCM, use the inventory import
from SCCM instead of this adapter.)

In its streaming implementation, Microsoft App-V release 5.0 (and later) has the following components, apart
from the App-V clients:

• A database (referred to here as the App-V Management Server database), which may be on a separate server

• A separate reporting database (referred to here as the App-V reporting database), which may also be on a
separate server (importantly, this database stores application usage information)

• One or more Management Servers that access the App-V Management Server database and provide a user
interface for system control

• One or more Reporting Servers that access the App-V reporting database and provide operational reports to
help manage the App-V infrastructure

• One or more streaming servers (called App-V Publishing Servers) that may directly deliver application
packages.

Of these, for App-V 5.0 and later, only the App-V reporting database and an App-V Management Server are
relevant to the App-V server adapter for FlexNet Manager Suite. (If you are familiar with the adapter for release
4.6 of App-V, notice that we have switched databases, and added the Management Server — the architecture is
completely different.)

Prerequisites

Operation requires that you have:

• A supported version of Microsoft App-V (see App-V Server Adapter).

• An operational App-V reporting database.

• An operational AppV Management Server.

• The AppVMgmtSvr.ps1 PowerShell script installed, configured and scheduled on your AppV Management

Server (see Obtaining (and Deploying) the Adapter Components for details). This is one of the significant
changes since the previous adapter.

• A FlexNet inventory beacon that has network access to your App-V reporting database, and is also able to
upload gathered inventory to the central FlexNet Manager Suite server (either directly or through a hierarchy
of inventory beacons).

• An inventory beacon importing Active Directory data from the same domain where the App-V server resides.
(This may be the same inventory beacon that runs the App-V server adapter, but this is not a requirement.)
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Tip: If you have App-V applications secured by security groups from multiple Active Directory domains,
ensure that the Active Directory import runs against all applicable domains in your environment. The
simplest approach may well be to ensure that you import from all your Active Directory domains, since if
you use foreign security principals from multiple trusted domains, it can be difficult to keep track of access
to App-V packages. FlexNet Manager Suite imports only from each individually specified Active Directory
domain; so you need to ensure that all applicable domains are specified. As an example of multiple
domains being affected:

◦ Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes
from Domain-B.

◦ In this case, granting access to an App-V package to Group-A also grants access to Group-B (because of
the parent-child relationship between the groups).

◦ This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.

◦ In such a case, it is imperative that you run an Active Directory import against both Domain-A and
Domain-B. When you have many domains, the simplest path is just to run an Active Directory import
from every domain.

• Operators who can link the applications identified in the App-V packages to the appropriate licenses.

Tip: You need only one connection from the FlexNet Manager Suite App-V server adapter (on an inventory
beacon) to the App-V reporting database. This single App-V reporting database may support multiple App-V
Management Servers, and multiple Publishing Servers; but only a single connection to the database is
required.

Limitation

For App-V release 5.0 and later, the system supports installation of the AppVMgmtSvr.ps1 PowerShell script on
only one App-V Management Server. This single Management Server may support multiple Publishing Servers
(if necessary spread worldwide for faster distribution of App-V packages to App-V clients); and the App-V clients
may report to multiple Reporting Servers (independent of the source from which the App-V packages were
downloaded). Different App-V Management Servers do not self-identify in the .raa inventory file, and the App-
V reporting database does not identify which application usage information is associated with which App-V
Management Server. For these reasons, only a single App-V Management Server (for release 5.0 and later) is
supported.

If your App-V (release 5.0 or later) environment has multiple Management Servers, choose one as the data
source for App-V packages and the applications they contain. For example, if you have Production, Dev, and
Test servers, place the AppVMgmtSvr.ps1 PowerShell script on the Production App-V Management Server. Also
ensure that the App-V server adapter (on an inventory beacon) connects to the matching Production App-V
reporting database.

In operation

The following diagram shows the operational architecture for the App-V server adapter for release 5.0 and later.
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The numbers here refer to the numbers shown in the diagram above:

1. The inventory beacon imports data from Active Directory, including groups (and their members), users, and
computers, and the security identifiers for each item within Active Directory. (These security identifiers, or
SIDs, are the same identifiers that App-V reports for usage of the applications delivered through App-V
packages.)

• These are immediately uploaded to the central application server for FlexNet Manager Suite.

• As soon as the upload is completed, the data is imported into the compliance database.

2. On the schedule you specify on the App-V Management Server, the AppVMgmtSvr.ps1 PowerShell script:

• Uses the API to gather a list of the available App-V packages

• Imports from the database, and the access control lists (ACLs) that determine which Active Directory
groups and users have access to the applications inside the packages. The latter are identified by their
security identifiers (SIDs)

• Uploads the collected data in a remote application access (.raa) file to its configured inventory beacon,

which in turn uploads the file to the central application server for FlexNet Manager Suite.

• The data waits in the staging area on the central application server for the next scheduled inventory
import and compliance calculation (by default, scheduled overnight).

3. On the schedule you specify on the inventory beacon, the App-V adapter:

• Connects to the App-V reporting database

• Imports App-V package usage by users and computers. These are all identified by their security
identifiers (SIDs).

• Immediately uploads the data to the central application server for FlexNet Manager Suite. (If the upload
fails for some reason, there is a catch-up upload task that by default is scheduled overnight.)

• The .raa file collected by the PowerShell script is uploaded and immediately resolved into staging

tables in the database.
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Tip: If you manually copy an .raa file to your application server, you can import it with the following
command:

> mgsimport -t remoteApplication

• The data waits in the staging area on the central application server for the next scheduled inventory
import and compliance calculation (by default, scheduled overnight).

4. When the compliance calculation is run, FlexNet Manager Suite uses the uploaded SIDs to correlate the
various data elements:

• App-V packages are shown as installer evidence (based on the MSI information uploaded by the
AppVMgmtSvr.ps1 PowerShell script).

• If an appropriate application record exists (either in the Application Recognition Library or as a locally-
created record) with a suitable installer evidence rule, the installed evidence (package) is automatically
matched with the application.

• All users with access to an App-V package are shown as having an installation of the related application
on every computer for which the user is either the assigned or calculated user.

• All computers with access to an App-V package are shown as having an installation of the related
application.

• If the application is linked to a license, consumption is shown for the correct users and computers on
that license (or, if it is linked to multiple licenses, on the highest priority license still having unconsumed
entitlements). This consumption information is then available both in the management views and in
reports. (If this is the first import to reveal an application in an App-V package, an operator needs to link
the application record to an appropriate license.)
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2
Set Up and Operations

This chapter covers the configuration of the adapter, and the work needed to enable application recognition
from the imported inventory.

Keep clearly in mind the distinctions required for App-V release 4.6, and release 5.0 and later. For example,
Obtaining (and Deploying) the Adapter Components documents processes needed only for release 5.0 and later;
and Configuring the Adapter requires a distinct database connection in each of the cases.

Obtaining (and Deploying) the Adapter
Components

1. Download the Adapter Tools for FlexNet Manager Suite 2018 R1.zip archive from the Flexera
Customer Community knowledge base:

a. Access https://flexeracommunity.force.com/customer/articles/en_US/INFO/Adapter-Tools-for-
FlexNet-Manager-Suite.

Tip: Access requires your Customer Community user name and password. If you do not have
one, use the link on the login page to request one.

b. Click the link Adapter Tools for FlexNet Manager Suite.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet
Manager Suite 2018 R1.zip commences.

c. In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C:\Temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it
to the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....
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3. In the extracted archive, navigate to Adapter Tools\App-V Management Server Agent\

AppVManagementServer5.

Tip: As an alternative to downloading the archive again, if you still have access to the 'CD image' you
downloaded to install FlexNet Manager Suite itself on your application server(s), you can also find these
files in the unzipped installation archive under FlexNet Manager Suite\Installers\App-V
Management Server Agent\AppVManagementServer5.

4. Use your preferred method to deploy the AppVMgmtSvr.ps1 PowerShell script to your App-V Management
Server.

You may install the script in your preferred folder.

5. Use your preferred task scheduling technology to schedule data collection by the PowerShell script.

Typically you want the .raa file uploaded to the central FlexNet Manager Suite operations databases
before the system import and license calculations take place. By default, this occurs daily at 2am central
server time. As a two-hour upload buffer should be more than adequate, this suggests (within a single
time zone) a data collection trigger at around midnight.

These example steps are for Windows Server 2012. Adjust as necessary for your server operating system,
or your chosen scheduling tool.

a. In Windows Explorer, navigate to Control Panel > System and Security > Administrative Tools,
and double-click Task Scheduler.

The Task Scheduler window appears.

b. In the navigation tree on the left, select Task Scheduler Library, and then in the Actions list on the
right, click New Folder....

A dialog appears for entering the folder name.

A suggested value is FlexNet Manager Suite.

c. Click OK, and select the new folder in the navigation tree.

d. Select Action > Create Task....

The Create Task dialog appears.
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e. Enter an appropriate Name, such as FlexNet Manager Agent for App-V 5.x, and add any
Description to help future maintenance of this task.

Your description may be something like Collects App-V data from the Management Server

and uploads to an inventory beacon.

f. Click Change User or Group....

The Select User, Service Account, or Group dialog appears.

g. Enter the account name that is to run the scheduled task, and click OK.

An appropriate account:

• Can run a Windows scheduled task on the App-V Management Server

• Can execute the PowerShell script

• Is an App-V Management Server administrator

• May conveniently be a domain account that can upload the results (using HTTP PUT) to the
inventory beacon, although a separate account and password can be configured in the
command line (required only where that inventory beacon is using Basic Authentication — if the
inventory beacon uses anonymous authentication, ignore this requirement).

h. Further down in the Security options group, select Run whether user is logged in or not.

i. Switch to the Triggers tab, and click New....

The New Trigger dialog appears.

j. Ensure that the default setting Begin the task On a schedule is selected, set the parameters for
the schedule, and from the Advanced settings group, be sure that Enabled is selected.

The suggested schedule is daily at or before midnight local time, but be sure that this suits the
upload procedures for your enterprise.

k. Switch to the Action tab, and click New....

The New Action dialog appears.

l. Ensure that the default Action, Start a program, is selected, and browse to your local copy of
AppVMgmtSvr.ps1.

m. In the Add arguments (optional) field, specify all the command-line arguments you need for the
agent.

All command line arguments are documented in Command Line for PowerShell Script. For
common implementations, you need to define only the URL to the inventory beacon.

This example uploads the .raa file to the flexnetbeacon inventory beacon, using the credentials of
the account running the scheduled task.

.\AppVMgmtSvr.ps1 -beaconUrl http://flexnetbeacon
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Tip: You need to specify only the basis server in the URL, Internally, the FlexNet Beacon
service briefly saves the uploaded file to %CommonAppData%\Flexera Software\Incoming\

RemoteApplications before uploading the file to its parent. (If security within your
enterprise prevents the PowerShell script uploading the .raa file to a inventory beacon, you
can arrange an alternative method to save the .raa file to this folder on a convenient
inventory beacon, and it is automatically uploaded and processed from this point.)

n. Click OK.

o. Optionally, make any preferred adjustments to the Conditions or Settings tabs (normally the
defaults are acceptable).

p. Click OK to close the Create Task dialog.

The new task appears in the list of scheduled tasks for this server.

q. Right-click the new task, and click Run in the context menu.

This checks that the scheduled task completes successfully.

r. Validate operations in the following ways:

• Review the log file (by default, AppVMgmtSvr.log in the same folder as the PowerShell script)

for any errors or warning messages.

• Review the content of the output file (by default, FNMS_AppV.raa in the same folder as the

PowerShell script). This file contains the results of the most recent execution of the PowerShell
script, and is replaced at each invocation of the script. For more details of the file format, see File
Format for .raa.

• If uploaded to the inventory beacon, check for the presence of the FNMS_AppV.raa output file

in %CommonAppData%\Flexera Software\Incoming\RemoteApplications on the inventory

beacon. Remember that you have only a brief time window to check this before it is uploaded to
the central application server and removed (by default, around 10 minutes).

The AppVMgmtSvr.ps1 PowerShell script is now configured on your App-V release 5.0 or later Management
Server. You can now configure the adapter itself that runs on the inventory beacon (see Configuring the
Adapter).

Command Line for PowerShell Script
The AppVMgmtSvr.ps1 PowerShell script is required only when importing inventory from Microsoft App-V
release 5.0 or later. (It is not required if you are using App-V release 4.6.)

For applicable releases, AppVMgmtSvr.ps1 is installed on the App-V Management Server, where, on a schedule
that you determine, it collects details of the available App-V packages, and the users and computers that have
access to the packages. (Separately, usage information is collected by the App-V server adapter, with its
separate configuration described in Configuring the Adapter.)

Set Up and Operations

84 FlexNet Manager Suite Adapters Reference | Company Confidential



The following options are supported, both for running AppVMgmtSvr.ps1 manually and for executing it from a
scheduled task or other scheduling tool. None of the options is mandatory, although some are required for
normal operation.

Syntax

Syntax:
AppVMgmtSvr.ps1 [ options...]

Options

-beaconUrl validURL

-logFilePath log_file

-outputFilePath output_file

-password password

-upload $true | $false

-username account

where

-beaconUrl validURL The URL to the appropriate inventory beacon to which the script should upload
the generated .raa file. Include the protocol (HTTP or HTTPS), and if your
inventory beacon uses a non-default port, include the port number in the
standard way.

Note: Include only the basic URL of the server. No internal paths are
needed, as these details are added automatically by AppVMgmtSvr.ps1.

There is no default value for beaconUrl, so that in production use (when -

upload $true), a value must be supplied. It can be omitted for local testing on
the server when uploading is not required. If -upload $true and beaconUrl is
not set, obviously the upload must fail.
Example values:

http://flexnetbeacon.example.com

https://flexnetbeacon.example.com:499

-logFilePath

log_file

A file path (either absolute, or relative to the folder in which the script is
executing) and file name for the log file generated by AppVMgmtSvr.ps1.
Enclose the path in double quotation marks. A file with consistent name and
path over time is replaced at each execution, containing only the results of the
last execution, thus preventing unmanaged storage requirements. When this
option is not specified, the default value is AppVMgmtSvr.log, saved in the
folder where the script is executing.
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-outputFilePath

output_file

A file path (either absolute, or relative to the folder in which the script is
executing) and file name for the output remote application access (.raa) file
generated by AppVMgmtSvr.ps1. Enclose the path in double quotation marks.
If the same name and path is used, the file is overwritten at each run of the
script. When the option is not specified, the default value is FNMS_AppV.raa,
saved in the folder where the script is executing.

-password "password" The password (in plain text) for the account specified in username. Omitted
when that option is not required. If specified, enclose the value in double
quotation marks. When required and not specified, the script uses details of the
account running the process.

-upload $true |

$false

A Boolean that determines whether to attempt uploading the output file to an
inventory beacon identified in beaconUrl. When not specified, the default is
true, requiring that beaconUrl is specified so that the upload can succeed.

-username "account" The account name used to upload the generated .raa file to the inventory
beacon identified in beaconUrl. This is not required for inventory beacons
using anonymous authentication. It may be specified for inventory beacons
using Windows Basic Authentication. If specified, enclose the value in double
quotation marks. When it is specified, the matching password must be
provided in the -password option. When required and not specified, the script
uses details of the account running the process.

Examples

(Examples here may be line-wrapped for convenient presentation; but should be entered on a single command
line.)

Collect the inventory from the App-V Management Server, saving the file locally for inspection:

.\AppVMgmtSvr.ps1 -upload $false

Similarly, collect the inventory, saving the output and logs to temporary locations to avoid overwriting the
normal output:

.\AppVMgmtSvr.ps1 -outputFilePath "C:\temp\FNMS_AppV.raa"

-logFilePath "C:\temp\AppVMgmtSvr.log"

-upload $false

Collect the inventory, and upload it to the specified inventory beacon, using the username and password for
the account currently running the script:

.\AppVMgmtSvr.ps1 -beaconUrl http://flexnetbeacon.example.com

Upload the collected inventory to the specified inventory beacon, using the testdomain\administrator

account:
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.\AppVMgmtSvr.ps1 -beaconUrl http://flexnetbeacon.example.com

-username "testdomain\administrator"

-password "somepassword"

File Format for .raa
The AppVMgmtSvr.ps1 PowerShell script interrogates the App-V Management Server, and saves the resulting
data in a remote application access file (filename extension .raa), by default called FNMS_AppV.raa. This is an
XML file that encapsulates data about each application's App-V package, and the MSI installer information
known to App-V.

Here is an excerpt from an FNMS_AppV.raa file (here line-wrapped for presentation):

<remoteApplications accessModeID="2">

<app farmName=""

appID="9b09bc0d-9634-4838-b0ba-8c256ef4710d"

appName="Blender"

appFileName=""

appFileVersion=""

appFilePublisher=""

appFileDesc=""

userSid=""

serverName=""

serverDomainName=""

isStreamingProfile="1" />

<msiData farmName=""

appID="9b09bc0d-9634-4838-b0ba-8c256ef4710d"

msiDisplayName="Blender"

msiPublisher="Blender"

msiVersion="1.0"

msiProductCode="{DFFFE0C6-3E9A-44E9-9EC1-B5C92DCEE4AF}" />

<app farmName=""

appID="5d80bef6-de4a-44f6-b4f8-9aa6a657880e"

appName="FileZilla_3.2.4.1_win32-setup"

appFileName=""

appFileVersion=""

appFilePublisher=""

appFileDesc=""

userSid="S-1-5-21-1336908958-3350896562-3141117955-1690"

serverName=""

serverDomainName=""

isStreamingProfile="1" />

<msiData farmName=""

appID="5d80bef6-de4a-44f6-b4f8-9aa6a657880e"

msiDisplayName="FileZilla Client 3.2.4.1"

msiPublisher=""

msiVersion="3.2.4.1"
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msiProductCode="filezilla client" />

<app farmName=""

appID="02787044-d434-4e7d-8770-cda46c988de8"

appName="AdobeReader9"

appFileName=""

appFileVersion=""

appFilePublisher=""

appFileDesc=""

userSid="S-1-5-21-1336908958-3350896562-3141117955-1690"

serverName=""

serverDomainName=""

isStreamingProfile="1" />

<msiData farmName=""

appID="02787044-d434-4e7d-8770-cda46c988de8"

msiDisplayName="Adobe Reader 9.1"

msiPublisher="Adobe Systems Incorporated"

msiVersion="9.1.0"

msiProductCode="{ac76ba86-7ad7-1033-7b44-a91000000001}" />

...

</remoteApplications>

Some points of interest to note:

• The complete set of MSI attributes needed for FlexNet Manager Suite makes use of Asset Intelligence on the
App-V release 5.0+ system, which saves a series of AssetIntelligenceProperties in the manifest file.

From these properties, AppVMgmtSvr.ps1 extracts the four msi... properties shown for the applications

above.

• Not all applications deployed through App-V use MSI, as some applications use third-party installers. App-V
packages using third-party installers cannot include the Asset Intelligence properties available through MSI.
For such cases, the AppVMgmtSvr.ps1 PowerShell script interrogates the App-V application registry to get

complete installer evidence, populating the same attributes in the .raa file. (Thus the presence of

AssetIntelligenceProperties in the manifest file does not necessarily mean that Asset Intelligence was

available; but does mean that equivalent data has been obtained.)

• The msiDisplayName becomes the Name property of the installer evidence record, the msiPublisher

maps to Publisher, msiVersion maps to Version. As with all installer evidence, the resulting record is

matched against installer evidence "rules" (previously-recorded installer evidence records, most often
generalized with judicious use of wild card % characters), and when matched, adds an installation count to

the application linked to the rule. This means that in listings of installer evidence, the visible entry remains
the generalized rule that matched our individual piece of installer evidence. However, the individual installer
evidence record is visible by drilling down into the properties of the inventory device on which the inventory
evidence was found.

• For a worked example of how the installer evidence for the FileZilla application in the extract above is
matched against an installer evidence rule, see Investigating Issues.
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Configuring the Adapter
The (core) App-V server adapter is set up on an inventory beacon.

Only two tasks are required for configuring this built-in adapter:

• Specifying the connection to the appropriate database. There are distinct databases in the two versions:

◦ For App-V release 4.6, the App-V server adapter connects to the Microsoft App-V Management Server
database

◦ For App-V release 5.0 and later, the App-V server adapter connects to the Microsoft App-V reporting
database.

• Scheduling the imports.

Both tasks are summarized here. Further details are available in the inventory beacon help.

To configure the App-V server adapter (summary):

1. On the appropriate inventory beacon, start the FlexNet Beacon interface.

An appropriate inventory beacon has network access to the appropriate database as described above; and
it can upload to the central FlexNet Manager Suite server, either directly or through a hierarchy of
inventory beacons.

Tip: Remember that logging into an inventory beacon requires an account with administrator
privileges.

2. Select the Inventory systems page in the FlexNet Beacon interface.

3. At the bottom of the page, click New....

The Create SQL Source Connection dialog opens.

4. Complete the values required in this dialog:

Connection name A descriptive name for this connection that you will recognize later in lists.

Source Type Select App-V Standalone. (Use this same value whether you are connecting to
App-V release 4.6, or release 5.0 or later.)

Tip: 'Standalone' means that you are using the adapter to connect directly to
the appropriate App-V database, rather than collecting inventory through
another source such as Microsoft SCCM.

Server Type the server name or IP address. If the database instance you need is not the
default one on the server you identify, add the instance name, separated with a
backslash character.

Set Up and Operations

FlexNet Manager Suite Adapters Reference | Company Confidential 89



Authentication Select one of:

• Windows Authentication — Select this option to use standard Windows
authentication to access the database server. The credentials of the account
(on the inventory beacon) running the scheduled task for importing inventory
are used to access the SQL Server database. This account must be added to
an Active Directory security group that has access to the database.

• Windows (specific account) — Use the following two fields (enabled when
you make this choice) to specify an account on the inventory beacon that can
make a connection to the SQL database.

• SQL Authentication — Use the following two fields to specify an account and
password registered as a user with database access on SQL Server . This
account is used to access the database, regardless of the local account
running the scheduled task on the inventory beacon server.

Username The account name used for SQL authentication, or Windows (specific account).
(Not required for Windows Authentication.)

Password The password for the account name required for SQL authentication, or
Windows (specific account). (Not required for Windows Authentication.)

Database Enter the name of the database, or use the pull-down list to select from database
names automatically detected on your specified server.

Connection is in test
mode (do not
import results)

Ensure that this check box is clear for production use. (For more details, see
Managing Microsoft SQL Server Database Connections in the online help for
FlexNet Manager Suite, in the section covering the inventory beacon.)

Tip: When using App-V release 4.6, you cannot complete configuration for
operation of this adapter (specifically, you cannot map the App-V packages to
real applications) until you have run an import in production mode, with this
check box clear.
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Overlapping
Inventory Filter

If you use more than one inventory source, it is possible to get overlapping
inventory (records about the same endpoint device from multiple inventory
tools). Because of differences between inventory tools, the overlapping inventory
records may contain slightly different data. In the compliance browser (in
FlexNet Manager Suite), you may nominate one inventory source as Primary,
which gives its collected data priority for hardware properties imported from
target inventory devices. The choices here give another, separate axis of control,
based on whether or not the data from this particular source is to be considered
"stale". This is different from the Primary setting in the following ways:

• It is assessed first (before the primary setting is taken into account), and so
may even modify the effect of your Primary setting. It is best practice to make
sure that your chosen primary inventory source is not marked as stale with the
following settings.

• It affects not only imported hardware properties, but also software inventory
(installer evidence, file evidence, and so on), as follows:

◦ With two inventory sources (when neither one is considered stale), the total
software inventory is a union (merging) of the results from both sources.
This is useful when two different inventory tools have different
specializations for software detection: the union means you are not blind-
sided by a software inventory tool that missed something you should have
licensed. This is considered the 'normal' operational case in a stable
environment using multiple inventory sources.

◦ When one of the two available sources is declared "stale" (using either of
the first two choices below), all of its overlapping software inventory is
excluded from the possible union of data sources (hardware inventory too,
but here we're considering software). This behavior is valuable, for instance,
when a target inventory device has migrated from one inventory source to
another (perhaps by moving offices), but has not yet been obsoleted from
this first source. Imagine that, as part of the office move, the MyApp
application had also been uninstalled from the inventory device. You do
not want the old and stale record from this source insisting there's an
installation of MyApp when in fact it's no longer on the device. Of course,
best practice is to obsolete the device from this stale source so that it is no
longer reported in this inventory source; but these first two settings allow a
quick control of all the overlapping data from this source, rather than
having to obsolete devices one by one in the source tool. Another common
scenario is when you are migrating over time from an old version of your
chosen inventory tool to a newer version (on a new connection), and during
transition both systems are still running. Declaring the old version's
connection as "stale" means that as soon as a record appears in the new
version's inventory for a particular device, the old device import is
automatically superseded, and updates rely entirely on the new version of
your inventory tool.
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Each of the following settings only takes affect when FlexNet Manager Suite is
comparing the inventory dates of a device from this current inventory source
and an overlapping record from another inventory source:

• Ignore the device’s inventory from this data source: When you have more
recent inventory from another source for the same target inventory device, the
record from this source is completely ignored. (Technically, the device record is
deleted from the staging table in the database, and so can never be imported.)

• Ignore this device’s inventory if older than nn days: If you select this option,

overlapping inventory collected by this source more than the set number of
days before the import is ignored. Fresher overlapping data is still imported
and considered for data merging.

• Import the inventory from this source for possible merging: Choose this
option (the default) to declare that overlapping inventory collected from this
connection is never considered stale. This is the normal operating setting when
you are not trying to manage transitions from one inventory source to another.
With this setting, overlapping records are merged in this way:

a. If a data point exists in the Primary inventory source, it is used

b. If two equal-priority sources have different inventory dates, the data point
is taken from the most recent inventory

c. As a tie-breaker, the connection ID for this source recorded in the
database is used (normally meaning that the earliest-created inventory
source has priority).

5. Click Test Connection.

• If the inventory beacon can successfully connect to the nominated database using the details supplied,
a Database connection succeeded message displays. Click OK to close the message. Click Save to

complete the addition. The connection is added to (or updated in) the list.

• If the inventory beacon cannot connect, a Database connection failed message is displayed, with

information about why that connection could not be made. Click OK to close the message. Edit the
connection details and retest the connection.

You cannot save the connection details if the connection test fails. If you cannot get the connection test to
succeed, click Cancel to cancel the addition of these connection details.

6. If you do not already have a schedule specified that can be used to run the adapter for this connection,
create one now (see Creating a Data Gathering Schedule in the online help).

7. With the connection for this adapter selected in the Inventory systems page, click Schedule....

The Select Schedule dialog opens.

8. From the drop-down list, select the schedule you wish to apply.
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Tip: As you select each schedule from the list, the area below displays a summary of the schedule
settings and the expected Next run time for this schedule.

9. Click OK to apply the selected schedule.

10. Click Save to store these details.

The list of connections is updated, and the Next run column for your selected connection shows the
projected run time from the schedule you just attached.

11. With the connection for this adapter still selected in the Inventory systems page, click Execute now.

The adapter collects information from the appropriate database (App-V Management Server database for
App-V release 4.6, and App-V reporting database for App-V release 5.0 and later), packages it, and uploads
it to the central FlexNet Manager Suite (or, if it uploads to a parent inventory beacon, the file is briefly
saved in %CommonAppData%\Flexera Software\Incoming\RemoteApplications on the parent
inventory beacon). Allow time for this process to complete before continuing with the next setup
procedure.

Import Evidence and Recognize
Applications
Because your App-V package naming may be unique to your enterprise, you may need to identify the applications
they contain.

If you have many App-V packages, setting up application recognition may be a significant effort on the first
import from your App-V server adapter. Once the initial work is done, it is a simpler task to maintain recognition
as new App-V packages are put into production.

This procedure continues from the work just completed at the inventory beacon where the adapter runs. Move
now to the web interface for FlexNet Manager Suite.

To import evidence for application recognition:

1. Ensure that the upload of data from the App-V server adapter is complete:

a. In the Management view, open the System menu ( in the top right corner) and select Data
Inputs.

The Data Inputs page appears.

b. Select the Inventory Data tab, and select the Show details check box near to top.

c. Find the App-V server adapter listed for the appropriate inventory beacon, and check its Last
import date, Duration, Validation issues, and Status.

When these are appropriate (in particular, Status is Successful on the appropriate Last import
date), continue this procedure. Until then, you need either to remediate any upload problems, or
simply wait until the upload is completed.
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Tip: This page does not dynamically update results, but shows the status when the page was
opened. Therefore, if you are waiting for an upload to finish, refresh the page (F5) from time to
time to see updated information.

For App-V 5.0 and later, the upload of the .raa file saves the contents into staging tables in the
compliance database, awaiting the arrival of usage information. For both App-V 4.6 and 5.0 (and later), the
upload of the datafile from the App-V server adapter (on an inventory beacon) queues a job with the batch
scheduler. When this job can next be processed, the adapter data (which, for App-V 5.0 and later, is
combined in this process with the installer evidence from the .raa file) is imported into the compliance
database. Thereafter, either of two results applies:

• Recognized installer evidence is linked to the application, and shows an installation count for each
device on which the evidence was found (and can be further examined on the properties for each of
those devices).

Tip: The next step, showing consumption against an appropriate license, requires both that the
application is linked to the license, and that a reconcile has been run, either automatically on schedule
or manually.

• The installer evidence that was successfully imported but not matched to an application record needs
your attention to map it to the correct application. (This is more common with the adapter for release
4.6.) To do that, continue with this process.

2. Identify newly-imported evidence (the App-V packages) that requires a link to application records:

a. Navigate to License Compliance > Discovered Evidence (in the Evidence column).

The Discovered Evidence page appears. Ensure that the default Installer evidence tab is selected.

b. Near the top of the tab, click Add filter, and from the drop-down list select Type.

A second drop-down list appears, listing the possible values of the evidence type.

c. Select App-V.

d. Click Add filter again, and from the pull-down drop-down list select Assigned, then choose the
value No. With both filters defined, click the blue check mark (tick) to apply this filter.

The list is redrawn to show only evidence of type App-V (the list of App-V packages discovered
through the adapter) that have not been matched (manually or automatically) to an application.

Tip: You may have no results when these filters are applied. This is a healthy state, meaning that
all your App-V evidence is successfully matched to applications. When you have no records here,
and want further validation of success, you can drill down into the properties of devices that have
a record of installation for the appropriate application.

3. Use your special knowledge of the App-V packages to link each piece of unassigned evidence to an
application record. You may do this either by:

• Clicking the Name of the evidence, which opens the property sheet for this evidence where you can
work on the Applications tab

• Following these guidelines to edit locally, still on the Discovered Evidence page:
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a. Click anywhere else in a row (other than on the Name) to select that App-V package from the list.

The action buttons above the list become active.

b. Click Assign.

A blue editor Assign evidence to an application appears above the tabs.

c. Click in the search field, optionally enter a few characters from the application name, and click
Search.

The editing area expands to include a list of application results matching your search. These
applications include any previously created in your enterprise, together with all matching
applications from the Application Recognition Library regularly updated by Flexera.

d. Select your chosen application from the list, and (above the list) click Add.

The search field is updated to show the name of the application you selected.

Tip: If you cannot find the correct application in the search results, you may create a new
application record by clicking Create an application, and completing the details in the
application properties (the App-V package is automatically listed in the Evidence tab of the
application properties).

e. Click Assign.

• The blue editing area closes.

• The App-V package is linked to the application you chose (the App-V package now functions like
installer evidence to show consumption against any license linked to the application).

• In the list of evidence, the Assigned column is updated to Yes, showing that this package has

been linked (or assigned) to an application. (If you currently have a filter on the Assigned column
to show only rows with a No value, the evidence you just assigned must disappear from the list.)

Tip: This links the evidence to the application as an exact match across publisher, name, and
version records. To protect against future upgrades of the App-V package, you may wish to
generalize the version number with a % wild-card. For example, if the original version was 1.0,
manually editing the Version property of the installer evidence to 1.% means the link to the
application remains valid through all the minor upgrades of this package.

4. If the selected application is not yet linked to a license, you can:

a. Double-click the App-V package in the evidence list (or, while it is selected, click Open).

The evidence property sheet opens.

b. Select the Applications tab.

c. In the list of applications, click the name of the one you have just assigned to the App-V package
(or double-click elsewhere in the row; or select the row and click Open).

The application property sheet opens.

d. Select the Licenses tab in the application properties.
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e. Optionally enter a few characters of a license name (where you know it); click Search.

The search area expands to show the list of available licenses (matching any characters you
entered).

f. Select the appropriate license from those offered, and click Add license.

Where a suitable license does not already exist, you may instead create one (for example, navigate
to License Compliance > Create a license (in the Licenses column).

Tip: Don't forget to link some purchase records to the license to provide your entitlement count.
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3
Issues and Limitations

Diagnosis is covered in this chapter, along with limitations and known issues.

Limitations
The following limitations apply to the current releases of the App-V server adapter:

• In the unlikely event that App-V packages have been shared to non-persistent XenDesktop VDI devices
(instead of users), and FlexNet Manager Suite is linked to a XenDesktop broker, no license consumption
occurs for those non-persistent devices (because non-persistent VDI devices are not modeled within FlexNet
Manager Suite when XenDesktop broker information is available).

• License consumption calculations depend on the integration of data both from Active Directory, and from the
appropriate App-V database (App-V Management Server database for release 4.6, or reporting database for
release 5.0 and later) and the AppVMgmtSvr.ps1 PowerShell script. As linking of this data occurs when the

App-V server adapter data is imported, current users, computers, and groups must be imported from Active
Directory first, before the latest App-V server adapter import occurs. From FlexNet Manager Suite 2014 R2,
this ordering is automatic, since Active Directory data is imported to the central database as soon as it is
uploaded from an inventory beacon.

Tip: If you have App-V applications secured by security groups from multiple Active Directory domains,
ensure that the Active Directory import runs against all applicable domains in your environment. The
simplest approach may well be to ensure that you import from all your Active Directory domains, since if
you use foreign security principals from multiple trusted domains, it can be difficult to keep track of access
to App-V packages. FlexNet Manager Suite imports only from each individually specified Active Directory
domain; so you need to ensure that all applicable domains are specified. As an example of multiple
domains being affected:

◦ Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes
from Domain-B.

◦ In this case, granting access to an App-V package to Group-A also grants access to Group-B (because of
the parent-child relationship between the groups).

◦ This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.
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◦ In such a case, it is imperative that you run an Active Directory import against both Domain-A and
Domain-B. When you have many domains, the simplest path is just to run an Active Directory import
from every domain.

• The quality of installer evidence recovered from App-V release 4.6 is not high. You should expect to do
remedial work both to generalize the evidence found (for example, using the % wild card to generalize version

numbering), and to link the evidence to appropriate applications.

• For App-V release 5.0 and later, the system supports installation of the AppVMgmtSvr.ps1 PowerShell script

on only one App-V Management Server. This single Management Server may support multiple Publishing
Servers (if necessary spread worldwide for faster distribution of App-V packages to App-V clients); and the
App-V clients may report to multiple Reporting Servers (independent of the source from which the App-V
packages were downloaded). Different App-V Management Servers do not self-identify in the .raa inventory

file, and the App-V reporting database does not identify which application usage information is associated
with which App-V Management Server. For these reasons, only a single App-V Management Server (for
release 5.0 and later) is supported.

Investigating Issues
Proof that the App-V server adapter is operational, and the data upload is also successful, can be seen in either
or both of two ways:

• Installation records for the appropriate applications against expected inventory devices (possibly including
Remote devices for which no hardware inventory is available)

• The presence of any newly-discovered inventory of type App-V in the Discovered Inventory list, typically

with an Assigned value of No.

If neither of these is the case, the issues could be with:

• Imports from the App-V server adapter on an inventory beacon (for both App-V release 4.6, and App-V
release 5.0 or later)

• Imports of the .raa file from your App-V Management Server (only for App-V release 5.0 or later)

• Missing links between the installer evidence (representing App-V packages) and the applications in the
packages

• Missing consumption on an appropriate license.

Each of these is covered in turn below.

No data imports from adapter on inventory beacon
Check the following to identify the problem with imports from the App-V server adapter:

1. Are you sure that there should be new records? Have new packages been brought into production since
the last time inventory was collected and fully processed?
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2. Check the Status of the latest upload ( > Data Inputs > Inventory Data tab > select Show details).
Also validate that the Last import date is as expected, so that the upload occurred after new App-V
packages were brought into production.

3. If uploads are not happening, move to the inventory beacon where the adapter runs, and check the status
of the App-V connection. Use the Test connection button to ensure it can connect to the appropriate
database (App-V Management Server database for App-V release 4.6, and the App-V reporting database
for release 5.0 and later). Details about setting the connection are in Configuring the Adapter.

4. On the same inventory beacon, test its connection to the central application server for FlexNet Manager
Suite, using the Parent connection page and the Test connection button there. (If this inventory beacon
is part of a hierarchy, check the connections all the way up the hierarchy to prove that uploads can reach
the central server.)

5. Check for stalled uploads by looking for an App-V inventory file in the %CommonAppData%\Flexera

Software\Beacon\IntermediateData directory on the inventory beacon (or, in a hierarchy, in the chain
of inventory beacons). (Notice that the folder for files from the App-V server adapter is separate from the
folder for .raa files from the PowerShell scripts used with release 5.0 and later.) App-V data files are
named in part for the connection you established (see Configuring the Adapter). Once an inventory file of
this type is successfully uploaded, it is removed from this intermediate data location on the inventory
beacon; so any file in this folder on any server in the hierarchy has not yet been uploaded to the parent
server. Upload failures may occur for temporary reasons, such as a network timeout; but there is a catch-up
task run overnight to re-attempt uploads of any stalled files.

6. Has a reconciliation calculation occurred since the upload? Until this occurs (normally overnight), new App-
V inventory cannot be displayed in the web interface for FlexNet Manager Suite. Check the date and time
on the System Health page ( > System Health), in the License reconciliation card. The last import
and reconciliation must be after the latest upload from the inventory beacon.

7. If you are using App-V release 5.0 or later, a failure to upload and save .raa files may also prevent
presentation of results, even when the application usage information is successfully imported from the
App-V server adapter. Issues with .raa files are covered in the next section.

No data imports from the PowerShell script for App-V release 5.0 and later

If uploads of .raa files do not appear to be working:

1. Ensure that a new upload is required: that is, that the AppVMgmtSvr.ps1 script has executed successfully
since the last inventory import and license consumption calculation (the most recent file is always saved on
the App-V Management Server for checking, and is only replaced the next time that the script executes):

• Check your scheduling for the script's execution, in particular that the command line options are correct
(see Obtaining (and Deploying) the Adapter Components).

• Check the log file for the last run (you may have renamed or relocated the log file, as described in
Command Line for PowerShell Script). In particular, ensure that there were no problems with the file
upload to the inventory beacon.

2. Move to that inventory beacon, and check for stalled uploads by looking for an .raa file in
%CommonAppData%\Flexera Software\Incoming\RemoteApplications (this file path is different from
the one used for files uploaded by the App-V server adapter). If you have a hierarchy of inventory beacons,
check each in turn.
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3. If file uploads are happening successfully, has there been a reconcile since the last .raa file was uploaded?

Check the date and time on the System Health page ( > System Health), in the License
reconciliation card. The last import and reconciliation must be after the latest upload from the inventory
beacon. If not, you may (as an administrator) manually trigger a reconcile (see the FlexNet Manager Suite
Help > What Is an Inventory Beacon? > What Is an Inventory Beacon?).

Missing application recognition

For App-V release 4.6, data imported from the App-V server adapter includes only the App-V package name
and the Active Directory groups (or individuals) that may access the package, according to the Access Control
Lists (ACL). Specifically, this imported information cannot recognize what application is hidden within the App-V
package. Application recognition requires a separate step. Even for App-V release 5.0 and later, where much
better installer evidence allows automatic matching of the evidence rules for the appropriate application, there
may be cases where the installer evidence needs manual attention. This will be the case when:

• There is no matching application available within FlexNet Manager Suite, either in application records that
you have created locally, or in the Application Recognition Library

• There is an appropriate application, but the values returned from App-V do not match with the existing
inventory rules for the application record.

In cases where installer evidence from App-V is unmatched, you can check as follows:

1. First be sure that data uploads and imports are happening, as validated in the previous sections.

2. Navigate to License Compliance > Evidence column > Discovered Evidence > Installer evidence tab,
filter for Type=App-V, and check the Assigned column. If it displays No, you need to link this package to an
application, as described in Import Evidence and Recognize Applications.) For App-V release 4.6, newly
imported evidence is always unassigned, and requires you to manually associate the evidence (or App-V
package) with an application.

3. For App-V release 5.0 (and later), when installer evidence appears in the above listing, it may be worth
checking why the data from the App-V installer evidence did not match existing evidence rules for the
appropriate application (assuming the application is already present locally or in the Application
Recognition Library). To do this, navigate to the Evidence tab of the application's properties, where all
existing evidence "rules" are listed (making sure that Installer is the selected subtab). Compare the data
displayed there with content in your .raa file (see sample .raa file in File Format for .raa). Here is a worked
example of successful matching using the FileZilla 3 application:

App-V element's attribute Application's installer evidence property

msiDisplayName="FileZilla Client 3.2.4.1" Name FileZilla Client 3.2.%

msiPublisher="" Publisher (blank)

msiVersion="3.2.4.1" Version 3.2.%

accessModeID="2" (produces the evidence type
App-V)

Type Any

Thus the .raa entry produces installer evidence that is immediately matched by the existing installer
evidence rule for the application, and produces an installation count against that application. But looking
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ahead (in imagination) to the day when the .raa entry covers a version of 4.2.3.1, the App-V package
data in the .raa file would no longer match this evidence rule. At that time, if a new rule was yet to be
published in the Application Recognition Library, the installer evidence created from the .raa file would
appear in the Discovered Evidence listing, and you could link it to the application, preferably generalizing
it (similarly to the example above) to create a rule that would match several minor releases.

Missing consumption

Showing consumption of license entitlements for App-V packages (and the applications they contain) requires:

• The adapter gathers data from the App-V server and uploads and imports it into FlexNet Manager Suite (see
first section above for more details).

• For App-V release 5.0 or later, the .raa file is uploaded from your App-V Management Server

• The application is recognized, either automatically, or because you have linked the App-V package to an
application record (see previous section)

• The application is linked to a license (and in turn the license should be linked to purchase records to show
your legal entitlements) — here, this is left as an exercise for the reader.

• Active Directory imports are current, allowing mapping of the groups and users from the ACLs in the App-V
Management Server database to user records in FlexNet Manager Suite.

These notes address the last stage, enabling Active Directory to map from the ACL lists to user records. This
process is automatic, provided that all the necessary data is available.

1. On the appropriate inventory beacon, open the Active Directory page (from the Connections group), and
validate that a connection is both established and scheduled. (For details, see Importing from Active
Directory in the online help.) Review the Last run time to see when data was last collected, uploaded, and
imported. You may also choose Execute Now if imports have been disrupted.

2. Once sufficient time has passed for Active Directory data collection, upload, and import (normally, 30
minutes should be more than adequate), review the list of All Users to establish that the expected user
names are all available (navigate to Enterprise > Users group > All Users).

Tip: If you have App-V applications secured by security groups from multiple Active Directory domains,
ensure that the Active Directory import runs against all applicable domains in your environment. The
simplest approach may well be to ensure that you import from all your Active Directory domains, since if
you use foreign security principals from multiple trusted domains, it can be difficult to keep track of
access to App-V packages. FlexNet Manager Suite imports only from each individually specified Active
Directory domain; so you need to ensure that all applicable domains are specified. As an example of
multiple domains being affected:

• Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes
from Domain-B.

• In this case, granting access to an App-V package to Group-A also grants access to Group-B (because
of the parent-child relationship between the groups).

• This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-
A.
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• In such a case, it is imperative that you run an Active Directory import against both Domain-A and
Domain-B. When you have many domains, the simplest path is just to run an Active Directory import
from every domain.

Note: You cannot review Active Directory group memberships within FlexNet Manager Suite. Only the
resulting list of users is available (along with computers, sites, and subnets).

Known Issues
The following issues relate primarily to the stability of data available for collection from the App-V server.

Renaming packages

App-V allows you to rename packages (without necessarily changing their contents). When a package is
renamed, the App-V application record no longer links to usage records within the appropriate App-V database.
This means that the App-V server adapter (and, for App-V release 5.0 and later, the AppVMgmtSvr.ps1

PowerShell script) cannot import meaningful data for license consumption calculations. As well, the installer
evidence generated from the App-V import now has a different name, which may not match evidence rules for
the appropriate application. If that is the case, the consumption calculations for any license linked to an
application that was linked to the previous installer evidence from App-V drops to zero (from this import
connection).

For this reason, it is strongly recommended that you do not change the name of existing App-V packages in the
App-V Management Server interface. Where renaming is unavoidable, remember that you may need to link the
new package (represented as installer evidence in FlexNet Manager Suite) to the application to restore
consumption calculations (especially for App-V release 4.6).

Updating package versions

Typical "rules" for applying installer evidence to identify applications use the publisher, the application, and the
version recorded in the installer evidence. If you use a version number for your App-V packages (such as 1.0),
and link exactly this App-V 'installer' evidence to the application record in FlexNet Manager Suite, then updating
the version number of the package on your App-V Server (say, to 1.1) may break the link to the application, and
the linked license loses its consumption as a result.

You can avoid this problem (at least for minor version changes) by using wild-cards in the linking of evidence to
applications. To do this, after you have linked the App-V evidence to the application:

1. Navigate to the Installer Evidence Properties page.

2. Select the General tab.

3. Edit the Version property, using a wild-card percentage sign (%) to generalize the match across multiple
versions. For example:

• The original (say 9.2) is an exact match for only one version number.

• A value of 9.% matches all the minor releases of version 9.

• A value of % matches all versions of the App-V package with the same name and publisher.
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4
Data mapping

This chapter covers the relationships between the data fields in the source App-V data and the final locations of
the data inside the FlexNet Manager Suite database.

App-V Release 4.6 Data Transfers
This table lists the data extracted from App-V release 4.6, and where it is stored the compliance database in
FlexNet Manager Suite.

Imported data is stored in temporary staging tables for data manipulation, and then moved into their final
destination tables as noted below. These columns in the compliance database are available for use in custom
reports, and the like.

App-V (Table)/Column FNMS (Table)/Column Notes

(REPORTING_CLIENT_INFORMATION)
host_name

(ComplianceComputer)

ComputerName

If the computer name already exists in the
ComplianceComputer table, this device is
identified as the consuming device.
If it does not already exist, the device is
added to the ComplianceComputer table
with a ComplianceComputerTypeID of 4,
which (through the
ComplianceComputerType table)
indicates a remote device from which
inventory cannot be collected. All such
created records display their connection
name (as the Inventory Agent), are marked
as incomplete records, and are given a
fictitious serial number of 1.
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App-V (Table)/Column FNMS (Table)/Column Notes

(REPORTING_CLIENT_INFORMATION)
host_name

(ComplianceComputer)

ComplianceDomainID

The domain name is extracted from the
host record on the App-V server. If the
domain does not already exist in the
compliance database, it is added to the
ComplianceDomain table, and as required
the ComplianceDomainID may be updated
in the ComplianceComputer table.

(APPLICATION_USAGE)
username

(ComplianceComputer)

ComplianceUserID

The last logged on user for this computer.

(VW_APPLICATIONS)
app_name

(InstallerEvidence)
DisplayName

The name of the App-V package (which
may bear no resemblance to the
application inside) is used to identify the
evidence record.

Note: It is possible for an App-V
package to contain more than one
application. This makes it impossible to
link the App-V evidence to a single
application record. Best practice is to
make each package contain exactly one
licensable application.

(VW_APPLICATIONS)
version

(InstallerEvidence)
Version

The version of the App-V package. Again,
this bears no necessary relationship to the
version of the application inside the
package, and is at the whim of the person
preparing the package (for example, it may
represent the number of times the
application package was modified).

String literal App-V (InstallerEvidence)
Publisher

All App-V evidence is given the publisher
name of App-V.

App-V Release 5.0 (and Later) Data
Transfers
This data is imported from Microsoft App-V release 5.0 and later. It is imported by the combination of the
PowerShell script installed on your App-v Management Server, and the App-V server adapter on an inventory
beacon that can access the App-V reporting database.

Several staging tables in the compliance database store information uploaded from the App-V reporting
database and the .raa files. These include:
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• ImportedComputer

• ImportedInstalledInstallerEvidenceUsage

• ImportedInstallerEvidence

• ImportedRemoteApplication

• ImportedRemoteApplicationAccess

• ImportedRemoteApplicationServer

• ImportedRemoteApplicationInstallerData

Data is held in these tables until the import from the App-V server adapter is complete, and then the resolvers
are triggered to combine the data from:

• The most recent Active Directory import(s) across all relevant domains

• The most recent imports of the .raa file from all App-V Management Server

• The App-V reporting database.

For this reason, it is important that the import from the App-V reporting database happens last.

The following table lists the elements and their attributes from the .raa file, and their final table and column in
the compliance database within FlexNet Manager Suite.

XML (Element) / Attribute FNMS (Table) / Column Notes

(app) appID n.a. Used as a key as required across
the temporary tables listed above.

(app) userSid n.a. The group SID (from Active
Directory) identifying the users
and computers with access to the
package. This drives the linking of
inventory device and user records
to the application.

(msiData) msiDisplayName (InstallerEvidence)

DisplayName

Visible as the Name in Installer
Evidence properties.

(msiData) msiPublisher (InstallerEvidence)

Publisher

Visible as the Publisher in
Installer Evidence properties.

(msiData) msiVersion (InstallerEvidence) Version Visible as the Version in Installer
Evidence properties.

(msiData) msiProductCode (InstallerEvidence)

ProductCode

Not visible in the web interface.

The following are the views used for source data from the App-V reporting database. It is not possible to give a
simple mapping of this source data to columns in particular database tables within FlexNet Manager Suite,
because the data is normalized and otherwise processed at each stage. For example, the usernamecolumn
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collected from view_ApplicationUsage in the App-V reporting database is already subject to considerable
validation and processing before it is stored in the lastloggedonuser column in the staging tables (staging
tables are listed above). Thereafter, the user name is correlated with other inventory sources, resulting in further
processing before it is used to determine a link between the application and the user. For that reason, this table
shows only the source content in the App-V reporting database.

App-V View Columns

dbo.view_ApplicationUsage • app_name

• app_version

• end_time

• host_id

• start_time

• username

• version_guid

dbo.view_ClientInformation • host_id

• host_name

dbo.view_PackageInformation • host_id

• package_id

• version_guid
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III
BMC Atrium and Remedy Integration

The BMC Atrium adapter is a mechanism for two-way information synchronization between an on-premises
implementation of FlexNet Manager Suite, and BMC Software's Atrium configuration management database
(CMDB) and Remedy IT Services Management product. Data flows in two directions, which in this document are
described from the viewpoint of FlexNet Manager Suite as export and import:

• The adapter exports computer system and recognized product information from FlexNet Manager Suite to the
CMDB. (Details of fields exported are available in Appendix 1: Export of Computers and Appendix 2: Export of
Applications/Products.)

• The adapter also imports Asset role, status and owner information from the CMDB and Remedy into FlexNet
Manager Suite. (Details of the imported data are available in Appendix 3: Import of Assets.)

Note: This adapter is only available for on-premises implementations of FlexNet Manager Suite. Specifically, it
cannot be used with the cloud implementation.

This documentation (and the BMC Atrium adapter) assume that the Atrium server is running on a Microsoft
Windows operating system.

This documentation covers the following supported products:

• FlexNet Manager Suite version 2018 R1

• BMC Atrium CMDB version 8.1 through 9.1 (together with Atrium Integrator version 8.1 through 9.1)

• BMC Remedy ITSM Applications version 7.6.04 SP4 through 9.1.
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1
Architecture, Operation, and

Prerequisites

This chapter provides a framework for your understanding of later, more detailed information.

Architecture and Operations
To facilitate the two-way exchange of data between FlexNet Manager Suite and BMC Atrium, components
already supplied with both systems are used, and additional elements are supplied with the downloaded
adapter.

The following diagram combines the positioning of these elements on different servers, with the data flows for
both export and import (as defined in BMC Atrium and Remedy Integration). There are two determining factors
in this structural arrangement:

• The schedule for triggering both exports and imports is configured within Atrium, and the Atrium Integrator
needs to invoke the data export utility and the FlexNet Business Importer. For this reason, all three
components (Atrium Integrator, export utility, and Business Importer) are located on the same server.

• For performance, it is preferable that the intermediate database be on the same database server as your
compliance database for FlexNet Manager Suite. (Where you choose a different location, ensure there is a
high-speed network connection between the two servers, and a trust relationship for the accounts used
during operations.)

The combination of these two determinants produces the following physical architecture. Net data flows are
shown here, with each process also shown separately below.
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Once the adapter components are installed and all systems are configured (as described in the chapter Installing
the Adapter), operation is fully automatic, triggered by schedules you set during configuration. The two
directions of data exchange function independently, and are summarized below.

Export of Computers and Products

In summary, the process for exporting computer and product information from FlexNet Manager Suite to BMC
Atrium (shown below in blue arrows) is as follows:

1. The schedule for export fires in Atrium, and the Atrium Integrator calls the data export tool (installed as
part of the adapter).

2. The data export tool reads content from the compliance database for FlexNet Manager Suite, and writes
the data into the intermediate database. (It also creates entries in the log file, and sends alert emails if there
any errors.)

3. On success, the Atrium Integrator reads the data from the intermediate database, maps it using the defined
data transforms to the fields required in Atrium
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4. The Atrium Integrator writes the results into the CMDB.

Import of Assets

In summary, the process for importing assets (and their ownership) from BMC Atrium into FlexNet Manager
Suite (shown below in green arrows) is as follows:

1. The schedule for import fires in Atrium.

2. The Atrium Integrator reads data from both the Remedy database and the CMDB, and writes the results
into the Intermediate database. (It also sends alert emails if there are any errors.)

3. On success, the Atrium Integrator calls the FlexNet Business Importer.

4. The Business Importer reads the data from the intermediate database, transforms it as required, and writes
the results into the compliance database of FlexNet Manager Suite.

Prerequisites
The prerequisites for the BMC Atrium adapter include the following:

• On the server where the data utility is to be installed, .NET Framework 4.5 is required. (To validate, open
Windows Programs and Features, and search for .NET.)

• FlexNet Business Importer must be installed on the same server where the Atrium Integrator is installed. This
is installed as a part of the FlexNet Business Adapter Studio. Collecting the installer files is covered in
Obtaining the Adapter Components, and completing the installation and configuration is detailed in Install
the Business Importer and Link with Remedy.

• The adapter requires an intermediate database to be installed, conceptually between the compliance
database for FlexNet Manager Suite and the CMDB for BMC Remedy. In practice, this intermediate database
may reside on the same database server as the compliance database; or any other convenient server running
at least Microsoft SQL Server 2008 that is accessible from both your BMC Atrium server and your FlexNet
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Manager Suite database server. Scripts to set up the database are included with the adapter, and the process
is covered in Preparing the Databases.

• FlexNet Manager Suite version 2018 R1

• A FlexNet Manager Platform BMC Atrium CMDB Option license. To verify that you have this license term,

navigate to the system menu ( in the top right corner) > FlexNet Manager Suite License, and look for
this item in the list of Licensed products. If not present, you can request the license term through the
Contact us to renew or upgrade email link on the same page.

• BMC Atrium CMDB version 8.1 through 9.1 (together with Atrium Integrator version 8.1 through 9.1)

• BMC Remedy ITSM Applications version 7.6.04 SP4 through 9.1.

Obtaining the Adapter Components
Here's where to collect the adapter, and the main elements it contains.

It is most convenient to complete this procedure on the computer where you will install the adapter (see
Architecture and Operations).

To download adapter components:

1. Use your browser to access the Flexera Customer Community.

a. On https://flexeracommunity.force.com/customer/CCLanding, use the account details emailed to
you with your order confirmation from Flexera to log in (using the Login link in the top right).

Tip: Access requires your Customer Community user name and password. If you do not have
one, use the Request Community Access link on the login page to request one. Your
credentials are configured for access to content you have licensed.

b. Select the Downloads tab from the row across the top of the page.

A routing page appears to let you Access Product and License Center, displaying lists of
products from Flexera.

c. In the lists of products, identify FlexNet Manager Platform, and click the Access Above Products
button that is below that product name.

The Product and License Center site is displayed.

d. In the Your Downloads section of the Home page, click the link for FlexNet Manager Platform.

e. In the Download Packages page, click the link for FlexNet Manager Platform 2018 R1 to access the
downloads. (You may need to repeat this action on a second page to access the downloadable
files.)

2. Select the Adapter Tools for FlexNet Manager Suite 2018 R1 archive (Adapter Tools for FlexNet
Manager Suite 2018 R1.zip), and save to a convenient location (such as C:\temp) on the server where
Atrium Integrator Spoon is installed.
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3. Similarly, download the Business Adapter Studio version Installer and save on the same server.

Installation of the Business Adapter Studio is covered in Install the Business Importer and Link with
Remedy.

4. Unzip the adapter tools archive, navigate through Tier 1 Adapter Tools > BMCAtriumAdapter, and
copy the contents into C:\Program Files\Flexera\.

Important: This path is referenced in various steps in the Atrium jobs and transformations (see file list
below). If you do not use the same path, you must edit the Atrium Integrator Spoon jobs and
transformations manually to point the shell scripts to different location.

The archive includes the following key components:

• An SQL script to create the intermediate staging database (archive\BMCAtriumAdapter\scripts\

CreateIntermediateDatabase.sql)

• Another SQL script to modify the database for FlexNet Manager Suite (archive\BMCAtriumAdapter\

scripts\FNMPDatabaseChanges.sql)

• The definition of Atrium Integrator jobs (.kjb) and transformations (.ktr):

◦ archive\BMCAtriumAdapter\BMCAtriumAdapter.kjb

◦ archive\BMCAtriumAdapter\FNMPExports\Execute FNMP Export Tool.kjb

◦ archive\BMCAtriumAdapter\FNMPExports\ExportComputerProductRelationshipsTransform.ktr

◦ archive\BMCAtriumAdapter\FNMPExports\ExportComputersTransform.ktr

◦ archive\BMCAtriumAdapter\FNMPExports\ExportProductsTransform.ktr

◦ archive\BMCAtriumAdapter\FNMPExports\ExportUpdateIntermediateDBTransform.ktr

◦ archive\BMCAtriumAdapter\FNMPExports\FNMPExports.kjb

◦ archive\BMCAtriumAdapter\FNMPImports\Asset.ktr

◦ archive\BMCAtriumAdapter\FNMPImports\ImportUpdateIntermediateDBTransform.ktr

• The adapter's main executable (archive\BMCAtriumAdapter\FNMPExports\Utility

\FNMPDataExportUtility.exe), and its many dependencies, including:

◦ Query files (archive\BMCAtriumAdapter\FNMPExports\Utility\Queries\Computers.txt,

ProductIds.txt, Products.txt)

◦ Adapter configuration file (archive\BMCAtriumAdapter\FNMPExports\Utility\

FNMPDataExportUtility.exe.config)

• Business Importer adapter definition file (archive\BMCAtriumAdapter\FNMPImports\

FNMPImportDefinition\Asset.xml).
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2
Installing the Adapter

Integrating two sophisticated systems likes these involves a number of procedures, documented in the topics
shown:

1. Installing the new, intermediate DB used for data manipulation and transfer (see Preparing the Databases).

2. Modify the compliance database in FlexNet Manager Suite with a custom property for additional values
(also in Preparing the Databases).

3. Installing and configuring the export utility that brings data out of FlexNet Manager Suite and into the
intermediate database (still in Preparing the Databases).

4. Declaring a dataset within Atrium for data exchange, and authorizing an account to use that dataset (see
Reserving an Atrium Dataset).

5. Importing the supplied Atrium jobs and data transforms into your Atrium system (see Importing Atrium Jobs
and Transforms).

6. Configuring the supplied Atrium jobs with appropriate settings for your environment (see Configure Atrium
Jobs).

7. For the import of asset data from Atrium to FlexNet Manager Suite, installing the FlexNet Business Adapter
Studio (which brings with it the Business Importer), and integrating the Business Importer with BMC Remedy
Mid-Tier (see Install the Business Importer and Link with Remedy).

8. Initially populating the CMBD with configuration items from FlexNet Manager Suite, and then adjusting
settings to allow for reuse for future imports (see Tuning Creation of Configuration Items).

9. Schedule regular operations of the adapter (see Scheduling the Adapter).

This chapter also includes details about Verifying Data Export to BMC Atrium.

If you are transferring large datasets, you should also prepare an environment variable as described in Preparing
for Large Datasets. (Other configuration options, including relocating or renaming the log file, are also
documented in the chapter Additional Customization of the Adapter.)
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Preparing the Databases
You have a clear understanding of your physical architecture for the installation (see Architecture and
Operations), and have downloaded and unzipped the archive containing the adapter (see Obtaining the Adapter
Components).

To prepare the databases:

1. Determine where the intermediate database used by the adapter will reside, and log into that database
server using an account that has DB Owner privileges.

For details, refer back to Architecture and Operations.

Tip: If the archive cannot be accessed from this database server, first copy the script (or both scripts for
a common DB server) from this folder to a location accessible from SQL Server Studio. If you use copies
of the scripts, modify the paths described below to suit.

2. On this server, in Microsoft SQL Server Studio, create the intermediate database (suggested name
AtriumIntermediateDB).

3. Open a query window that is connected to your new database, and execute
CreateIntermediateDatabase.sql (located in the unzipped archive, by default in C:\Program Files\

Flexera\BMCAtriumAdapter\scripts).

This SQL procedure creates the required tables and pre-populates some fixed values.

4. If the intermediate database is on another server separate from your compliance database for FlexNet
Manager Suite, switch over and log into the FlexNet Manager Suite database server, again using an
account that has DB Owner privileges.

You need access to the second SQL script here, so if necessary, copy the second script to this server
before continuing.

5. In Microsoft SQL Server Studio, navigate to and execute C:\Program Files\Flexera\

BMCAtriumAdapter\scripts\FNMPDatabaseChanges.sql.

This SQL script adds a custom property to the Details tab of computer properties in FlexNet Manager Suite
where the machine's Role can be imported from BMC Atrium.

6. On the server where the data extraction executable will run (likely, the Atrium server), open a command
prompt, and navigate to C:\ProgramFiles\Flexera\BMCAtriumAdapter\FNMPExports\Utility.

This executable requires .NET Framework 4.5 installed, a high-speed network access to the database(s),
and an account trusted to access both the compliance database and the intermediate database. It must be
callable by the Atrium Integrator. If need be, first copy the entire contents of the folder shown above
(including subdirectories) to a convenient location on the appropriate machine.

Tip: To validate that the host in correctly configured with .NET Framework 4.5 or later, execute

FNMPDataExportUtility.exe /help
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A list of command-line options is displayed. If not, investigate the version of .NET installed.

7. Execute the following (on a single line):

FNMPDataExportUtility.exe

/Source "FNMP-DBConnectionString"

/Target "IntermediateDBConnectionString"

/Encrypt true

where:

Parameter Notes

FNMP-DBConnectionString The connection string (enclosed in double quotation marks) for the
export utility to connection with the compliance database for FlexNet
Manager Suite.
The Data Source value must be the fully-qualified domain name of the
database server. Where the compliance database is not in the default
instance on this server, add the instance name (separated by a slash).
An example connection string when the default name for the compliance
database is FNMSCompliance, is (all on one line):

Data Source=DBServer.example.com/myInstance;

Initial Catalog=FNMSCompliance;Integrated
Security=SSPI;

Connection Timeout=60;Min Pool Size=2;Max Pool Size=20;

IntermediateDB

ConnectionString

The connection string (enclosed in double quotation marks) for the
export utility to connection with the intermediate database you recently
created. An example connection string when this is on the same server
and instance as the compliance database, and the default name for the
intermediate database is IntermediateDB, is (all on one line):

Data Source=DBServer.example.com/myInstance;

Initial Catalog=IntermediateDB;Integrated Security=SSPI;

Connection Timeout=60;Min Pool Size=2;Max Pool Size=20;

/Encrypt Required field. When set to true the connection strings are encrypted
when they are saved into the configuration file for the export utility. Use
false when not encrypting the connection strings. (The configuration file
lives in the same folder as the executable, and is called
FNMPDataExportUtility.exe.config).

8. Configure where the export utility sends email notifications about any export errors.

a. From the same folder, open FNMPDataExportUtility.exe.config in a flat text (or XML) editor.

b. Locate the following section and replace the values shown:
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<appender name="SmtpAppender" type="log4net.Appender.SmtpAppender">

<to value="toaddress@somedomain.com"></to>

<from value="fromaddress@somedomain.com"></from>

<subject value=" Atrium Integration Adapter Error"></subject>

<smtpHost value="smtp.somedomain.com"></smtpHost>

where:

Value Notes

toaddress

@somedomain.com

Valid email address for the person who is to receive alerts when
errors occur during export.

fromaddress

@somedomain.com

Valid email address for an account known on the specified SMTP
host that is identified as the sender of the email when an error
occurs.

smtp.somedomain.com The fully qualified domain name of the SMTP email server.

c. While here, you may want to customize the location of the log file for the export utility:

<log4net>

<appender name="RollingFileAppender"

type="log4net.Appender.RollingFileAppender">

<file value="C:\Log.txt" />

d. Save the edited file, and exit the editor.

Reserving an Atrium Dataset
You must specify a dataset for information exchange, and ensure you have an account with write access to that
dataset.

This procedure sets up a data area within Atrium reserved for data exchange with the FlexNet Manager Suite
adapter. Your Atrium Administrator may assist with an account that had permissions to access this dataset. You
will reference this dataset later in the installation of the adapter.

To reserve the area in Atrium for data exchange:

1. In the BMC Remedy User application, open the CMDB console.

2. Select Reconciliation Manager > Create > Dataset.

A Dataset Information form appears.

3. Complete the following parameters:

Dataset name A friendly name for the dataset that you will recognize later in other listings.
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Dataset ID The system identifier for the dataset.

Tip: This value is needed when you configure your Atrium jobs.

Accessibility Use the drop-down list to set this to Writable.

DatasetType Use the drop-down list to set this to Regular.

4. Click Save.

The new dataset is created.

5. Consult with your Atrium Administrator about an account with write access to the created dataset. This
account must be used on the Atrium side to run the adapter.

For more information about creating the dataset, see  http://discovery.bmc.com/confluence/display/81/
Configuring+the+BMC+Atrium+Adapter.

Importing Atrium Jobs and Transforms
You need to get the supplied files into the Atrium repository, configured for your local connections.

For this procedure, you must be logged into your Atrium server with administrator privileges. This server needs
access to the unzipped archive for the adapter (in this procedure, shown as on the same server).

To import jobs and transforms to Atrium:

1. Open the Atrium Integrator Spoon tool.

2. Select File > Open URL..., navigate to and open C:\Program Files\Flexera\BMCAtriumAdapter\

FNMPExports\ ExportComputersTransform.ktr.

3. Modify the connection strings for each of:

• Atrium_CMDB

• AR Server

• IntermediateDB.

4. Click File > Save.

Repeat this procedure for each of the following files in the order listed:

1. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\ ExportProductsTransform.ktr

2. C:\Program Files\Flexera\BMCAtriumAdapter\
FNMPExports\ ExportComputerProductRelationshipsTransform.ktr

3. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\ ExportUpdateIntermediateDBTransform.ktr

4. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPImports\ Asset.ktr

5. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPImports\ ImportUpdateIntermediateDBTransform.ktr
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6. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\FNMPExports.kjb

7. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\ Execute FNMP Export Tool.kjb

8. C:\Program Files\Flexera\BMCAtriumAdapter\BMCAtriumAdapter.kjb

Configure Atrium Jobs
In Atrium, jobs must be linked to transforms.

You have completed the import of both tasks and jobs into the Atrium repository (as in Importing Atrium Jobs
and Transforms). Now configure the jobs, still logged into Atrium Spoon.

To configure the jobs in Atrium:

1. Select File > Open..., and select FNMPExports.kjb from the repository.

A map of the transformations required for the job is displayed.

2. Right-click ExportComputersTransform, and from the context menu select Edit job entry.

The Job entry details for this transformation dialog appears. The transform name as recorded in the job
entry appears in the first field, Name of job entry.

3. Select the Specify by name and directory option.

4. To provide a value in the associated field, browse the repository and select the transform name matching
the first field.
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For example, when processing the job entry for ExportComputersTransform, select the transform of the
same name from the repository.

5. Click OK.

6. Repeat steps 2-5 for each of the remaining job entries in this chart:

• ExportProductsTransform.ktr

• ExportComputerProductRelationshipsTransform.ktr

• ExportUpdateIntermediateDBTransform.ktr.

7. Select File > Save.

8. Select File > Open..., and select BMCAtriumAdapter.kjb from the repository.

A map of the job is displayed.

9. Repeat steps 2-5 for the transform in this chart:

• Asset.ktr.

10. Double-click the FNMPExports job.

The Executing a job dialog appears. The Job entry name appears as the first field.
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11. Select the Respository: specify by name option.

12. To provide a value in the associated field, browse the repository and select the job name matching the first
field.

13. Click OK.

14. Repeat steps 10-13 for the remaining job in this chart:

• Execute FNMP Export Tool.kjb.

15. Select File > Save.

16. Either press Ctrl-J; or right-click the BMCAtriumAdapter diagram background, and from the context
menu select Job settings.

The Job properties dialog opens.

17. Edit the following values:

COMPANYNAME Enter your company name as it is recorded in the CMDB. (A match is required.)
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DATASETID Enter the ID for the dataset that you created for the adapter (see Reserving an
Atrium Dataset).

18. Select File > Save.

19. To configure email alerts for errors occurring on the Atrium side of the adapter:

a. In the BMCAtriumAdapter job, right-click on the Mail step in the center.

b. From the option menu, select Edit job entry.

The Job mail details dialog appears.

c. In the Addresses tab, insert the following:

• Destination address - the person who is to receive the email alert for each error.

• Sender name - the value to appear on the emails as the sender.

• Sender address - The email address from which the email will appear to come. This must be a
valid email account known to the mail server (specified next).

d. Switch to the Server tab, and complete the SMTP Server details.

e. Click OK.

20. Select File > Save.
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Install the Business Importer and Link with
Remedy
The Business Importer performs parts of the integration work, writing data from Remedy into the FlexNet Manager
Suite database.

The Business Importer is installed as part of the Business Adapter Studio, a stand-alone environment you can
use to build business adapters. These 'adapt' the format of data from other business systems in your computer
estate for import into FlexNet Manager Suite, and are exercised by the Business Importer. You downloaded the
installer for the Business Adapter Studio in Obtaining the Adapter Components. To enable the business import
process, you also configure the reconciliation process to link with the Business Importer. Since the Atrium
Integrator must trigger the Business Importer, the normal architecture is to install the Business Adapter Studio
on the Atrium server. In this location, the business adapter for importing asset records must also be amended to
update its access to the compliance database.

To install the Business Importer and link with Remedy:

1. On the Atrium server, navigate to the downloaded archive, and extract the Business Adapter Studio

folder.

2. Execute Business Adapter Studio\setup.exe.

The installation wizard for Business Adapter Studio opens.

3. Complete the installation wizard using the default values it provides.

4. Use the Business Adapter Studio to update connection details for the asset business adapter for both
output and input:

a. On the Atrium server, launch the newly-installed Business Adapter Studio.

b. Do either of the following:

• Click the Open icon ( ) in the tool bar.

• From the File menu, click Open....

c. Navigate to the asset business adapter, by default located at C:\ProgramFiles\Flexera\
BMCAtriumAdapter\FNMPImports\FNMPImportDefinition\Asset.xml, and click Open.

d. In the navigation bar on the left, click the top-most node, labeled FlexNet Manager Platform

Database, to display the output connection properties for this adapter.

Tip: This node is visible only when the Business Adapter Studio is running on a server
other than an inventory beacon. (On an inventory beacon, the Business Adapter Studio

takes the connection details from the inventory beacon, which already has them recorded.)

e. In the Database Connection panel, select Use the specific connection information below, and
click the ellipsis (...) at the right-hand end of the Connection String field to expose the Data Link
Properties dialog.
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f. Edit the connection details so that they apply to your compliance database:

a. For step 1, enter the SQL Server instance name for your compliance database. Examples:

• IPv4 address: 198.51.100.123

• The database server hostname: MyFNMSServer

• A non-default database instance: 198.51.100.123\MSInst3

• Non-standard connection port: 198.51.100.123,5678

b. Supply the credentials for writing to the compliance database. If you are using an account
specific to your database server, choose Use a specific user name and password, and
complete the account name and password in the next two fields.

c. For Select the database on the server, use the drop-down to choose your compliance
database (the default name suggested during installation was FNMSCompliance).

d. Click Test Connection, and rejoice at success (or remedy any issues until the connection
succeeds).

g. Click OK to close the dialog.

h. In the left-hand navigation bar, click on the next row that names the adapter (Asset).

i. In the second panel, Connection and Query Properties, click the ellipsis (...) on the right end of the
Connection field to expose the relevant Data Link Properties dialog for the staging database.

j. In the Provider tab, select the database type (typically Microsoft OLE DB Provider for SQL

Server), and click Next.

k. In the same way as before, complete the details in the Connection tab, but this time for the staging
database, and validate your data with the Test Connection button.

l. Click OK to close the dialog, and save the updated adapter (Ctrl+S, or click the diskette icon in the
toolbar, or File > Save).

5. Log in to BMC Remedy Mid-Tier using an account name and password provided by your BMC
Administrator.

The IT Home page appears.

6. Click the Applications tab on the left boundary.
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The Applications menu expands.

7. Select Atrium Core, and in the sub-menu select Atrium Core Console.

The BMC Atrium Core Console window opens.

8. Click the Application Launcher tab on the left edge, then select Applications from the menu, and in the
sub-menu select Reconciliation.
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The Reconciliation tab opens.

9. Click the new job icon in the toolbar.

The Job Editor page appears.

10. In the Name field, provide a name for this job that you will recognize later.
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Suggested value: FNMP Asset Reconciliation.

11. In the Activities group, click New.

The Activities group changes to the Edit Activity area.

12. Complete the details for the first (Identify) activity:

a. In the Name field, provide a name you will recognize later.

Suggested value: Identify.

b. Ensure that the Continue on Error check box is clear.

Recall that the system is configured to send emails on any errors in exporting the assets to FlexNet
Manager Suite.

c. Set the Sequence number to control ordering of activities in the job.

Recommendation: Number in hundreds to allow for later changes. Suggested value: 500.

d. In the Dataset Configuration area, click the first icon to add a new dataset, and select the one you
created for this exchange.

The suggested value was BMC.FNMS.

e. Click Done to save details of this activity.

The Activities group reappears, showing this first activity in the list.

13. Once again, in the Activities group, click New, and complete the details for a merge activity:
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a. Add a Name for the activity.

Suggested value: Merge.

b. Ensure that the Continue on Error check box is clear.

c. Set the Sequence number to a value higher than the identification step.

Suggested value: 600.

d. From the list of Source Datasets, select only the one identified in the previous activity.

The suggested value was BMC.FNMS.

e. From the list under Target Dataset, select the BMC Asset dataset.

f. In the Precedence group, click the + icon to add a new Precedence Association Set.

Suggested value: BMC.FNMS,BMC Asset.

g. Click Done to save details of this activity.

The Activities group reappears, showing your two activities.
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14. In the Schedule group, click New.

Set the values to suit your business processes, with a suggested frequency being once every 2-4 weeks.

15. At the bottom of the Job Editor, click Save to store your job details in the repository.

Tuning Creation of Configuration Items
Atrium requires an initial run to populate the database, and then customization for regular scheduled operations.

In the first run of the adapter, all the products and computers exported from FlexNet Manager Suite are inserted
as configuration items in the CMDB. Thereafter, matching records should be updated, and only new items
inserted. We therefore run the first pass with the default settings, and then modify the settings to schedule the
regular data exchange.

To configure the creation process for configuration items:

1. In BMC Atrium Integrator console, from the list of Jobs on the left, choose the BMCAtriumAdapter job.

2. In the toolbar, click the third icon (with the play button) to run the selected job once.
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As there may be a large backlog of data to handle, and Spoon processes a line at a time, the first import
can be quite time-consuming. Wait for the first import to complete successfully before continuing with
this procedure.

3. In Atrium Integrator, update the way Atrium receives the export of computers as follows:

a. Open the ExportComputersTransform transformation from the repository.

b. Double-click the CMDBoutput step to expose its properties.

c. Clear (turn off) the Always Insert CIs check box.

d. Select (turn on) the Only insert new CIs check box.

e. Click OK to close the CMDBoutput step, and click Save to store the changes to the transform.

4. Update the processing of the export of products:

a. Open the ExportProductsTransform transformation from the repository.

b. Double-click the CMDBoutput step to expose its properties.

c. Clear (turn off) the Always Insert CIs check box.

d. Click OK to close the CMDBoutput step, and click Save to store the changes to the transform.

Scheduling the Adapter
The adapter to exchange data between FlexNet Manager Suite and BMC Atrium is driven by a schedule set up in
Atrium.

Continue this process in the Atrium Integrator console.

To configure the schedule for data exchange:

1. If you are not already in the Atrium Integrator console:
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a. Login to BMC Remedy Mid-Tier using user name and password provided by BMC Administrator.

b. Click the Applications tab on the left edge.

The Applications menu expands.

c. Select Atrium Integrator, and then click Atrium Integrator Console.

2. In the Jobs list on the left, select your BMCAtriumAdapter job.

3. In the tool bar, select the icon to manage the job schedule ( ).

4. Select Active.

5. Select the Create new schedule option.

The Schedules - "BMCAtriumAdapter" page appears.
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6. Complete the details for the regular operation of the adapter (this schedule controls data flow both ways,
for import and export):

a. Give the schedule a meaningful name in the top right corner (Enter Schedule Name).

b. Use the Start Time spinners to dial up the time of day to start operation of the adapter.

Tip: This is local time on the BMC Remedy AR System server.

c. In the Recurrence Type area, specify how frequently you want the job to run.

Recommendation: The process is quite time-consuming. In a stable environment, consider a
monthly data exchange (Interval Based).

d. Depending on your choice, complete the Recurrence Details.

e. Click Save.

The integration between FlexNet Manager Suite and BMC Atrium is now operational.
However, before the next scheduled run, you should consider any further customization that may be necessary,
especially in relation to large data sets.

Verifying Data Export to BMC Atrium
This process confirms that data has been exported from FlexNet Manager Suite and successfully imported by
Atrium.

This procedure uses the Atrium Core application (not Atrium Integrator).

To verify successful data transfer into Atrium:

1. If you are not already in the Atrium Core console:

a. Login to BMC Remedy Mid-Tier using user name and password provided by BMC Administrator.
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b. Click the Applications tab on the left edge.

The Applications menu expands.

c. Select Atrium Core, and then click Atrium Core Console.

A new window opens with the Application Launcher tab on the left edge.

2. Click the Application Launcher tab, and in the fly-out menu, click Applications.

3. In the sub-menu, click Explorer.

The Explorer tab opens, with multiple accordion folds. Ensure that the Find fold is open.

4. In the Find area, use the drop-down list on the left below the tool icons to select the BMC.FNMS dataset.

5. Optionally choose an object type to search for, or expand the Quick search of all CIs.

6. Optionally, add data (or partial values) to the Name and Short Description fields (and controls for
matching) to narrow the search for particular configuration items, or leave the fields blank for a full listing
of all results.
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7. Click Search.

A list of results (shown inset) is displayed. Validate that the data is as expected.
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3
Additional Customization of the

Adapter

The following notes help with minor changes to configuration, especially for future changes to configuration. The
one case that may be critical to your initial implementation is the first topic, covering preparations for large
datasets.

Preparing for Large Datasets
Large numbers of data records require a customized environment variable.

If your integration between FlexNet Manager Suite and BMC Atrium will exchange large numbers of records (for
example, 100,000 computer records or more), you need to configure an environment variable on the Atrium
server.

To prepare for large datasets:

1. Ensuring that you are logged onto the Atrium server with Administrator privileges, open the Windows start
menu, and right-click Computer.

2. From the context menu, select Properties.

The Control Panel page of system properties appears.

3. In the navigation bar, select Advanced system settings.

The System Properties dialog appears. Confirm that the Advanced tab is selected.

4. Click Environment Variables....

The Environment Variables dialog appears.

5. In the System Variables (lower) group, click New....

The New System Variable dialog appears.

6. Insert the Variable name:

Additional Customization of the Adapter

134 FlexNet Manager Suite Adapters Reference | Company Confidential



_JAVA_OPTIONS

7. Insert the Variable value:

-Xms512m -Xmx15360m

This configures the Java heap size above 15GB.

8. Click OK three times to close the various dialogs, and you can close the Control Panel window.

Updating Connection Details
When system passwords change, you need to update the adapter's configuration file.

Connection details are stored, encrypted, in the adapter's configuration file (by default located at C:\Program
Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\ FNMPDataExportUtility.exe.config on
the Atrium server). The encryption process happens the first time the adapter runs after the configuration file is
edited. Once the process has run, the connection strings are unreadable and not editable, something similar to
the following:

<connectionStrings configProtectionProvider="DataProtectionConfigurationProvider">

<EncryptedData>

<CipherData>

<CipherValue>AQAAANCMnd8BFdERjHoAwE/Cl+sBAAAAeNhcGMAVK0uVGNTq

Og/WbQQAAAACAAAAAAADZgAAwAAAABAAAACTO9kpn6BptpLvsXExg1UBAAAAAASAAACgA

AAAEAAAAELCyiwz5AXZw9xZXfEPiAAAAgAAPJQYe+G9AfScFMJTYgA0NDbAgZdRA9nB91

DN42A1xjeCskUs9+KNjVU1PSFRV4ujta40evf3IOZy5odyHsIrJRCKOOGdhDb1wh4ISEk

pJk/QDna6LeCbbtXXsQK2LoAHQc/plz77UkQZxnxkL5ElPIGHl6AojEXT2F5NGjElJX6G

XbUXQDkNnDfi2o6XI/CDbX8gCuMonY1cTLYGe6+AQPpDgcY3rA02ZFOs7/Zb0cKOw7IoZ

dB6H8OIvrClSzqNkVBd3YfLhP/KOrkQFP8orqj54BJW74E1v3VUZnte1ESgLA5MYb/F9A

h3M5xi2Q6ITXOQmVRGESrivsdqr6nyGz5APx2yVBuEcoVhpOMYURbEbBSW+6/aydg8nY1

DrcMzkPlXiZ0CQs4yZYHSWt3+bFEN30xh6XKFH7Tpc8e5y9Tq1Bhwk+Kw6AFfZhcdewAp

J4ZkGAr4ixE6gNqWXnomk2puKNFImhJfqLLIuQx9T00Uu2bjJ9Y+dUlrcuov12hQXOCh9

nqOdmeIQHPXgw8//eHYOzwy2TgMcq2M2LxXRbQqCTeWtlP1ucJVyct9gnJlk2L3FSBNgM

u1C9mncR7MsGDBWoQMXnwC5+Y6P1GT45sPOedBQvIQITj7MCuzfgDD1R9c7w1gejTGmrl

3Kmf33tGPMRYPV7CPNET3DUV9AGQUAAAAaIEkjyqfExrbeiYJvG2usqYO3Nk=</CipherValue>

</CipherData>

</EncryptedData>

</connectionStrings>

To replace connection strings and/or passwords:

1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C:\Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config

2. Locate the connectionStrings element (similar to that shown above), select it all, and delete it.
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3. Copy the following example, paste into the same place in the configuration file, and replace the
placeholder values (including their containing brackets) as described below (you may also remove the
white space from the connection strings):

<connectionStrings>

<clear />

<add name="FNMPDBConnection"

connectionString="Data Source=[FNMPDBServerName];

Initial Catalog=FNMSCompliance;
User ID=[accountName1];Password=[somePassword];

Integrated Security=false;

Connection Timeout=60;"/>

<add name="IntermediateDBConn"

connectionString="Data Source=[intermediateDBServerName];

Initial Catalog=IntermediateDB;

User ID=[accountName2];

Password=[anotherPassword];

Integrated Security=false;

Connection Timeout=60;"/>

</connectionStrings>

where:

Placeholder Notes

[FNMPDBServerName] The database server (and optionally, the database instance name) containing
the FlexNet Manager Suite compliance database. You may use:

• A dot (.) when the database is installed on the same server where the

adapter executable runs

• The flat name of the server

• The IP address of the server

• Where the database instance is not the default instance on that server,
any of the above with a slash (/) separator, and the database instance

name.

FNMSCompliance This is the recommended database name for the compliance database. If
you used a different name, substitute the name you used.

[accountName1] The user name that the executable uses to connect to the compliance
database.

[somePassword] The (newly current) password for the above account.

[intermediate

DBServerName]

The database server (and if necessary, instance) for the intermediate
database. The same formats are supported as described above for
[FNMPDBServerName].
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Placeholder Notes

[accountName2] The user name that the executable uses to connect to the intermediate
database.

[anotherPassword] The password for [accountName2].

4. Save the edited configuration file.

The file is saved in plain text. The next time the adapter runs, this section of the configuration file is
automatically encrypted. If you are unhappy about leaving the file unencrypted until then, trigger an
additional run of the adapter by adding a one-time schedule (see Scheduling the Adapter).

Updating Email Details
The adapter sends emails as a heads-up when an error occurs.

With data flows in both directions between FlexNet Manager Suite and BMC Atrium, errors may occur in either
export or import. The emails for the two directions are defined separately:

• For export from FlexNet Manager Suite, the data export utility generates the emails, with settings in its
configuration file. If the details of your email server are changed, you need to update the adapter's
configuration file. It also defines who receives the alerts, and the address from which alerts originate. You can
modify any of those detail with this procedure.

• Similarly, for imports from BMC, the email is generated by Atrium based on settings in that system. Those
settings are also summarized in this procedure, since it is likely that a change in your infrastructure or
personnel affects both kinds of email alerts equally.

We start with emails for exports from FlexNet Manager Suite; and then continue with those for imports to the
same system (that is, data is exported from BMC Atrium).

To update email details:

1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C:\Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config

2. Locate the <appender> element for the SmtpAppender node in the file and update the settings marked
here with placeholders:

<appender name="SmtpAppender" type="log4net.Appender.SmtpAppender">

<to value="toaddress@somedomain.com"></to>

<from value="fromaddress@somedomain.com"></from>

<subject value=" Atrium Integration Adapter Error"></subject>

<smtpHost value="smtp.somedomain.com"></smtpHost>

where:
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Value Notes

toaddress

@somedomain.com

Valid email address for the person who is to receive alerts when errors
occur during export.

fromaddress

@somedomain.com

Valid email address for an account known on the specified SMTP host
that is identified as the sender of the email when an error occurs.

smtp.somedomain.com The fully qualified domain name of the SMTP email server.

3. Save the edited file.

4. Open the Atrium Integrator Spoon tool.

5. Select File > Open..., and select BMCAtriumAdapter.kjb from the repository.

A map of the job is displayed.

6. To configure email alerts for errors occurring on the Atrium side of the adapter:

a. In the BMCAtriumAdapter job, right-click on the Mail step in the center.

b. From the option menu, select Edit job entry.

The Job mail details dialog appears.
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c. In the Addresses tab, insert the following:

• Destination address - the person who is to receive the email alert for each error.

• Sender name - the value to appear on the emails as the sender.

• Sender address - The email address from which the email will appear to come. This must be a
valid email account known to the mail server (specified next).

d. Switch to the Server tab, and complete the SMTP Server details.

e. Click OK.

The revised email settings for data transfer in both directions take effect for the next run of the adapter.

Turning Off Email Alerts for Export Errors
You can disable email alerts for problems arising during export from FlexNet Manager Suite.

This procedure provides a quick way to temporarily disable emails sent by the data utility during data export
from FlexNet Manager Suite for transfer to BMC Atrium. This procedure turns the emails off without removing
the settings details.

Tip: For emails generated by BMC Atrium about data preparation for import to FlexNet Manager Suite, there
is no single "off switch". To stop those emails, re-do the settings to remove the email details (as described in
Updating Email Details).

To turn off email alerts:

1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C:\Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config
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2. Locate the following section (towards the end of the configuration file):

<root>

<level value="ALL" />

<appender-ref ref="RollingFileAppender" />

<appender-ref ref="SmtpAppender" />

</root>

3. Comment out the appender-ref element for the SmtpAppender:

XML comments are surrounded by <!-- -->:

<root>

<level value="ALL" />

<appender-ref ref="RollingFileAppender" />

<!-- appender-ref ref="SmtpAppender" / -->

</root>

4. Save the amended file.

Email alerts for export errors are suspended until you reverse this process, re-editing the file to remove the
comment tags and restored the original value.

Changing the Log File
You can rename or relocate the log file generated by the adapter for exports from FlexNet Manager Suite.

By default, five copies of the log file, each capped at 10MB, rotate in the nominated folder (total disk space
requirement is therefore about 50MB for logging). You can customize the location and base name of the log file
as follows:

To rename or relocate the log files:

1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C:\Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config

2. Locate the following section in the file:

<appender name="RollingFileAppender"

type="log4net.Appender.RollingFileAppender">

<file value="C:\Program Files\Flexera\BMC Atrium Adapter\Log.txt" />

...

</appender>

3. Edit the value attribute with the new path and file name.

Tip: Keep in mind that the file name will be expanded with dating information to differentiate the
various logs.
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4. Save the modified file.
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4
Appendices

The following topics provide data mapping between attributes recorded in the FlexNet Manager Suite database
and those recorded in the BMC Atrium CMDB. In addition, some values are generated as part of the export and
import processes, and are included in the following listings.

Two separate data objects are exported from FlexNet Manager Suite: Computers, and Products. A much smaller
dataset is imported from Atrium into FlexNet Manager Suite, updating information about assets to show their
role and owner.

Appendix 1: Export of Computers
For optimal performance, exports are differential (that is, only data changed since the last export is included).
The following table shows:

• Columns from the ComplianceComputers table (and related tables) in FlexNet Manager Suite that are

exported

• The equivalent column name in the ComputerSystemChanges table of the intermediate database (in case you

wish to inspect the dataset there)

• The matching column in the BMC_ComputerSystem table in the Atrium CMDB.

Note:

1. Some values are not read from the source database, but inserted as fixed values. These are shown in
double quotation marks, and explained in the associated comments.

2. Some values exported from FlexNet Manager Suite to the intermediate database are not transferred to
BMC Atrium. Instead, they are used to manage the exported data, removing records not relevant to the
CMDB and so on.
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Compliance

Computer

ComputerSystem

Changes

BMC_

ComputerSystem

Comments

Not applicable. GeneratedTokenID TokenID TokenID takes different formats for
different types of computers. In the
following examples, the placeholder X
represents any hexadecimal digit (0-9,
A-F).

• For physical hosts and computers,
the TokenID is

hostname:DNSdomainName.

• For some virtual machines, TokenID

takes the form of a prefix, a colon,
and a UUID:

◦ For VMware, VI-

UUID:XXXX-XX-XX-XX-XXXXXX

◦ For Hyper-V, HYPERV-

ID:XXXX-XX-XX-XX-XXXXXX

Note: With Hyper-V, the
UUID is only available on the
physical machine, so TokenId

is only set for virtual machines
that have been successfully
linked to their hosting physical
machines.

◦ For Xen (including Oracle VM),
XEN-ID:XXXX-XX-XX-XX-XXXXXX

◦ For KVM (including RedHat
Enterprise Virtualization), KVM-

ID:XXXX-XX-XX-XX-XXXXXX.

TokenID is generated dynamically,
checking the value in ComputerType.
For virtual machines, the value in
ComputerToVirtualMachine_

VMTypeID is used to determine the
prefix, and the UUID is attached from
ComputerToVirtualMachine_UUID.
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Compliance

Computer

ComputerSystem

Changes

BMC_

ComputerSystem

Comments

Compliance

ComputerID

ComputerID CITag The identifier for the computer in the
FlexNet Manager Suite database,
passed to BMC as the configuration
item tag. (This is passed back again if
Asset records are imported by FlexNet
Manager Suite.)

ComputerName ComputerName HostName The name of the computer, limited to
256 characters.

“DNS” Name Format A fixed string value determining the
data type for Name.

[ComplianceDomain]
QualifiedName

Domain Domain The fully qualified domain name for the
domain where this computer exists.
Extracted from
ComplianceDomain.QualifiedName

using ComplianceComputers.

ComplianceDomainID as a foreign key.
Used when there is no value for
FlatDomain received from FlexNet
Manager Suite.

[ComplianceDomain]
FlatName

FlatDomain Domain The unqualified name of the domain
containing the computer. Extracted
from ComplianceDomain.FlatName

using ComplianceComputers.

ComplianceDomainID as a foreign key.
Where this value is present, it is stored
in BMC_ComputerSystem.Domain; if
not, the qualified domain name is used
instead.
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Compliance

Computer

ComputerSystem

Changes

BMC_

ComputerSystem

Comments

[Compliance
ComputerStatus]
DefaultValue

ComputerStatus (Not stored.) The current status of this computer
within the inventory records. Values
include:

• New (this is the first appearance of

this computer in inventory)

• Ignored (an operator has marked

this computer to be ignored)

• Registered (this inventory record is

linked to an asset record)

• Awaiting Inventory (a dummy

computer record, allowing its
associated asset record to exist,
which will be removed when an
operator links the asset record to a
real inventory item)

• Discarded.

These values are extracted from
ComplianceComputerStatus.

DefaultValue based on the foreign
key ComplianceComputers.

ComplianceComputerStatusID.

Tip: The DefaultValue is the US
English representation of the values,
not localized.

The status is used to make sure that
computers that are Awaiting

Inventory, Discarded, or Ignored
are not transferred to BMC Atrium.

Not applicable. "Workstation" CapabilityList

Primary

Capability

Fixed literal string inserted in the BMC
database.
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Compliance

Computer

ComputerSystem

Changes

BMC_

ComputerSystem

Comments

[Compliance
ComputerType]
DefaultValue

ComputerType isVirtual The boolean isVirtual is set true
whenever the ComputerType in the
intermediate database is either VMHost
or Virtual Machine. Possible values
are extracted from
ComplianceComputerType.

DefaultValue based on the foreign
key ComplianceComputers.

ComplianceComputerTypeID .

InventoryDate InventoryDate (Not stored.) The date inventory was last collected
from this computer.

Manufacturer Manufacturer ManufacturerName Values from FlexNet Manager Suite are
provided to avoid data normalization
by the CMDB that may modify names.

SerialNo SerialNo SerialNumber The serial number of the computer.

[VirtualMachine]
Compliance

ComputerID

ComputerTo

VirtualMachine_

Compliance

ComputerID

(Not stored.) Populated only for virtual machines. A
foreign key that links records in the
VirtualMachine table to the matching
records in the ComputerCompliance

table. Used here in the calculation of
TokenID.

[VirtualMachine]
UUID

ComputerTo

VirtualMachine_

UUID

(Not stored.) Populated only for virtual machines.
The UUID (Universally Unique
Identifier) of the virtual machine. Used
to match virtual machine properties to
their associated
ComplianceComputer. Used here in
the calculation of TokenID for virtual
machines.
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Compliance

Computer

ComputerSystem

Changes

BMC_

ComputerSystem

Comments

[VirtualMachine]
VMTypeID

ComputerToVirtual

Machine_ VMTypeID

(Not stored.) Populated only for virtual machines. A
foreign key to the VMType table, which
identifies the kind of virtual machine,
including:

• VMware

• Hyper-V

• LPAR

• WPAR

• nPar

• vPar

• SRP

• Zone

• Unknown.

Used here in the calculation of
TokenID.

Not applicable. UpdatedDate (Not stored.) Used when identifying changed data
for differential exports to BMC Atrium.

Compliance

Computer TypeID

Compliance

Computer TypeID

(Not stored.) This value is used to filter out remote
devices (those from which inventory
cannot be collected) and VDI
templates, which are not relevant to
the CMDB.

Not applicable. ViewID (Not stored.) Deprecated and not in use.

Not applicable. TenantID (Ignored.) Always contains a zero value (a string
of 16 zeroes) for an on-premises
implementation.

Not applicable. “BMC_
COMPUTERSYSTEM”

ClassID Fixed literal string inserted in these
records to identify the data class in the
data set.

Not applicable. "CompanyName" Company A fixed value that must match the
company identifier embedded in the
Atrium CMDB.

Not applicable. "DataSetID" DataSetID Value attached to the dataset
considered. Must match the value
embedded in the Atrium CMDB.
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Appendix 2: Export of Applications/
Products
The term 'product' is used in two slightly different ways in FlexNet Manager Suite and BMC Atrium.

• In FlexNet Manager Suite, the base unit of software is called an "application", which is specific to a particular
release (version) and edition. A 'product' is the same software unit, but across multiple versions (and perhaps
editions as well). In our terms, then, FlexNet Manager Suite exports application records. To confuse things
further, the underlying database table is called SoftwareTitle.

• In Atrium, a "product" is the base unit of software, and related to an individual installation. The CMDB also
offers a catalog of the products available for installation. In BMC terminology, Atrium imports product
records, from which the Product Catalog may also be updated.

The following table shows:

• Columns from the SoftwareTitle table (and related tables) in FlexNet Manager Suite that are exported

• The equivalent column name in the ProductChanges table of the intermediate database (in case you wish to

inspect the dataset there)

• The matching column in the BMC_Product in the Atrium CMDB. This indirectly populates the Product Catalog.

Note:

1. Some values are not read from the source database, but inserted as fixed values. These are shown in
double quotation marks, and explained in the associated comments.

2. Some values exported from FlexNet Manager Suite to the intermediate database are not transferred to
BMC Atrium. Instead, they are used to manage the exported data, removing records not relevant to the
CMDB and so on.

SoftwareTitle ProductChanges BMC_Product Comments

Not applicable. GeneratedTokenID ParentCITag The token ID generated for the
computer system on which this
product is installed is assigned to
the ParentCITag column in BMC.
For details about the generated
TokenID, see Appendix 1: Export
of Computers.

SoftwareTitleID ApplicationID (Not stored.) Used internally in data
management.
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SoftwareTitle ProductChanges BMC_Product Comments

FullName ApplicationName ShortDescription By default, the full name of the
application is the concatenation
of the product, version, and
edition fields (for example,
“Microsoft Office Professional
2010”). However, an operator may
overwrite this with any preferred
value.

[SoftwareTitle
Version]
VersionName

ApplicationVersion MarketVersion The marketing version number
(such as "2010"). Extracted from
SoftwareTitleVersion.

VersionName using
SoftwareTitle.

SoftwareTitleVersionID as a
foreign key.

(Generated ID) FlexeraID TokenID FlexeraID is a unique identifier
for application records used for
unambiguous identification across
various Flexera solutions. The
format is either:

• For applications published in
the FlexNet ARL, arl://MGS-

APP-00000000000 (where the

11-digit number varies by
application)

• For applications defined locally,
app://serverGUID/LOCAL-

APP-SoftwareTitleID (where

serverGUID depends on the

identity of the central
application server, and
SoftwareTitleID is the value

of SoftwareTitleID assigned

to this application).

The result is presented as the
TokenID in the BMC_Product

table, and as SignatureID in the
Product Catalog.
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SoftwareTitle ProductChanges BMC_Product Comments

[SoftwareTitle
Publisher]
PublisherName

Publisher ManufacturerName Identifies the company that
produces the application/product
(for example, “Microsoft”).
Extracted from
SoftwareTitlePublisher.

PublisherName via
SoftwareTitleProduct.

SoftwareTitlePublisherID,
using SoftwareTitle.

SoftwareTitleProductID as a
foreign key.

[Compliance
Computer]
ComputerName

ApplicationTo

Installation_

ComputerName

SystemName Name of the computing device
reported in inventory (such as
“vincent-ltp”). Extracted from
ComplianceComputer.

ComputerName using the foreign
key InstalledSoftware.

ComplianceComputerID. The view
InstalledSoftware is itself
linked to the application by the
foreign key SoftwareTitleID.

ComputerID InstallationTo

Computer_

ComputerID

(Not stored.) The computer identifier, extracted
in much the same way as
described for ComputerName. Used
internally for data management.

[Compliance
Connection]
LastImportDate

InstallationTo

Computer_

InventoryDate

(Not stored.) The date of the most recent
inventory collection that recorded
the installation of this application
on the current computer. When no
other value is available, this
defaults to the date of data export
from FlexNet Manager Suite. Used
internally for data management.
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SoftwareTitle ProductChanges BMC_Product Comments

CategoryID InstallationTo

Application_

Category

Category First level of application
categorization.
The full path of categorization is
extracted from the GroupEx table
using SoftwareTitle.

CategoryID as the foreign key.
The full path is then broken up on
its / separators, and the first level
is passed to Category in the
BMC_Product table.

CategoryID InstallationTo

Application_

Category

Type Second level of application
categorization. (See Category for
details.)

CategoryID InstallationTo

Application_

Category

Item Third level of application
categorization. (See Category for
details.)

Not applicable. ViewID (Not stored.) Deprecated and not in use.

TenantID (Ignored.) Always contains a zero value (a
string of 16 zeroes) for an on-
premises implementation.

Not applicable. EvidenceVersion Deprecated and not in use.

Not applicable. “BMC_PRODUCT” ClassID A string literal that identifies the
class in the BMC dataset.

Not applicable. "CompanyName" Company A fixed value that must match the
company identifier embedded in
the Atrium CMDB.

Not applicable. "DataSetID" DataSetID Value attached to the dataset
considered. Must match the value
embedded in the Atrium CMDB.

Not applicable. FullName:VersionName Name Full name separated by a colon
from the market version of the
software product (for example,
“Microsoft Office
Professional:2010”).

Not applicable. “ProductName:
Version“

NameFormat A string literal describing the
format of the Name attribute.
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SoftwareTitle ProductChanges BMC_Product Comments

Not applicable. FullName on
ComputerName

Description Composite of the software name
and device name (such as
“Microsoft Office Professional
2010 on vincent-ltp”).

Not applicable. “Deployed” Status A fixed value, since the records are
extracted from the installed
software listings.

Not applicable. Calculated value MarkAsDeleted Boolean (0 = no, 1 = yes). Whether
or not this product has been
deleted from the computer system
under consideration. Note that this
flag is raised only for the first
import after the product is
deleted; thereafter, further imports
do not contain this row.

Appendix 3: Import of Assets
The following table shows:

• Columns from the BMC_ComputerSystem view (and AST:ComputerSystem form) in Atrium CMDB that are

exported

• The equivalent column name in the Assets table of the intermediate database (in case you wish to inspect

the dataset there)

• The matching columns in the FlexNet Manager Suite database where this information is imported.

BMC_ComputerSystem Assets ComplianceComputer Comments

Reconciliation

Identity

Reconciliation

Identity

Not stored. Used internally to link the
BMC_ComputerSystem view and
AST:ComputerSystem form.
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BMC_ComputerSystem Assets ComplianceComputer Comments

Domain DOMAIN [ComplianceDomain]
QualifiedName and
FlatName

The domain extracted from BMC
Atrium is processed to provide a
dot-separated qualified name in
the form flexerasoftware.com.
The same value is processed again
to provide a flat domain name
(such as flexerasoftware).
Where these values match existing
entries in the ComplianceDomain

table, no further action is taken
with them (other than to return the
ComplianceDomainID key); but
where they are not already known,
they are added to this table for use
in FlexNet Manager Suite.
As well, the ComplianceDomainID

value returned form this update is
then written into the
ComplianceComputer record,
which may update the domain for
the current computer.

HostName HostName ComputerName The name of this computer. Based
on a matching
ComplianceComputerID, this value
may be over-written with the value
imported from Atrium.

CITag CITag Compliance

ComputerID

The identity for the computer
record. Where this matches an
existing record, its other columns
may be updated. Otherwise, a new
record is created for
ComplianceComputer in FlexNet
Manager Suite.

InstanceId Not stored. Deprecated and not in use.

ImportLog table LastImportDate Not stored. Calculated from data in the
ImportLog table.
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BMC_ComputerSystem Assets ComplianceComputer Comments

[AST:
ComputerSystem]
System Role

System Role Custom property Role

in the Details tab
(User group) of the
inventoried computer
properties.

Both systems record roles for
servers, but the FlexNet Manager
Suite role has various licensing
implications, and so is not updated
by imports from Atrium. Instead, a
read-only custom field is added to
FlexNet Manager Suite to accept
the asset role for each
BMC_ComputerSystem. The role is
displayed in the Details tab of the
computer properties. Values
include:

• Lab

• Development

• SIT

• UAT

• Training

• Performance

• Contingency

• Production.

[AST:
ComputerSystem]
Reconciliation

Identity

Reconciliation

Identity

Not stored. Used internally to link the
BMC_ComputerSystem view and
AST:ComputerSystem form.

[AST:
ComputerSystem]
Assigned To

Assigned To AssignedUserID The ID associated with
ComplianceUser.UserName,
written here to link the
ComplianceComputer to the user
record.

Modified Date Not stored. Deprecated and not in use.
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BMC_ComputerSystem Assets ComplianceComputer Comments

[AST:
ComputerSystem]
Owner_name

Owner_name [ComplianceUser]
UserName

The full name of the user assigned
to this computer. FlexNet Manager
Suite defaults to a concatenation of
title, first name, middle name, last
name and suffix, so any of these
parts may be present, based on the
record in BMC Atrium. Where this
matches an existing user record, no
further action is taken with it;
otherwise a new user record is
created. In either case, the ID for
this user is returned, and written
into the AssignedUserID column.

Tip: Beware of small changes
in record data from Atrium
causing near-duplicate records
to represent the same person.
Also note that when new
records are created, you may
wish to update additional
details about this person in
FlexNet Manager Suite.

[AST:
ComputerSystem]
AssetLifecycle

Status

AssetLifecycle

Status

Compliance

Computer StatusID

A translation of the BMC Atrium
status values into the nearest
equivalent status value supported
in FlexNet Manager Suite. This is
then mapped by the Business
Importer into the correct ID for the
status value before being written
into the ComplianceComputer

record.

[AST:
ComputerSystem] DNS
Host Name

DNS Host Name Not stored. Host name from the
BMC_ComputerSystem is used in
preference to this one.

[AST:
ComputerSystem]
Domain

Domain_1 Not stored. Domain from the
BMC_ComputerSystem is used in
preference to this one.

[AST:
ComputerSystem]
Instance Id

Instance Id Not stored. Used internally.
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BMC_ComputerSystem Assets ComplianceComputer Comments

[AST:
ComputerSystem]
Data Set Id

Data Set Id Not stored. Used internally.
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IV
Using the HPE Universal Discovery

Adapter

You can use the HPE Universal Discovery (HPE-UD) adapter tool to collect and import inventory data from HPE
Universal Discovery System to FlexNet Manager Suite. The HPE-UD adapter fetches all hardware, software, and
virtualization information from the HPE-UD system and stores it in the compliance database maintained by
FlexNet Manager Suite. The HPE-UD adapter support is available only with FlexNet Manager Suite version 2015
and later.

Note: The HPE-UD adaptor tool works only with version 10.10 and 10.11 of the HPE Universal Discovery
System. These versions do not support Solaris 11 zones, for which reason the HPE-UD adapter cannot import
these zones. Since host serial number and zone name are used for rationalizing duplicate inventory records
across different inventory sources, this may mean that a device imported through the HPE-UD adapter cannot be
merged with another record of the same device imported through another inventory source that supports zones
information.
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1
Selecting a Configuration

This chapter gives an overview of the architecture, working, and configuration of the HPE-UD adapter. Choose
the appropriate configuration for your enterprise before you implement the adapter.

Architecture and Working of the HPE
Universal Discovery Adapter
The HPE-UD adapter architecture has the following main components:

• HPE-UD Server: This server has the HPUD uCMDB database and HPE discovery tools installed on it. The HPUD

uCMDB database stores the HPE-UD inventory details.

• Staging Server: This server contains the Flexera HPuCMDBStage.exe tool and a staging database. The

HPuCMDBStage.exe tool retrieves topology maps by executing TQL queries on HPUD uCMDB. The retrieved

topology maps are stored in a staging database (uCMDB_Staging) present on the staging server. The query

execution is performed using the web service interface of HPUD uCMDB.

• FlexNet Manager Suite: The Compliance Reader component residing on this server fetches data from the
staging database and loads it into the FlexNet Manager Suite database when you run an inventory import.

The following diagram shows the architecture and working of the HPE-UD adapter:

Figure 5: Architecture and working of the HPE-UD adapter

1. The HPuCMDBStage.exe tool extracts the inventory information through the web API of HPUD uCMDB. This
tool executes Topology Query Language (TQL) queries on the HPUD uCMDB database and retrieves
responses in the form of topology maps. With the default configuration, this tool stores the retrieved
topology maps directly into the staging database without storing them in XML files. However, you can
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configure this tool to write the retrieved topology maps to XML files and then write data from those XML
files to the staging database.

Note: One topology map is generated for each TQL query executed on HPUD uCMDB.

2. The Compliance Reader component of FlexNet Manager Suite collects data from the staging database.
When you run an inventory import on the FlexNet Manager Suite server, the data extracted from the
staging database is written to the compliance database on the application server

The Adapter Executable
HPE Universal Discovery (HPE-UD) adapter uses the ucmdb-api to obtain the version of the uCMDB instance. It
uses the UcmdbService web service API to retrieve the topology maps by executing TQL queries on the uCMDB

instance. You can retrieve the WSDL definition of the UcmdbService web service API from http://<uCMDB

Server>/axis2/services/UcmdbService?wsdl. The configuration of the staging tool includes the TQL
queries that will be executed on the HPUD uCMDB database. You don't have to import the TQL queries into the
HPUD uCMDB database and there is no need to deploy and maintain the TQL queries on every HPE-UD instance
of your enterprise.

Note: The URL to retrieve the WSDL definition of the UcmdbService web service API may use 'https' instead
of 'http'. It may also include a port number. Please check with your HPE-UD system administrator for more
details on the web service URL.

The tool to query the web API has the following two parts:

• HPuCMDBStage.exe — A console program capable of querying the UcmdbService API of HPE-UD and

writing the results into an SQL Server database, and optionally to XML files on the local file system. This
program supports command line arguments, available using HPuCMDBStage.exe -h. Here is the list of

available command line options.

-h                             This help

-x <settings file>           Settings file

-s <address or URL>          uCMDB server address or URL

-u <user name>               uCMDB export user name

-p <password>                uCMDB export user password

-c <connection string>       SQL Server staging database connection string

-m <staging method>          Set staging method (stage/staged/prestaged/stream)

-f <staging file path>       Set the staging file path

• FNMPuCMDBSettings.xml — The self-documenting configuration file for HPuCMDBStage.exe which contains

TQL queries executed against HPE-UD, and can include connection settings for HPE-UD and SQL Server.

In operation, the executable, HPuCMDBStage.exe, extracts the inventory data from HPE-UD and saves it for
further processing. The value of the method parameter determines how the data is saved. The method

parameter can have the following values:
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• Stage — This option enables you to save inventory data from HPE-UD to a series of XML files on the staging

server (HPE-UD to XML). The XML files are not imported into the staging database, but you can review the
extracted inventory data. This option also enables you to collect inventory data from the HPE-UD servers that
are not directly connected to the staging server. You can manually copy and upload the inventory XML files
to the staging server. Also see the Prestaged method below.

• Staged — This options enables you to write the data extracted from the HPE-UD servers to XML files and

then copy the information to the staging database (HPE-UD to XML/SQL) where it can be imported into
FlexNet Manager Suite for use in compliance calculations.

• Prestaged — This option takes information stored in XML files (from the Stage and Staged method) and

loads it into a staging SQL database (XML to SQL). Inventory is not gathered from HPE-UD in this mode.

• Stream — This option enables you to extract the inventory information from HPE-UD and load it into the

staging database directly, without storing it in XML files on the staging server (HPE-UD to SQL). You can
import these files to into FlexNet Manager Suite for use in compliance calculations.

You can set the default values for the method parameter and all other parameters in the
FNMPuCMDBSettings.xml file. The adapter tool uses the default parameter values when you use it without
other command-line options. The settings file is self-documented and the matching command-line options are
available using HPuCMDBStage.exe -h.

Files Created by the Staging Tool

The following files are created when the staging tool performs a read/write operation on the local disk of the
staging server. You can view the contents of the following files to review HPE-UD configuration item details that
have been extracted.

Filename Content

Computer.xml Details of computers and their properties.

Virtualization.xml Virtualization and partitioning details.

InstalledSoftware.xml Installed software evidence linked to each computer.
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2
Installation and Configuration

For on-premises implementations, the adapter XML files are included as a part of the FlexNet Manager Suite
installation. You need to download the staging tool, the configuration file, and the staging schema for this tool
from https://flexerasoftware.flexnetoperations.com, or from the Flexera Customer Community.

You need credentials supplied by Flexera to access this download. Details of the download are included in
Download Adapter Tools Archive.

• The HPE-UD adapter suits FlexNet Manager Suite releases 2015 and later for on-premises delivery.

• The build number for this adapter is 10.3.0.12006 (or higher). You can identify this number by right-clicking the
HPuCMDBStage.exe file in Windows Explorer, selecting Properties, and looking at the Details tab.

Save the zipped archive to a suitable temporary location, and unzip it.

Full details of setting up the HPE-UD adapter are included in this chapter. The following chapter (see HPE-UD
Adapter Operation) covers testing the completed installation and validating the results.

Download Adapter Tools Archive
The Adapter Tools archive includes content for many adapters, and is updated on the Flexera website from time to
time.

Start this procedure using a web browser on a computer that has good network accessibility from all the
machines needing installations for your adapter.

To download the adapter tools archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2018 R1.zip archive from the Flexera
Customer Community knowledge base:

a. Access https://flexeracommunity.force.com/customer/articles/en_US/INFO/Adapter-Tools-for-
FlexNet-Manager-Suite.

Tip: Access requires your Customer Community user name and password. If you do not have
one, use the link on the login page to request one.
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b. Click the link Adapter Tools for FlexNet Manager Suite.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet
Manager Suite 2018 R1.zip commences.

c. In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C:\Temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it
to the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.

Selecting a Staging Server
Multiple configuration options are there to configure the staging server. You can install the staging server on
any of the following types of computers:

• A dedicated stand-alone server or a virtual machine.

• Any other suitable machine in your enterprise, such as a print server.

• An inventory beacon.

• The central application server where FlexNet Manager Suite is installed.

The following are the requirements for a staging server:

• Microsoft Windows 2008 or later.

• Access to an instance of Microsoft SQL Server 2008 or later to host the staging database. You can implement
the staging database on the staging server or on a separate database server.

• Microsoft .NET 4.0 run time environment installed.

• Efficient network access to each HPE-UD server in your enterprise, using the HTTP or HTTPS protocols.

Creating the Staging Database Tables
Once your selected staging server is able to access the Microsoft SQL Server instance, you can use the provided
script to create the staging database and set up the appropriate database tables. You can achieve this through
SQL Server Management Studio, or from the command line as described in the following procedure.

To create the staging database from the command line:

1. Download and install the Adapter Tools archive. For more information, see Download Adapter Tools
Archive.

2. Navigate through the unzipped archive to Adapter Tools > HP Universal Discovery Tools > SQL.
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3. If necessary, copy the script uCMDB_staging.sql from the SQL\ folder of your unzipped adapter archive to
a temporary folder on your staging server.

4. Open a command prompt on the staging server.

5. In the command prompt window, execute the following command, as amended:

sqlcmd -S ServerName\InstanceName -i TemporaryPath\uCMDB_staging.sql

where:

• The database uCMDB_staging is created with all necessary tables, indices, and so on.

• ServerName is the name of the server hosting the SQL Server 2008 or later. You can install the

database on the staging server or on any remote server. You can use the name of the staging server or
its IP address, or a “.” (dot) if you are running the staging script on the same server as the database

instance.

• InstanceName is the name of the database instance to use for the database staging tables. You can

omit this parameter if the default instance name is being used.

• TemporaryPath is the location where you saved the SQL procedure.

Example:

sqlcmd -S 192.100.0.20\Development -i C:\temp\uCMDB_staging.sql

The staging database is now ready for operation.

Configuring HPE Universal Discovery
System
You must configure the HPE-UD adapter settings to include a user which can perform the Run Legacy API and
the Run Query by Definition actions on the HPE-UD system.

To create and configure a user in HPE-UD:

1. In the HPE-UD interface, click Security, Roles Manager.

2. Create a new role for FlexNet Manager import.

3. Select the role that you just created and click General Actions and assign the Run Query By Definition and
the Run Legacy API actions to this role.

4. In the HPE-UD interface, click Security, Users and Groups.

5. Create a new user for FlexNet Manager import.

6. Click the Roles tab and assign the role that you created in Step 2 to this user.

7. Click the Permissions Overview tab and review the assigned permissions for this role.
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8. Click Data Flow Management, Universal Discovery, Zone-Based Discovery and expand the Mapping
Options section in Preferences.

9. Check the Raw OS Installed Software and set the Include option to name=.*. This enables HPE-UD
adapter to capture all raw installation evidence.

You have created and configured an HPE-UD user for use in the HPE-UD staging tool. You must add this user to
the FNMPuCMDBSettings.xml file.

Installing and Configuring the Staging Tool
This procedure includes many separate sub-processes to complete the setup of the HPE-UD adapter.

To install and configure the HPE-UD adapter:

1. Ensure that the account under which the adapter executable will run has read/write/execute permissions on
this uCMDB_staging database. Authentication may be through Windows authentication or SQL Server
authentication. Using Windows authentication, the default account is the username running the
HPuCMDBStage.exe adapter. The username and password for SQL Server authentication are specified in
the database connection string, which you may supply in FNMPuCMDBSettings.xml, or override with the -

c option on the command line.

2. To extract information from the HPE-UD system, the HPuCMDBStage.exe tool must have the required
permissions to query the HPE-UD system. You must create a user in the HPE-UD system and assign it with
permission to perform the Run Legacy API and the Run Query by Definition actions. You must specify this
user in the FNMPuCMDBSettings.xml file. For more information on configuring the HPE-UD system, see
Configuring HPE Universal Discovery System.

3. Navigate to the fixed location on the inventory beacon where the inventory reader must find configuration
files to control its uploads. Verify the existence of the following path: C:\ProgramData\Flexera
Software\Compliance\ImportProcedures\Inventory\Reader\HP Universal Discovery.

4. Create a folder to contain the adapter executable and its configuration file. Location is not critical; a
suggested path is under C:\Program Files\Flexera Software (for version 2015 and later, or for a
stand-alone server that is not an inventory beacon or application server). In your chosen location, create a
folder such as HPUDAdapter.

5. From the HPuCMDBStage\ folder within your unzipped archive, copy both HPuCMDBStage.exe and
FNMPuCMDBSettings.xml to your newly created folder (such as C:\Program Files\Flexera Software\
HPUDAdapter).

6. Open your copy of FNMPuCMDBSettings.xml in a text editor of choice, and review the self-documenting
comments within that file. Modify the following values as required. Ensure that you specify the IP address
of your HPE-UD server. You can use the command line options to configure HPuCMDBStage.exe. Use the '-
h' option to get the list of available options.

• Update values in the first element describing the downstream connection to the HPE-UD server,
including the IP address, port, the account name and password for access. Keep a record of the account
name and password for registering with HPE-UD. The default values are:
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<server protocol="http" address="10.200.20.138"

port="8080" username="exportuser" password="Pa$$w0rd" timeout="3600"/>

Tip: If you do not wish to record the password in the plain text configuration file, you can use a script
to retrieve the password from an encrypted store, and supply it as a command-line option when
starting the HPuCMDBStage.exe tool. Here is an example:

HPuCMDBStage.exe -p <password>

• Update the second element for the connection to the staging database. The default values are:

<database

connection-string="Server=.;Database=uCMDB_Staging;Trusted_Connection=yes;"/>

• Update the third element to configure whether, and where, the executable should save XML files of the
inventory collected from HPE-UD. The default value stores any XML files below the location of the
executable: <staging path="StagingData" method="stream"/> You may wish to redirect the path

setting for easier access for human inspection.

• Make sure that the user details in the <Server> section match with the user configured in the HPE-UD

system.

• Save the settings file.

7. Validate the HPE-UD adapter operation. For more information about validating the adapter, see Validating
the HPE-UD Adapter.

8. Assuming that you do not wish to trigger the adapter manually every time it needs to run, start Windows
Task Scheduler, and create a basic task to run the adapter.

Important: It is suggested that you schedule the adapter to run at times which cannot overlap with the
inventory reader uploading the results to the application server. Check the schedule for the compliance
reader on the central application server, and avoid this time slot.

By default, the inventory import (starting with the reader) is triggered around 2 am. Therefore you might
consider scheduling this task for some time such as 10 pm daily. The command line for the scheduled task
(assuming that you have saved your preferred settings) is simply to invoke the executable. Any parameters
not specified on the command line are taken from the settings file in the same folder as the executable.
Here is an example:

HPuCMDBStage.exe -x <settings file>

This completes the configuration of the adapter executable.
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3
Operation and Validation

This section describes the normal operation of HPE-UD adapter and also lists the steps to validate its operation.
This section has the following tasks:

• HPE-UD Operation: See HPE-UD Adapter Operation

• Validating the HPE-UD Adapter: See Validating the HPE-UD Adapter

HPE-UD Adapter Operation
Normal operation of the HPE-UD adapter relies on the following sequence of events:

1. According to the scheduled instructions, the adapter reads the current content of the HPE-UD database
and stages the new data in the staging database after removing the previously stored data. A flag stored in
the staging database indicates the status of the data extraction. The resulting status is flagged within the
database. For more information on installing and configuring the staging tool, see Installing and
Configuring the Staging Tool

2. Following the schedule on the central application server, and provided that the staging status is Success,
the import reader uploads this content to the inventory database.

3. The next compliance import brings the final data set into the compliance database, where it is
automatically taken into account for compliance calculations. As always, for compliance calculations to
proceed, the inventory records must be recognized by the Application Recognition Library, and you must
have the resulting application records linked to the appropriate license.

Validating the HPE-UD Adapter

To validate the adapter operation:

1. Manually trigger the adapter executable.

You can specify a value for the method parameter if you need to override the default settings set in the
settings XML file. For example:
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'C:\Program Files\Flexera Software\HPUD\HPuCMDBStage.exe' -f 'C:\temp' -m staged

This will write XML files under your C:\temp directory for review. It will also write data into the staging
database.

2. Inspect the saved XML files to validate the inventory gathered.

3. Use SQL Server Management Studio to validate that the data is written to the staging database. Also review
the StagingState property in the uCMDBStagingDatabaseConfiguration table in the staging database.
Possible values are Running, Failed, or Success. This value must be Success before the HPE-UD data can
be uploaded from the staging database to the central inventory database.

4. Wait until the next inventory import and calculations have run. You might have to wait overnight for this.

5. Use FlexNet Manager Suite to validate that new evidence has been recovered. Identify which evidence has
been recognized by the ARL and which new rules are required. Link the applications to appropriate
licenses.
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V
Introducing the HP DDMI Adapter

This part introduces the FlexNet adapter for importing data from HP DDMI (for those enterprises that have not yet
migrated to HPE Universal Discovery, for which see Using the HPE Universal Discovery Adapter).

168 FlexNet Manager Suite Adapters Reference | Company Confidential



1
Purpose and Architecture of the HP

DDMI Adapter

The FlexNet adapter for HP Discovery and Dependency Mapping Inventory (HP DDMI) collects data from your HP
DDMI implementation, and stores it in an intermediate staging database. From there, the FlexNet Manager Suite
importers bring the data into the compliance database so that you have a single, unified view of all inventory
sources, and of the impact that the collected inventory has on your license position.

The work is done in two separate stages, and by two separate components:

• The FlexNet DDMI agent reads inventory directly from the HP DDMI incoming inventory (.xsf) files, and writes

the data into the staging database.

• The FlexNet DDMI adapter connection connects to the staging database, massages the data into the format
required for integration with FlexNet Manager Suite, and imports it to the compliance database.

This architecture is summarized in the following diagram, with the numbers described below:
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1. XSF files (compressed XML files) are produced by HP agents and uploaded to a central HP DDMI server.

2. XSF files are imported into the databases for HP DDMI and HP uCMDB. These two stages are the normal
operation of HP DDMI, and are unaffected by the presence of the FlexNet adapter.

3. The first component of the FlexNet adapter for HP DDMI (an agent which may be installed on the HP DDMI
server, where the XSF files are uploaded, or on any other device with read access to the same collection of
XSF files) reads the uploaded files and writes the data into the staging database required for this adapter.
Copying the data from the original XSF files allows FlexNet Manager Suite to capture evidence that, if
unrecognized by HP DDMI, is otherwise discarded.

4. The data import connection (configured from an inventory beacon, which is not shown in this simplified
diagram) links to the staging database, extracts the latest data, and uploads it to the compliance database
for FlexNet Manager Suite.
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2
Installation and Configuration

Everything needed to set up the FlexNet adapter for HP DDMI is included in the Adapter Tools archive available
from the Flexera Customer Community. You need credentials supplied by Flexera to access this download. The
download includes:

• Two SQL scripts to define the schema for, and populate stored procedures for, the staging database.

• The agent executable FnmpDDMIAgent.exe, and an accompanying CommandLine.dll to enable command-

line use.

This chapter includes all the details needed for installation and configuration. There are validation notes are
included at each stage of the set-up.

This chapter assumes that you have a functional implementation of HP DDMI, and an account with sufficient
privileges on your HP DDMI server to install the agent executable there (or similar in your chosen location, if you
are placing the agent elsewhere).

Download Adapter Tools Archive
The Adapter Tools archive includes content for many adapters, and is updated on the Flexera website from time to
time.

Start this procedure using a web browser on a computer that has good network accessibility from all the
machines needing installations for your adapter.

To download the adapter tools archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2018 R1.zip archive from the Flexera
Customer Community knowledge base:

a. Access https://flexeracommunity.force.com/customer/articles/en_US/INFO/Adapter-Tools-for-
FlexNet-Manager-Suite.

Tip: Access requires your Customer Community user name and password. If you do not have
one, use the link on the login page to request one.
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b. Click the link Adapter Tools for FlexNet Manager Suite.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet
Manager Suite 2018 R1.zip commences.

c. In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C:\Temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it
to the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.

Creating the Staging Database
The FlexNet adapter for HP DDMI requires a staging database, which is used as follows:

• The agent installed on your HP DDMI server reads the DDMI inventory files directly, performs minimal data
rationalization, and saves the results to the staging database

• The connection from FlexNet Manager Suite reads the data from the staging database, shapes it
appropriately, and uploads it to the compliance database.

The staging database can be created on any convenient instance of Microsoft SQL Server that meets the
following criteria:

• Provides high-speed network access from the HP DDMI server (or other location of the installed agent), and
from an appropriate inventory beacon that can upload to the application server for FlexNet Manager Suite

• Allows read/write access to the account running the FlexNet agent on the HP DDMI server, and read access
by the service account running the BeaconEngine service on the inventory beacon (or you may choose to

implement either a special Windows account and an SQL account to collect the DDMI staged data)

• Is running an instance of Microsoft SQL Server 2008 or later.

The staging database size will be roughly equivalent to the sum of the inventory (.xsf) files uploaded to your
HP DDMI server. The agent overwrites any previous record from the same device with the latest inventory
upload, to that the net database size does not grow appreciably larger than the sum of the source inventory
files.

Your download of the Tier 1 adapters archive (see Download Adapter Tools Archive) included two SQL scripts
that can assist with creating the staging database. You can achieve this through SQL Server Management
Studio, or from the command line as described in the following procedure. Use whichever approach best suits
your enterprise practices.

To create the staging database from the command line:

1. Navigate through the unzipped tools archive to Tier 1 Adapter Tools > HP Discovery and

Dependency Mapping Inventory Tools > SQL.
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2. If necessary, copy the script DDMIStagingSchema.sql from the this folder of your unzipped adapter
archive to a temporary folder on your staging database server.

3. Logged in on the database server as an account with read/write access to the database, open a command
prompt.

4. In the command prompt window, execute the following command, as amended:

sqlcmd -S ServerName\InstanceName -i TemporaryPath\DDMIStagingSchema.sql

where:

• ServerName is the name of the server hosting the SQL Server 2008 or later. Use a “.” (dot) if you are

running the staging script on the same server as the database instance; or if you are adapting these
instructions to a different environment, insert the server name or its IP address.

• InstanceName is the name of the database instance to use for the database staging tables. You can

omit this parameter (and the backslash separator) if the default instance name is being used.

• TemporaryPath is the location where you saved the SQL procedure.

Example:

sqlcmd -S .\Development -i C:\temp\DDMIStagingSchema.sql

The database DDMIStaging is created with all necessary tables, indices, and so on.

5. Similarly, execute the second script (with the same parameter substitution) to create the stored procedures
necessary in the staging database.

sqlcmd -S ServerName\InstanceName -i TemporaryPath\DDMIStagingProcedures.sql

Example:

sqlcmd -S .\Development -i C:\temp\DDMIStagingProcedures.sql

The staging database is now ready for operation.

Tip: If you wish to do so, you may now rename this database. Keep the name handy for the configuration
processes that follow.

The schema for the staging database (below) is, in the main, self-explanatory, reflecting the content of the .xsf

files found on your HP DDMI server. The one unique table is InventoryImportDate. This table lists the names
of inventory files that have already been loaded into the staging database, and saves the last modified date of
each file as its most recent inventory date. When the FlexNet agent scans through the inventories for possible
import into the staging database, it uses this table to manage differential imports, only importing an inventory
file if it is newer than the last recorded inventory file of that name that was imported.
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Configuring the FlexNet Agent for HP
DDMI
The FlexNet agent for HP DDMI is the code entity that accesses the inventory (.xsf) files uploaded to your HP
DDMI server, and saves the resulting data to the staging database that you have just established. Operationally,
it consists of two parts:

• A small C# application (an .exe and a .dll) that acts only as a transport, decompressing the .xsf files

(which are compressed XML) and feeding them to the second part

• A stored procedure, already created in the staging database (see Creating the Staging Database), that
unpacks the XML elements and saves the resulting data in the staging database.

Clearly, it is only the first of these that is the focus of this topic.

The agent may be installed anywhere, as long as it has access to the folder on your HP DDMI server where the
.xsf inventory files are uploaded, and to the staging database. Optional locations include:

• On the HP DDMI server (optimal from a network performance viewpoint)

• On the server hosting the staging database

• On an inventory beacon that has fast network access to both of the above

• On any other computer meets that same requirement of fast network access to the data source and
destination.

Although much of the inventory processing load is delegated to the SQL stored procedure, you can further
control the impact of the executable on its host device by specifying the number of CPU threads it devotes to
throughput of the .xsf files. In any case, the agent is normally scheduled to run only once daily in off-peak
hours.

To configure the agent executable:

1. Navigate through the unzipped tools archive to Tier 1 Adapter Tools > HP Discovery and

Dependency Mapping Inventory Tools > DDMIAgent.

2. Copy both the FnmpDDMIAgent.exe and CommandLine.dll files to their new operational location.

Important: Both files must be installed in the same folder.

3. Identify or configure the account that is to run the agent.

A suitable account:

• Has execute rights on the device where the agent is installed

• Has at least read-only privileges on the folder where the .xsf inventory files are saved on your HP

DDMI server

• Has read/write privileges on the staging database.

Installation and Configuration

FlexNet Manager Suite Adapters Reference | Company Confidential 175



You may prefer to make this a service account to prevent interactive use.

4. Configure a Windows schedule task (or use your preferred scheduling tool) to trigger execution of the
agent running as your selected account on your preferred schedule.

Choose a schedule to suit your environment. This should allow enough time to:

• Process all new .xsf files into the staging database

• Upload the results to the compliance database for FlexNet Manager Suite

• Align with the nightly full import and license compliance calculations, by default scheduled for 2am
nightly.

A suggested schedule is daily at 10pm.

The task must invoke the FnmpDDMIAgent.exe executable with a command line that includes some of the
following parameters (the agent also supports -h to list command-line options):

FnmpDDMIAgent.exe

-s PathToInventories

-d StagingDBConnectionString

-l LoggingLevel

-t TimeOutSeconds

-n ThreadCount

where the parameters are:

Switch M/O Value

-s Mandatory The location of the HP DDMI inventory files (no default value). The path may be
enclosed in double quotation marks, which are mandatory when there is any
white space in the file path. Example: "C:\HPDDMI\Inventories"

-d Mandatory The connection string for the staging database (no default value). Example:
"server=172.16.38.83;Database=DDMIStaging;Trusted_Connection=yes"

-l Optional An integer in the range 0-3 for the level of logging:

• 0: no logging (default value)

• 1: Errors only

• 2: Errors and warnings

• 3. Verbose logging.

-t Optional The number of seconds the executable should wait for a response to any
command given to the staging database. Default value is 3600 (an hour).
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Switch M/O Value

-n Optional An integer in the range 1-20 (default 5), being the number of CPU threads the
agent should use for processing the .xsf inventory files. Each thread invokes
the database stored procedures independently.

Tip: Depending on the hosting device architecture, optimum throughput is
achieved somewhere within the range of 1-20 threads, after which increasing
the number of threads overloads the system and decreases performance.
Given the variety of factors involved, there is no real substitute for experiment
to determine the optimum value for your environment.

Example usage (all on one line):

FnmpDDMIAgent.exe

-s "C:\HPDDMI\Inventories"

-d "server=172.16.38.83;Database=DDMIStaging;Trusted_Connection=yes"

-l 2

When thus invoked, the agent reads through all updated XSF files in the source directory, and uploads their
data into the staging database. Files unchanged in the nominated path since the last upload are ignored.

5. On the assumption that you already have .xsf files in the nominated folder on your HP DDMI server, you
may wish to run the agent once now, and use Microsoft SQL Server Studio to validate the content is stored
in the staging database. (Loading the staging database also provides material for testing the next stage of
the process.) If you enabled logging, you may also check the log file, which is written to the same folder
where the executable is running.

Configuring Upload and Import Connection
With data arriving in the staging database, it's time to configure its upload to the central application server for
FlexNet Manager Suite, followed by its import to the compliance database. This process is configured on, and
managed by, an inventory beacon.

To configure the connection for upload from the staging database:

1. Run the inventory beacon interface (for example, in the Windows Start menu, search for FlexNet Beacon,
right-click it, and select Run as administrator).

Tip: Remember that you must run the inventory beacon software with administrator privileges.

2. Open the Inventory systems page.

3. Expand the pull-down beside the New... button below the list, and choose SQL Server.

The Create SQL Source Connection dialog appears.

4. Complete the details to define the connection to the staging database:

Installation and Configuration

FlexNet Manager Suite Adapters Reference | Company Confidential 177



a. Create a distinctive Connection Name that is easily recognized in the list of connections (even
when the columns are narrow).

For example: HPDDMI Staging.

b. For Source Type, you must choose HP Discovery and Dependency Mapping Inventory

(DDMI).

c. Provide the host name or IP address (in IPv4 format) for the Server hosting the staging database.

d. Choose the Authentication method that the BeaconEngine process should use to connect to the
database:

• If you select Windows Authentication, ensure that the service account that runs the

BeaconEngine process on this inventory beacon has (as a minimum) read access to the staging

database.

• With either of the remaining two options, specify the Username and Password in the next two
fields. Of course, validate that the nominated account has (as a minimum) read access to the
staging database.

e. Use the Test connection button to validate that you have specified the details correctly, and adjust
if necessary.

f. For the Overlapping Inventory Filter, accept the default Import the inventory from this source
for possible merging selection (unless you are in the process of migrating inventory collection
away from HP DDMI, in which case see the online help for the Inventory systems page).

g. Click Save to close this dialog and add your new connection to the list in the Inventory systems
page.

5. If you do not already have a suitable schedule for this connection available on this inventory beacon, select
the Scheduling page, and click New... to open the Edit Schedule dialog and define one.

6. Back on the Inventory systems page, select the new connection in the list, and click Schedule... to select
your appropriate schedule in the Select schedule dialog. Click OK to confirm your selection.

7. In the main FlexNet Beacon interface, click Save to store your newly scheduled connection.

8. If you have already run the agent to populate your staging database, you may test the new connection by
keeping it selected in the list, and clicking Execute Now.

The upload, the resulting import (which follows immediately), and the subsequent license compliance
calculation may take some time to complete. You may monitor progress in the web interface for FlexNet
Manager Suite — navigate to the system menu ( in the top right corner) and choose System Health
> System Tasks, and see the online help for that page. When the process is complete, you can inspect the
inventory imported from HP DDMI in the All Inventory page.

Tip: In the All Inventory page:

a. Add the Connection name to the listing from the column chooser

b. Display the simple filter bar

c. Filter for the name you have your HP DDMI connection (the suggestion was HPDDMI Staging).
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VI
Oracle Enterprise Manager Adapter

Oracle Enterprise Manager monitors and manages other Oracle software installed on customer sites. Therefore it is
a useful aid in gathering inventory from Oracle systems.

The Oracle Enterprise Manager (OEM) adapter, from Flexera, connects to Oracle Enterprise Manager, and extracts
a file of connection information for the Oracle systems it monitors. This file is in a standard format
(TNSNames.ora) used by Oracle. (In fact, if you already have files of the same name generated by Oracle, you can
simply copy these to the appropriate folder on an inventory beacon. This may be a viable alternative to using this
adapter.)

When the file is saved to a special location on an inventory beacon (and the inventory rules for this inventory
beacon allow processing of TNSNames.ora files), the connection information in it can be used by FlexNet Manager
for Oracle, a separately-licensed product within FlexNet Manager Suite, to collect software inventory information.
This document covers the set up and configuration to use the adapter as part of an Oracle inventory solution.

Terminology

Throughout, the Flexera adapter is referred to as the OEM adapter. The database for Oracle Enterprise Manager
(to which the OEM adapter connects) is referred to as the OEM repository.

The OEM adapter is tested for use with Oracle Enterprise Manager releases 12.1 to 13.2.
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1
Understanding the Oracle Enterprise

Manager Adapter

As well as providing a functional overview of the straight-forward OEM adapter itself, this chapter provides
additional background about the other aspects of your system that collaborate to provide Oracle introspection
and inventory reporting. As well, this chapter covers the prerequisites, content, and delivery of the OEM adapter.

How the Adapter Assists in Inventory
Gathering
The OEM adapter provides an alternative or additional method of discovering Oracle Database servers in your
computing estate. Discovery (by one means or another) is a prerequisite for collecting software inventory from
the Oracle servers.

The OEM adapter is installed on a convenient computer that has network access to Oracle Enterprise Manager
and its OEM repository. Typically, this computer may be a FlexNet Beacon. Multiple instances of the OEM
adapter may be installed (on one or more computers), each of which can connect with one instance of Oracle
Enterprise Manager.

Numbers in the diagram (where "OEMA" identifies the OEM adapter) correspond to the process description
below:

Understanding the Oracle Enterprise Manager Adapter
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The process runs as follows:

1. The Windows scheduled task triggers the OEM adapter, which contacts its instance of Oracle Enterprise
Manager, and collects the connection data from the OEM repository.

2. The OEM adapter formats the data into a TNSNames.ora file, and saves it to a special location on the
inventory beacon.

You may configure the name of the saved file, and, if multiple instances of the OEM adapter save files to
the same inventory beacon, you must modify the file names so that the files do not overwrite each other.

Note: This completes the function of the OEM adapter. The remainder of the process is standard
operating procedure for FlexNet Manager Suite with the FlexNet Manager for Oracle product installed. If
you already have an operational system, several of these steps may already be completed.

3. You set up a special account with read-only permissions on your Oracle Database for all the tables and
views needed for Oracle introspection. One helpful practice is to use the same purpose-driven set of
credentials on all servers. A utility is available to help created the account(s) required with the correct
permissions.

4. The same credentials must be recorded in the Password Manager on each of the relevant inventory
beacons.

5. In the web interface for FlexNet Manager Suite, you define a subnet (or several subnets) that contain the
Oracle Database servers of interest; and you assign to these subnet(s) the inventory beacon(s) where the
TNSNames.ora files are being saved. (Assignments are distributed automatically to inventory beacon(s),
along with rules.)

6. Continuing n the web interface, you create a rule with an action including Oracle inventory collection, with
the option to use TNS name file selected. The rule also has a target which matches the subnet(s) you are
interested in. This rule is automatically distributed to inventory beacon(s).

7. On the inventory beacon(s) of interest:

a. The rule and assignment are received.
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b. The inventory beacon assesses these, concludes that it is authorized to act, and looks for a any
*.ora file(s) in the special path on the inventory beacon.

c. For any Oracle server which is both within the authorized subnet and listed in the .ora file, the
inventory beacon checks for credentials in its Password Manager, and tests them (from the most
closely matching to the most general) until either one gets a response (success), or there are no
further applicable credentials (failure).

d. When successfully logged in, the FlexNet inventory agent running on the inventory beacon, uses the
credentials to read the data necessary for Oracle introspection. It writes the data as an Oracle
inventory file into its staging folder.

e. Within a minute of completion, the regular upload process starts moving this inventory file to the
central application server (or, in a multi-server installation, the inventory server).

8. After the next inventory import and resulting consumption calculations, the Oracle inventory is available in
the web interface for FlexNet Manager Suite; and the Oracle servers originally identified in the
TNSNames.ora file are visible in the All Discovered Devices listing, displaying Yes in the Oracle column.

Prerequisites for the OEM Adapter
The OEM adapter must be installed on a computer with network access to Oracle Enterprise Manager, and
requires read access to certain tables and data views there (the required permissions are listed in Grant
Permissions to Account).

The OEM adapter requires that, on the computer where it will execute, the Oracle client version 12.1 is installed.
Only the 32-bit version is supported: even for a Windows 64-bit computer, use 32-bit ODAC 12c Release 1
(12.1.0.1.0).

To take advantage of the information gathered by the OEM adapter, there are also the following requirements
on the remainder of the system. Once the OEM adapter saves a TNSNames.ora file, the subsequent gathering of
Oracle inventory requires that:

• The FlexNet inventory agent can access each Oracle system. This can be achieved either by installing the
FlexNet inventory agent on the target Oracle server(s), or by remote execution (Zero-footprint inventory
gathering, a term further explained in the Gathering FlexNet Inventory PDF, avai;able through the title page of
online help).

• You have FlexNet Manager for Oracle, a separately licensed product within FlexNet Manager Suite.

Tip: You can check whether your implementation has this product licensed in the web interface for FlexNet
Manager Suite:

1. Navigate to the system menu ( in the top right corner) > FlexNet Manager Suite License.

2. Check the list of Subscribed and purchased products on the right, looking for a card for FlexNet
Manager for Oracle. If the card is present, you have this product licensed.
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Components
The OEM adapter is supplied as an installer, called OEMAdapter.exe, which installs the following:

• OEM adapter executable and dependencies

• OEM adapter configuration file

• OEM adapter scheduled task, which can be created during installation if desired.

Download Adapter Tools Archive
The Adapter Tools archive includes content for many adapters, and is updated on the Flexera website from time to
time.

Start this procedure using a web browser on a computer that has good network accessibility from all the
machines needing installations for your adapter.

To download the adapter tools archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2018 R1.zip archive from the Flexera
Customer Community knowledge base:

a. Access https://flexeracommunity.force.com/customer/articles/en_US/INFO/Adapter-Tools-for-
FlexNet-Manager-Suite.

Tip: Access requires your Customer Community user name and password. If you do not have
one, use the link on the login page to request one.

b. Click the link Adapter Tools for FlexNet Manager Suite.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet
Manager Suite 2018 R1.zip commences.

c. In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C:\Temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it
to the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.
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2
Installing the Adapter, and More

This chapter covers the fairly simple process of installing the OEM adapter. However, once installed, the OEM
adapter is only a small part of gathering Oracle database inventory. Therefore the remainder of this chapter
assumes a fairly new implementation of FlexNet Manager Suite, and introduces the other kinds of set up
necessary for a working system of Oracle introspection. Some of the latter may already be in place within your
enterprise.

Installing the OEM adapter
The OEM adapter is normally installed on an inventory beacon that has high-speed network access to the Oracle
server to which the adapter must connect. It is possible to install multiple instances of the OEM adapter on the
same computer, each configured to access a different OEM repository. Each instance of the OEM adapter can
access exactly one OEM repository.

To install the OEM adapter:

1. From the unzipped Adapter Tools archive, navigate into the Oracle Enterprise Manager Adapter

folder.

For details about downloading the archive, see Download Adapter Tools Archive.

2. In Windows Explorer, execute the OEMAdapter.exe installer from that folder.

If this is the first installation of the OEM adapter on this computer, the welcome page appears, and you can
click Next. If another instance of the OEM adapter is already installed on this computer, the following
screen appears.
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3. If this page appears, choose either of the following:

a. For an additional installation, click Install a new instance, and click Next. Follow the remaining
instructions below.

b. To change one of the instances previously installed, select the instance from the list on this page,
click Maintain or upgrade an existing instance, and click Next.

The Customer Information page appears.

4. Identify the license owner, and the enterprise name, in the User Name and Organization fields
respectively.

5. Provide credentials for the Windows scheduled task that triggers operation of the OEM adapter.

Tip: This account need not be the same as the one to access the OEM repository (identified in a later
page).

Leave the fields blank to run the scheduled task as the local SYSTEM account on this computer.

Note: To change timing or frequency of the scheduled task, use the Microsoft Windows facilities as
usual. They are not configurable through the installer.
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6. Click Next >.

The Destination Folder page appears.

7. Optionally, click Change... to modify the supplied installation location.

Note: If you are installing multiple instances of the OEM adapter on this computer, you must modify
the path so that each is installed in a separate folder. The InstallShield wizard offers the default folder 0
for the first instance. Increment this value to give a unique folder for each instance.

Important: By default the OEM adapter saves the .ora file in the directory where it is executing (that
is, the one you specify here). This is useful as a holding bay where the files may be manually inspected
for initial testing/verification; but no automated processing of the .ora files occurs from this location.
For automated operation after initial testing, you must reconfigure the file path and name as described
in Configure Data Staging.

8. When satisfied with the location, click Next >.

The Database Connection Information page appears.

9. If necessary, confer with your Oracle DBA to complete details about the Oracle database from which this
instance of the OEM adapter collects inventory:
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a. In the Host field, identify the server where Oracle Enterprise Manager is installed.

b. The Port is used by the OEM adapter to access Oracle Enterprise Manager.

c. Service Name identifies the Oracle service (for this database instance) that was defined when
Oracle was installed.

d. UserID is the account name (with its related Password) accepted by Oracle Enterprise Manager for
login by the OEM adapter.

Suggestion: FNMS-OEMadapter.

When satisfied, click Next >, and the Email Configuration page appears.

10. To receive email alerts when the OEM adapter encounters any errors:

a. Enter your email address as the To Mail value.

b. In From Mail, enter the email address from which the error alerts should come.

c. In the SMTP field, enter the fully qualified domain name (or IP address) of the email server.

Tip: Ensure that the To Mail and From Mail addresses are both recognized by this email server.

d. Click Next >.

The Ready to Install the Program page appears.

11. When satisfied, click Install.

The installer writes the OEM adapter executable (OEMAdapter.exe) into your chosen folder, and records your
other settings in a configuration file (OEMAdapter.exe.config) saved in the same folder. It also creates a
scheduled task to run the OEM adapter. To allow for multiple instances of the OEM adapter on the same
computer, the scheduled tasks are named based on the numbering of the installed instances. The default
scheduled task for the initial installation on a computer looks like this:

Installing the Adapter, and More

FlexNet Manager Suite Adapters Reference | Company Confidential 187



You may update the scheduled task(s) as usual through the Microsoft interface.
Before using the OEM adapter in production, you must also do all of the following:

• Confirm that the account used to access Oracle Enterprise Manager (suggested name FNMS-OEMadapter) has

adequate permissions to read from the OEM repository (see Grant Permissions to Account)

• Modify the location where the .ora file is saved for production use (see Configure Data Staging)

• Ensure that the appropriate subnets containing target Oracle servers are identified and assigned to the
inventory beacon where the TSNNames.ora file is saved (see Assign Beacon to Subnet)

• Configure the collection of Oracle inventory in the web interface for FlexNet Manager Suite (see Configure
Collection of Oracle Inventory)

• Set up accounts on each Oracle server with adequate permissions to gather inventory, with target machines
being based on the contents of the .ora file created by the OEM adapter (see Inventory-Gathering Accounts
on Oracle Servers)

• Register the same account(s) in the Password Manager for each relevant inventory beacon (see Save
Inventory Account in Password Manager).

Grant Permissions to Account
The account used to access Oracle (suggested name FNMS-OEMadapter) must have adequate permissions to
read from tables in the OEM repository. If you are setting up multiple instances of the OEM adapter, repeat the
process for each adapter (you may be using a common account name for all of them to access each distinct
OEM repository, or providing each with a unique account name). This task is normally completed by an Oracle
DBA.

To provide appropriate permissions and validate operation:

1. To grant adequate permission, do either of the following:

a. Make the account (suggested name FNMS-OEMadapter) a member of the EM_ALLVIEWER role

b. Give the account read permissions on the following:
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Target views • MGMT_Targets

• MGMT_TARGETS_LOAD_TIMES

• MGMT_TARGET_TYPES

Target properties views • MGMT_Targets

• MGMT_TARGET_PROPERTIES

2. When permissions have been set up, test as follows:

a. Log in using the account name (suggestion: FNMS-OEMadapter) and password registered during
the installation process.

b. Execute the following query against the OEM repository:

SELECT * from mgmt$Target

Note the number of rows returned.

c. Log out, and log in using a DBroot account (or other account known to have full permissions); and
repeat the same query.

The same number of rows should be returned by the root account with full permissions, and by the
account for the OEM adapter with more limited and specific permissions.

3. Repeat the process and testing for any further instances of the OEM adapter accessing other distinct
instances of OEM repository.

Other Setup Activities
The OEM adapter is relatively straight-forward, and, as triggered by the Windows scheduled task set up during
installation, regularly collects data from Oracle Enterprise Manager and saves the data as a TNSNames.ora file in
a special location on the inventory beacon.

However, by itself, when the goal is to gather inventory from Oracle Database servers, the TNSNames.ora file is
just the first step. Many other 'cogs in the machine' need to do their part for the .ora file to be beneficial:

• You need a defined set of sites and subnets, most easily obtained by Active Directory import through an
inventory beacon.

• The subnet(s) containing your Oracle servers of interest must be assigned to the inventory beacon that
collects the TNSNames.ora file, and which subsequently collects the Oracle inventory (see Assign Beacon to

Subnet).

• An inventory rule must be defined that associates the target subnet with an action including inventory
collection using the TNSNames.ora file, and schedules its execution (see Configure Collection of Oracle

Inventory).
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• Quite separately from the account that queries the OEM repository to create the TNSNames.ora file, one or

more separate accounts must be defined that connect to the Oracle Database servers and collect the
inventory data. There are two parts to configuring these accounts:

◦ The accounts must be created and given adequate permissions on each Oracle Database server (there is a
utility available to assist with this, as described in Inventory-Gathering Accounts on Oracle Servers)

◦ The same accounts must be registered in the Password Store on the inventory beacon (see Save Inventory
Account in Password Manager).

Strictly speaking, none of these are part of the OEM adapter; but all are integral to the process of Oracle
introspection, and therefore are at least summarized in the following sections.

Inventory-Gathering Accounts on Oracle Servers
The inventory beacon collects inventory from Oracle servers using accounts that must be registered at both
ends.

To set up inventory-gathering accounts on an Oracle server:

1. Using your credentials supplied as part of order confirmation/fulfilment, log in to the Flexera knowledge
base available through the Support pages of the Flexera website, and access the following knowledge
article:

https://flexeracommunity.force.com/customer/articles/en_US/INFO/Q200934

2. Scroll to the bottom of the article, and click the link CreateOracleAuditUserQ200934.sql.

This downloads a SQL script that an Oracle DBA can review. (Ignore the text content which is for earlier
products.)

3. In a flat text editor, modify lines 8 and 9 of the script, replacing the default user name and password with
credentials of your choosing; and save the modified script.

To minimize configuration and maintenance effort, the same credentials can be implemented on each
Oracle Database server. Keep a note of these credentials, as you must also record them in the Password
Manager on the inventory beacon.

4. An Oracle DBA can run the script on each target Oracle Database server.

This (re)creates the user name on each run, and grants read access to a numbers of tables and views
(shown below) that are required for Oracle Database introspection.

The downloaded SQL script gives the account read-only access to the following tables and views:

• applsys.fnd_app_servers

• applsys.fnd_nodes

• applsys.fnd_product_installations

• applsys.fnd_application_tl
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• applsys.fnd_user

• applsys.fnd_responsibility

• apps.fnd_user_resp_groups

• SYS.DBA_USERS

• SYS.V_$PARAMETER

• SYS.V_$INSTANCE

• SYS.V_$DATABASE

• SYS.V_$OPTION

• SYS.DBA_FEATURE_USAGE_STATISTICS

• SYS.DBA_ENCRYPTED_COLUMNS

• SYS.DBA_TABLESPACES

• ODM.ODM_MINING_MODEL

• ODM.ODM_RECORD

• DMSYS.DM$OBJECT

• DMSYS.DM$MODEL

• DMSYS.DM$P_MODEL

• DVSYS.DBA_DV_REALM

• LBACSYS.LBAC$POLT

• OLAPSYS.DBA$OLAP_CUBES

• SYS.DBA_AWS

• SYS.DBA_SEGMENTS

• SYS.DBA_CUBES

• SYS.GV_$INSTANCE

• SYS.GV_$PARAMETER

• MDSYS.ALL_SDO_GEOM_METADATA

• SYS.V_$SESSION

• SYSMAN.MGMT_LICENSE_DEFINITIONS

• SYSMAN.MGMT_ADMIN_LICENSES
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• SYSMAN.MGMT_LICENSES

• SYS.DUAL

• SYSMAN.MGMT_LICENSE_CONFIRMATION

• SYSMAN.MGMT_TARGETS

• SYSMAN.MGMT_$TARGET

• SYSMAN.MGMT_VERSIONS

• SYSMAN.MGMT_INV_COMPONENT

• SYSMAN.MGMT_FU_REGISTRATIONS

• SYSMAN.MGMT_FU_STATISTICS

• SYSMAN.MGMT_FU_LICENSE_MAP

• SYS.DBA_REGISTRY

• SYS.V_$LICENSE

• SYS.DBA_TABLES

• CONTENT.ODM_DOCUMENT

• SYS.V_$VERSION

• SYS.USER_ROLE_PRIVS

• SYS.USER_SYS_PRIVS

• SYS.ROLE_SYS_PRIVS

• MDSYS.SDO_GEOM_METADATA_TABLE

• SYS.DBA_INDEXES

• SYS.DBA_LOBS

• SYS.DBA_OBJECTS

• SYS.DBA_RECYCLEBIN

• SYS.DBA_MINING_MODELS

• SYS.REGISTRY$HISTORY

• SYS.DBA_TAB_PARTITIONS

• SYS.DBA_TAB_SUBPARTITIONS

• SYS.DBA_LOB_PARTITIONS
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• SYS.DBA_LOB_SUBPARTITIONS

• SYS.V_$ARCHIVE_DEST_STATUS

• SYS.DBA_SQL_PROFILES

• SYS.DBA_ADVISOR_TASKS

• SYS.DBA_SQLSET

• SYS.DBA_SQLSET_REFERENCES

• SYS.DBA_FLASHBACK_ARCHIVE

• SYS.DBA_FLASHBACK_ARCHIVE_TS

• SYS.DBA_FLASHBACK_ARCHIVE_TABLES

• SYS.V_$BLOCK_CHANGE_TRACKING

• SYS.V_$CONTAINERS

Save Inventory Account in Password Manager
The accounts that collect Oracle inventory must exist in the Password Manager.

This process must be completed on the inventory beacon.

To register an account in the Password Manager on an inventory beacon:

1. Log into the inventory beacon, using an account that has administrator privileges.

2. Start the FlexNet Beacon software from the Windows Start menu.

3. In the navigation bar on the left, select the Password management page, and click Launch Password
Manager.

The separate interface for the Password Manager opens.

4. In the Current credentials group, click New.

The controls in the Editor group are activated. When you are updating an existing entry, the controls are
populated with the currently saved values.

5. Provide a Logical name to identify this set of credentials.

Logical naming allows you to have one account name, but with different passwords on different servers.
For more, see the online help.

6. For Account type, choose Account on Oracle database.

7. Complete the User (account name) and Password.

8. Click View/Edit filter....

The Password Store: Password Filter dialog is displayed.
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9. Use the Oracle service names filter to create a comma-separated list of the Oracle services for which this
account/password pair should be used.

The services names are visible in your .ora file. Filtering the account/password pair to apply only to
specified Oracle services provides maximum efficiency for login and introspection.

10. Click Apply to close the dialog, and continue to save the entry in the Password Manager.

Repeat the process as required until all your Oracle machines are covered by one or more entries in the
Password Manager. Thereafter you may exit the FlexNet Beacon interface.

Assign Beacon to Subnet
Before rules can take effect, inventory beacons must know their subnets.

It is a requirement for an operational system that your subnets are assigned to appropriate inventory beacons.
This summary covers only making adjustment for the collection of Oracle inventory.

To assign subsets to an inventory beacon:

1. In the web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Subnets (in the
Network group).

This page is populated with the sites and subnets in your enterprise after you have completed an import
from Active Directory (for details, consult FlexNet Manager Suite Help > Inventory Beacons > Active
Directory Page > Importing from Active Directory).

2. Expand the appropriate site(s), using the + expander icon, until you can see the subnet that includes your
Oracle Database servers.

Tip: If the subnet does not yet appear in the listing, you can add its details manually. In the row for
the appropriate site, click the + sign on the right-hand end, and enter the subnet IP address in the new
row that appears.

3. If the Beacon name column shows Unspecified, click the editing (pencil) icon at the right-hand end of
this row.

The row becomes editable. Beware of accidentally over-writing the IP address, which initially has focus.

4. In the Beacon name column, use the drop-down list to choose the appropriate inventory beacon from
the list of those registered so far; and click the blue disk icon on the right to save your change.

Your chosen inventory beacon is now authorized to work in the subnet that contains your Oracle Database
servers. Now continue and create a rule that dictates what should happen within that subnet.

Configure Collection of Oracle Inventory
Rules must be established that allow Oracle inventory collection, including the use of .ora files.

Inventory rules are created on the Discovery and Inventory Rules page of the web interface for FlexNet
Manager Suite. Each rule has three parts:
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• A target that identifies the machines on which the rule is to be exercised

• Actions that are the be performed on those target machines

• The schedule on which the rule is to be applied.

When an action includes permission to use a .ora file, the relevant inventory beacon uses the locally-available
.ora file to 'filter' the related target and identify the Oracle Database servers from which inventory should be
collected. For example, if you target an IP range that covers your server room, and include the action setting to
apply the .ora file to this range, then Oracle inventory is collected only from the matching machines listed in
the .ora file.

Once a discovery and inventory collection has been completed, the individual Oracle database servers are
identified in the list of discovered devices. Should you wish to change to tighter targeting rules, you can use
this information to redefine the target until (if you wish) it identifies exactly the Oracle Database servers and no
others. Keep in mind that if you use this approach, you will need to adjust the target each time you vary the list
of your Oracle Database servers. To reduce this manual maintenance, keep a target that specifies an
appropriate IP range (or ranges), and applies the .ora file to this to identify the individual Oracle Database
servers from which to collect inventory.

To configure Oracle inventory collection:

1. In FlexNet Manager Suite, navigate to Discovery & Inventory > Discovery and Inventory Rules (in the
Discovery group).

2. If you do not already have a target to reach the Oracle servers from which you want to gather inventory:

a. On the left side, select the Targets tab.

Fastpath: In the hints area across the top of the page, click Create targets. These hints can guide
you through the process.

b. On the right side, click Create a target.

c. The page appearance changes, allowing you to define a target.

d. Complete the details requested, with particular attention on Define machines to target.

Notice that:

• After you complete each definition for this control, a + icon is displayed that allows you to add
more to your definition of target machines. Use these lines to define a target sufficiently broad
to capture your Oracle Database servers.

• If you do not want the FlexNet inventory agent to be installed on these Oracle servers, be sure
to select Do not allow these targets to be adopted.

• You should likely also select Do not allow application usage tracking on these targets, since
you may not want to collect a large quantity of file evidence from these servers.

e. Click Save.

3. If you already have an action for Oracle discovery, you can check its settings; or create a new one:

a. Click the Actions tab (or in the hints section, click Create actions).
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b. If you wish to collect hardware inventory for these servers (perhaps to assist with licensing
calculations for your Oracle Database license), expand the General accordion and select Gather
hardware and software inventory.

Tip: You may want to clear the check box for Discover devices, if you are limiting this action
specifically to inventory collection for known Oracle database servers identified in your .ora
file.

c. Expand the Oracle database accordion.

d. If you are confident that every Oracle Database is identified in your .ora file, you may clear the
check box for Discover Oracle databases. Alternatively, if you may have rogue servers, leave this
check box selected, and the network within your declared target will be probed for other Oracle
servers.

e. Select the check box for Also gather Oracle database inventory.

Additional controls, if not already visible, are exposed.

f. Ensure that the Port scan check box is selected, and if necessary use the + icon to add additional
ports to the list until every port listed in your .ora file is included.

g. Ensure that the SNMP scan check box is selected.

h. It is critically important that you select the TNS names file check box.

This setting authorizes the relevant inventory beacons to apply any .ora files found in the 'magic
path' to the target used for this action (in the rule soon to be completed). This is the mechanism
that most efficiently restricts probing to the relevant servers.

i. Adjust other settings in other parts of the accordion to suit your environment, and click Save.

The action is stored, ready for inclusion in a rule.

4. Select the Rules tab (or in the hints area, click the third Create rules step).

a. Do either of the following:

• If you have an existing rule to review or modify, click the edit (pencil) icon on its right-hand
end.

• Click Create a rule (upper right) to define a new rule (as described in the following steps).

A rule builder work area appears above the list of existing rules.

b. Return to the Actions tab (for example, using the link in the rule builder), and on the row for your
edited Oracle action, click Add to rule builder.

The name of your action appears in the rule builder.

c. Return to the Targets tab (for example, using the link in the rule builder), and on the row for your
edited target, click Add to rule builder.

5. On the right side of the rule builder, click Schedule.

The rule builder changes to display controls for scheduling:

a. Choose a value from the Frequency drop-down list.
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This control sets the style of scheduling. For example, the Daily option lets you make further
choices about a pattern of days, and does not enforce inventory collection every day.

Option Notes

Once A single-shot trigger for inventory collection the next time the declared
time window occurs (you cannot nominate a future date). For example,
if it is 4pm when you set a Once schedule for 8am, commencing within
4 hours, inventory collection occurs next morning. Compare with As

soon as possible. Keep in mind the propagation delays for your
changed instructions, as described there.

Daily An additional drop-down list, Every, appears so that you can choose
the pattern of days you want. For example, you may wish to trigger
inventory collection every second day. Choose a value from this list as
well.

Weekly New check boxes appear that allow you to choose specific days within
the weekly cycle when inventory should be collected. For example, you
may want collection on Sunday and Wednesday every week. Select
(check) the boxes for the days you prefer.

Monthly New controls appear that allow you to specify a pattern within the
month:

• Choose the option for On day to nominate a particular day within
the month (such as the third Saturday). Make your choices from the
two drop-down lists adjacent. Notice that the option Last chooses

the fifth occurrence in months long enough to have one, and
otherwise takes the fourth occurrence.

• Choose the option for On date to nominate the calendar date within
the month.

As soon as

possible

This is a single shot trigger which causes each FlexNet inventory agent
to randomize an inventory collection within the time window starting
when it receives this setting and lasting for the interval you specify in
the Commence within controls.

Tip: Any change you save to these settings is first collected by the
inventory beacons on the schedule specified by the Beacon settings
(further down this web page), by default checked every 15 minutes.
Each inventory beacon then prepares new instructions for all the
installed FlexNet inventory agents that it manages, which come
calling to collect their latest package every 12 hours. Because of
these propagation periods, As soon as possible on average
means starting about six hours from now, or worst case a little over
12 hours from the time you save this change.

6. In the rule builder, click Save as, give the rule a name you will recognize later in lists, and click Save.
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If you accepted the default Enabled setting, the rule is ready to run on the schedule you have established.
(Remember to allow around 15 minutes for the new rule to be distributed to your inventory beacons.) When
the rule is executed on an inventory beacon, if a .ora file exists in the 'magic path', the systems that lie both
within the inventory beacon's assigned subnet(s) and within the .ora file are targeted for Oracle inventory
collection.
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3
Modifying the Adapter

This chapter covers changes you can make to the operations of the OEM adapter by modifying its configuration
file. Read the first topic for general guidance on the editing process, and choose the detailed subtopics based on
what changes you need.

Reconfiguring the OEM Adapter
During installation, you recorded your preferred settings for the OEM adapter, and no further work is required in
the installation process.

If you later wish to modify the configuration of an instance of the OEM adapter:

1. In Windows Explorer, navigate to the correct folder for the appropriate instance of the OEM adapter.

Keep in mind that there may be several instances installed on a computer, accessing distinct instances of
Oracle Enterprise Manager.

2. In your preferred plain text (or XML) editor, open the OEM adapter’s configuration file, called
OEMAdapter.exe.config.

It is strongly recommended that you make a backup copy of the original configuration file, so that you
can easily revert your changes if there are problems.

3. Use the following subtopics to guide your changes to the configuration file.

4. When you have finished, save the updated file.

5. Either wait until the next scheduled run of the OEM adapter, or use the Windows scheduled task interface
to trigger an immediate test run to confirm that your changes work as expected.

Updating Connection Details
You can change all details and credentials for connection to the Oracle Enterprise Manager instance.

When the OEM adapter is first run, it encrypts the connection details used to access the Oracle Enterprise
Manager implementation. Therefore, the process to edit the connection details is different, based on whether
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the OEM adapter has been run since the connection details were last recorded. You can tell whether this is so
by looking in the configuration file.

The details are all stored in the <connectionStrings> element of the configuration file.

1. If the OEM adapter has been run since the details were recorded in the configuration file, the encrypted
<connectionStrings> element appears similar to this:

<connectionStrings

configProtectionProvider="DataProtectionConfigurationProvider">

<EncryptedData>

<CipherData>

<CipherValue>AQAAANCMnd8BFdERjHoAwE/Cl+sBAAAAeNhcGMAVK0uVGNTqOg/

WbQQAAAACAA

AAAAADZgAAwAAAABAAAACTO9kpn6BptpLvsXExg1UBAAAAAASAAACgAAAAEAAAAELCyiwz5A

XZw9xZXfEPiAAAAgAAPJQYe+G9AfScFMJTYgA0NDbAgZdRA9nB91DN42A1xjeCskUs9+KNjV

U1PSFRV4ujta40evf3IOZy5odyHsIrJRCKOOGdhDb1wh4ISEkpJk/

QDna6LeCbbtXXsQK2Lo

AHQc/plz77UkQZxnxkL5ElPIGHl6AojEXT2F5NGjElJX6GXbUXQDkNnDfi2o6XI/

CDbX8gCu

MonY1cTLYGe6+AQPpDgcY3rA02ZFOs7/Zb0cKOw7IoZdB6H8OIvrClSzqNkVBd3YfLhP/

KOr

kQFP8orqj54BJW74E1v3VUZnte1ESgLA5MYb/

F9Ah3M5xi2Q6ITXOQmVRGESrivsdqr6nyGz

5APx2yVBuEcoVhpOMYURbEbBSW+6/

aydg8nY1DrcMzkPlXiZ0CQs4yZYHSWt3+bFEN30xh6X

KFH7Tpc8e5y9Tq1Bhwk+Kw6AFfZhcdewApJ4ZkGAr4ixE6gNqWXnomk2puKNFImhJfqLLIuQ

x9T00Uu2bjJ9Y+dUlrcuov12hQXOCh9nqOdmeIQHPXgw8//eHYOzwy2TgMcq2M2LxXRbQqCT

eWtlP1ucJVyct9gnJlk2L3FSBNgMu1C9mncR7MsGDBWoQMXnwC5+Y6P1GT45sPOedBQvIQIT

j7MCuzfgDD1R9c7w1gejTGmrl3Kmf33tGPMRYPV7CPNET3DUV9AGQUAAAAaIEkjyqfExrbei

YJvG2usqYO3Nk=</CipherValue>

</CipherData>

</EncryptedData>

</connectionStrings>

In this case, delete the entire element and replace it with a plain text version as shown below.

2. If the OEM adapter has not been run since the configuration file was changed, it has a plain text form
similar to this (line wrapping has been added here for legibility). Replace the italicized placeholders with
your own values, as described below. Keep the connectionString attribute all on one line.

<connectionStrings>

<add name="OEMConn"

connectionString="Data Source=(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)
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(HOST=HostIPAddress)

(PORT=PortNumber))

(CONNECT_DATA=(SERVICE_NAME=ServiceName)));

User Id=AccountName;Password=UnencryptedPassword;"></add>

</connectionStrings>

where the following details should be confirmed with your Oracle administrator:

• HostIPAddress is the IP address of the Oracle server hosting Oracle Enterprise Manager

• PortNumber is the port that the OEM adapter should use to query Oracle Enterprise Manager

• ServiceName is the service name established when Oracle was installed on the Oracle server

• AccountName is the account (user name) that the Oracle administrator has established for accessing

Oracle Enterprise Manager

• UnencryptedPassword is a plain text rendition of the password for the same account (remembering

that all the connection details are encrypted together as soon as the OEM adapter runs next).

3. Save the amended configuration file.

4. Use the Windows schedule task interface to run a test of the OEM adapter to confirm that the connections
details were correctly entered.

Configure Data Staging
Modify the name and location of the file of Oracle connection information.

The OEM adapter collects information about connections to Oracle systems from which you need to gather
inventory information. This file is in a standard Oracle format, used for their TNSNames.ora file. It is saved by
default where the OEM adapter is executing; but the default location for the OEM adapter does not support
automated processing of the TNSNames.ora file when the inventory beacon applies rules for gathering Oracle
inventory. For the OEM adapter to function seamlessly, you must customize the location as you edit the
OEMAdapter.exe.config file.

Another reason to customize the file name is if you have multiple instances of the OEM adapter running from
the same computer (or if anyone manually adds TNSNames.ora files to the processing directory). Each instance
must write to a unique file name, so that one output does not over-write the other.

These settings live in an add element with the key attribute of ConnectionInfoFile.

1. In the OEMAdapter.exe.config file, locate the appropriate element. Its default values are similar to the
following:

<add key="ConnectionInfoFile"

value="C:\Program Files\Flexera\Oracle Enterprise Manager Adapter\

TNSNames.ora"></add>

This reflects the default location of the OEM adapter, and must be modified.

2. Replace the value string with the new file path and name.
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Important: The file name must use the extension .ora.

You may use a mapped drive on the local computer to specify a network path. This example shows the
file in the recommended 'magic path' on the inventory beacon where the .ora file is automatically
processed to 'filter' the target supplied from the central application server. Also notice the customized
file name to avoid naïve overwriting of the TNSNames.ora file name by other copies saved here:

<add key="ConnectionInfoFile"

value="C:\ProgramData\Flexera Software\Repository\TNSNames\

TNSNames-01.ora"></add>

3. Save the amended configuration file.

4. Use the Windows schedule task interface to run a test of the OEM adapter to confirm that the staging file
is saved according to your revised specifications. Check the location (recommended: C:\ProgramData\
Flexera Software\Repository\TNSNames\) for the presence of a saved file immediately after the test
run (if you wait too long, the resulting file may be automatically uploaded and removed from this staging
location).

Managing Email Alerts
You can turn the alerts off, changes their addresses, or switch email servers.

The OEM adapter can send email alerts any time that it encounters an error. Manage the emails with the
following XML elements in the OEMAdapter.exe.config file.

1. To stop email alerts entirely comment out the reference to the SmtpAppender like this:

<appender-ref ref="RollingFileAppender"></appender-ref>

<!-- <appender-ref ref="SmtpAppender"></appender-ref> -->

(The character sequence <!-- starts an XML comment, and the sequence --> closes the comment.)

Tip: Using this technique is preferable to deleting this line entirely, as this can be easily reversed if you
decide to reinstate email alerts in future. Notice that, depending on the configuration you saved, there
may be other elements between the <appender-ref> tags.

2. To reconfigure the email alerts, locate the <appender> element, and modify three of its child elements by
changing the example values shown in italics here:

<appender name="SmtpAppender" type="log4net.Appender.SmtpAppender">

<to value="toaddress@somedomain.com"></to>

<from value="fromaddress@somedomain.com"></from>

<subject value="OEM Adapter Error"></subject>

<smtpHost value="smtp.somedomain.com"></smtpHost>

</appender>

3. Save the amended configuration file.
4.
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Configure Logging
Change the path and file name for logging by the OEM adapter.

The log file name and location cannot be set during installation of the OEM adapter, but after installation, they
can be modified as follows:

1. In the OEMAdapter.exe.config file, locate the <appender> element called RollingFileAppender.

2. Edit the child <file> element by replacing the drive, path and file name shown as placeholders here:

<appender name="RollingFileAppender"

type="log4net.Appender.RollingFileAppender">

<file value="drive:\path\path\logfilename.txt"></file>

</appender?

3. Save the amended configuration file.

After the next run of the OEM adapter, inspect the log in your new location.
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VII
ServiceNow Integration with FlexNet

Manager Suite
You can exchange a limited set of data between these systems to provide a consistent view of your hardware and
software estate, and related contracts.

ServiceNow provides cloud-based IT Service Management, while FlexNet Manager Suite is focused on Software
Asset Management. To help provide a unified view of your management data, there are two parts to the
integration of these systems, each of which is available independently:

• Data on hardware assets, application installations, and contracts can be exported from FlexNet Manager Suite
and imported into ServiceNow

• Data on assets and contracts can be exported from ServiceNow and imported into FlexNet Manager Suite.

This release of the ServiceNow integration package supports the following versions of ServiceNow:

• Helsinki

• Istanbul

• Jakarta.
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1
Architecture, Components, and

Prerequisites

This chapter provides the background information you need to get started. It is valuable to understand the
concept of 'sources of truth' which guides the flow of information between the two systems:

• FlexNet Manager Suite is authoritative on hardware assets, application installations, and contracts.

• ServiceNow is authoritative on assets and contracts.

These ideas drive the default configuration of exports and imports. (You can also customize the exports, as
described in a later chapter.)

Architecture
This big-picture overview provides context for understanding both configuration and operation of the integration
between ServiceNow and FlexNet Manager Suite.

Because ServiceNow is cloud-based, and your implementation of FlexNet Manager Suite is on your premises,
there is a level of separation required (for example, the products must be accessed in separate browser tabs/
windows). The following architecture allows for the necessary data flows between these two distinct systems.
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The following two processes (illustrated in the diagram) operate completely independently:

• The export of computer and contract data from ServiceNow for import into FlexNet Manager Suite (gold
arrows). For details, see Process for Exports from ServiceNow to FlexNet Manager Suite.

• The export of computer, application, and contract data from FlexNet Manager Suite into ServiceNow (purple
arrow). For details, see Process for Exports from FlexNet Manager Suite to ServiceNow

Prerequisites
The following are requirements for integrating FlexNet Manager Suite and ServiceNow.

• You must have a license issued by Flexera that permits use of the integration package. This license authorizes
all communications in both directions through the integration package.

◦ To check, in the web interface navigate to the system menu ( in the top right corner) and click FlexNet
Manager Suite License. Check under the Subscription details for ServiceNow integration enabled:

Yes. If this is not the case, please request the license from your Flexera representative.

• You need a functional implementation of FlexNet Manager Suite. This documentation is for release 2018 R1.
(The current integration package is supported from FlexNet Manager Suite 2015 R2 SP5, with hotfix applied.)

• The FlexNet Manager Suite feature called ServiceNow Exporter must be installed. To check:

1. On your batch server, navigate to the installation directory for FlexNet Manager Suite.

2. Navigate down to the child directory DotNet\bin.

3. Validate that there is a ServiceNowExport folder, with content. If so, the check is satisfactorily
completed.

4. If the folder is missing, you must re-reun the FlexNet Manager Suite installer, and ensure that the
ServiceNow Exporter feature is selected for installation. You should also re-reun the configuration
PowerShell script in order the create the required scheduled task. (For more information, see your copy
of the Installation Guide PDF, available through the title page of your online help.)

Architecture, Components, and Prerequisites

206 FlexNet Manager Suite Adapters Reference | Company Confidential



• You need to download the ServiceNow integration package (see Download Adapter Tools Archive).

• You must have an operational ServiceNow instance. This release of the ServiceNow integration package
supports the following versions of ServiceNow:

◦ Helsinki

◦ Istanbul

◦ Jakarta.

• For data flows from ServiceNow to FlexNet Manager Suite:

◦ You must have an operational inventory beacon that communicates with your central application server for
FlexNet Manager Suite.

◦ You need a MID server configured for your ServiceNow implementation.

Tip: If you prefer, your FlexNet Beacon and ServiceNow MID server can be implemented on the same
physical computer (provided that there are common communications requirements — for example, you
don't have a case where one requires a proxy server setting that the other cannot use).

• For data flows from FlexNet Manager Suite to ServiceNow:

◦ Your ServiceNow instance must have the Software Asset Management plugin installed and enabled, to
allow application import to work. The methods for enabling this plugin vary depending on which release of
ServiceNow runs on your instance. For details, see Configuring the SAM Plugin.

Download Adapter Tools Archive
The Adapter Tools archive includes content for many adapters, and is updated on the Flexera website from time to
time.

Start this procedure using a web browser on a computer that has good network accessibility from all the
machines needing installations for your adapter.

To download the adapter tools archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2018 R1.zip archive from the Flexera
Customer Community knowledge base:

a. Access https://flexeracommunity.force.com/customer/articles/en_US/INFO/Adapter-Tools-for-
FlexNet-Manager-Suite.

Tip: Access requires your Customer Community user name and password. If you do not have
one, use the link on the login page to request one.

b. Click the link Adapter Tools for FlexNet Manager Suite.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet
Manager Suite 2018 R1.zip commences.
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c. In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C:\Temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it
to the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.
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2
Installation and Configuration

Because the system involves a number of different servers, there are several installation and configuration steps.
These are described in full in the following topics.

The information is divided into three sections:

• Setting up the Integration — these tasks are common and must be completed for all implementations

• Setting up Data Flows from ServiceNow to FlexNet Manager Suite — required if you want to import data on
assets and contracts into FlexNet Manager Suite

• Setting up Data Flows from FlexNet Manager Suite to ServiceNow — required if you want to export the
FlexNet Manager Suite data on hardware assets, application installations, and contracts for use within
ServiceNow.

Setting up the Integration
Most of the groundwork on the FlexNet Manager Suite side has already been completed as part of product
installation. Therefore the balance of the work that is common to both directions of data flow involves setting
up ServiceNow.

• In ServiceNow terminology, you need to install an integration 'application' in ServiceNow (see Installing the
FlexNet Manager Suite integration application for ServiceNow).

• There must also be a user account correctly configured in ServiceNow (see Creating a ServiceNow User).

Installing the FlexNet Manager Suite integration
application for ServiceNow

Tip: If an existing integration application for FlexNet Manager Suite is installed in ServiceNow, depending on
the application version, additional steps are required during and after the new installation. For additional
information about removing an earlier integration application (to be completed after the new installation is
complete), refer to Removing a Legacy Integration Application.
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This process assumes that you have downloaded the adapter package and unzipped the archive, and that the
resulting folders are accessible from your ServiceNow server (for details, see Download Adapter Tools Archive).

Warning: The ServiceNow documentation warns you to configure imports of update sets outside business
hours, as the import process can impact the performance of your ServiceNow instance.

To install the ServiceNow application to link with FlexNet Manager Suite:

1. Log into ServiceNow as a ServiceNow administrator.

2. In the left-hand navigation bar, expand the System Update Sets group, and click Retrieved Update Sets.

A list of already registered updated sets is displayed.

3. Below the list, click the Import Update Set from XML link.

4. Under Step 1: Choose file to upload, click Browse..., navigate in your extracted folder to the
ServiceNow subdirectory, and select FlexNet Manager Suite Integration.xml.

5. Click Upload.

When your file finishes uploading, it displays in the list of Retrieved Update Sets with a State value of
Loaded.

Tip: From release 3.0 of the integration adapter, the ServiceNow integration application is created in its
own private scope.

6. Click on the hyperlinked Name of your update set.

The Retrieved Update Set properties are displayed.

Tip: You cannot commit the update set until you have previewed it (as follows) and addressed any
problems.

7. Below the properties, click Preview Update Set.

Note: Consider the following scenarios:

• Fresh installation—In the case of a fresh installation, Preview Update Set should not report any
errors.

• Upgrade from 3.x—If upgrading from 3.x, you should backup any property sets (such as MID Server
Name and Integration Properties) or customizations. You should choose Accept remote update set
for all conflicts and after the newer application is installed, reset the properties, and redo
customizations.

• Upgrade from 2.x—If you are upgrading from version 2.x, Preview Update Set should not report
any errors.

For more details on previewing remote update sets see http://wiki.servicenow.com/
index.php?title=Transferring_Update_Sets#Previewing_Remote_Update_Sets).

8. When there are no (remaining) errors, click Commit Update Set.
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9. If you are upgrading from application version 2.x, you must run the migration script:

a. In ServiceNow, go to FlexNet Manager Suite > Scheduled Jobs.

b. Click Upgrade to V3.0 job to open it.

c. Click Execute Now to run the migration.

d. Check the system logs to see the following log message:

Done migrating cmdb_ci_computer

The application now appears in the ServiceNow menu, displayed in the left-hand navigation panel as FlexNet
Manager Suite.

Creating a ServiceNow User
This simple process sets up the user account used for integration between Service Now and FlexNet Manager
Suite, and assigns the user to the appropriate role. Complete this task while you are still logged into
ServiceNow as an administrator.

1. In ServiceNow, go to User Administration > Users.

2. Click New, complete the properties for your new user, and click Submit.

Tip: Take note of the user ID and password, which you will need again later in the set-up processes.

3. Once the creation process finishes, click the hyperlinked User ID for this user, and scroll down to Roles.

4. Click Edit, and select x_fls_flexera_fnms.admin from the collection, and add to Roles List.

5. Click Save.

6. Close the user properties page.

Setting up Data Flows from ServiceNow to
FlexNet Manager Suite
Details of hardware assets and/or contracts, for which ServiceNow is considered the authoritative source of
truth, can be imported into FlexNet Manager Suite from ServiceNow. In summary, the process is:

1. Each data collection is triggered by a scheduled job in Service Now that invokes a script.

2. The script uses ServiceNow database views to gather the required data and transfers it, in chunks, to the
appropriate MID server.

3. The MID server writes the chunks into an XML file.

4. A separate schedule configured on the inventory beacon for FlexNet Manager Suite triggers an import
through a business adapter, collecting the XML file, transforming it, and uploading it to the central
application server.
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5. The normal import processes on the application server imports the data (transformed as appropriate) into
the operations databases for FlexNet Manager Suite.

If you wish to make use of this data flow, you need to complete the following processes:

• Setting up a MID Server

• Configuring ServiceNow for Export

• Configuring FlexNet Beacon for Import.

No configuration of the central application server is needed, since this part of the integration leverages all
standard operating processes.

Setting up a MID Server
You may already have an operational MID server (accessible from your chosen inventory beacon) that you wish
to use for data transfers from ServiceNow to FlexNet Manager Suite. If so, and the MID server is validated in
ServiceNow, you may skip this topic.

On the other hand, you may prefer to set up a specific MID server especially for this integration. Follow these
steps while you are still logged into ServiceNow with administrator privileges:

1. In the navigation bar, expand MID Server and click Downloads.

2. Click the link appropriate for your platform.

3. In the navigation bar, in the MID Server group, click Installation Instructions, and click the link
appropriate to your version of ServiceNow.

The documentation opens in a new tab.

4. Step through those instructions to complete installation of your MID server.

Take particular note of the exact name you give this MID server, as you will need it again soon. (It is also
available through MID Server > Servers.)

5. Be sure to validate your MID server (see link near to the top of the title page of the instructions).

Configuring ServiceNow for Export
Now that you have a MID server installed, two further configuration points for ServiceNow remain:

• Identifying the MID server as the one to use for the exports to FlexNet Manager Suite

• Scheduling the exports from ServiceNow.

Continue the following while still logged into ServiceNow with administrator privileges.

To configure ServiceNow for export:

1. In the navigation bar, expand the FlexNet Manager Suite integration group and expand Advanced.

2. Click Integration Properties.
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3. In the list of Flexera FlexNet Manager Suite Properties, scroll down to the MID Server Name field, and
enter the full name of the MID server.

4. Scroll down (if necessary), and click Save.

The MID server is now registered as the path for data exports from ServiceNow to FlexNet Manager Suite.

5. Navigate in ServiceNow to FlexNet Manager Suite > Scheduled Jobs.

The list of standard jobs to export data from ServiceNow is displayed, including:

• Export Assets From ServiceNow

• Export Contracts from ServiceNow.

Each of these jobs needs to be configured for your environment.

6. Click the first export task to schedule (such as Export Assets From ServiceNow).

The Scheduled Script Execution properties are displayed.

Note: The MID server collects the exported XML data in chunks, such that the XML file is not well
formed until the last chunk has been received. Be sure to schedule sufficient time for the exports to
complete before the scheduled import from the MID server into FlexNet Manager Suite.

7. Change the value in the Run field to suit your business needs.

These data exports may be large, based on the size of your ServiceNow repository. A common practice
would be to choose Weekly exports.

Tip: ServiceNow by default limits its exports from the database to 10,000 records (for a general
discussion, see https://community.servicenow.com/community/blogs/blog/2014/08/01/increasing-the-
export-limit, but note that this page discusses limits for exports from the ServiceNow user interface
grids, which are not relevant to the database exports to FlexNet Manager Suite). You can modify the
maximum number of records exported from ServiceNow by having your ServiceNow administrator add
the property glide.db.max_view_records and setting a new limit. For instructions on adding the
property, see http://wiki.servicenow.com/index.php?title=Adding_a_Property#gsc.tab=0.

8. Use the additional fields that appear to complete your scheduling.

For example, for Weekly exports, set the Day, and Time of day, when the export should occur. An off-
peak time is preferable.

9. Click Update to save your changes.

Repeat the scheduling for the Export Contracts from ServiceNow task.

10. With both exports now scheduled, run a test of each by clicking Execute Now on the associated
Scheduled Script Execution properties page.

(This same button can be used to run the export if you chose the Run On Demand setting for the
schedule.) Use the test to assess the time taken to complete the export and finish a well-formed XML file
on the MID server, as a check on your scheduling plans. The test also allows you to troubleshoot any
problems.

11. Monitor queue management:
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a. From the ECC group, select Queue.

b. In the Queues list, click the Created column header to show the most recently-created entries at
the top of the list.

The MID server agent collects content from this queue.

c. Click the hyperlinked date/time under Created to inspect the contents of each package.

Because data is chunked, the first segment just lays down the opening elements for the XML file;
subsequent segments add data entries; and the last closes the XML elements and reports success.

12. Monitor overall progress by navigating to FlexNet Manager Suite > Export Runs.

The State column on this view shows the progress of export, and the Stage column displays File
Completion when the XML file is done.

13. On the MID server, check for well-formed (complete) XML files.

The files are located in the installation folder of the MID server, which by default is called agent. The file
names are of the form x_fls_flexera_fnms_ExportType.xml, where the placeholder ExportType is
either Asset or Contract. You can check the files in your preferred XML reader, or in Microsoft Internet
Explorer.

This completes the configuration of ServiceNow for data flows from ServiceNow to FlexNet Manager Suite.
These same data flows also require some configuration of FlexNet Manager Suite to receive the data. This side
of the configuration is covered next.

Configuring FlexNet Beacon for Import
If you are not already familiar with importing business-related data to FlexNet Manager Suite, the following
terminology summary may help:

• A "business adapter" is an XML file that allows configuration of a connection to a source of business data, as
well as mapping of that data from the source format to the database tables and columns required in FlexNet
Manager Suite. The data from ServiceNow is handled as business data, and therefore data transfers make
use of business adapters.

• The "Business Adapter Studio" is a utility available on each inventory beacon for customizing and testing
business adapters.

• The "Business Importer" is the process that exercises the business adapters to the schedule you define, and
controls each import as defined in its business adapter.

In previous tasks, you have configured ServiceNow to run two exports that queue data about hardware assets
and contracts and send it to the MID server of your choice. On the MID server, the data is written into XML
files. Once these have been completed, two business adapters running on your inventory beacon collect this
data and upload it to your central operations databases. You must use the following process to configure these
business adapters before they can operate.

Tip: Clearly, the inventory beacon and the ServiceNow MID server must access a common folder for the
transfer of the XML files. It is possible that the FlexNet Beacon software and the ServiceNow MID server are
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installed on the same physical machine; but if they are on separate machines, network access allowing a file
share is required. This means you may need to grant at least read access for the share on your MID server to
two accounts on your inventory beacon:

• The local administrator account with which you will log in now for configuring and testing your business
adapters

• The account that runs your FlexNet Beacon Service, which will exercise the business adapters in production
(by default, this is the local SYSTEM account on your inventory beacon).

As well as access to the MID server, your inventory beacon requires access to the unzipped archive you
downloaded for the ServiceNow integration package to complete this process.

To configure an inventory beacon for importing data for FlexNet Manager Suite:

1. On your chosen inventory beacon, log in as a local administrator.

2. If necessary, validate that, from this server, you can access the file share where the MID server saves the
completed XML files.

3. In the unzipped archive you downloaded for the ServiceNow integration package, open the Importer

folder and locate the two business adapters ServiceNowAssets.xml and ServiceNowContracts.xml.

4. Copy these two files to the business adapters folder, %CommonAppData%\Flexera Software\Beacon\
BusinessAdapter, on the inventory beacon.

5. Start the FlexNet Beacon software from the Windows start menu on the inventory beacon, using the Run
as administrator option.

6. In the interface for FlexNet Beacon, select the Business Importer page from the Connections group (in
the left-hand navigation pane).

The two adapters appear in the list of available business adapters.

7. For each of these adapters in turn, select the adapter from the list, and click Edit.... In the following dialog,
click Edit Adapter.

The Business Adapter Studio opens, editing this adapter.

8. In the Business Adapter Studio, select the top level import node (like ServiceNowAssets or
ServiceNowContracts) and locate the File name field. Complete the file path and file name for the
appropriate XML file on the MID server. If you have already exported data from ServiceNow to the MID
server, you may click the ... button and browse to the respective XML file in the folder on the MID server.

The following example from the assets adapter shows a path when the MID server and inventory beacon are
installed on the same physical computer:

C:\ServiceNow\MyMIDServerFolder\agent\x_fls_flexera_fnms_asset.xml

The following example from the contracts adapter shows a path when the MID server is separate, using
UNC format:

\\MyMIDServer\ServiceNow\MyMIDServerFolder\agent\

x_fls_flexera_fnms_contracts.xml
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9. When the file path and name are identified, click Refresh (just below the ... button).

10. Save the modified adapter; and repeat the process for the other adapter.

11. When both are completed and saved, close Business Adapter Studio.

12. If you have not already created the schedule(s) on which you want to run these adapters, switch to the
Scheduling page of the FlexNet Beacon interface, and create one or two now.

You may run these two business adapters on the same schedule, as the inventory beacon queues them
and runs them one after the other.

Important: Remember that there is a delay between when the scheduled job starts executing in
Service Now, and when the MID server finishes assembling the transmitted chunks into a valid XML file.
You can test the elapsed time for your environment by triggering each export, and waiting until, in the
Export Runs view (in ServiceNow), it reaches the Succeeded state. Allow a safety buffer for future data
growth, and set the schedule for the business adapters to run after the exports and assembly of the XML
files are completed.

13. In the Business Importer page of the FlexNet Beacon, select each adapter in turn, and:

a. Click Schedule....

b. From the list of available schedules, select the one for each adapter.

c. Click OK.

d. Ensure that the adapter is marked as Enabled.

e. Repeat for the other adapter.

14. At the bottom of the inventory beacon interface, click Save to store your changes.

15. Optionally, if you have test data waiting for a system check, you can select each adapter in turn, and click
Execute Now.

The Business Importer takes the raw data from XML files, transforms it into the formats required for
FlexNet Manager Suite, and uploads it to the central application server.

To check the status of imports, navigate to the system menu ( in the top right corner) of the web interface
for FlexNet Manager Suite and choose either Data Inputs (in the Business Data tab) or System Health >
System Tasks.

Tip: If you need to interrupt the export from ServiceNow, disable the scheduled jobs in ServiceNow, and
disable the relevant schedule(s) in FlexNet Beacon.

Setting up Data Flows from FlexNet
Manager Suite to ServiceNow
For records of applications and hardware inventory, FlexNet Manager Suite is considered the authoritative
source of truth. Data on applications and inventory, as well as contracts, can be exported from FlexNet Manager
Suite to ServiceNow. In summary, the process is:
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1. On the batch server for FlexNet Manager Suite, a Microsoft scheduled task Export to ServiceNow

initiates the process.

2. The scheduled task launches an exporter utility for FlexNet Manager Suite which extracts the appropriate
data and transfers it to ServiceNow using API calls.

3. In ServiceNow, the FlexNet Manager Suite Integration application processes the data received through
the API calls, and schedules imports of that data using the ServiceNow Import Set.

Tip: The Transform Maps used during import to switch data from one product's formats to the other are
also defined in the integration application.

If you wish to make use of this data flow, you need to complete the following processes:

• Configuring ServiceNow for Import

• Configuring FlexNet Manager Suite for Export.

• Optionally, you may customize the export from FlexNet Manager Suite using the guidelines in Configure the
Utility for Export from FlexNet Manager Suite

Configuring ServiceNow for Import
Continue the following while still (or again) logged into ServiceNow with administrator privileges:

1. In the ServiceNow navigation bar, expand FlexNet Manager Suite and Advanced, and click OAuth.

2. In the Application Registries page, click FNMS OAuth Provider.

The OAuth provider details are displayed.

3. On the right side, for the Token URL control, click the padlock icon to allow editing, and replace the
YOUR-INSTANCE placeholder with the name of your ServiceNow instance (visible in your browser URL
field). When done, click the padlock icon again.

4. Repeat that editing process for the Redirect URL, replacing YOUR-INSTANCE with your ServiceNow
instance name.

5. Scroll to the bottom of the page, and click Update.

6. In the FlexNet Manager Suite group in the navigation bar, click Generate Token.

7. From the account details you created earlier (see Creating a ServiceNow User), insert the user ID in the
Usernamefield and supply the Password, and click Generate OAuth Token.

A long Refresh Token appears at the top of the page.

8. Copy this Refresh Token value, and transfer to the web interface of FlexNet Manager Suite.

Important: As configured immediately after installation, the integration application does not allow
records that are marked for deletion in FlexNet Manager Suite to be deleted in ServiceNow. This
prevents any surprise or accidental deletions during testing and configuration. However, in production,
since you have set FlexNet Manager Suite as the source of truth for hardware inventory and application
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installations, the normal practice would be to allow records in ServiceNow to be removed automatically
once marked for deletion in FlexNet Manager Suite. To modify the settings, continue with the next
steps.

9. When ready to go into production, and as aligned with your corporate policies, decide whether to allow
records in ServiceNow to be deleted once they have been deleted in FlexNet Manager Suite. To allow this:

a. In ServiceNow, navigate to FlexNet Manager Suite > Advanced > Integration Properties.

b. In that page, set the check box for Set this to YES to delete inventory in ServiceNow if it is
deleted in FNMS. This allows hardware inventory records to be deleted in ServiceNow when you
have deleted them from FlexNet Manager Suite.

c. Similarly, set the check box for Set this to YES to delete installation in ServiceNow if it is
deleted in FNMS. This allows application installation records to be deleted in ServiceNow when
you have deleted them from FlexNet Manager Suite.

d. Click Save at the bottom of that page.

Configuring FlexNet Manager Suite for Export
You need to complete this configuration once to commence operations. Repeat if your ServiceNow details
change at any time in the future. You may also use this same page to trigger an immediate export from
FlexNet Manager Suite to ServiceNow.

To configure export from FlexNet Manager Suite:

1. Ensure that you are (still) logged into FlexNet Manager Suite with an account that is a member of the
Administrator role, and that this account has the Configure access right.

2. In the web interface, navigate to the system menu ( in the top right corner) > System Settings, and
select the ServiceNow tab.

Tip: The ServiceNow tab is only visible when your account has the access rights described above.

3. In Instance URL, enter the protocol and path to your ServiceNow website (for example, https://YOUR-
INSTANCE.service-now.com).

4. In Username, enter the account you use to access ServiceNow. This must exactly match the User ID value
shown in the ServiceNow interface (see Creating a ServiceNow User).

5. Paste the Token value from ServiceNow into the Token field on this page (see Configuring ServiceNow
for Import).

Tip: The Username is mandatory for FlexNet Manager Suite to commence the export process, but it is
not transferred back to ServiceNow, as the Token value alone is now sufficient for authentication.

Note: In future, if you wish to temporarily disable these data exports from FlexNet Manager Suite, you
can either disable the edit the Windows scheduled task Export to ServiceNow or remove any one or
more values from Instance URL, Username, or Token.
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6. If necessary, change the default selection of data types to export to ServiceNow. It is best practice to
export all available data types.

Warning: Hardware inventory details are critical to the ServiceNow data set. Contracts and
applications both have dependencies on assets in that system. If you clear the Hardware inventory
check box, you may produce gaps in the contract and software records imported into ServiceNow.

7. Click Save.

When details are complete, the export from FlexNet Manager Suite to ServiceNow is triggered weekly at
3am on Sunday mornings by default (if required, you may edit the Windows scheduled task Export to

ServiceNow to modify the schedule). If you need to trigger an additional export (for example, when
commencing integrated operations), continue with the rest of this process.

Tip: While the first export of any given data type is always a full export of all relevant data, subsequent
data transfers from FlexNet Manager Suite to ServiceNow are differential (that is, only data that is new
or changed since the last export of the same type is included). If you wish to make your additional export
transfer all available data (rather than the differential data set), select the Perform full export check
box before continuing.

8. Optionally, click Export to trigger an immediate export using the settings saved in the fields displayed
above.

Tip: The export from FlexNet Manager Suite to ServiceNow is delayed if any of the following processes
are already running:

• A previous instance of the export to ServiceNow

• An inventory import

• A license reconciliation.

The Export button, and the scheduled task, trigger the command-line executable
fnmp_servicenow_export.exe, which:

• Extracts the required data of the first data type from your operations database (the normal order when
all are selected is inventory, contracts, applications)

• Segments the data for easier transmission across the Internet, minimizing time-out risks with
ServiceNow

• Reassembles the data into staging tables in ServiceNow

• Repeats the process for the next selected data type.

Separate transforms on your ServiceNow instance then map each data type from the staging tables to
your operational ServiceNow CMDB.

Tip: It is also possible to run the executable from the command line, provided you have a copy of the
ServiceNow token available (see Command-line Tool for Export to ServiceNow).

To verify progress of a test run:
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1. In the ServiceNow navigation bar, expand FlexNet Manager Suite > Import Transactions. Each of these
transactions represents a data chunk* or segment transferred to ServiceNow. The segmentation is
necessary because of the large number of records that may need to be transferred. When the data is
received by ServiceNow, the integration application separately schedules each transaction for import into
the operational database tables in ServiceNow. As each transaction is completely imported, its State
column value is set to Succeeded.

2. Similarly, navigate to FlexNet Manager Suite > Import Runs. Each data type exported from FlexNet
Manager Suite creates a separate entry here for import into ServiceNow. For each data type, when all its
individual transactions have succeeded, the State value on the overall Import Run is also set to
Succeeded.

3. Finally, when all the data types transferred have been successfully imported, a status report is sent to
FlexNet Manager Suite. On the System Settings page in the ServiceNow tab, the status is displayed
under Last completed export.

* The default configuration for data transfers from FlexNet Manager Suite to ServiceNow uses these values:

• The number of database records included in each transferred segment: 8000

• The number of retries if ServiceNow returns a connection failure: 10

• The length of time to wait for ServiceNow to respond before timing out: 30 seconds

• The maximum number of records of each data type to be included in the transfer, by type:

◦ Inventory: 500,000

◦ Contracts: 500,000

◦ Applications: 2,000,000.

For details of configuring these additional elements in an on-premises implementation, see Configure the
Utility for Export from FlexNet Manager Suite.

Configure the Utility for Export from FlexNet
Manager Suite
Optionally, the configuration file for the export utility may be customized to suit your environment.

Several settings for the utility for exporting data from FlexNet Manager Suite are configurable, including

• The maximum number of records for each data type (applications, contracts, and inventory) that may be
transferred to ServiceNow in each export

• The maximum number of records in each data segment or 'chunk' transferred

• Log file location

• Maximum retries after failure of a web request.

All reside in one configuration file, called fnmp_servicenow_export.exe.config, located in the same folder
as the executable fnmp_servicenow_export.exe (which performs the data export from FlexNet Manager
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Suite to ServiceNow) on your batch server (or, in a smaller implementation, the server hosting the equivalent
functionality). The default path is installation-directory\DotNet\bin\ServiceNowExport.

To configure exports from FlexNet Manager Suite:

1. Save a backup copy of the configuration file, for example as
fnmp_servicenow_export.exe.config.orig, so that you can revert if there are problems.

2. Open the configuration file fnmp_servicenow_export.exe.config in your preferred XML or plain text
editor. (Do not edit in a word processor that cannot save plain text files.)

3. Optionally, customize the values for data segmentation, retries, and timeout when the executable is
accessing ServiceNow.

Path/element Attribute Default Notes

<configuration>

<fnmpGroup>

<fnmp>

<baseConfig />

maxRetries "10" When ServiceNow is not
responding, the executable will
retry each connection (one for
each data segment being
transferred) this many times. If
this number of retries is reached
for any data segment, the export
fails. Each successful connection
resets the count to zero. (If this
attribute is omitted, the
executable uses a default value
of 10.)

<configuration>

<fnmpGroup>

<fnmp>

<baseConfig />

timeout "30000" The maximum number of
milliseconds to wait for a
response from ServiceNow. This
timer is applied independently
to each connection request (at
least one per data segment
being transferred). If ServiceNow
does not respond within this
interval (default 30 seconds), a
new request is issued (up to
maxRetries). (If this attribute is
omitted, the executable uses a
default value of 30000.)

<configuration>

<fnmpGroup>

<fnmp>

<application />

maxRows "500000" Specifies the maximum number
of application records that can
be exported in a single export.
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Path/element Attribute Default Notes

<configuration>

<fnmpGroup>

<fnmp>

<contract />

maxRows "500000" Specifies the maximum number
of contract records that can be
exported in a single export.

<configuration>

<fnmpGroup>

<fnmp>

<inventory />

maxRows "500000" Specifies the maximum number
of hardware inventory records
that can be exported in a single
export.

<configuration>

<fnmpGroup>

<fnmp>

<records />

numRecords "2000" The number of records in each
XML-based data segment to be
transferred from FlexNet
Manager Suite to ServiceNow.
To avoid time-out issues with
ServiceNow, the total exported
data (in each of the three
available types) is chunked into
segments containing a
maximum of this number of
records.

4. Optionally, configure the location for your log files.

Path/element Attribute Default Notes

<configuration>

<log4net>

<appender>

<file />

value "C:\Temp

\Log

\ServiceNow_

date.log"

(All on one line)

You may adjust the path to
store the log files to suit your
preference. For on-premises
installations, you may also
change the file name.

With the other default values for the elements under appender, multiple passes on the same date
append to the end of the log file, and a new log file is commenced each day.
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3
Operational Details

Standard operation is automatic.

The exchange of data between ServiceNow and FlexNet Manager Suite happens in a pair of independent
processes driven by schedules (either Windows scheduled tasks or schedules built in to the products).

As these schedules by default run on a weekly cycle, you may expect the data to be synchronized after the weekly
runs and up until either system is subsequently updated. If you require an intermediate synching after an
important update to one system or the other, you can also trigger either process manually.

The process flows are described in detail in the following topics. Notes about configuration and customization
are included.

For your on-premises implementation of FlexNet Manager Suite, the command-line utility is also documented
here, should you choose to run that directly.

Process for Exports from ServiceNow to
FlexNet Manager Suite
Here is how the import of data from ServiceNow works.

Prerequisites

• You have licensed the option for ServiceNow integration from Flexera. As previously mentioned (see
Prerequisites), this license authorizes all communications through the integration package.

• You have loaded the XML customization into your ServiceNow instance (see Installing the FlexNet Manager
Suite integration application for ServiceNow).

• Your MID server (Setting up a MID Server) is accessible across the network from your inventory beacon, and
read permissions have been set on the file share on the MID server for the accounts used on the inventory
beacon (Configuring FlexNet Beacon for Import).

• The two supplied business adapters for reading asset data and contract data from ServiceNow are configured
on your inventory beacon.
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Process Details

1. Two scheduled reports are run independently in ServiceNow.

Note: These reports are visible in System Definition > Scheduled Jobs as Export Assets from
ServiceNow and Export Contracts from ServiceNow. Click the report names to make them active
or inactive, to modify the schedule, or to execute either one immediately.

2. When either report is triggered:

a. ServiceNow adds a record in the FlexNet Manager Suite > Export Runs view (for information about
the main columns, see Export Runs Properties).

b. Database views gather the required data in ServiceNow. These views are accessible in the FlexNet
Manager Suite > Advanced > Database Views page:

• For assets, the view x_fls_flexera_fnms_asset reads from the alm_hardware,

cmdb_ci_computer, and sys_user database tables.

• For contracts, the view x_fls_flexera_fnms_contract reads from the cmdb_model and

ast_contract database tables.

Tip: To preview the records for an export (without actually invoking the export), click the view name
in that page to display the properties of the view; and under the Related Links heading, click Try

It.

c. In the installation folder of your MID server, any previous XML file is overwritten, replaced with the
opening tags for the new XML file. This XML file is named for the database view used to extract its
data.

d. Data is transferred to the MID server in segments (to prevent time-out issues with large files), and
gradually assembled into the XML file.

e. The closing tags for the XML file are written.

f. In Export Runs, ServiceNow updates the state to Succeeded.

3. Two independent business adapters from FlexNet Manager Suite (on potentially independent schedules)
connect from your inventory beacon to your MID server, and collect the latest XML files saved there,
converting them into the intermediate data form required for business data uploads. (For details of the
mapping between source data in ServiceNow and destination fields in the FlexNet Manager Suite database,
see Business Adapter Mappings.)

Important: The business adapters will fail if they are run while the XML files on the MID server are
incomplete. Be sure that the schedules for export from ServiceNow, and the running of the business
adapters, allow sufficient time for the export to be completed. For large datasets, this may be several
hours.

4. As the adapters complete their run, the dataset is uploaded immediately to the application server for
FlexNet Manager Suite. (There is also a catch-up upload task that runs overnight to retry any failed
uploads.)
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5. On a separate schedule, the batch server starts a business import job. This imports data from the data
package into the FlexNet Manager Suite database.

At the completion of this process, data exported from ServiceNow is reflected in your FlexNet Manager Suite
data set.

Export Runs Properties
These are the major properties of the entries in the FlexNet Manager Suite > Export Runs view created as
ServiceNow commences each data export.

Column Notes

Number An automatically-generated sequential numbering of each created record in this
listing.

Export Type The type of data being exported, either Contract or Asset.

Stage May have the following values:

• File Creation — Displayed when the integration application sends the

opening XML tag to the MID Server to be commence writing the XML file.

• Data Collection — Displayed while the integration application gathers the

data and sends it to MID Server to be written into the XML file. The data is
sent in multiple chunks of 500 records each.

• File Completion — Displayed when the closing XML tag has been sent to

the MID Server.
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Column Notes

State Provides additional insight into the Data Collection stage in particular. Values
include:

• New — This default state is set when a record is created in the Export Runs

listing.

• Processing — The integration application is reading from the ServiceNow

database and compiling a chunk of data.

• Processed — All database records required for the current chunk (maximum:

500) have been prepared.

• Waiting — The data chunk is being transferred to the MID server.

• Ready — The MID server has notified that the data chunk has been added to

the XML file. At this point, the integration application sets the state back to
Processing and prepares the next chunk of data.

• Succeeded — All data chunks have been transferred, and no more are

required.

• Failed — For some reason (unspecified here), the export has failed.

Counter The number of database records that the integration application has read and
processed. Because the data is transferred to the MID server in a number of
chunks, the counter value is used as a cursor for reading the correct records
from the database for the next data chunk.

Business Adapter Mappings
Two business adapters are supplied as a standard part of the ServiceNow integration package for FlexNet
Manager Suite, and are used in the process of transferred asset and contract data from ServiceNow to FlexNet
Manager Suite. The following lists show the source data from ServiceNow, and the target (destination) fields in
FlexNet Manager Suite, for each of these adapters in turn.

Tip: For special purposes, mappings can be added, removed, or changed by editing the business adapter(s) in
Business Adapter Studio on your inventory beacon.

In each listing, the first field shown is used for matching existing records (a key). During import, if the value in
this field already exists in the compliance database, the record is updated with the other values imported for
this item. Otherwise, a new record is automatically created in FlexNet Manager Suite.

In both listings below, "display" names are the names visible in the two products' web interfaces; and the
Source Field column shows a compound name made up of:

• An abbreviated reference to a ServiceNow database table name (see below)

• An underscore character
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• The field name in the relevant database table (which name may contain additional underscores).

The mapping of the abbreviated references to the actual database table names in the ServiceNow database is:

• acntrct represents ast_contract

• ahrdwr represents alm_hardware

• cicomp represents cmdb_ci_computer

• cmdbmdl represents cmdb_model

• sysusr represents sys_user.

Assets Imports

• Business adapter file name: ServiceNowAssets.xml

• Original data source: ServiceNow database view x_fls_flexera_fnms_asset

• Destination table in FlexNet Manager Suite database: Asset

Source Display Name Source Field Target Display Name Target Field

Serial number cicomp_serial_number Serial Number SerialNumber (key)

Asset tag ahrdwr_ asset_tag Asset Tag AssetTag

Configuration Item ahrdwr_ci Name ShortDescription

Installed cicomp_install_date Installed on InstallationDate

Manufacturer cicomp_manufacturer Manufacturer Manufacturer

Model number cicomp_model_number Model ModelNo

Status ahrdwr_

install_status

Status AssetStatusID [Note 1]

Notes:

1. AssetStatusID is a foreign key to the AssetStatus table, from which display values are drawn.

Note: AssetStatusID is a mandatory field for asset records in FlexNet Manager Suite. If a record in
ServiceNow has a Status value that does not exist in FlexNet Manager Suite:

• The new status value is inserted into the AssetStatus table (you may also need to customize localized

values of this status, if other languages are in use within your enterprise)

• An AssetStatusID is automatically created for this new entry

• The AssetStatusID is inserted into the asset record.

If you are 'round-tripping' this data (that is, copying it back from FlexNet Manager Suite to ServiceNow at
some future point, to maintain synchronization), the new value is returned when appropriate.
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Contracts Imports

• Business adapter file name: ServiceNowContracts.xml

• Original data source: ServiceNow database view x_fls_flexera_fnms_contract

• Destination table in FlexNet Manager Suite database: Contract

Source Display Name Source Field Target Display Name Target Field

Contract number acntrct_vendor_ contract Contract no. ContractNo (key)

Description acntrct_description Information Comments

Display name cmdbmdl_display_name Contract type ContractTypeID [Note
1]

Ends acntrct_ends Expiry date EndDate

Short description acntrct_short_description Description ContractName

Starts acntrct_starts Start date StartDate

State acntrct_state Status ContractStatusID

[Note 2]

Notes:

1. ContractTypeID is a foreign key to the ContractType table, from which display values are drawn. Also
see note below.

2. ContractStatusID is a foreign key to the ContractStatus table, from which display values are drawn.

Note: ContractTypeID is a mandatory field for contract records in FlexNet Manager Suite. If a record in
ServiceNow has a Display name value that does not exist in FlexNet Manager Suite:

• The new contract type is inserted into the ContractType table (you may also need to customize localized

values of this type, if other languages are in use within your enterprise)

• An ContractTypeID is automatically created for this new entry

• The ContractTypeID is inserted into the contract record.

If you are 'round-tripping' this data (that is, copying it back from FlexNet Manager Suite to ServiceNow at
some future point, to maintain synchronization), the new value is returned when appropriate.
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Process for Exports from FlexNet Manager
Suite to ServiceNow

Prerequisites

• You have licensed the option for ServiceNow integration from Flexera. As previously mentioned (see
Prerequisites), this license authorizes these exports, as well as all other communications through the
integration package.

• The utility fnmp_servicenow_export.exe is installed in installation-directory\DotNet\bin\

ServiceNowExport (see Prerequisites).

• The configuration file fnmp_servicenow_export.exe.config in installed in the same directory, and

customized to your requirements (for example, for logging).

• A Windows scheduled task Export to ServiceNow is configured to trigger the utility (by default, weekly at

3am on Sunday morning).

• The "emergency switch" has not been turned off to interrupt exports (this is a value in the
ComplianceSettings database table, EnableServiceNowExport). Naturally, this defaults to on, allowing

exports.

Process Details

1. On your central application server, the scheduled task triggers the utility (fnmp_servicenow_export.exe).

Tip: If you are in an administrator role, you can also trigger an export through the web interface for
FlexNet Manager Suite. Navigate to the system menu ( in the top right corner) System Settings >
ServiceNow.

The executable performs the following checks:

• It validates all the command-line parameters. If validation fails, it exits with code 4 on the command line,

or shows an error in the web interface (under Last completed export on the same page).

• It checks for a valid license from Flexera for the ServiceNow integration option. If the license is not
found, it exits with code 3 on the command line, or shows an error in the web interface.

• It checks the connection to ServiceNow, passing the credentials you have configured. (Failure writes an
exit code of 2 to the command line.) If the credentials are good, ServiceNow passes back a connection

code. If the command-line parameter -connectionTest is true, the executable exits with code 0 on the

command line, and the process ends at this point.

2. The utility checks whether ServiceNow is able to accept an import at this time:

• It checks whether a record in Scheduled Data Imports, and another in Data Sources, have been

created by the integration application. (Links to the relevant pages where you can inspect the records in
ServiceNow are under FlexNet Manager Suite > Advanced.)
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• It ensures that no prior import is already in process, checking that there is no record in the Import Runs

table or the Import Transactions table that are incomplete (that is, have a State other than

Succeeded or Failed). Both lists are available for inspection in the FlexNet Manager Suite group.

If either of the checks fails, the utility abandons the export and displays an appropriate error.

3. The utility checks the connection with the operations databases for FlexNet Manager Suite. (If there is any
failure, the utility abandons the export and displays an appropriate error.)

4. All being well, the data export, transfer, and import processes are run for all data types (unless any of them
have been specifically excluded) in the following order:

a. Hardware inventory and assets

b. Contracts

c. Applications and installation details.

Caution: In ServiceNow, contracts and applications/installations both have dependencies on
computers/assets. It is recommended that you do not exclude the hardware inventory and asset
transfer, as this may result in unpredictable gaps in other records when the correct dependencies
cannot be established.

The data is collected in the way specified by the command-line options, for which see Command-line
Tool for Export to ServiceNow. To prevent timeout issues, each data set is split into segments for
transfer to ServiceNow. Each segment is identified with a transaction id, transaction type, and the data
in an XML file. ServiceNow returns a connection code for each segment of data.

• If the connection code shows a failure, the segment is retransmitted for a maximum number of tries
(the default value of 10 can be changed in the configuration file), after which the utility exits
(skipping any remaining exports) and returns 1 to the command line.

• While success continues, the utility waits for each stage to complete before commencing the next
stage (although it does not wait for a result after the last segment of application data is uploaded).

5. In ServiceNow, as the first data segment is received, the integration application creates a record in the
Import Runs table. (For details of the main columns in the Import Runs table, see Import Runs
Properties.)

6. For each data segment (including the first), ServiceNow creates a record in the Import Transactions

table. (For details of the main columns in the Import Transactions table, see Import Transactions
Properties.)

7. When the transaction record is created, it returns a success code to FlexNet Manager Suite, which then
processes and transmits the next data segment. This loop continues until all the records of a particular
export type have been transmitted.

8. In ServiceNow, the inbound data segments are written to staging tables (visible in the navigation panel
under FlexNet Manager Suite) based on the transaction type:

Transaction type Import Set Table

application_export Application Imports
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Transaction type Import Set Table

contract_export Contract Imports

inventory_export Inventory Imports (note that this is hardware inventory)

connection_test Not applicable

export_status Not applicable

9. In ServiceNow, the integration application uses the Scheduled Data Imports and Data Sources records
to process each Import Transaction record. The integration application queues the transaction records,
and as each record is processed sets its State to Succeeded. When all the transaction records for an
Import Run are completed, the integration application also sets the State to Succeeded.

10. During this processing loop, FlexNet Manager Suite continues polling the API for status. Only when it
receives a successful completion message does it resume the process with the next required data type.

11. When the data has been collated from the individual transactions to the staging tables, Transform Maps
are executed to map the fields in the import set tables to fields in ServiceNow database tables. The final
tables for data from each transaction type are shown below. (For a complete set of the transform
mappings, see Transform Maps for ServiceNow Integration.)

Transaction type Ultimate Data Tables in ServiceNow

application_export Software Models, Discovery Models, and Software
Installations (all in the Software Asset Management group).
The process updates the tables in the order above, as later
tables reference the previous one.

contract_export Contracts (Navigate to Contracts Management > Contracts
> All)

Tip: Check the Contract used by field near the bottom of
the page of contract properties. This references all
computers linked to the contract.

inventory_export Computers (Navigate to Computers Table.Configuration >
Base Items > Computers)

12. When all the data has been transformed into the ServiceNow database, a check is made of the system
properties controlling deletion of records. These are visible in FlexNet Manager Suite > Advanced >
Integration Properties page, as check boxes for Set this to YES to delete dataType in ServiceNow if it
is deleted in FNMS (where dataType is either inventory (hardware) or installation (of applications). When
true (expected for normal operations, but requiring your configuration as described in Installing the
FlexNet Manager Suite integration application for ServiceNow), all the affected tables in ServiceNow are
checked for items on which the data flag u_fnmp_isdeleted has been raised by FlexNet Manager Suite.
These items are now deleted to bring the data sets into alignment.

Tip: If you do an initial import (which is always a full import rather than a differential one) with these
preferences turned off, the records of computers deleted in FlexNet Manager Suite are not created in
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ServiceNow. If you subsequently turn these options on to make FlexNet Manager Suite the source of truth
for hardware inventory and application installations, you should force another full export so that any
records already in ServiceNow but marked for deletion in FlexNet Manager Suite are cleaned up.

At the completion of this process, data exported from FlexNet Manager Suite is reflected in your ServiceNow
data set.

Import Runs Properties
These are the major properties of the entries in the FlexNet Manager Suite > Import Runs view created as
ServiceNow commences each data import.

Column Notes

Number An automatically-generated sequential numbering of each created record in this
listing.

Import Id A GUID created by FlexNet Manager Suite as it exports the data, used to track
activity and exchanges for this particular import into ServiceNow.

Import Type The type of data being imported, being one of Asset (for inventory data),
Contract, or Application.

State Values include:

• New — This default state is set when a record is created in the Import Runs

listing.

• Waiting — ServiceNow has received the final data chunk for the particular

Import Type.

• Succeeded — All data chunks for this Import Run have been processed by

ServiceNow.

• Failed — For some reason (unspecified here), the import has failed.

Import Transactions Properties
These are the major properties of the entries in the FlexNet Manager Suite > Import Transactions view
created as ServiceNow receives each data segment for import.

Column Notes

Number An automatically-generated sequential numbering of each created record in this
listing.

Import Run The ID of the import run of which this transaction is a part.
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Column Notes

Import Type The type of data being imported, being one of Asset (for inventory data),
Contract, or Application.

State Values include:

• New — This default state is set when a record is created in the Import

Transactions listing.

• Waiting — ServiceNow is processing another transaction received earlier.

• Processing — Set when the integration application invokes import of this

transaction.

• Succeeded — ServiceNow has completed the import of this transaction.

• Failed — For some reason (unspecified here), the import of the transaction

has failed.

Payload The segment of data, in XML format, that makes up this transaction.

Transform Maps for ServiceNow Integration
These transform maps map hardware, license, and contract data collected from FlexNet Manager Suite into
ServiceNow.

Data collected from FlexNet Manager Suite is initially held in staging tables within ServiceNow, and must be
transformed for insertion in the operational tables in your ServiceNow implementation. For example, the FNMP

Inventory Imports set has columns that are matched with the Computers table in ServiceNow. Contract
data is first mapped into the Contracts table in ServiceNow, and a second Transform Map is run to provide
links to relevant Configuration Items (Computers).

The following tables show the standard transformations from the staging tables (the source) to operational
tables (the target) within ServiceNow. Items marked [Script] involve a data transformation, which may
involve finding the foreign key to another record, or conversion of units such as bytes to MB.

In each transform, the "(key)" fields are used for record matching. If a record already exists with identical values
for fields so marked, it is updated; and if not, a new record is created.

Note: There are specialized properties (three for the computer transforms, and two for the remainder) that
define:

• Whether a new record should be created in ServiceNow when a match for incoming data is not found

• Whether an existing record should be updated when a match is found

• (For computer transforms only) whether a record marked for deletion in FlexNet Manager Suite should be
deleted from ServiceNow.

These properties can be modified in ServiceNow by navigating to FlexNet Manager Suite > Advanced >
Integration Properties. For more information, see Configuring ServiceNow for Export (final step).
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Computer Transform

• Original data from FlexNet Manager Suite: Inventory.

• Target table in ServiceNow: cmdb_ci_computer

Source Display
Name

Source Field Target Display
Name

Target Field

SerialNo (key) u_serialno Serial number serial_number

[Script] [Script] RAM (MB) ram

[Script] [Script] Correlation ID correlation_id

[Script] [Script] Disk space (GB) disk_space

AssetID u_assetid FlexNet Asset ID x_fls_flexera_fnms_asset_id

CalculatedUser u_calculateduser Calculated User x_fls_flexera_fnms_calculated_user

ChassisType u_chassistype Chassis type chassis_type

ComputerID u_computerid FlexNet Computer
ID

x_fls_flexera_fnms_computer_id

ComputerName u_computername Name name

ComputerStatus u_computerstatus Status
(hardware_status)

hardware_status

ComputerType u_computertype Subcategory subcategory

DiscoveredDate u_discovereddate Discovered date x_fls_flexera_fnms_discovered_date

Domain u_domain Domain sys_domain

InventoryConnection
Name

u_inventoryconnection
name

Inventory
Connection

x_fls_flexera_fnms_inventory_connection

InventorySource u_inventorysource Inventory Source x_fls_flexera_fnms_inventory_source

IPAddress u_ipaddress IP Address ip_address

IsDeleted u_isdeleted Is deleted x_fls_flexera_fnms_isdeleted

LastLoggedInUser u_lastloggedinuser Last logged in user x_fls_flexera_fnms_last_logged_in_user

MACAddress u_macaddress MAC Address mac_address

Manufacturer u_manufacturer Manufacturer manufacturer

MaxClockSpeed u_maxclockspeed CPU speed (MHz) cpu_speed

ModelNo u_modelno Model ID ->
model_number

model_id

ModelNo u_modelno Model number model_number

NumberOfCores u_numberofcores CPU core count cpu_core_count

NumberOfProcessors u_numberofprocessors CPU count cpu_count
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Source Display
Name

Source Field Target Display
Name

Target Field

NumberOfThreads u_numberofthreads CPU core thread cpu_core_thread

OperatingSystem u_operatingsystem Operating System os

ProcessorType u_processortype CPU type cpu_type

Computer Model Transform

• Original data from FlexNet Manager Suite: Inventory.

• Target table in ServiceNow: cmdb_model

Source Display Name Source Field Target Display Name Target Field

ModelNo (key) u_modelno Model number model_number

ChassisType u_chassistype Type type

ComputerType u_computertype Model categories cmdb_model_category

Manufacturer u_manufacturer Manufacturer manufacturer

ModelNo u_modelno Name name

Contracts Transform

• Original data from FlexNet Manager Suite: Contracts.

• Target table in ServiceNow: ast_contract

Source Display Name Source Field Target Display Name Target Field

ContractNumber (key) u_contractnumber Contract number vendor_contract

ContractName u_contractname Description short_description

ContractStatus u_contractstatus State state

ContractType u_contracttype Short Description short_description

EndDate u_enddate Ends ends

IsDeleted u_isdeleted Is deleted x_fls_flexera_fnms_is_deleted

StartDate u_startdate Starts starts

Vendor u_vendor Vendor vendor

Contract Instance Transform

• Original data from FlexNet Manager Suite: Contracts.

• Target table in ServiceNow: ast_contract_instance
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Source Display Name Source Field Target Display Name Target Field

ContractNumber (key) u_contractnumber Contract ast_contract ->
vendor_contract

ContractType u_contracttype Contract Type contract_type

See note. See note. Configuration Item ci_item

Note: Script is run to query cmdb_ci_computer table. If the CI is found, the script returns the sys_id for
REF. If the CI is not found, this field is left blank.

Software Installation Transform

• Original data from FlexNet Manager Suite: Application.

• Target table in ServiceNow: cmdb_sam_sw_install

Source Display
Name

Source Field Target Display
Name

Target Field

ApplicationID (key) u_applicationid FlexNet Application ID x_fls_flexera_application_id

[Script] (key) [Script] Installed on installed_on

[Script] [Script] Is deleted x_fls_flexera_fnms_is_deleted

ApplicationVersion u_applicationversion Version version

DiscoveredAt u_discoveredat Last Discovered x_fls_flexera_fnms_last_discovered

DiscoveredBy u_discoveredby Discovered by x_fls_flexera_fnms_discovered_by

DisplayName u_displayname Display name display_name

FlexeraID u_flexeraid Discovery model ->
prod_id

discovery_model

FlexeraID u_flexeraid Prod id prod_id

LastScanned u_lastscanned Last scanned last_scanned

Publisher u_publisher Publisher publisher

Software Model Transform

• Original data from FlexNet Manager Suite: Application.

• Target table in ServiceNow: cmdb_software_product_model

Source Display
Name

Source Field Target Display
Name

Target Field

FlexeraID (key) u_flexeraid FlexNet Manager Id x_fls_flexera_fnms_id
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Source Display
Name

Source Field Target Display
Name

Target Field

ApplicationName u_applicationname FlexNet Application
Name

x_fls_flexera_fnms_application_name

ApplicationVersion u_applicationversion Version version

Classification u_classification Type type

FlexeraID u_flexeraid Short description short_description

ProductName u_productname Name name

Publisher u_publisher Manufacturer manufacturer

Command-line Tool for Export to ServiceNow
This tool extracts data from the FlexNet Manager Suite operations database, and imports it into ServiceNow.

Note: This utility may be triggered in three different ways:

• Automatically by a scheduled task

• Manually by an operator through the web interface for FlexNet Manager Suite. Navigate to the system

menu ( in the top right corner) System Settings > ServiceNow.

• From the command line, as described in this topic.

In all cases, it exports the data specified to ServiceNow. However, when it is run manually from the command
line, the behavior of the utility then differs: it does not update the results in the web interface for FlexNet
Manager Suite. For this reason, automatic operations are the preferred method of operation; but this
command line is available for testing and troubleshooting.

Syntax:

fnmp_servicenow_export.exe

-url ServiceNow-URL

-user ServiceNow-account-name

-token ServiceNow-token

-endpoint ServiceNow-endpoint

-changes Boolean

-changesPeriod -numberOfDays

-changesSince YYYY-MM-DD

-connectionTest true

-withApplications Boolean

-withContracts Boolean

-WithHardwareInventory Boolean
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Option Sample value Notes

-url https://YOUR-

INSTANCE.service-now.com

Mandatory. The URL to your ServiceNow server
instance in the cloud. Use the HTTPS protocol.

-user account@mydomain.com Mandatory. This is the user name specified in the
appropriate credentials set within ServiceNow,
the same credentials from which the token is
collected.

-token 86 random alpha-numeric
characters

Mandatory. This is the refresh token copied from
ServiceNow.

-endpoint fnmp.do or api/
x_fls_flexera_fnms/

integration/fnmstosn

Mandatory. Leave the value unchanged. This is
the integration point for ServiceNow.

Tip: While the endpoint is visible in
ServiceNow and could be modified there, it is
also recorded in the operations database for
FlexNet Manager Suite. Changing it in
ServiceNow without a matching change in the
operations database will cause automated
exports to fail.

-changes true Optional, with a default of true if it is not
present. When this option is not present, or when
it is present with a value of true (case
insensitive), only differential changes are included
in all data exports to ServiceNow. For the
baseline from which differences are measured,
see the -changesSince or -changesPeriod
options. When this option is present and has a
value false, all data (from the relevant period) is
exported from the relevant tables in FlexNet
Manager Suite (which is likely to make the data
transforms in ServiceNow considerably more
time-consuming).

Tip: You may use the default value even for
an initial data transfer, or for the first transfer
after an upgrade from an earlier version of the
executable. Initial transfers are always the full
data set, with differential transfers following
thereafter.
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Option Sample value Notes

-changesPeriod -5 Optional (no effect when not present). When
present, specifies the time window (as a number
of days) before the export for which changes are
included in the export. The negative sign is
mandatory. The example means that changes in
the previous five days are exported. Days are
measured as complete 24-hour blocks prior to
the time of the export.

-changesSince 2015-02-28 Optional. Use only when necessary to over-ride
the default date, which is the last run of the batch
scheduler on the central batch server for FlexNet
Manager Suite (or, for smaller on-premises
implementations, the server hosting this
functionality). The format is YYYY-MM-DD.

-connectionTest true Optional. If this option is provided, and has a
value true (case insensitive), no data exports are
attempted. The executable attempts a connection
to ServiceNow, and reports the results (0 or 2 as
described below) on the console. In order to
transfer data from FlexNet Manager Suite to
ServiceNow, this parameter must either be
omitted, or set to false.

-
withApplications

false Optional. When omitted, it is assumed to be
true, and applications are included in the export.
If set to false, applications are excluded from
the export. Note that at least one of these -

with* parameters must be true.

-withContracts false Optional. When omitted, it is assumed to be
true, and contracts are included in the export. If
set to false, contracts are excluded from the
export. Note that at least one of these -with*

parameters must be true.
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Option Sample value Notes

-WithHardware
Inventory

false Optional. When omitted, it is assumed to be
true, and hardware devices are included in the
export. If set to false, hardware devices are
excluded from the export. Note that at least one
of these -with* parameters must be true.

Caution: In ServiceNow, contracts and
applications/installations both have
dependencies on computers/assets. It is
recommended that you do not exclude the
hardware inventory and asset transfer, as this
may result in unpredictable gaps in other
records when the correct dependencies cannot
be established.

Result Codes

0 Success

1 A data upload to ServiceNow has failed through the maximum number of retries set in the
configuration file.

2 Connection failure, being either of:

• Failed to connect to ServiceNow. Check the URL and account details for connection.

• Failure to connect to the FlexNet Manager Suite compliance database.

3 There is no valid license for execution of the export utility recorded for your enterprise.

4 Incomplete set of command-line parameters provided (see syntax listing above). Help
information is displayed in this case.

5 An invalid tenantUId was provided. (Not applicable to on-premises implementations.)

6 Export from FlexNet Manager Suite cannot proceed because ServiceNow has not completed
previous pending imports.

Example: Examples

This example runs a connection test (because of the final parameter). Although the defaults are set for
all data transfers (applications, contracts, and hardware inventory), no exports occur. The command-line
result is 0 for good credentials, and 2 for bad credentials.

fnmp_servicenow_export.exe

-token

DbBNKvekyBVGFxPXe7TAGooeyb5bsByB2jSubap232lAkerucGHn5SnlaQasincR89...
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-user myname@mycorp.com

-url https://myserver.service-now.com

-endpoint fnmp.do

-connectionTest true

The following example restricts the export to collect only hardware inventory. Because it is not
mentioned, the default true value includes hardware inventory, with the other two possibilities
excluded. Because the -changes and -changesSince options are both missing, only hardware changes
occurring since the last scheduled export are included.

fnmp_servicenow_export.exe

-token

DbBNKvekyBVGFxPXe7TAGooeyb5bsByB2jSubap232lAkerucGHn5SnlaQasincR89...

-user myname@mycorp.com

-url https://myserver.service-now.com

-endpoint fnmp.do

-withContracts false

-withApplications false

This example covers all export types from FlexNet Manager Suite, but including only changes that
occurred in the previous 3 days, measured back in 24-hour blocks from the time the export is run.
Assuming this example is run at 1pm Thursday, it will export only changes from 1pm Monday to 1pm
Thursday (all times are local on the batch server). Strictly, -changes true is redundant, since this is the
default.

fnmp_servicenow_export.exe

-token

DbBNKvekyBVGFxPXe7TAGooeyb5bsByB2jSubap232lAkerucGHn5SnlaQasincR89...

-user myname@mycorp.com

-url https://myserver.service-now.com

-endpoint fnmp.do

-changes true

-changesPeriod -3
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4
Appendices

The following topics cover removal of any previously-installed legacy integration application (any version less
than 3.0), and improving the performance of ServiceNow with additional database indexes. A possible exception
in the ServiceNow log files is also explained.

Configuring the SAM Plugin
When you export application data from FlexNet Manager Suite for use in ServiceNow, the export utility
fnmp_servicenow_export.exe makes use of tables that are part of a plugin for ServiceNow. The naming of
this plugin, and your method of enabling it, have changed considerably across various releases of ServiceNow.
Choose the appropriate step below depending on your current version of ServiceNow.

Summary of procedures across ServiceNow releases:

1. Up to and including the Helsinki release of ServiceNow, the following applies:

• The plugin name is Software Asset Management, and its ID is

com.snc.software_asset_management.

• This plugin has a dependency on a second one named Software Asset Management Core with the ID
com.snc.sam.core.

• Your ServiceNow administrator can make the Software Asset Management plugin Active in the

System Plugins page of your ServiceNow instance. This action automatically makes the Software Asset
Management Core plugin active as well.

2. For the Istanbul release of ServiceNow, the following applies:

• If you had activated the Software Asset Management plugin in an earlier version of ServiceNow, and

your ServiceNow instance has now been upgraded to Istanbul, there should be no need to activate the
plugin a second time.

• The plugin feature is called "Software Asset Management Template", but still accessed through the
System Plugins page of your ServiceNow instance.
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• The plugin name is Software Asset Management, and its ID is

com.snc.software_asset_management.

• (There is no visible dependency on any other plugin, as had been the case for earlier releases of
ServiceNow.)

• Your ServiceNow administrator can make the Software Asset Management plugin Active in the

System Plugins page of your ServiceNow instance.

3. For the Jakarta release of ServiceNow, the following applies:

• If you had activated the Software Asset Management plugin in an earlier version of ServiceNow, and

your ServiceNow instance has now been upgraded to Jakarta, there should be no need to activate the
plugin a second time.

• Confusingly, there is a new and different plugin named Software Asset Management Premium, and

its ID is com.snc.samp. This is used internally by a new SAM application that is subscription based.

Important: This new subscription-based application and its plugin are not relevant to the
integration with FlexNet Manager Suite, and this subscription is not required for the integration. Do
not be confused by the similarities. Be aware that, when current ServiceNow documents refer to
"Software Asset Management" or "SAM", they are generally referring to the new application and the
premium plugin it uses, and this is not relevant to your project for integration with FlexNet Manager
Suite.

• The plugin from previous releases, named Software Asset Management or Software Asset

Management Template, with its ID com.snc.software_asset_management, is no longer visible in the

System Plugins page of your ServiceNow instance. However, it is still supported for the Jakarta release,
and is still required for the integration between ServiceNow and FlexNet Manager Suite.

Tip: Some documents from ServiceNow refer to this plugin as the "Base SAM plugin" or the "old SAM
plugin", and the like. Be prepared to be precise, and refer to its ID
com.snc.software_asset_management to be sure the correct plugin is identified.

• To activate the "base SAM plugin", send a request to ServiceNow Support to activate the Software

Asset Management Template plugin with the ID com.snc.software_asset_management on your

ServiceNow instance.

Removing a Legacy Integration Application
The integration application for ServiceNow (from version 3.0 and later of the adapter) is a scoped application.
Previous integration applications used global scope. While two integration applications can be present in
ServiceNow at the same time (with different scopes), it is recommended that you remove any previously-
installed integration application for FlexNet Manager Suite after installing the newer version and successfully
running the migration script.
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Note: Using the following process to remove all the components of the legacy integration application
(including its menu, tables, scripts, and user interface components). As expected, this process does not remove
any records from ServiceNow core tables.

To remove a legacy integration application:

1. In ServiceNow, navigate to System Applications > Applications, and click FlexNet Manager Suite
Integration.

2. On the page that appears, click Delete.

A confirmation dialog appears asking you to type in the word “delete”.

3. Enter delete in the dialog, and click Ok.

The application deletion progress dialog appears, and the integration application is deleted.

Tip: Sometimes deleting the integration application fails to remove the Scheduled Jobs it created. To
check, or to delete them manually:

a. In ServiceNow, navigate to System Scheduler > Scheduled Jobs > Scheduled Jobs.

b. Filter the list of scheduled jobs to find those with Name starting with Export.

c. If the following scheduled jobs exist, delete them manually:

• Export Assets From ServiceNow

• Export Contracts From ServiceNow.

Additional ServiceNow Indexes for
Performance
Creating additional indexes on your ServiceNow instance substantially improves the intake of data exported from
FlexNet Manager Suite.

ServiceNow enables you to create your own database indexes. A worked example suggests that, with the
following indexes added, you can expect better than four-fold performance increase in the initial data
transforms to finish the import of data that has been exported from FlexNet Manager Suite.

Database table New column indexed

Contract [ast_contract] vendor_contract

Software Model

[cmdb_software_product_model]

x_fls_flexera_fnms_id

Product Model [cmdb_model] model_number

Computer [cmdb_ci_computer] x_fls_flexera_fnms_computer_id
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Database table New column indexed

Software Installation [cmdb_sam_sw_install] x_fls_flexera_fnms_application_id

Exception in Log File for ServiceNow
When using the integration application for version 3.0 (or later), the ServiceNow log file shows an exception like
the following (line wrapping amended):

[2016-06-14 14:38:49] - [ERROR]: ServiceNowConnectionTest.SendTestConnection:

Error Checking Connetion to endpoint: fnmp.do

System.Net.WebException: The remote server returned an error:

(401) Unauthorized.

at System.Net.HttpWebRequest.GetResponse()

at FNMP.ServiceNow.HTTP.ServiceNowRequest.GetResponseString(HttpWebRequest

request)

in d:\SRC\FNMS\trunk\mgs\Compliance\Importer\Connectors\ServiceNow\

FNMP.ServiceNow.Console\HTTP\ServiceNowRequest.cs:line 105

at FNMP.ServiceNow.HTTP.ServiceNowRequest.Post(String content)

in d:\SRC\FNMS runk\mgs\Compliance\Importer\Connectors\ServiceNow\

FNMP.ServiceNow.Console\HTTP\ServiceNowRequest.cs:line 68

at FNMP.ServiceNow.HTTP.ServiceNowConnectionTest.SendTestConnection()

in d:\SRC\FNMS runk\mgs\Compliance\Importer\Connectors\ServiceNow\

FNMP.ServiceNow.Console\HTTP\ServiceNowConnectionTest.cs:line 30

If this exception appeared for version 2 (or earlier) of the integration application, it would mean that the
connection information for either ServiceNow or FlexNet Manager Suite was incorrect.

However, for version 3.0 (or later) of the integration application, a single exception of this type is expected, and
may be safely ignored. It occurs for the following reasons:

• The ServiceNow export utility simultaneously supports both the version 2 and version 3 architectures.

• The export utility first tries the version 2 endpoint.

• When this version 2 endpoint fails, ServiceNow posts the exception in the log file, and immediately tries the
connection to the version 3 endpoint.

• Provided that the connection information is correctly specified in the web interface of FlexNet Manager Suite
(through the system menu at System Settings > ServiceNow tab, available only when the operator is a
member of an administrator role), the connection to the version 3 endpoint succeeds and the data transfer
can proceed.

This means that, should there ever be a failure with the version 3 connection, two of these exceptions will be
logged in rapid succession (the first for version 2 and the second for version 3).
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VIII
XenApp Server Adapter

The XenApp Server adapter, provided by Flexera, allows you to collect software inventory from Citrix XenApp and
import it into FlexNet Manager Suite. Depending on the type of virtualized applications being served, the evidence
appears in either the installer evidence list (for App-V or streaming profile applications delivered through XenApp),
or in the file evidence list (for file-based applications managed through XenApp).

In either case, the evidence must be linked to an application record. This can happen in either of two ways:

• Where the evidence is matched by an existing inventory rule for an application, it is automatically linked to that
application record.

• Where required details (below) are incomplete, or there is no exact match in any existing evidence rules/records
(either supplied by the Application Recognition Library or created locally in your enterprise), the evidence is left
in the Discovered Evidence page (and All Evidence page) with its Assigned property set to No. The fields that

require matching are:

◦ For installer evidence, the application name, version and publisher

◦ For file evidence, the file name, version, company, and description.

Once the evidence is linked to an application, the application must be linked to a license. The license should then
be linked to purchase records to determine your entitlements. Of course, these are manual tasks outside the scope
of the adapter's operations.

The term XenApp Server is used in this documentation as a generic term to cover the differently-named control
servers for different versions of XenApp:

• In version 6.x, the XenApp Server was officially named the Zone and Data Collector. One such controlling server
was required per farm.

• In version 7.5 and later, the XenApp Server is called the Delivery Controller. One such controlling server is
required per delivery site.

Supported versions

The adapter links the current version of FlexNet Manager Suite to one of the following versions of XenApp:

• Version 6.0

• Version 6.5
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• Version 7.5

• Version 7.6

• Version 7.8

• Version 7.9

• Version 7.11

• Version 7.12

• Version 7.13

• Version 7.14

• Version 7.15

• Version 7.16

If it happens that you have multiple of these versions of XenApp in operation (for example in different domains),
you can use the same structure described in this section to link them all to FlexNet Manager Suite.
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1
Architecture, Operations and

Prerequisites

This chapter provides a useful framework for your understanding of the more detailed content to follow.

Architecture and Operation
In order to track licenses for applications delivered remotely to users from a Citrix XenApp environment, FlexNet
Manager Suite needs information about which users and devices have access to which applications. There are
several sources of such data available from XenApp Servers, depending on the version of XenApp:

• For XenApp 6.0 and 6.5:

◦ Access control lists (ACLs)

◦ Streaming profiles

◦ Citrix EdgeSight servers

• For XenApp 7.5 and later:

◦ Access control lists (ACLs)

◦ App-V 5 packages (and the applications they contain)

◦ For XenApp 7.6 and later, the XenDesktop database supplied as part of XenApp that tracks application
usage.

Tip: No usage tracking is possible for XenApp 7.5, as in this release Citrix did not include usage tracking
capabilities in XenApp.

Each of these sources is discussed in turn in the following sections.

Access control lists (ACLs)

These are lists which specify the permissions associated with an object, such as an application’s executable file,
on a server. The FlexNet Manager Agent for XenApp Server (XenApp Server agent) is a tool that extracts
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information about users and which applications they can access remotely, and transfers that information to an
inventory beacon for use in licensing calculations in FlexNet Manager Suite. To do this, the XenApp Server agent
must be installed:

• For XenApp 7.5 and later, on one Delivery Controller for each Delivery Site. If you have multiple Delivery Sites,
you may choose either of the following:

◦ Install the FlexNet XenApp Server agent on one Delivery Controller in each Delivery Site

◦ Use only a single FlexNet XenApp Server agent, and provide that agent with the required network access
and credentials to access all required XenApp Delivery Controllers.

• For XenApp 6.0 or 6.5, on one controlling XenApp Server in each Citrix farm.

Tip: While the XenApp Server agent is installed only on one server per farm, for XenApp 6.x you also need
software inventory from every XenApp Server, in order to identify the editions of applications available to users
and computers. This separate inventory of the XenApp Servers can be obtained either by installing the FlexNet
inventory agent on the XenApp Server, or using Zero-footprint inventory collected by an inventory beacon. Do
not get the two separate agents (FlexNet inventory agent, and XenApp Server agent) confused. The main focus
of this adapter documentation is the XenApp Server agent.

The XenApp Server agent is supplied as an integral part of the XenApp Server adapter.

Tip: In earlier releases, the XenApp Server agent extracted Active Directory names and details of users and
devices from the XenApp Server. Now, the XenApp Server agent collects only Active Directory SIDs (a large
performance improvement). As a result, best practice is that your inventory beacon completes its import of
Active Directory data before importing XenApp data, so that all Active Directory SIDs can be resolved against
the user names, devices, and groups collected directly from Active Directory.

Streaming profiles (for XenApp version 6.0 and 6.5)

The XenApp Server agent is also able to read the contents of the .profile and the key executable files
associated with streamed applications published to your XenApp Servers.

Tip: As the streaming profile is not stored in the XenApp Server’s database, the XenApp Server agent must
have at least read access to the streaming profile location to be able to read and extract this information.

As these applications are not physically installed on your XenApp Server, combining the XenApp Server agent’s
data from .profile files with EdgeSite server information may be the only way for FlexNet Manager Suite to
recognise usage of such applications.

Note: FlexNet Manager Suite is only able to recognize usage of files streamed to a XenApp Server, not those
streamed directly to client devices.

Citrix EdgeSight servers (for XenApp 6.0 and 6.5)

Citrix EdgeSight for XenApp monitors and profiles the usage of remote and streamed applications by users,
telling you both who is using that application, and on what device. The data from EdgeSight is very valuable for
FlexNet Manager Suite: you may use it for license optimization (for example, tightening access through ACL
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permissions to exclude users who evidently do not need to use the applications); or it may be critical for any
user-based or usage-based licensing of applications delivered through XenApp 6.0 or 6.5.

EdgeSight agents may be installed on each XenApp Server, and report back to a central EdgeSight server, which
can keep track of application usage on multiple XenApp machines, belonging to one or more farms. The FlexNet
Beacon can connect to each EdgeSight server and collect this usage information for use in compliance
calculations.

Unlike data from the XenApp Server agent, EdgeSight data does contain details of which devices access a
particular application. Thus, EdgeSight data is usually more valuable to an enterprise for calculating license
compliance than the data about application availability returned by the XenApp Server agent alone. If, however,
your enterprise deploys streamed applications, EdgeSight usage data may need to be supplemented by XenApp
Server agent information to accurately recognize these applications.

The following information is returned from the EdgeSight server:

• A list of applications (product name, version, publisher, and description) and the users who use them

• The devices on which users request and run applications

• The XenApp Servers from which users request applications

• The farms to which the XenApp Servers belong.

Tip: The EdgeSight data does not include application editions. Because different XenApp Servers may have
different editions installed (and available to users), it is important to take software (and hardware) inventory of
the XenApp Servers themselves, using the FlexNet inventory agent (either installed locally on each server or
operating remotely from an inventory beacon). This inventory reveals the software editions available on each
of the servers, which can be combined with the information listed above to give complete usage data required
for license calculations. For example, if server XenApp01 offers Visio Standard, while server XenApp02 offers
Visio Professional, the inventory from XenApp01 and XenApp02, combined with the data listed above, allows
the license consumption calculations to link users to the appropriate license.

To use EdgeSight data, you must create a database connection to the EdgeSight SQL server database.

App-V 5 packages (for XenApp 7.5 or later)

The XenApp Server agent is able to inspect the contents of App-V 5 packages and recover the name, version,
and publisher of the application contained in each package. The agent also returns the user's ability to access
these App-V packages (as recorded in the ACLs described earlier). However, in the ability to track which users
actually use the applications, there are differences across versions:

• Version 7.5 has no technology like the EdgeSight server available in version 6.x, and so cannot report
application usage

• From version 7.6, XenApp again allows tracking application usage through connection to the XenDesktop
database incorporated in XenApp 7.6 and later.

VDI images (for XenApp 7.5 or later)

The same capabilities apply to VDI images. The XenApp Server agent interrogates any VDI device managed by
the XenApp Server to read the applications listed in all VDI master images available (including spinning up any
images that are currently dormant to inspect their applications). As with App-V packages:
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• For XenApp version 7.5, there is no ability to track who uses any VDI image, or when

• For XenApp 7.6 and later, the included XenDesktop database allows collection of application usage
information.

Changed architecture across versions

Because XenApp release 7.5 follows an extensive rewrite of the XenApp line by Citrix, the architectures of the
two systems (and therefore the ways that the adapter integrates with the architecture) are quite different from
version 6.x to 7.x.

Tip: The following three diagrams do not include the import of Active Directory data by the inventory beacon,
as this is not part of the adapter itself. However, the prior import of Active Directory data (typically, by the
same inventory beacon connecting to the staging database) is a prerequisite for operation of the adapter.
Also keep clearly in mind the distinction between the XenApp Server agent, an executable installed on your
XenApp Server(s), and the XenApp Server adapter, an XML file (with embedded SQL) installed on your
inventory beacon. The agent is responsible for the first part of the process, collecting data and normally writing
it into a staging database; and the adapter takes the second part, loading data from the staging database to
the central application server and its compliance database.

This diagram represents the architecture and data flows for the adapter connected to XenApp 6.0 or 6.5 (the key
numbers are referenced in the table below):

The next diagram shows the architecture and data flows when connected to XenApp 7.5. The diagram is laid out
similarly to highlight the changes in architecture, and in particular the absence of usage information:

Architecture, Operations and Prerequisites

FlexNet Manager Suite Adapters Reference | Company Confidential 251



Finally, the third diagram shows the architecture and data flows when connected to XenApp 7.6 or later. The
main point to note is the return of usage information:
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The following table shows the data collected by the adapter through the different channels numbered in the
three diagrams.

Table 1: Lists imported by XenApp adapter

List Case 1 Case 2 Case 3 Case 4

User SIDs, Active Directory Group SIDs Y Y

File evidence (.exe) details – file name, version,
company, description

Y Y Y

Installer evidence (from App-V/streaming profiles)
details – name, version, publisher

Y Y Y Y

Application access rights per user SID Y Y

Application usage per user Y Y*

Client computer SIDs (with user SIDs) Y Y

XenApp Servers with applications present for delivery Y

App-V packages (and the applications therein)
managed by XenApp

Y

XenApp Servers that served applications Y

Applications available in App-V packages (creates
App-V 'evidence' records too)

Y Y

Applications available as streaming profiles Y

* Application usage by users and devices for XenApp 7.6 and later releases is limited to applications delivered in
App-V packages. (Usage based on imported file evidence is not collected.)

Operation without a staging database

It is possible to vary the integration architecture (shown in previous diagrams) so that it does not require a
separate staging database. This is achieved by using additional command-line options for the XenApp Server
agent that allow it to connect directly to an inventory beacon (see XenApp Server Agent Command Line Options
for details). The inventory beacon uploads the collected data through the central application server (or, in a
large multi-server implementation, the inventory server) directly into pre-staging tables in your compliance
database.

This model still requires the XenApp Server adapter installed on the inventory beacon, and you must still
configure a connection to the "incoming" data (as described in Create Connections for Data Upload) — except
that in this case, instead of connecting to an external staging database, the connection is directly to your central
database server. The adapter continues to perform its regular work on the central database, de-duplicating,
normalizing and transforming data from the pre-staging tables in the compliance database into the appropriate
Imported* staging tables in the same database, where it awaits the next compliance import.

This alternative varies the third diagram above to look more like this:
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Operation with XenApp 7.5 and later

The XenApp Server agent is installed on the XenApp Server (at your discretion, on only one server that can
access all other controllers for XenApp in your enterprise, or as many as one per XenApp site).

Triggered by a Windows scheduled task, the agent runs according to your settings. It may collect inventory
details only from the XenApp Server on which it is installed (default), or it may collect from several controlling
XenApp Servers in sequence (identified with the -s command line option, detailed in XenApp Server Agent
Command Line Options).

a. VDI images

Based on information found on the XenApp Server, the agent may connect to any relevant XenApp servers
hosting VDI images that contain applications. XenApp allows an administrator to nominate applications within
VDI images for delivery

1. As individual applications only

2. Within a VDI (delivered as a whole environment) only

3. Either as individual applications or within a VDI.

The XenApp Server agent collects information on all applications within the VDI master images that are
identified for individual delivery (options 1 or 3 above). The VDI evidence is returned to FlexNet Manager Suite
as file evidence. (For XenApp version 7.6 and later, usage tracking is not available for the file evidence.)

Tip: To track inventory delivered within an entire VDI environment (option 2 above), use XenDesktop
discovery and inventory through the rules-based process in the web interface of FlexNet Manager Suite.
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b. App-V packages

Again based on information gathered from the XenApp Server, the agent connects to any Microsoft App-V
publication server to inspect any App-V packages registered for delivery through XenApp. Because XenApp
requires App-V version 5 (or later) for integration, the agent can interrogate the packages to identify the
applications inside. The App-V evidence is returned to FlexNet Manager Suite as installer evidence.

For XenApp version 7.6 and later (but not for version 7.5), a connection is also made to the XenDesktop
database from the appropriate inventory beacon. This collects details of App-V application packages that users
and devices have accessed. This additional information restores the ability (missing for version 7.5) to determine
which users and devices have actually used each application, as distinct from merely having access to them. This
may allow for more accurate license consumption calculations in later compliance calculations for applications
delivered in this way.

c. Processing

So both kinds of applications are returned to FlexNet Manager Suite as evidence:

• From VDI images, file evidence is produced that normally includes file name, version, company, and
description

• For App-V packages, installer evidence is returned that normally includes application name, version, and
publisher.

When the data is finally imported into FlexNet Manager Suite:

• The incoming evidence is tested against existing evidence records (including "rules" generalized with wild
cards) already linked to applications (either from the Application Recognition Library or from records
produced in your enterprise).

• If the incoming evidence matches any existing rule or record, it is recorded against the linked application, and
its presence is recorded in the properties of the appropriate user or device as an "installation" record. For
XenApp 7.6 (or later), a usage record is automatically created for each user and each device shown to have
accessed the application.

• If the incoming evidence is not matched, it is displayed in evidence listings (for example, navigate to License
Compliance > Evidence group > Discovered Evidence, selecting the Installer evidence tab for App-V
applications and the File evidence tab for VDI applications). You can select the evidence in the appropriate
tab, and click Assign to choose an application record (or create a new one) to link to the evidence. (You only
need do this the first time that new evidence is reported. Once linked to the application, your evidence serves
as a 'rule' for matching future imports of the same evidence.)

• Once the incoming evidence is linked to an application (either automatically or manually), license
reconciliation attempts to calculate consumption through XenApp on any license linked to the application.
For this to take effect, you must correctly configure at least one license attached to the application:

1. Navigate to the Use rights & rules tab of the license properties.

2. Ensure that the License consumption rules heading is expanded (if not, click the heading).

3. Select Access granted to users, or usage, consumes license entitlements to expose additional
controls.

4. Depending on the terms of your license, choose one of Consume one entitlement for each user or
Consume one entitlement per device owned by each user.
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5. For XenApp 7.5, set Consume entitlements based on to Access (because only access records are
available through XenApp 7.5). For other versions tracking App-V applications, check the terms of your
license to see whether usage-based licensing is acceptable for this application, and make selections
accordingly.

Prerequisites
The XenApp Server adapter requires the following:

• The executable and supporting files for the XenApp Server agent. These are available as described in Creating
the Staging Database.

• The XenApp Server (on which the XenApp Server agent is installed) requires:

◦ .NET version 4.5 or greater

◦ PowerShell 2.0 or greater.

• A staging database that can run in a convenient Microsoft SQL Server instance. For example, this may be a
database running on the inventory beacon, or on the XenApp Server hosting the XenApp Server agent, or on
your central operations databases for FlexNet Manager Suite. For more about the requirements for this
database, see Creating the Staging Database.

Tip: As outlined in Architecture and Operation, it is possible to use additional command-line options for
the XenApp Server agent to remove the need for a staging database, and instead upload directly to an
inventory beacon. Once the inventory beacon uploads the collected data to the pre-staging tables within the
compliance database, the XenApp Server adapter on the inventory beacon can continue operations as
though these pre-staging tables were the staging database.

• An inventory beacon (or multiple if required) that collects Active Directory data for the domain(s) where your
XenApp Server(s) are located.

• An inventory beacon (possibly the same as in the previous point) that can connect to your staging database
and upload the inventory to the central FlexNet Manager Suite database. This process is performed by the
XenApp Server adapter on the inventory beacon.

• If you are using XenApp 6.x with the recommended EdgeSight server, an inventory beacon (almost invariably
the same one as in the previous point) that can connect to the EdgeSight database.

Tip: For XenApp 6.x with EdgeSight, also be sure to take inventory from your XenApp Servers so that
edition information is available to your license consumption calculations. This inventory may also be
collected by an appropriate inventory beacon.

• If you are using XenApp 7.6 or later, an inventory beacon (usually the same one) that can connect to your
XenDesktop database, and uploaded the imported data to your central operations databases.

The adapter links the current version of FlexNet Manager Suite to one of the following versions of XenApp:

• Version 6.0

• Version 6.5
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• Version 7.5

• Version 7.6

• Version 7.8

• Version 7.9

• Version 7.11

• Version 7.12

• Version 7.13

• Version 7.14

• Version 7.15

• Version 7.16
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2
Setting Up the XenApp Server

Adapter

The XenApp server adapter is available for different versions of XenApp:

• For version 6.0 and 6.5, it augments information available from EdgeSight, particularly about streamed
applications

• For version 7.5, it is the primary means of gathering inventory information from XenApp

• For version 7.6 and later, it again augments information about application usage collected from the
XenDesktop database included with XenApp.

The adapter is automatically saved as part of the standard installation of FlexNet Manager Suite. Installation
consists of five main activities, all described in the following topics:

• Setting up the staging database for the inventory that is collected (see Creating the Staging Database)

• Copying the appropriate folder for the adapter to your chosen XenApp Server(s) (see Installing the XenApp
Server Agent)

• Ensuring an appropriate account is available to run the adapter (also in Installing the XenApp Server Agent)

• Setting up a local scheduled task to run the agent as you require (see Create a Scheduled Task)

• Setting up a connection from an appropriate inventory beacon to the staging database (see Create
Connections for Data Upload).

Creating the Staging Database
The staging database allows the XenApp Server agent to drop collected data in a conveniently close location.
From here, an inventory beacon collects the data for transfer to the central operations databases for FlexNet
Manager Suite.

Tip: If you are choosing to use direct upload by an inventory beacon instead of using a staging database, skip
this topic.
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The staging database can be installed in any convenient Microsoft SQL Server 2008 (or later) database:

• If your inventory beacon is located on a SQL server, the staging database can be on the inventory beacon

• If your central operations databases for FlexNet Manager Suite are accessible from the XenApp Server, the
staging database tables are already present on your central SQL Server

• Where there is an inventory beacon with network access to your XenApp Server (and XenApp is running its
database in SQL Server), the staging database can be installed into the same database as used by XenApp

• If none of these suit, use any other SQL Server instance that allows network access both from the XenApp
Server agent on the XenApp Server and from the inventory beacon.

It is a small footprint database (half a dozen tables and one stored procedure) that is size-limited by the scale of
your XenApp implementation, with data being replaced at each upload.

To create the staging database (using supplied script):

1. Using Windows Explorer, locate the temporary location where you unzipped the downloaded product
archive to install FlexNet Manager Suite.

2. In your unzipped archive, navigate into the \Citrix XenApp Server Agent subdirectory.

3. Further navigate into the appropriate sub-folder for your version of XenApp:

• XenAppAgent6

• XenAppAgent65

• XenAppAgent75

• XenAppAgent76

• XenAppAgent78

• XenAppAgent79

• XenAppAgent711

• XenAppAgent712

• XenAppAgent713

• XenAppAgent714

• XenAppAgent715

• XenAppAgent716

Note: If it happens that you have multiple different versions of XenApp (for example, in different
domains), you may use a single database for all versions of XenApp. The following script is identical in
all these folders.

4. From your chosen folder, collect a copy of the database creation/update script
SetupXenAppAgentStagingDatabase.sql.
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5. On your selected SQL Server, drop a copy of this file, and execute it in SQL Server Administration Studio
against your chosen database instance.

An appropriate SQL Server database instance:

• Is accessible from the XenApp Server(s) running the XenApp Server agent

• Is accessible from the inventory beacon responsible for uploading collected inventory to FlexNet
Manager Suite

• Grants read/write access to the account running the scheduled task for the XenApp Server adapter (if
you choose to use Windows Authentication — if not, take note of the account name and password for
database access that you will include in the database connection string)

• Grants read access to the service account running the inventory beacon engine (if you choose to use
Windows Authentication — if not, take note of the account name and password for database access
that you will include in the database connection string).

The script generates the SQL schema for the database, including creating the appropriate stored procedure.
Take note of the connection string needed to connect to this database for your future reference.

Installing the XenApp Server Agent
This procedure assumes you have already located the installation folder where the XenApp server adapter
awaits.

To install the XenApp server agent:

1. In your unzipped archive, navigate into the \Citrix XenApp Server Agent subdirectory.

2. Copy the appropriate sub-folder to match your installed version of XenApp:

• XenAppAgent6

• XenAppAgent65

• XenAppAgent75

• XenAppAgent76

• XenAppAgent78

• XenAppAgent79

• XenAppAgent711

• XenAppAgent712

• XenAppAgent713

• XenAppAgent714

• XenAppAgent715
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• XenAppAgent716

Tip: If you have different versions of XenApp deployed in different domains, install the appropriate
agents on the correct XenApp Servers. Agents for different versions may connect to a single staging
database(or upload collected data directly through a convenient inventory beacon).

3. Using your network, a memory stick, or other available means, paste the entire folder into an appropriate
location on your XenApp Server(s).

For example, you could paste the folder at the root level (such as C:\XenAppAgent75). Keep in mind that
for version 6 and 6.5, you must install the agent on a single XenApp Server for each Citrix farm. For
version 7.5 (or later), you may choose to install an agent on one XenApp Server in each site, or to install
on only one XenApp Server that has network access (and credentials) for all your sites.

4. Ensure that, on your XenApp Server (Delivery Controller), there is an account with sufficient privileges to
run the agent in production.

Such an account:

• Can run a Windows scheduled task on the XenApp Server where the agent is installed

• Has read access to the file system on the XenApp Server(s) where it is to collected inventory

• Has read access to any file shares used to house XenApp packages (versions 6 and 6.5 only), App-V
packages, or applications hosted in VDI images

• For versions 6 and 6.5, is a Citrix Admin account (a limitation in the PowerShell API for those versions
means that only a Citrix Admin can retrieve the list of XenApp Servers in a farm)

• For version 7.5 (or later), is a Citrix Read only admin account, with read access to the file systems of any
other XenApp Servers sharing locally published applications for which inventory is to be collected

• Is recognized by the SQL Server hosting the shared database (if you prefer to use Windows
Authentication for access to the staging database; otherwise, you may choose to include an account
name and password in the connection string for the staging database).

Note: If you are choosing direct transfer to an inventory beacon instead of using a staging database,
you may either ensure that this same account has privileges to upload files to your inventory beacon,
or use the separate parameters for username and password to identify an appropriate account for the
transfer when running the XenApp Server agent (for details, see XenApp Server Agent Command Line
Options).

Create a Scheduled Task
The XenApp Server agent must be run locally on the XenApp Server, where it collects inventory and transfers the
data immediately either to the staging database, or to an inventory beacon for upload to the central compliance
database. This is triggered by a Windows scheduled task on the XenApp Server.

Because the XenApp Server agent, as its first action for each inventory collection, clears all old data from the
staging database, it is important that the XenApp Server agent does not run at the same time as the inventory
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beacon collects data from the staging database (otherwise, corrupt or incomplete data may result). A buffer of 2
hours provides a good safety margin (depending on the scale of your XenApp implementation).

Another consideration is that you want your XenApp inventory uploaded to the central FlexNet Manager Suite
database before the system import and compliance calculations take place. Typically, this process starts around
2am central server time. A two-hour upload buffer should be more than adequate.

These considerations suggest (within a single time zone) a collection schedule around 10pm, an inventory
beacon connection around midnight, and everything in place for the nightly compliance calculation.

The process for setting up Windows scheduled tasks varies across different editions of Windows Server. The
following example is for Windows Server 2012. Adjust for your XenApp Server's conditions.

To create the scheduled task (Windows Server 2012 example):

1. In Windows Explorer, navigate to Control Panel > System and Security > Administrative Tools, and
double-click Task Scheduler.

The Task Scheduler window appears.

2. In the navigation tree on the left, select Task Scheduler Library, and then in the Actions list on the right,
click New Folder....

A dialog appears for entering the folder name.

A suggested value is FlexNet Manager Suite.

3. Click OK, and select the new folder in the navigation tree.

4. Select Action > Create Task....

The Create Task dialog appears.

5. Enter an appropriate Name, such as FlexNet Manager Agent for XenApp Server, and add any
Description to help future maintenance of this task.

Your description may be something like Collects application and access information from a

Citrix XenApp server and transfers this information to a staging database.

6. Click Change User or Group....

The Select User, Service Account, or Group dialog appears.
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7. Enter the account name that is to run the scheduled task, and click OK.

This is the account you identified in Installing the XenApp Server Agent, and you can check the
requirements for this account there.

8. Further down in the Security options group, select Run whether user is logged in or not.

9. Switch to the Triggers tab, and click New....

The New Trigger dialog appears.

10. Ensure that the default setting Begin the task On a schedule is selected, set the parameters for the
schedule, and from the Advanced settings group, be sure that Enabled is selected.

The suggested schedule is daily at 10pm local time, but be sure that this suits the upload procedures for
your enterprise.

11. Switch to the Action tab, and click New....

The New Action dialog appears.

12. Ensure that the default Action, Start a program, is selected, and browse to your local copy of
FnmpXenAppServerAgent.exe.

13. In the Add arguments (optional) field, specify all the command-line arguments you need for the agent.

All command line arguments are documented in XenApp Server Agent Command Line Options. For
common implementations, you will either define the connection string to your staging database, or
provide the URL, account, and password for direct transfer to an inventory beacon. In addition, if you are
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using XenApp 7.5 (or later) and want a single agent to collect inventory from multiple servers, you need
the option to define those servers.

Example 1: Command line arguments to connect to your staging database.

-d "Data Source=192.168.13.38;Initial Catalog=MyStaging;

User ID=accountName;Password=password"

Example 2: For XenApp 7.5 (or later), accessing multiple XenApp Servers and recording their details in a
common staging database (all on one line):

-d "Data Source=192.168.13.38;Initial Catalog=MyStaging;

User ID=accountName;Password=password"

-s "localhost, xda01.fqdn.com"

14. Click OK.

15. Optionally, make any preferred adjustments to the Conditions or Settings tabs (normally the defaults are
acceptable).

16. Click OK to close the Create Task dialog.

The new task appears in the list of scheduled tasks for this server.

17. Right-click the new task, and click Run in the context menu.

This checks that the scheduled task completes successfully.

18. Validate operations in the following ways:

• Review the log file (FnmpXenAppAgent.log in the same folder as the agent’s executable file) for any

errors or warning messages.

• Use Microsoft SQL Server Management Studio to check the contents of the staging database.

Create Connections for Data Upload
The XenApp Server agent gathers inventory information from your XenApp Server, and does either of two
things with the collected data:

• It saves it in a separate staging database. In this case, the XenApp Server adapter (running on the inventory
beacon) takes over, and is responsible for collecting the staged data, de-duplicating and normalizing the
data, and uploading it to a set of Imported* tables in the central compliance database. The adapter requires

a connection to the staging database, and a schedule to trigger collection of inventory data from the staging
database.

• The XenApp Server agent transfers collected data directly to an inventory beacon. In this case, the inventory
beacon uploads the data to pre-staging tables in the central compliance database. Thereafter, the XenApp
Server adapter must be triggered to de-duplicate and normalize the data, loading results into the Imported*

staging tables in the same compliance database. The adapter requires a connection to the compliance
database, and a schedule to trigger processing of inventory data from the pre-staging tables to the
Imported* staging tables.
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In addition, with the exception of XenApp version 7.5, a connection to the appropriate database is strongly
recommended, as this allows tracking who is actually using applications:

• If you are using XenApp 6.0 or 6.5, the connection is to your EdgeSight server database

• If you are using XenApp 7.6 or later, the connection is to the XenDesktop database included with XenApp.

Perform this process on the inventory beacon.

To create connections for data upload:

1. Log in to your selected inventory beacon.

Tip: Starting the FlexNet Beacon interface requires that you are logged in with administrator privileges.

2. If you have not already specified a schedule (or two) that can be linked to the connection(s) you are about
to create, it's convenient to do so now.

There are two connections for each version of XenApp except version 7.5, which needs only one.
Remember that you already decided on the schedule for data collection on the XenApp Server (see Create
a Scheduled Task), and the schedules on the inventory beacon need to tie in with that plan. For example,
you might schedule the connection to the staging database at midnight, and the secondary connection
for usage data at 12:15am. For details about creating a schedule on the inventory beacon, see FlexNet
Manager Suite Help > Inventory Beacons > Scheduling Page > Creating a Data Gathering Schedule.

3. In the navigation pane on the left, select the Inventory systems page, and towards the bottom of the
page, click New....

The Create SQL Source Connection dialog opens.

Tip: The New... button defaults to creating a connection for Microsoft SQL Server. If you use the down
arrow on the split button, you can choose between SQL Server, Spreadsheet, PowerShell, and Other

connections. However, while you are creating a connection to a Microsoft SQL Server database (regardless
of the Source Type of the connection), use only the SQL Server option.

4. Complete the values in the dialog, as follows:

Control Comments

Connection Name A descriptive name for this connection, such as XenApp ServerName Staging

DB (or, if you are using the inventory beacon upload process, perhaps something
like XenApp Data Normalization).

Source Type Select Citrix XenApp (Server Agent). (Don't be confused by Citrix XenApp
(EdgeSight), which you may use shortly.)
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Control Comments

Server Type the server name or IP address. Use the special value (localhost) if the
database is installed on this same inventory beacon server. If the database
instance you need is not the default one on the server you identify, add the
instance name, separated with a backslash character. Example:

(localhost)\myInstance

Note: If you are using the inventory beacon upload process, so that the
collected data has already been uploaded to the pre-staging tables in the
central compliance database, this connection is to your central database server
running that compliance database.

Authentication Select one of:

• Windows Authentication — Select this option to use standard Windows
authentication to access the database server. The credentials of the account
(on the inventory beacon) running the scheduled task for importing inventory
are used to access the SQL Server database. This account must be added to
an Active Directory security group that has access to the database.

• Windows (specific account) — Use the following two fields (enabled when
you make this choice) to specify an account on the inventory beacon that can
make a connection to the SQL database.

• SQL Authentication — Use the following two fields to specify an account and
password registered as a user with database access on SQL Server . This
account is used to access the database, regardless of the local account
running the scheduled task on the inventory beacon server.

Username The account name used for SQL authentication, or Windows (specific account).
(Not required for Windows Authentication.)

Password The password for the account name required for SQL authentication, or
Windows (specific account). (Not required for Windows Authentication.)

Database Enter the name of the database, or use the pull-down list to select from database
names automatically detected on your specified server.
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Control Comments

Connection is in test
mode (do not
import results)

For inventory beacons that are free-standing (and not co-located with your
application server, or in larger implementations your inventory server), this
controls the upload of data collected from this connection and its import to
FlexNet Manager Suite:

• When this check box is clear, the connection is in production mode, and data
collected through this adapter is uploaded to the central server and (in due
course) imported into the database there.

• When the check box is set:

◦ The adapter for this connection is exercised, with data written to the
intermediate file in the staging folder on the inventory beacon
(%CommonAppData%\Flexera Software\Beacon\IntermediateData)

◦ The immediate upload that normally follows data collection is suppressed,
so that you can inspect the contents of the file

◦ The catch-up process that retries stalled uploads, normally scheduled
overnight, runs as usual and uploads the file to the central server

◦ At the central server, the file contents are discarded (and not imported into
the central database).

Tip: When an inventory beacon is co-located with your application server,
data from the connection is read directly into staging tables in the database,
and no intermediate file is saved.

Overlapping
Inventory Filter

This control does not apply to XenApp inventory records, and you may leave it at
the default setting.

5. Click Test Connection.

• If the inventory beacon can successfully connect to the nominated database using the details supplied,
a Database connection succeeded message displays. Click OK to close the message. Click Save to

complete the addition. The connection is added to (or updated in) the list.

• If the inventory beacon cannot connect, a Database connection failed message is displayed, with

information about why that connection could not be made. Click OK to close the message. Edit the
connection details and retest the connection.

You cannot save the connection details if the connection test fails. If you cannot get the connection test to
succeed, click Cancel to cancel the addition of these connection details.

6. When the first connection to the database is successful, and if you are using any XenApp version other than
7.5, repeat the steps above to define a second connection to the usage database (EdgeSight database for
version 6.x, and XenDesktop database for version 7.5 and later). This time through, for all these versions set
the Source Type control to Citrix XenApp (EdgeSight) (including for XenApp version 7.5 and later).
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7. On the Inventory systems page, from the list of connections select the one to the staging database you
created first in this process, and below the list, click Schedule....

8. In the resulting dialog, choose the schedule you wish to use for this connection, and then click OK to close
the dialog, and Save to apply the selected schedule to your connection.

9. For any XenApp version other than 7.5, on the Inventory systems page, from the list of connections select
the EdgeSight connection, and repeat the scheduling process, choosing the second schedule you created.

Don't forget, as you move this XenApp adapter into production, to ensure that Connection is in test mode (do
not import results) is clear (not checked).
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3
Command-Line Options

For those times when you want to control execution of the command-line agent directly, this chapter covers all
options.

XenApp Server Agent Command Line
Options
The FlexNet Manager Agent for XenApp Server (FnmpXenAppAgent.exe), or XenApp Server agent, is a
command line tool which runs regularly on a Citrix XenApp server to determine which end-users have the right
to run applications through that server. The data it collects is sent back to FlexNet Manager Suite and processed
further once the inventory import process runs. Here are the details for manual operation from the command
line, or configuring a scheduled task.

Syntax:
FnmpXenAppAgent.exe [ options...]

Options

-d connection

-f site_name_override

-h

-i true/false

-pass password

-o output_file

-s servers

-t timeout

-url beacon_address

-user username

-v 0|1

where
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-d connection A database connection string to your staging database. Refer to
http://www.connectionstrings.com/sql-server-2008 for some examples. If you do
not have a staging database but connect directly to your central compliance
database, create the connection string for that database.

Note: Do not use more than one of the -d option, the -o option, and the -

url option at the same time.

-f

site_name_override

Force an override of the default XenApp farm/site name.

-h Displays usage for the XenApp Server agent.

-i true/false (Default false.) Ignore errors. Used only for debugging purposes so that the
adapter runs end-to-end and logs all issues in the log file (in the same directory
as the agent executable).

-pass password The password for the account used for data upload to an inventory beacon.

Note: This option is used in conjunction with the -user and -url options. If
you do not specify the -pass option, the credentials for the account running
the XenApp Server agent are used.

-o output_file The full path of a file to store the output of the XenApp Server agent as it runs.
Use such an output file for debugging purposes, to see the content collected by
the agent. The output file is not required for normal operations (the collected
data is uploaded directly to the staging database).

Note: Do not use more than one of the -d option, the -o option, and the -

url option at the same time.
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-s servers Option only for Citrix XenApp 7.5 (and later). For both 6.5 (which does not
support this option) and 7.5 or later (where the option may be omitted), the
XenApp Server agent assumes that it is running on the XenApp Server from
which it is to collect inventory. In both systems, therefore, you may handle
multiple XenApp Servers by installing the XenApp Server agent on each one.
When the agent is installed locally on the XenApp Server from which it gathers
inventory, omit this option.
In Citrix XenApp 7.5 or later, you have the option for a XenApp Server agent
installed on a single XenApp Server to collect the inventory for all XenApp
Servers in a server farm. To do this, create a comma-separated list of fully-
qualified domain names or IP addresses for all the servers from which this agent
should collect inventory. Inside such a list, use the keyword localhost to
include the server on which the XenApp Server agent is installed.

Note: The account executing the XenApp Server agent must have
permissions to connect to each of the servers named in your list.

-t timeout The timeout period (in seconds) when connecting to the staging database
(default 600 seconds). If the timeout expires, the upload fails, and the data
collected from the XenApp Servers on this occasion is lost. An entry is made in
the log file (in the same directory as the agent executable) to record the failed
connection.

-url beacon_address The URL of the inventory beacon where the XenApp Server agent uploads
collected data.

Note: Do not use more than one of the -d option, the -o option, and the -

url option at the same time.

Note: This option is used in conjunction with the -pass and -user options. If
you do not specify the -pass and -user options, the credentials for the
account running the XenApp Server agent are used.

-user username The username on the inventory beacon, the account which allows data upload to
the inventory beacon.

Note: This option is used in conjunction with the -pass and -url options. If
you do not specify the -user option, the credentials for the account running
the XenApp Server agent are used.

-v 0|1 (Default 1). Sets logging messages to verbose mode. For less information, specify
-v 0.
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Examples

The following examples are split across several lines for readability. Run each example on a single command
line.

The examples depend on which form of authentication you have chosen to use:

• Windows Authentication, using a Windows (Active Directory) account that is recognized by the SQL Server
hosting your staging database

• A separate SQL Server account specified in the database connection string.

(You decided on your approach in Installing the XenApp Server Agent.) These two approaches are mutually
exclusive, so each example applies to one or the other, but not both.

Use Windows Authentication (for the account running the scheduled task, or the command line) to connect to
the staging database with a ten minute (600 second) timeout:

FnmpXenAppAgent.exe

-d "Server=192.168.13.38;Database=MyStaging;Trusted_Connection=yes"

-t=600

Using SQL Server authentication, identify a particular user name and password to connect to the staging
database:

FnmpXenAppAgent.exe

-d "Data Source=192.168.13.38;Initial Catalog=MyStaging;

User ID=accountName;Password=password"

Using Windows Authentication (with the relevant account known to both SQL Server hosts) to collect inventory
(in Citrix XenApp 7.5) from two servers, saving the collected data in an XML file for debugging purposes:

FnmpXenAppAgent.exe

-s "localhost, xda01.fqdn.com"

-o "c:\XenAppTest.xml"

Have the XenApp Server agent upload collected data to an inventory beacon:

FnmpXenAppAgent.exe

-url http://beacon01.example.com -user beaconAccountName -pass password
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4
Validation, Troubleshooting, and

Limitations

This chapter may assist in diagnosing operations of the adapter, as well as explaining certain inherent limitations
in its operation.

Validation and Problem Solving
Because the XenApp server adapter has a number of moving parts, validation and problem solving may also
involve multiple steps.

After initial implementation, the simplest validation is simply to inspect the additional installer evidence (for
App-V applications) and file evidence (for VDI applications) that are collected by the adapter, and displayed in
the web interface for FlexNet Manager Suite. Keep in mind that to complete the end-to-end process, you may
need to

• Manually link the evidence to an appropriate application

• Ensure that the application is linked to a suitable license

• Record entitlements on the license, typically by linking purchases to it.

Also remember that you must be importing information from Active Directory prior to importing inventory
through the XenApp server adapter.

When more detailed analysis is required, you may use the following checks.

XenApp server agent

The XenApp server agent, installed on your XenApp Server, records a log file in the same folder where it is
installed. The log file is replaced at each inventory collection (that is, each time the scheduled task triggers the
agent). Review the log for details of any problems. To increase the level of detail, run the agent with the
command-line option -v 1.

To see all the information that the XenApp server agent has collected, run the agent without a -d option (the
path to the staging database) and instead using a -o option with a path to a convenient local folder. This saves
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a plain-text XML file of the collected inventory that you can inspect in your preferred text editor. This is a
valuable check point when some inventory is being returned, but particular expected applications seem to be
missing. If these are missing from a file output with the -o option, look for reasons preventing agent access to
the source information. Examples might include credentials or access rights to folders containing packages.

If you use the -o option, don't forget to replace it with the -d option for normal operations!

Staging database

When records missing from the web interface for FlexNet Manager Suite are present in the output of the
XenApp server agent (see previous section), next use Microsoft SQL Server Administration Studio to inspect the
contents of the staging database. Recall that the contents of the staging database are over-written with each
inventory collection by the XenApp server agent. This means that there may be legitimate differences between
an output file obtained in the previous section, and the database contents examined in this section. Such
differences may come about if there is additional access granted to XenApp applications (the source data) in
between the time the agent is run to output the test file, and the time it is run to populate the staging database.
In general, however, there should be a high degree of correlation between the two data sets.

The inventory beacon intermediate file

Next, you can validate the data set that the inventory beacon collects from the staging database. Simply trigger
the connection to the staging database in test mode, as described in Create Connections for Data Upload. This
allows you to inspect the zip archive, which would otherwise be uploaded to the central server, in
%CommonAppData%\Flexera Software\Beacon\IntermediateData on the inventory beacon. Provided that
you make comparisons before the next run of the XenApp server agent, you should find 1:1 correspondence
between the data in the staging database and the intermediate file.

Uploads and imports

If the required data has made it into the intermediate file on the inventory beacon, you may need to debug
uploads from the inventory beacon to the central server (for example, see FlexNet Manager Suite Help >
Inventory Beacons > Inventory Beacon Reference > Troubleshooting: Inventory Not Uploading).

Keep in mind that there is a delay between the upload from the inventory beacon to the central server, and the
appearance of the data in the web interface for FlexNet Manager Suite. There must be an inventory import and
compliance calculation that occurs between these two events. If you are a member of the Administrator role, in
the web interface you may manually trigger an import and compliance calculation.

Limitations
The following limitations apply to the XenApp adapter:

• Information about who has access to applications on the one hand, and about who actually uses applications
on the other, is collected separately. Usage data relies on a Citrix EdgeSight server (for XenApp 6.x) or the
XenDesktop database included with XenApp version 7.5 and later. Since XenApp 7.5 does not support it, no
usage information is available for this version; and if you are using any other version without the appropriate
database connection, again no usage information is available.
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• When the XenApp server agent connects to a VDI image to read the applications it contains, and the image is
not currently running, the agent attempts to start up a server running the image for interrogation (and will
shut it down again afterward). This relies on the remote support of power actions (on and off, and so on) for
the master image. Where these are not available, or the XenDesktop does not have sufficient resources to
spin up another image, the start-up attempt fails. In these cases, the agent imports the name of the
executable, but it is missing the version, company, and description details. These cases appear in the list of
file evidence with the executable name, but with the name, version, company, and description columns blank.

• XenApp supports "application delivery from a remote PC" and "application delivery from the cloud". Neither
of these is supported by the adapter, and no inventory is returned for such cases.

• To improve performance compared with earlier versions of the XenApp adapter, the XenApp server agent no
longer collects user names and computer names through the XenApp Server. Instead, it collects only the
Active Directory security IDs (SIDs) from XenApp, and relies on the separate import from Active Directory to
flesh out the SIDs with more complete identities. This has two immediate implications:

◦ If you are upgrading from an earlier version of the XenApp adapter, the data from the access control lists
(ACLs) on the XenApp Server is removed on upgrade. An import from Active Directory is then required to
populate the SIDs and other identity details. After the first inventory import in the upgraded system, the
access data is repopulated.

◦ If Active Directory information is not imported by an inventory beacon for the domain(s) in which the
XenApp Servers (the ones hosting the XenApp server agent) are located, users and computers newly
registered in Active Directory (since the last import of Active Directory data) will not be recognized or
displayed in FlexNet Manager Suite.

• For XenApp version 7.6 and later, application usage information is available only for App-V packages and
applications, and streaming profile applications. Usage information is not available for file-based applications,
including VDI applications delivered through XenApp.
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5
Database Impacts

This chapter provides an overview of database tables within FlexNet Manager Suite that are affected by the
adapter. These brief notes can be augmented by reviewing the Schema Reference document for the current
release.

Affected Database Tables
The XenApp server adapter causes data to be imported to the following database tables in the operations
databases for FlexNet Manager Suite (specifically the compliance database). You may prepare custom reports
against these:

• ComplianceDomain records the domain of the XenApp Server where the XenApp server agent is installed. If

the record does not already exist, on import both the FQDN and the flat name are populated.

• ComplianceUser records are created for any user names identified in the XenApp inventory but not

previously in the operations databases. In these new records, only the UserName, SAMAccountName, and

domain are available and saved (with ComplianceUserID calculated automatically). (The domain is a link to

the ComplianceDomain table, which once again is updated as required with any new records. Such updates

should be rare, since domains should be identified from Active Directory.) Because the ComplianceUser

records created from XenApp inventory imports are far from complete, you may want to enhance these with
additional information.

• ComplianceComputer records may be created if a ComplianceUser record is created (or identified) that has

no link to an existing ComplianceComputer record. For many types of license, the consumption record is

linked to an individual ComplianceComputer, so when it is impossible to identify a computer for a particular

ComplianceUser, a new skeleton computer record is created. These have a computer name of the form

UserName (Remote)

and have their type shown as Remote Device. (This type is identified through a foreign key to the

ComplianceComputerType table.) They are also linked to the ComplianceUser for whom they are created.
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Tip: If, in future, inventory from another source identifies the same ComplianceUser as either the
assigned user or the calculated user for a computer identified by that inventory, then this placeholder record
for the remote device is removed, and any license consumption recorded against it is moved to the newly-
identified (real) computer that belongs with the user.

• For App-V applications managed by XenApp 7.5 or later, or any XenApp applications managed by version 6.x:

◦ InstallerEvidence records are created as the primary inventory data for the use of those applications.

◦ InstalledInstallerEvidence records are create to link that evidence to the appropriate

ComplianceComputer records.

◦ Where the application name, version, and publisher in the InstallerEvidence table match an existing

evidence rule for an application, an entry is created in the SoftwareTitleInstallerEvidence table to

link (by foreign keys) the installer evidence to the application record in the SoftwareTitle table.

• For VDI applications managed by XenApp 7.5 or later:

◦ FileEvidence records are created as the primary inventory data for the use of those applications.

◦ InstalledFileEvidence records are create to link that evidence to the appropriate

ComplianceComputer records.

◦ Where the file name, version, company, and description in the FileEvidence table match an existing

evidence rule for an application, an entry is created in the SoftwareTitleFileEvidence table to link (by

foreign keys) the file evidence to the application record in the SoftwareTitle table.

• InstalledApplications records are created for any applications identified in the SoftwareTitle table,

linking the application to the ComplianceComputer record.
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IX
Data Platform Integration

This part introduces the integration between FlexNet Manager Suite and Data Platform, an umbrella product that
includes both Technopedia and Normalize.

The method of integration is a straight-forward connector, available without special installation on your inventory
beacons (including any inventory beacon you may have installed on your central application server). On the Data
Platform side, an enhanced license term and a new data pack are required (see Configuring the Data Platform
Connector for details).

Such simplicity means that the main use for the documentation in this part is to understand the mapping between

• Database tables and columns that underlie Normalize, and

• The destination tables and columns in the compliance database for FlexNet Manager Suite.

Also important is the embedded commentary on the current limitations of Data Platform as a sole data source
driving license compliance calculations. When you have multiple inventory sources, imports from Data Platform
can be a valuable addition to your data gathering.

Supported version

The Data Platform v5 connector supports import only from version 5 of Normalize.
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1
Integration with Data Platform v5

Data Platform version 5 (formerly from BDNA, and now from Flexera) combines Technopedia, a reference catalog
with 120 million datapoints across more than 1.7m products, and Normalize, which provides a unified view of the
data applicable to your environment.

To integrate this data for your use in license and asset management within FlexNet Manager Suite, release 2018
R1 includes a connector that imports normalized data from Normalize v5 into your compliance database. The
imported data includes:

• Records of inventory devices (for both physical servers and virtual machines) found in your environment by the
inventory tools (such as Microsoft SCCM or BMC ADDM) that are feeding into Normalize v5

• Details of applications recognized within your enterprise through those tools

• Installation records that link the found software to the inventory devices where it is installed

• Details of end-users who log onto the inventory devices

• Where available, records of application usage (how often, and for how long, an end-user utilized an
application).

Application records are dealt with in the same way as inventory data from any other source. This means that the
data representing applications within Normalize v5 is imported into FlexNet Manager Suite in the first place as
inventory evidence (in this case, as installer evidence). What happens next depends on the details of the software:

• If the application is already known to the Application Recognition Library (ARL), and therefore has a Flexera ID
included in the import from Data Platform, the evidence is recognized by the ARL and a matching installed
application record is created (if it did not exist already) and displayed in the Installed Applications page. For
such records, the inventory evidence type is set to FlexeraID, and the installer evidence record is linked to

the application record.

Tip: It may happen that the application is only recognized by a later update of the ARL than is currently
deployed in your enterprise. If this occurs, a widget on the System Health Dashboard highlights the need to
refresh your local, downloaded ARL (or you can wait until the next automated download, which typically
happens each weekend).

• If the installer evidence is not [yet] recognized by the ARL, then following normal system processes, it cannot
be linked to an application record, and it remains in the Unrecognized Evidence page, in the listing under the
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Installer evidence tab. For these cases, the inventory evidence type is displayed as Data Platform. (Future

updates to Data Platform and the ARL may mean that the same installer evidence re-imported thereafter may
be recognized, and an installed application record automatically created at that time. For this reason, it is best
not to manually trigger application creation from such records of public applications, but to wait for Flexera's
continuing alignment work to automatically complete the links for you. If you find such a case that is needed
in your enterprise with some urgency, you can ask Flexera to prioritize its delivery through a later release of
the ARL. )

Tip: A subset of these unrecognized cases may be application records that you created locally within your
enterprise (records that in Data Platform are called "private applications", and in FlexNet Manager Suite are
called "local applications"). As such records may never be matched by the ARL, you may wish to start from
the unrecognized evidence record to re-create your local application record within FlexNet Manager Suite. In
summary, best practice is to manually trigger the creation of application records only for locally-created,
'private' applications; and to await updates from Flexera for 'public' applications.

Connector, not adapter

The integration with Data Platform v5 is not strictly an "adapter", for the following reasons:

• It does not require any custom XML file to be maintained through either the Inventory Adapter Studio or the
Business Adapter Studio

• There is no need (nor purpose) for any staging database

• There is no separate download and installation required (with the possible exception of the initial release,
where shipment of the connector is not synchronized with the product release; but in future it is embedded as
a standard part of the product).

Instead, this integration is through a connector that is available on any up-to-date inventory beacon. You set up
the import in exactly the same way as for any other inventory connection: specifying the details in the new
inventory connection dialog on the Inventory systems page on your preferred inventory beacon; and
nominating your preferred schedule for the regular imports. Full details are included below in Configuring the
Data Platform Connector.

Inventory gaps and limitations

Following topics cover the mapping of data from within Data Platform to the import tables within the compliance
database in FlexNet Manager Suite. (Hints are also given for tracking data from the import tables to the
operational tables within the compliance database, with further information being available in the FlexNet
Manager Suite 2018 R1 Schema Reference PDF, available through the title page of online help.) Within those
topics are specific comments about the impact of particular inventory gaps on tracking your license compliance.

At a high level, inventory gathered only from Normalize v5 is insufficient for:

• Oracle license calculations

• IBM server license calculations

• Any licenses that rely on details about virtual machines, such as assigned core or processor counts (for VMs,
this connector can only import the virtual host, and no other details of the VM, including pools, clusters,
capping and the like).
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As always, the recommended best practice to remedy these shortcomings is, on target devices, to install the
FlexNet inventory agent, which is optimized for collecting license-related inventory. FlexNet Manager Suite
reconciles multiple overlapping inventory sources to create unified records as appropriate.
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2
Configuring the Data Platform

Connector

Configuring the Data Platform connector is a one-time task, and quite straight-forward. Thereafter, the imports
continue at the intervals you schedule. Have ready your connection details for the Normalize v5 database.

To configure the Data Platform connector:

1. If necessary, apply for your updated Data Platform license to enable integration with FlexNet Manager Suite,
by contacting your Flexera Support consultant.

This updated license is available free of charge to existing customers who have implemented Data
Platform. It authorizes additional functionality and a new data pack. If you are unsure whether you already
have this updated license, there are two ways you may check:

• You can send a question to Data Platform Support

• You can run the following SQL statement against your Normalize v5 database:

Select IS_SUBSCRIBED from BDNA_CP where CP_NAME = ‘Technopedia Flexera Mapping’

If the result returns Y, your Data Platform instance includes the license term, and you may skip ahead to

step 3. If it returns N, you need to apply for the license update.

2. When you receive the updated activation key:

a. In BDNA Admin, navigate to the Preferences page.

b. Enure that the Registration tab is selected (top left).

c. Delete the current contents of the Activation Key field.

d. Copy the key in full from the email you received, and paste it into the Activation Key field.

e. Click Register New Key.

3. Download the new data pack:

a. Navigate to the Technopedia page in BDNA Admin.
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b. Click Start Catalog Sync, and wait for the data pack to download.

4. Ensure that the Data Platform connector is in place in your FlexNet Manager Suite implementation.

You can check whether the Data Platform connector is already in place by inspecting any inventory beacon,
or (for an on-premises implementation) your central application server (in a multi-server implementation,
check the batch server). In each case, open Windows Explorer and navigate to C:\ProgramData\Flexera

Software\Compliance\ImportProcedures\Inventory\Reader. If you find a folder there called Data

Platform v5, your connector is already in place, and you may skip ahead to the next major step. If not,
switch to a web browser to obtain your copy:

a. Access https://flexeracommunity.force.com/customer/articles/en_US/INFO/Adapter-Tools-for-
FlexNet-Manager-Suite.

Tip: Access requires your Customer Community user name and password. If you do not have one,
use the link on the login page to request one.

b. Click the link Adapter Tools for FlexNet Manager Suite.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet
Manager Suite 2018 R1.zip commences.

c. In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C:\Temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it
to the appropriate working location when the download is finished.

d. Right-click the downloaded zip archive, and choose Extract All....

e. Navigate through the unzipped archive to Adapter Tools for FlexNet Manager Suite 2018
R1.zip > Data Platform v5.

f. Copy the Data Platform v5 folder in its entirety to C:\ProgramData\Flexera Software\

Compliance\ImportProcedures\Inventory\Reader on your chosen inventory beacon.

Tip: Copy the folder to the same location on your central batch server (or server hosting that
functionality), and FlexNet Manager Suite automatically transmits it to all your inventory beacons
as part of their regular policy update. Allow an hour or two (depending on how many inventory
beacons you have) for this process to complete.

5. Ensure that you have your preferred schedule for imports from Data Platform set on the appropriate
inventory beacon:

a. Log into the inventory beacon interface as an administrator (for example, in the Windows Start menu,
search for FlexNet Beacon, right-click it, and select Run as administrator).

Tip: Remember that you must run the inventory beacon software with administrator privileges.

b. From the Data collection group in the navigation bar, choose Scheduling.

c. If there is not already a suitable schedule in the list, click New... and complete the details (see the
online help for that page for more information). Otherwise, identify the schedule you will use.
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6. Define the connection to your Data Platform implementation:

a. Select the Inventory systems page (in the same group), and then click New....

If you used the down arrow on the split button, use only the SQL Server option.

b. Complete the details, using a name that is distinct within the first few characters so that it is
recognizable in a narrow column.

Important: Take care that:

• The Source Type is Data Platform v5

• You provide the connection details for your Normalize database (not the Technopedia one).

See the help for this page for more details. When you are done, click Save.

7. Select your new connection from the displayed list, and click Schedule....

8. In the dialog that appears, select the name of your chosen schedule for inventory collection through this
connection, and click OK.

9. At the bottom of the FlexNet Beacon interface, click Save, and if you are done, also click Exit.

Tip: Consider whether you want to select your connection, and click Execute Now, before you exit.

The connection is now configured, and imports data from Data Platform on your chosen schedule. Shortly after
each import is completed, the inventory beacon automatically uploads the resulting inventory to the central
application server. After the next full import and compliance calculation (typically scheduled overnight), the
inventory is visible in the web interface of FlexNet Manager Suite.

Configuring the Data Platform Connector

284 FlexNet Manager Suite Adapters Reference | Company Confidential



3
Data Mappings, Gaps, and Impacts

The following topics provide a mapping between the source tables (and their columns) in the Normalize v5
database, and the corresponding destination tables and columns in the compliance database within FlexNet
Manager Suite. This mapping covers only the first stage of the process, into the tables with names starting
Imported.... These are effectively staging tables that hold the data between the upload from Data Platform,
and the major transition (or import) into the operational tables in the compliance database, normally followed
immediately by the license compliance calculations (the calculations of consumption against entitlements). The
descriptions also identify the operational tables where the data eventually resides, and for a more detailed
understanding of those tables and their columns, see the FlexNet Manager Suite 2018 R1 Schema Reference PDF,
available through the title page of online help.

The topics are separated by the target Imported... tables, each of which is aligned with a particular data object
within FlexNet Manager Suite. Within each listing, the columns are in the same order that they appear in the
Schema Reference, for your convenience if you are cross-referencing both documents.

As well as the list of imported data, a second list within each topic identifies the values that cannot be imported
through Data Platform v5, together with notes on the impact that these gaps have on compliance calculations.
Some gaps affect the suitability of this data source when you are managing certain types of licenses. As always,
gaps in inventory may be overcome by importing from more than one inventory source.

Each topic lists every column within the relevant Imported... table, so that if you are working across both this
and the Schema Reference, there is no ambiguity about any column: it is either listed in the imports, or in the list
of items missing from the import. Notice that this means some columns included for completeness appear in the
list of "missing" items when in fact there is no expectation that they should be imported from any inventory
source. These items are marked as "internally generated" by FlexNet Manager Suite.

Imported Installer Evidence
The ImportedInstallerEvidence table is a staging table used for input of records about installation evidence.
From here, de-duplicated and normalized records are merged into the InstallerEvidence table.

InstallerEvidence typically lists installer evidence left behind after a particular item of software has been
installed on a computer. In the case of imports from Data Platform v5, applications identified there are first
imported as installer evidence. As always, this installer evidence is tested against rules saved in the Application
Recognition Library (ARL), and when matched, the appropriate application record is added to the
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InstalledApplications table (if it does not already exist there), and is linked to the installer evidence. This
application record is then visible in the Installed Applications page of the web interface for FlexNet Manager
Suite. A record of installer evidence that cannot be matched by the ARL appears in the web interface on the
Unrecognized Evidence page.

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedInstallerEvidence table, that are not available from
Data Platform v5.

Data mapping for imported installer evidence

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedInstallerEvidence table. Other columns from the ImportedInstallerEvidence table cannot be
populated from Data Platform v5, and so are omitted here (and shown below). For more details on the database
tables and columns within FlexNet Manager Suite, please see the FlexNet Manager Suite 2018 R1 Schema
Reference PDF, available through the title page of online help.

Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_SW_PROD) /
CAT_SW_UUID

(ImportedInstallerEvidence) /
ExternalInstallerID

The identifier used in Data
Platform for the installer evidence.

(MATCH_HOST_SW_PROD) /
CAT_PRODUCT_NAME or the Flexera
ID for the application if available in
ARL_ID

Tip: A prefix of arl:// is
prepended to the ARL_ID on
import.

(ImportedInstallerEvidence) /
DisplayName

The display name of the software
recorded in Data Platform, which
is imported only when there is no
Flexera ID available. When the
Flexera ID is returned instead, this
allows matching in the ARL, which
then supplies its standard display
name for the application instead.

(MATCH_HOST_SW_PROD) /
CAT_VERSION or an empty string
when the Flexera ID for the
application is available

(InstallerEvidence) / Version When the Flexera ID is known, the
value is left empty for later supply
from the ARL. For applications
unknown in the ARL, the version
value is imported from Data
Platform.

(MATCH_HOST_SW_PROD) /
CAT_MANUFACTURER or an empty
string when the Flexera ID for the
application is available

(ImportedInstallerEvidence) /
Publisher

When the Flexera ID is known, the
value is left empty for later supply
from the ARL. For applications
unknown in the ARL, the
publisher's name is imported from
Data Platform.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

Hard-coded values:

• FlexeraID when it is available

in (CAT_FLEXERA_ARL) / ARL_ID

• BDNA when the Flexera ID for the

application is not available.

(ImportedInstallerEvidence) /
Evidence

When the Flexera ID is known, the
evidence type FlexeraID reflects
this. Otherwise, when Data
Platform is unaware of any
matching entry in the ARL, it is
identified as the evidence type.

Tip: The internal database
value BDNA is replaced with
Data Platform for presentation
in the web interface.

(CAT_FLEXERA_ARL) / ARL_ID
when the Flexera ID is available, or
an empty string

(ImportedInstallerEvidence) /
ProductCode

The Flexera ID (without the
arl:// prefix) is used when
available. Otherwise an empty
string.

Data not imported from Data Platform v5

These columns in the ImportedInstallerEvidence table cannot be populated by inventory imports from Data
Platform v5. These missing data points do not impact license compliance calculations. For further details about
these columns, please see the schema reference.

• ComplianceConnectionID — internally generated

• AccessModeID (relevant only to file evidence, whereas this import is of installer evidence).

Imported Computers (Inventory Devices)
The ImportedComputer table is a staging table used for input of inventory device records. From here, de-
duplicated and normalized records are merged into the ComplianceComputer table.

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedComputer table, that are not available from Data
Platform v5, and the impact of these gaps on license reconciliation calculations where these rely on data from
only this source.

Data mapping for imported inventory devices

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedComputer table. Other columns from the ImportedComputer table cannot be populated from Data
Platform v5, and so are omitted here (and shown below). For more details on the database tables and columns
within FlexNet Manager Suite, please see the FlexNet Manager Suite 2018 R1 Schema Reference PDF, available
through the title page of online help.

Data Mappings, Gaps, and Impacts

FlexNet Manager Suite Adapters Reference | Company Confidential 287



Data Platform (Table)/Column FNMS (Table)/Column Notes

Fabricated from:
(MATCH_TASK_DET) /
PROCESS_ID

(MATCH_TASK_DET) /
TASK_NAME and the checksum
for the same
(MATCH_HOST_OS) / HOST_ID

(ImportedComputer) / ExternalID
The format is of this form (shown with
nonsense values):

PID123|TheTask|654321:Host789

An external ID is fabricated
from the various details shown
(truncated as required and
joined with various separator
characters). This is then
mapped through the
ImportedStringMapping table
to convert string IDs to integer
IDs.

(MATCH_HOST_OS) / HOSTNAME (ImportedComputer) / ComputerName The name of the computer.

• In Windows, this is the
NetBIOS name of the local
computer, as returned by
GetComputerName()

• For UNIX-like platforms, it is
the host name of the
machine, as returned by
gethostname(2).

(MATCH_HOST_OS) / DOMAIN (ImportedComputer) / Domain The domain reported by the
computer.

Note: Data Platform
exports a domain flat name,
while the
ImportedComputer table
handles either a flat or DNS
domain name, but the DNS
domain name is preferred.
Watch out for possible
problems merging device
records obtained from
multiple inventory sources.

(MATCH_HOST_OS) /
DISOVERED_OS_NAME

(ImportedComputer) /
OperatingSystem

The operating system of the
computer.

(MATCH_HOST_OS) /
DISOVERED_OS_PATCH_LEVEL

(ImportedComputer) / ServicePack The service pack installed for
the operating system.

(MATCH_HOST_OS) /
CALC_NUM_OF_PHYSICAL_CPUS

(ImportedComputer) /
NumberOfProcessors

The number of processors in
the computer.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_OS) /
DISC_CPU_MODEL

(ImportedComputer) / ProcessorType The type of processor in the
computer.

(MATCH_HOST_OS) /
DISC_SPEED_MHZ

(ImportedComputer) / MaxClockSpeed The maximum clock speed of
the fastest processor in the
computer.

(MATCH_HOST_OS) /
CALC_NUM_OF_CORES

(ImportedComputer) / NumberOfCores The number of cores in the
computer.

Note: Currently Data
Platform gets an incorrect
result from virtual machines
(defect repair estimate
1Q2018). This affects the
consumption calculations
for all license types that use
cores as a metric (most of
these assume 1 core per
processor when the number
of cores is not available):

• Device (Core-Limited)

• Core Points

• IBM PVU

• Microsoft Server Core

• Microsoft Server/
Management Core

• Oracle Processor.

(DISC_ALL_OS) / TOTALMEMORY (ImportedComputer) / TotalMemory The total RAM in the computer,
in bytes.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_HW_PROD_MODEL) /
CAT_TAXONOMY_CATEGORY2

(ImportedComputer) / ChassisType The type of case of the
computer. Some license types
use this information to optimize
the licensing position,
particularly with desktop and
laptop computers. Types used
in Data Platform are mapped to
types in FlexNet Manager Suite
as follows:

Data
Platform

FNMS

Empty Unknown

Handhelds Tablet

Notebooks Laptop

Mainframes Main System

Chassis

Servers Rack Mount

Chassis

All others Desktop

(DISC_HDDS) / The count of
entries for this device

(ImportedComputer) /
NumberOfHardDrives

The number of hard drives in
the computer.

Note: Collected into Data
Platform only by a legacy
extractor or custom
extractor. FlexNet Manager
Suite imports it where it is
available.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(DISC_ALL_OS) /
LOCALFILESYSTEMSPACETOTAL

(ImportedComputer) /
TotalDiskSpace

The total size of all hard drives
in the computer. The results
differ for inventory collected
from SCCM directly by FlexNet
Manager Suite, or indirectly
through Data Platform v5:

• The FlexNet connection
imports the physical disk
space (DISK_DATA)

• Data Platform imports the
logical hard drive space
(v_GS_Logical_DISK).

(DISC_NICs) / The count of
entries for this device

(ImportedComputer) /
NumberOfNetworkCards

The number of network cards in
the computer.

(DISC_MONITORS) / The count of
entries for this device

(ImportedComputer) /
NumberOfDisplayAdapters

The number of graphics cards
in the computer.

Note: Collected into Data
Platform only by a legacy
extractor or custom
extractor. FlexNet Manager
Suite imports it where it is
available.

(DISC_NICs) / IP_ADDRESS (ImportedComputer) / IPAddress The IP address of the computer.

(DISC_NICs) / MACADDRESS (ImportedComputer) / MACAddress The MAC address of the
computer.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(DISC_COMPUTERSYSTEM) /
MANUFACTURER

(ImportedComputer) / Manufacturer The manufacturer of the
computer hardware. Some
examples include:

• On Windows, the SMBios
manufacturer (the WMI
Manufacturer property of the
‘Win32_ComputerSystem’
class).

• On Linux, ‘Manufacturer’ in
the ‘System Information’
section resulting from the
‘dmidecode’ command.
Sample command:
‘dmidecode -s system-
manufacturer’

• On Solaris x86, as for Linux,
with failovers first to ‘sysinfo
SI_HW_PROVIDER’ and then
to ‘ModelNo’.

• On Solaris SPARC, the ‘sysinfo
SI_HW_PROVIDER’. Typically
this value is
‘Sun_Microsystems’ or, more
recently, ‘Oracle Corporation’.
Failover to the ‘ModelNo’.

• On HP-UX, the string literal
‘HP’.

• On AIX, the ‘modelname’
system attribute preceding
the comma character. For
example, if the ‘modelname’
system attribute is
‘IBM,8202-E4B’, then use
‘IBM’. This value is typically
‘IBM’.

Data Mappings, Gaps, and Impacts

292 FlexNet Manager Suite Adapters Reference | Company Confidential



Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_HW_PROD_MODEL) /
CAT_HARDWARE_PRODUCT and
CAT_HW_MODEL, joined with a
space
Failover to
(DISC_COMPUTERSYSTEM) /
MODEL

(ImportedComputer) / ModelNo The model of the computer
hardware or the virtual
machine. This value is defined
for the context of the current
execution environment, rather
than the physical server that
may be hosting a virtual
machine or partition. For
examples across operating
systems, see the schema
documentation.

(MATCH_HOST_OS) /
SERIALNUMBER

Failover to (DISC_ALL_OS ) /
SERIALNUMBER

(ImportedComputer) / SerialNo The hardware serial number of
the computer. The goal of this
value is to be tied to the
physical hardware, partition or
virtual machine and to be as
unique as possible across all
computers in the organization.
This is due to its use in tracking
computers, particularly after an
operating system rebuild. This
value is also used to socialize
computer inventory from
different inventory sources, and
is used to map virtual machine
guest operating system
inventory to the VM host on
which the virtual machine is
running.

(DISC_HOSTS_USERLOGON) /
DOMAIN_USERNAME

(ImportedComputer) /
LastLoggedOnUser

The DOMAIN\
SAMAccountName of the user
last logged onto the computer.
Data Platform uses the flat
domain name.

(DISC_ALL_OS) / ScanDate (ImportedComputer) / InventoryDate The date the computer last had
inventory reported.

Hard-coded value Data

Platform

(ImportedComputer) /
InventoryAgent

The name of the person or tool
that performed the last
inventory.

(MATCH_HOST_CPU) /
DISC_NUM_OF_SOCKETS

(ImportedComputer) /
NumberOfSockets

The number of sockets in the
computer.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_CPU) /
CALC_NUM_OF_LOGICAL_CPUS

(ImportedComputer) /
NumberOfLogicalProcessors

The number of logical
processors in the computer.

Note: Currently Data
Platform gets an incorrect
result from virtual machines
(defect repair estimate
1Q2018). This affects the
consumption calculations
for all license types that use
processors as a metric:

• Device (Processor-
Limited)

• Microsoft Server Processor

• Processor

• Processor Points.

Data not imported from Data Platform v5

These columns in the ImportedComputer table cannot be populated by inventory imports from Data Platform
v5. The majority of these missing data points do not impact license compliance calculations (these are listed
here without comment). Those that do have an impact are noted below. For further details about these columns,
please see the schema reference.

• HardwareInventoryDate

• ServicesInventoryDate

• ComplianceConnectionID — internally generated

• ComplianceComputerID — internally generated

• ComplianceDomainID — internally generated

• IncompleteRecord — This is always set to zero for imports from Data Platform (that is, the imported record

is regarded as 'sufficient' for its normal use in license compliance calculations, subject to the known
limitations described in these pages).

• PartialNumberOfProcessors — Absence of this value prevents subcapacity license consumption

calculations for IBM PVU and Oracle Processor licenses.

• UntrustedSerialNo

• FullDetailsFromExternalID

• FullDetailsFromComplianceConnectionID
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• ComplianceComputerTypeID — This is the foreign key to the ComplianceComputerType table, identifying

whether the device is a VM, a VM host, and so on. Compliance impact: Prevents (unrecognized) VDI templates
consuming from a license. Prevents (unrecognized) VMs from observing license rules that require (or
disallow) consumption by VMs.

• ILMTAgentID — For imports from ILMT, identifies the device as a candidate for subcapacity calculations on

any related IBM PVU license(s). Compliance impact: Device consumption may be at full capacity, and
calculated only when a full inventory import and compliance calculation is run (typically, once daily).

• FNMPComputerUID

• HostIdentifyingNumber — Useful for matching records from different sources, but no direct effect on

compliance calculations.

• HostType — Useful for matching records from different sources, but no direct effect on compliance

calculations.

• IsRemoteACLDevice

• IsDuplicate

• LegacySerialNo

• UUID

• IMEI

• PhoneNumber (for mobile devices)

• EmailAddress (for mobile devices)

• CalculatedUser — Typically, calculated by FlexNet Manager Suite as the most frequent user in the last ten

log-on records. Data Platform v5 only reports this last logged on user name (LastLoggedOnUser); but this is

sufficient.

• LastSuccessfulInventoryDate

• MDScheduleGeneratedDate

• MDScheduleContainsPVUScan

• FirmwareSerialNumber

• MachineID

• IgnoredDueToLicense.

Imported VMs and Hosts
The ImportedVirtualMachine table is a staging table used for input of virtual machine records, including their
host server. From here, de-duplicated and normalized records of the VM properties are merged into the
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VirtualMachine table; and if not already present, records for both the VM and the host are added to the
ComplianceComputer table.

Tip: This data is in addition to the inventory imported for the virtual machine (and, separately, its host) and
imported as part of the inventory device records. For details, see Imported Computers (Inventory Devices).

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedVirtualMachine table, that are not available from
Data Platform v5, and the impact of these gaps on license reconciliation calculations where these rely on data
from only this source.

Data mapping for imported virtualization records

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedVirtualMachine table. Other columns from the ImportedVirtualMachine table cannot be
populated from Data Platform v5, and so are omitted here (and shown below). For more details on the database
tables and columns within FlexNet Manager Suite, please see the FlexNet Manager Suite 2018 R1 Schema
Reference PDF, available through the title page of online help.

Data Platform (Table)/Column FNMS (Table)/Column Notes

Fabricated from:
(MATCH_TASK_DET) /
PROCESS_ID

(MATCH_TASK_DET) /
TASK_NAME and the checksum
for the same
(DISC_VIRTUAL_HOSTGUEST) /
HOST_ID

(ImportedVirtualMachine) /
HostComputerID

The format is of this form (shown with
nonsense values):

PID123|TheTask|654321:Host789

A computer ID for the host is
fabricated from the various
details shown (truncated as
required and joined with
various separator characters).
This is then mapped through
the ImportedStringMapping

table to convert string IDs to
integer IDs.

(MATCH_HOST_HW_PROD_MODEL) /
CAT_MANUFACTURER

(ImportedVirtualMachine) /
VirtualMachineType

The type of virtual machine.
Values from Data Platform are
transformed as follows:

• Microsoft becomes

VMType.HyperV

• VMware becomes

VMType.VMware

• Any other value becomes
VMType.Unknown.

(DISC_ALL_OS) /
OSCOMPUTERNAME

(ImportedVirtualMachine) /
ComputerName

As Data Platform has only one
name for the VM, the previous
value is replicated here (again).
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_HW_PROD_MODEL) /
CAT_HW_MODEL

Failover to
(MATCH_HOST_HW_PROD_MODEL)
/ DISCOVERED_MODEL

(ImportedVirtualMachine) / ModelNo The model number reported for
the VM.

(MATCH_HOST_HW_PROD_MODEL) /
CAT_MANUFACTURER

(ImportedVirtualMachine) /
Manufacturer

The manufacturer visible to the
guest OS running on the VM.

Fixed value Data Platform (ImportedVirtualMachine) /
InventoryAgent

The tool that provided this
inventory record.

(DISC_ALL_OS) /
OPERATINGSYSTEM_TYPE_LABEL

(ImportedVirtualMachine) /
GuestFullName

The operating system
configured for the guest.

Fabricated from:
(MATCH_TASK_DET) /
PROCESS_ID

(MATCH_TASK_DET) /
TASK_NAME and the checksum
for the same
(DISC_VIRTUAL_HOSTGUEST) /
Guest_ID

(ImportedVirtualMachine) /
VMComputerID

The format is of this form (shown with
nonsense values):

PID123|TheTask|654321:Host789

A computer ID for the guest is
fabricated from the various
details shown (truncated as
required and joined with
various separator characters).
This is then mapped through
the ImportedStringMapping

table to convert string IDs to
integer IDs.

Data not imported from Data Platform v5

The following columns in the ImportedVirtualMachine table cannot be populated by inventory imports from
Data Platform v5. Notice that several of them (such as NumberOfProcessors, NumberOfHardDrives, and
IPAddress) have matching data points imported as part of the inventory device import for the same guest
machine. While several of these missing data points do not impact license compliance calculations, the following
gaps are significant:

• When the original input to Data Platform was from BMC Discovery (ADDM), information about virtual
machines (and hosts) is not available. In contrast, when the data source for Data Platform was Microsoft
SCCM, the identification of hosts and guests is available for supported platforms such as Hyper-V.

Tip: This is the inverse of the result obtained when FlexNet Manager Suite takes inventory from these
sources directly (rather than through Data Platform). In the this unmediated case, inventory from SCCM
does not include the host/guest, and the inventory from ADDM does include the host/guest relationship. Of
course, if you have multiple inventory sources collecting from a common target device, the results are
merged within FlexNet Manager Suite to provide the most complete record possible.

• When data is available (from inventory sources such as Microsoft SCCM into Data Platform), the import from
Data Platform to FlexNet Manager Suite is missing information about resource pools, vMotion, and partitions.
This means that, when Data Platform v5 is the only inventory source for these machines, compliance
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calculations are impossible for consumption from some licenses such as IBM PVU, Microsoft, or Oracle server
licenses.

For further details about these columns that are missing data, please see the schema reference.

• VMName

• VCObjectID

• FriendlyName

• UUID

• TotalMemory

• PoolName

• CPUUsage

• MemoryUsage

• MaxNumberOfLogicalProcessors

• VMEnabledStateID

• NumberOfProcessors

• ProcessorType

• NumberOfNetworkCards

• ComplianceConnectionID

• VMLocation

• PoolType

• ZoneResourceManagementMethodType

• AffinityEnabled

• CPUAffinity

• CoreAffinity

• PartitionID

• PartitionNumber

• FullComputerName

• IPAddress.
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Imported Installation Records
The ImportedInstalledInstallerEvidence table is a staging table used to collect records of which installation
evidence has been found on what inventory devices. From here, de-duplicated and normalized records are
merged into the InstalledInstallerEvidence table.

InstalledInstallerEvidence is a simple table that mainly links installer evidence records with inventory
device records. In the case of imports from Data Platform v5, only the two external IDs are needed, with other
values supplied by FlexNet Manager Suite as and when required. The first listing below maps the two columns
from Data Platform source to FlexNet Manager Suite destination. Below is a list of the remaining columns in the
ImportedInstalledInstallerEvidence table that are not populated by this import (and do not need to be).

Data mapping for imported installed installer evidence

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedInstalledInstallerEvidence table. For more details on the database tables and columns within
FlexNet Manager Suite, please see the FlexNet Manager Suite 2018 R1 Schema Reference PDF, available through
the title page of online help.

Data Platform
(Table)/Column

FNMS (Table)/Column Notes

(MATCH_HOST_SW_PROD) /
CAT_SW_UUID

(ImportedInstalledInstallerEvidence)
/ ExternalInstallerEvidenceID

The same value as the
(ImportedInstallerEvidence)
/ ExternalInstallerID.

Fabricated from:
(MATCH_TASK_DET) /
PROCESS_ID

(MATCH_TASK_DET) /
TASK_NAME and the
checksum for the same
(MATCH_HOST_SW_PROD) /
HOST_ID

(ImportedInstalledInstallerEvidence)
/ ExternalID
The format is of this form (shown with
nonsense values):

PID123|TheTask|654321:Host789

An external ID for the inventory
device is fabricated from the
various details shown (truncated
as required and joined with
various separator characters).
This is then mapped through
the ImportedStringMapping

table to convert string IDs to
integer IDs. The same value as
the (ImportedComputer) /
ExternalID.

(MATCH_HOST_SW_PROD) /
DISCOVERED_INSTALLDATE

(ImportedInstalledInstallerEvidence)
/ InstallDate

The installation date recorded
for the installer evidence.

Data not imported from Data Platform v5

These columns in the ImportedInstalledInstallerEvidence table cannot be populated by inventory
imports from Data Platform v5. These missing data points do not impact license compliance calculations. For
further details about these columns, please see the schema reference.

• ComplianceConnectionID — internally generated
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• ExternalInstanceID

• DiscoveryDate (will be set to the date of first import from this connection).

Imported Users
The ImportedUser table is a staging table used for input of records about users. From here, de-duplicated and
normalized records are merged into the ComplianceUser table.

ComplianceUser stores information about end-users in the enterprise, including contact details, login details,
and inventory source details (if applicable). End-users are the people using computers within your enterprise (as
distinct from operators, who are people permitted to use FlexNet Manager Suite).

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedUser table, that are not available from Data Platform
v5.

Data mapping for imported users

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedUser table. Other columns from the ImportedUser table cannot be populated from Data Platform v5,
and so are omitted here (and shown below). For more details on the database tables and columns within
FlexNet Manager Suite, please see the FlexNet Manager Suite 2018 R1 Schema Reference PDF, available through
the title page of online help.

Data Platform (Table)/Column FNMS (Table)/Column Notes

(DISC_HOSTS_USERLOGON) /
USERDOMAIN and USERLOGON

combined

(ImportedUser) / ExternalID Mapped through the
ImportedStringMapping table to
convert string IDs to integer IDs.

(DISC_HOSTS_USERLOGON) /
USERDOMAIN

(ImportedUser) / Domain The domain of the end-user. Data
Platform exports the flat domain
name.

(DISC_HOSTS_USERLOGON) /
USERLOGON

(ImportedUser) /
SAMAccountName

The login name (SAM account
name) of the end-user.

Hard-coded value Data Platform (ImportedUser) /
InventoryAgent

The name of the person or tool
that performed the last inventory.

Data not imported from Data Platform v5

These columns in the ImportedUser table cannot be populated by inventory imports from Data Platform v5.
These missing data points do not impact license compliance calculations. For further details about these
columns, please see the schema reference.

• ComplianceConnectionID — internally generated

• UserName
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• ComplianceDomainID

• LocationID

• FirstName

• LastName

• Email

• EmployeeNumber

• CostCenter (as reported in SAP)

• ComplianceUserID — internally generated

• ComplianceDomainID — internally generated

• IsBlacklisted — internally generated

• MapUsingEmailAddress.

Imported Software Usage
The ImportedInstalledInstallerEvidenceUsage table is a staging table used to collect records of actual use
of applications related to installation evidence found on inventory devices. From here, de-duplicated and
normalized records are merged into the InstalledSoftwareUsageData table.

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedInstalledInstallerEvidenceUsage table, that are
not available from Data Platform v5, and the impact of these gaps on license reconciliation calculations where
these rely on data from only this source.

Data mapping for imported usage related to installer evidence

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedInstalledInstallerEvidenceUsage table. Other columns from the
ImportedInstalledInstallerEvidenceUsage table cannot be populated from Data Platform v5, and so are
omitted here (and shown below). For more details on the database tables and columns within FlexNet Manager
Suite, please see the FlexNet Manager Suite 2018 R1 Schema Reference PDF, available through the title page of
online help.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_SOFTWARE_METERING) /
USAGE_YEAR and USAGE_MONTH_N

Failover to
(MATCH_SW_RECENTLY_USED_APPS)
/ LASTUSEDDATE

(ImportedInstalledInstaller
EvidenceUsage) / StartDate

The start date is set to a string
formatted similarly to ISO 8601
(except for the slash separator: 2019/
04/01) by conjoining the year and
month-number from Data Platform,
and adding an assumed day for the
first of the month. Only if there is no
value available by this path, we use
the date available from the alternate
table shown.

Fabricated from:
(MATCH_TASK_DET) / PROCESS_ID

(MATCH_TASK_DET) / TASK_NAME
and the checksum for the same
(MATCH_SOFTWARE_METERING) /
HOST_ID

(ImportedInstalledInstaller
EvidenceUsage) / ExternalID
The format is of this form (shown with
nonsense values):

PID123|TheTask|654321:Host789

An external ID is fabricated from the
various details shown (truncated as
required and joined with various
separator characters). This is then
mapped through the
ImportedStringMapping table to
convert string IDs to integer IDs.

Tip: If the
MATCH_SOFTWARE_METERING

table cannot provide a host ID, it is
taken from
MATCH_SW_RECENTLY_USED_APPS.

(MATCH_SOFTWARE_METERING) /
CAT_SW_UUID

(ImportedInstalledInstaller
EvidenceUsage) /
ExternalInstallerID

The identifier used in Data Platform
for the installer evidence.

Tip: If the
MATCH_SOFTWARE_METERING

table cannot provide an external
ID, it is taken from
MATCH_SW_RECENTLY_USED_APPS.

(MATCH_SOFTWARE_METERING) /
USAGECOUNT plus TSUSAGECOUNT

(ImportedInstalledInstaller
EvidenceUsage) / NumberOfSessions

If the number of sessions in which the
evidence was in use cannot be
calculated by this method, the default
value 1 is inserted.

(MATCH_SOFTWARE_METERING) /
LASTUSEDDATE

Failover to
(MATCH_SW_RECENTLY_USED_APPS)
/ LASTUSEDDATE

(ImportedInstalledInstaller
EvidenceUsage) / LastUsedDate

The last known date when usage of
the application is recorded (in one
table or the other).
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_SW_RECENTLY_USED_APPS)
/ LASTUSERDOMAIN, then a
backslash \, then LASTUSERLOGON

(ImportedInstalledInstaller
EvidenceUsage) / ExternalUserID

The end-user identified in the source
as using the software. The identifier is
fabricated by conjoining the flat
domain name and logon name
(separated by a backslash).

Data not imported from Data Platform v5

These columns in the ImportedInstalledInstallerEvidenceUsage table cannot be populated by inventory
imports from Data Platform v5. These missing data points do not impact license compliance calculations. For
further details about these columns, please see the schema reference.

• ComplianceConnectionID — internally generated

• ExternalInstanceID (used only for Oracle).
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